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STATISTICS CAN SOMETIMES prove something.
There are more than 1.1 billion Internet users;
around three billion mobile phone users; a billion
who use Internet Messengers and e-mail daily; and
lately, a third of a billion on Web 2.0 sites—the now
all-too-familiar Orkut and MySpace, and—the most
interesting part—Second Life.

We’ve spoken about that online phenomenon
quite early on in Digit, and even if most of us don’t
have the bandwidth to really be there, it’s an impor-
tant phenomenon.

Observe. There are two things central to all
these popular manifestations of technology—they
have raked in hundreds of millions of users in just
five years, and, all of them have one core agenda—
to link up human beings. They essentially foster
increased communication, sharing of thoughts and
opinions, and, exchange of content.

The second point deserves attention here—let
me elaborate.

Any technology-led innovation that has met
with instant success, been adopted globally, and
topped popularity charts worldwide—language and
cultural barriers notwithstanding—must satisfy
one fundamental need of human beings: the need
to socialise, express thoughts, and most pointedly,
to communicate. We love to build communities,
converse, and connect. If a technology helps us do
these, we lap it up. 

Why are MMORPGs such a rage, despite the fact
that you can always play the game with a bot? That,
I think, drives home my point. We want to con-
nect—even if for a duel—with other people. Real
people. Think about it... we might create virtual
identities in Second Life and satisfy our desire to be
that someone else, but eventually, we do it all to
connect with other human beings (even if they’re
represented by a virtual identity themselves). 

The achievements of these new technologies, if
I may say so, also displace the popular notion that

the increased usage of computers isolates people,
even making them vulnerable, prone to loneliness
and depression. If a “computer addict” is glued to
social networking sites, it’s not necessarily an
instance of isolation. For many introverts, these
sites are their only recourse when they feel the
need for social interaction.

Networking sites—and now Second Life—
becoming so popular clearly indicates that the suc-
cess formula for any technological innovation in
this space, to quickly scale up and find favour glob-
ally, is to bring in an element of human connect—
even if it’s virtual.

editor@thinkdigit.com

Editorial

Deepak Ajwani Executive Editor

To Connect 
Is Human

“If a technology helps us build
communities, converse, and connect, we

lap it up”
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Enter

16
Jan Blom talks
to us about
Nokia’s new
design studio in
India

16
When social
networking sites
become targets
for attack, it
doesn’t bode
well

20
The University
of Chicago says
“no PPT skills,
no admission!”

23
All about Moblin

Digital Passion

Contents Magazine

Cover Story
48 centrePieCe!
Sure, you can be the
brave geek and
assemble your family
PC, but what happens when
things go awry? The best thing
about branded PCs is the tech

support and
peace of mind that come

bundled with them... Here’s
a comparison of the best
in the market, for
budgets big and small

Lead Feature
27 Sci-Fa
Think science fiction—as in motherships
and cyborgs. Then think about what’s gone
beyond fiction, what’s not, what’s being
said today... think all such thoughts

Enhance
43 Access: Granted  
Got data? Here’s our primer to Microsoft’s Access,

and how it can make your life
much easier

40 Droolmaal
Gaudy speakers to hang from your ceiling, a
classy new cell phone and oodles of portable
storage in this month’s Droolmaal. The
pictures are pretty, and the things cost a
pretty penny. Get your tissues ready!

38 Take A Crack At
Want to be called a Windows magician?
We’re sure you can impress your folks real
easy—just make the Yahoo! icon! vanish!
from! the! toolbar! But make Explorer’s
menu bar vanish at will, and then make it
re-appear—and we’ll suitably reward you!

3 Incredibly Useful Sites
84 In Theory And In Practice
One for the science geek; getting serious, one for he
who seeks management wisdom. One for photo buffs.

Agent001
80 New Ways To Play
Old Games
You may be used to the keyboard
and mouse for gaming, but what
if you want more? Agent 001
goes on the hunt for wheels,
joysticks and more!

Digital Tools

Insight
32 Almost Intelligent
While they’re hardly sentient beings, our
appliances today baffle us with what they
can think of. Here’s what you need to know
about the fuzzy logic that drives them

Tomorrow
36 Alterface!
Tired of the boring
old window-icon-
menu-pointer
interfaces that
we’ve been stuck
with since the
eighties? We are, too. We explore the
reasons behind why things are where they
are, and present a look at what’s to come

Know More About
86 Touchscreens 
All you need to know about
different touchscreen technologies
and how they work—and also
about the hype vs. the matter
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108 Cause For Concern
Everyone worries about
their organisation’s
security, and it’s one area
where companies aren’t
shy to pay through their
noses. India’s companies,
too, are taking steps to
keep their data safe—
they’re all aware of the
gravity of the situation

Tech Careers
89 Powering The Tower
Join the wave of professionals heading into
India’s all-too-booming telecom industry!

Business Test
92 All-In-Wonders!
It’s the era of the multi-
functional device. So
here’s our annual test:
we’ve tested a bunch of
these do-it-alls, starting
with the most basic to the
powerhouses that even the
big corporates swear by

Smart Business
104 Cheapest 

Trumpet
Thought you needed
wads of cash to
promote your
business? Here’s how
you can do it on a
shoestring budget! All
you’ll need apart from
small change is time
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Here in this space, it’s
quite an adventure
for us: The Darkness is
upon us, and we fly
into it with Project
Sylpheed, wielding the
Sword Of The New World...

116 Webcam Test
Talk Tonight
Webcams were never
so cheap! Choose
from among the best,
and let your friends
and relatives see you
from miles away!

Escape

131
The ENIAC took
us into the age of
computing...
meet the men
who made it

130
Of all the
st00pid H4x0rs!
They “hacked” a
wiki! You may
commence
laughing now

Digital Leisure Touched by Tech
111 A Chain For The Chasm
Where do you go when you want to help

the community? Stick to your
armchair... some organisations

will allow you to
volunteer over

the Net

Tabloid Tech
147 Wallpaper Woman

Wields Wiimote
The world’s sexiest
woman (Playboy thinks
so!) loves her Wii,
screaming “Bimbo with
brains.” Cool.
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MULTIMEDIA
LEGO Digital Designer

LEGO Digital Designer is quite simply the
best virtual building system out there –
with its “Click-Stick” method of 3D
modeling winning praise from children,
parents, teachers and design enthusiasts
everywhere. And, as the virtual design
platform behind a growing number of
LEGO products, LEGO Digital Designer is
here to stay. A host of improvements and
new features are already in development,
including an improved user interface,
new connectivity, more life-like building,
Technic compatibility and improved train
building and animation. 

K-3D
K-3D features a robust, object oriented
plugin architecture, designed to scale to
the needs of professional artists. It is
designed from the ground up to generate
motion picture quality animation using
RenderMan compliant rendering engines.

Anime Studio 5.5
Anime Studio is your complete animation
program for creating 2D movies,
cartoons, anime or cut out animations.
Create your own desktop animated shorts
in the style of SouthParkStudios.com and
JibJab.com, or use it to produce full-
length animation for film, video or
streaming over the web.

■ CaraQ maker 0.61
■ DAZ Studio 1.7
■ Stickman 4.8
■ StudioLine Photo Basic 3.18.1
■ Antechinus Animator Professional
■ DigiCel FlipBook 4.55
■ Filter Forge 1.009
■ Flash Effect Maker Pro 3.5
■ Grid Magic Senior 1.0.2
■ MAGIX Movie Edit Pro 12
■ PhotoProto

SYSTEM
My Friend Mikey 2

Use your voice and/or your mouse to
quickly navigate to any Website, and
launch any program. Mikey is animated,
moves, floats, and talks to you. Mikey
also reads your mail (or any text) to you.
Common commands are included.

Autopatcher XP July 2007
Update
The latest update for AutoPatcher. To use
this, you’ll need to install the AutoPatcher
May 2007 release and June 2007 update
from the August 2007 DVD

■ AirSnare 1.5
■ Microsoft Windows Defender
■ NVIDIA PerfKit (Windows XP)
■ PC WIZARD
■ Vista Transformation Pack 7
■ Automize—Linux 7.35
■ DataPilot 52
■ Direct Access 1.6.2.1
■ MindSoft Utilities XP 9.8c
■ MobilEdit 2.4.5.4
■ Panda Internet Security 2008 12.00.00
■ Super Utilities Professional 7.65

PC-BSD
Blender 2.42
Blender is the open source software for
3D modeling, animation, rendering,
post-production, interactive creation
and playback. 

FREE
Fate By Numbers

Fate by Numbers is a Full Motion Video
adventure game filmed against a green
screen and featuring 3D pre-rendered
backdrops. The adventure games
includes over an hour of HD-video with
professional actors accompanied by a
soundtrack written for the game. Private
eye Alice Sanger is assigned to get a
briefcase, but quickly finds herself
immersed in a web of corruption and
shadowy motives. It becomes personal
when she finds out that one of
mysterious people behind the briefcase
is none other than her ex-husband whom
was declared dead several years ago.
What follows is a mysterious journey
through the layers of a future metropolis
with 50’s noir influences.

De Blob
de Blob is a 3D game in which the player
controls a ball of paint rolling through
the city. The ball can absorb coloured
NPCs to become larger and change its
colour. With the paint, the player can

then proceed to paint the entire city.
Almost everything is paintable:
buildings, trees, cars and using the paint
trace even the ground. The main goal of
the game is to paint all 17 landmark
buildings.

FlightGear Live CD
The FlightGear flight simulator project is
an open-source, multi-platform,
cooperative flight simulator development
project. Source code for the entire project
is available and licensed under the GNU
General Public License. The Live CD lets
you start playing the game as soon as you

boot—no installation, no changing files on
your disk.

■ Racer
■ Privateer Gemini Gold
■ TAGAP: The Apocalyptic Game About

Penguins

DEMOS
Anderson and the Legacy of
Cthulhu
The player impersonates Robert D.
Anderson, private investigator from New
York, who travels to Germany during the
first months of WWII in order to solve his
most frightening case to research his
origins. Arriving at the castle of his
ancestors, he discovers an occult secret
society among the SS, called “The order of
the black sun”, revealing secrets powerful
enough to endanger mankind itself.

■ Tasty Treats Adventures—The Secret
Recipes

■ Tribal Trouble

THE FREE OFFICE
FreeMind 0.9.0 Beta

FreeMind is a premier free mind-
mapping software written in Java.
The recent development has
hopefully turned it into high
productivity tool. We are proud that
the operation and navigation of
FreeMind is faster than that of
MindManager because of one-click
“fold / unfold” and “follow link”
operations.

OpenOffice.org 2.2.1

OpenOffice.org is a multiplatform
and multilingual office suite and an
open-source project. Compatible
with all other major office suites,
the product is free to download,
use, and distribute. 
■ Action Point Of Sale
■ FreeProxy (Windows)
■ JAMES
■ Maintenance Assistant
■ Mozilla Thunderbird
■ Squid (For Debian-based Linux

distros)
■ Tunir Accountant 2007
■ WAMP5

DEVELOPERS
Adobe FrameMaker 8

Adobe FrameMaker 8 software is a
powerful tool for technical
communicators that combines word
processing and XML-based
structured authoring with template-
based publishing.

Visual C# 2008 Express
Edition Beta 2

The next
version of
Visual
Studio,
Microsoft
Visual
Studio

2008, will provide an industry-
leading developer experience for
Windows Vista, the 2007 Microsoft
Office system, and the Web. This is
the beta release of Visual C#

■ EasyEclipse for C and C++ 1.2.1
■ Windows Media Center SDK 5.2
■ Audio Formats SDK 1.6
■ Zend Studio 5.5

Productivity

Tools

GamingF
8,700 MB Of Quality Content!

DUAL LAYER
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INTERACTIVE

CHANNEL 9
Microsoft Research TechFest—XNA, a
depth-sensing camera, an LCD
projector, and some genius
This is probably the world’s only example of real-
time terrain generation with XNA through the use
of a depth-sensing video camera and real world
objects. Video provided by Microsoft Channel 9
(channel9.msdn.com)
■ Byron Cook: Terminator—Proving Good Things Will Eventually Happen

AUDIO BOOKS
Love Among the Chickens by P. G. Wodehouse
Jeremy Garnet, a second-rate novelist, gets talked into joining
his old pal Stanley Featheringstonehaugh Ukridge in an insane
plan to start a chicken ranch. Garnet should bail out on his
crazy friend, but he falls in love with one of Ukridge’s
neighbors, Phyllis. Soon he is up to his neck in sick chickens,
bad debts, a hostile future father-in-law, a sinister plot, and
dirty golf. It all gets a bit thick, what?

■ The Adventures of Pinocchio by C. Collodi
■ The Island of Dr. Moreau by H. G. Wells

MOVIES
The Amazing Mr. X
On the beach one night, Christine Faber, two years a
widow, thinks she hears her late husband Paul calling
out of the surf...then meets a tall dark man, Alexis, who
seems to know all about such things. After more ghostly
manifestations, Christine and younger sister Janet
become enmeshed in the eerie artifices of Alexis; but he
in turn finds himself manipulated into deeper deviltry
than he had in mind...

■ Dracula’s Guest
■ Dracula’s Message
■ Dracula’s Prisoner

MUSIC
The Red Line of Hydrogen by Talley Lambert
This is the first album released by Talley Lambert, home recorded
in 1999. The album is mainly guitar-based singer/songwriter folk-
rock with a full band. Songs are generally acoustic, laid back, and
introspective. Preview this album in the Digit media player!

Port Angeles by Alex Bailey
Port Angeles, the most recent album of Alex Bailey was cut in
Winter 2006 in Seattle Washington.  Recorded on a mini disc
recorder with an upright house-piano, Port Angeles carves through
winding country songs celebrating singer/songwriters of the last 30
years. 

■ Anomalous Material by JT Bruce
■ Getting Back From Where I’ve Been by Kelly Allyn
■ I Don’t Know What I’m Doing by Brad Sucks
■ The Grasping Hands of Possibility by Ruined Machines
■ underground horn by Daniel Brandell
■ Words and Voices by Aesthetic Evidence

Entertainment

PC-BSD
PC-BSD has been designed with the “casual” computer user in mind. Installing
the system is simply a matter of a few clicks and a few minutes for the
installation process to finish. Hardware such as video, sound, network and other
devices will be auto-detected and available at the first system startup. NOTE:
During our tests, we discovered that PC-BSD’s hardware support can be shaky, so
it might not install on all PCs

Also Included
■ PC-BSD Disc 2 (the essential PBI installer pack)
■ Java Runtime (JRE) 1.5.0.07
■ KSmoothDock 4.5
■ NVIDIA Driver 9746
■ The Ur-Quan Masters 0.6.2
■ VLC 0.8.6a

PC-BSD

FREE
Mono
The object, as far
as there is one in
this game, is to
turn the screen
from black to
white, or vice
versa. You do this
by controlling a
round white circle which is capable of
shooting beautifully arranged displays
of firepower at faceless coloured
circles which float around the playing
field.

The Breakdown—A Snack-
Sized Adventure Game
NaaC

The Breakdown
is a fairly short
point-and-click
adventure game
where you’ve
broken down in

the desert and are in need of repairs
so you can return your lottery ticket in
time.

■ NaaC
■ Eternal Daughter
■ Halo: Hell on Earth Trilogy Edition
■ Wandering Knights
■ Zep’s Dreamland

DEMOS
■ People Shooter
■ RIP 3: The Last Hero

MOVIES
ExtraStrong
ExtraStrong is a short stop-motion
animation that tells the story of a
fight between two pieces of paper.

■ Star Wars: A Clone Apart—Episode 1

FUN SOFTWARE
Sketch Studio
Sketch Studio is an easy to use drawing
program for children. Although there
are a number of drawing programs
available for children, Sketch Studio is
unique in that it contains built-in
drawing lessons.

Magic Whiteboard 1.8
Magic Whiteboard is a fun and colorful
network drawing software, designed
especially for kids’ entertainment

MUSIC
Lies and Speeches by HYPE
HYPE is a
Parisian band of
4 musicians
whose taste for
the pop melodies
coupled with
power rock’n’roll
is somewhere
between the
West Coast and the London fog. They
wish to share their sound—a “perfect
blend of electric, pop lyricism and
‘entêtante’”—to fans all over the world

MULTIMEDIA
Flookey

Flookey is a free audio player that
learns which music you like through
observing your listening behavior
and looking at your music library’s
metadata. It then uses this
information to suggest songs from
your library that match your
listening preferences, to create
dynamic playlists, and to provide an
intelligent way of navigating your
audio library.

M.I.R. 1.2.05
Manual retouching of long image
sequences with thousands of images
can be a time consuming and tedious
task. With M.I.R. HS-ART offers an
efficient and easy to learn solution for
manual retouching of any kind of
single image defects. For example
dust spots, bad splices, tears, and the
like can be fixed with a few clicks.
M.I.R. can also be used for real-time
player of long image sequences. You’ll
need a graphics card with at least 128
MB of RAM to use this program.

■ Free Fast MPEG Cut 2.3.2.1
■ SCREEN2EXE
■ Wavosaur
■ A4 Flash Menu Builder 2.14
■ HyperCam 2.14.01
■ Livid Union 2.1.2

TOOLS

ENTERTAINMENT

GAMING
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Ashampoo Magical Security

A Digit Exclusive! Ashampoo Magical Security is the
successor to the popular Ashampoo Privacy
Protector. The new program is now even easier to
use, with a new look and even more powerful
security. You need to be connected to the Internet

to register for this exclusive full version.

SYSTEM

Digit
Exclusive

FREE



By Demand
You get to choose what goes
on Digit Interactive. This
month, you chose:

Visual C# 2008 Beta 2
Size: 414 MB  

Autopatcher XP June
2007 Update
Size: 38.5 MB

taste technology at www.thinkdigit.com

This Month’s Question

To vote Log on to www.thinkdigit.com

Which OS you think has the best GUI, and why do you feel so?

Digit Reader Poll

Ubuntu
Windows Vista
Windows XP
Mac OS X

Subscribe
No more snail-mail!
No need to visit post
offices! All you have
to do is log on to
www.thinkdigit.
com/subscribe and
use your Credit Card
to make sure you
never miss another
issue of your favourite
magazine!

What security software do you have installed on your computer?

Last Month’s Question

To
ta

l: 
36

96

THE BIG FIGHT ((wwwwww..tthhiinnkkddiiggiitt..ccoomm//ffoorruumm))
Search through our Fight Club, and you never know what turns up...

by adithyagenius 

Please repeat after me 
1) I am an intelligent person striving to be
perfect/genius and not a retard striving to be
fanboy/hindhole

2) People have unique requirements, learning
curve, time to spend learning and customising,
money etc for their software.

3) The software that I use is not the best for
every individual in the universe.

4) If I want to suggest my software/product in a
RELEVANT thread I will do so backed with logical
reasons and explanations along with advantages
AND disadvantages (if possible). I will not imply
(directly or indirectly) that they are disgusting
piece of animal/human excrement if they reject
my suggestions.

5) Forcing my software choice upon people with
ridiculous bandwagonism and fanboying is
immature.This is only going to make people
hate my software and make me look ridiculous.
This might also force people to avoid
conversing with me.

6) Every fanboy has the mental strength to
become an open-minded, practical user.

I browse digit forum for technology news and
some good discussions on software ( I could
contribute little due to my noobism) . Recently
the trend has changed here with lots of threads
being instigated by fanboyism which give
negligible information ( The most significant
information I got was how pathetic the fanboys
are ) with same arguements / fanboy wars. These
threads come disguised as useful technology
news or tutorials but have little use (The only use
was that I could send those links for entertaining

my friends). They also bury the real informative
threads. Of course a few posts boasting about
your software might introduce new software and
products to noobs like me but, fanboyism has
crossed a line here.

I request all sane digit forumers ( I hope I am
not alone) to work together to prevent this forum
from going to dogs/fanboys. I have noticed that
fanboyism increases when a fanboy is challenged.
So, I request forum members to ignore all fanboy
posts and threads or read them (if needed)
without replying, however insulting it might be to
your software choice.This should cool them down
from a fanboy to an open-minded fan. If this
succeeds I will know Gandhigiri works.

Sorry, for any bad language or spellings. I
apologise if I hurt anyone's feelings.

Got an opinion? Share it at:
http://www.thinkdigit.com/forum/showthrea
d.php?t=58763

Everything, from anti-virus to
anti-phishing software 21.53%

A firewall, an anti-virus, and
anti-spyware and anti-malware 33.44%

Only an anti-virus 35.78%
Security software… what’s that? 9.25%

Open-mindedness vs Fanboyism
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Nokia recently set up the first in
a series of satellite design
studios here in India. We caught
up with Jan Blom, Head of Nokia
Satellite Design Studio, India,
for a tête-à-tête.

What role will the Indian Design
Studio play in the context of
designing phones for Nokia? Will
you design future mobiles
specifically for the Indian market
or also for a global audience?
Jan Blom: The main objective of
the programme is to bring us
closer to local cultures and tradi-
tions, helping us find new ideas
that can be implemented across
our global portfolio of products. 

How do you see Internet services
shaping up on mobiles here?
Jan Blom: Internet usage on the
mobile phone is the new mega-
trend. We are looking at what
people want to do with mobile
phones—sharing and creating
content and building person-
alised networks.

What have you observed
regarding Indian mobile usage
habits and handset features
preferred by Indians?
Jan Blom: We have conducted a
lot of research into how
cultures and traditions in India
translate into colour and
materials / texture preferences.
Vibrant colours—reds and blues
are important right now—signify
a rich cultural identity and help
your phone to be noticed.
Metallic colours reinforce status
in India. Silvers, Blacks, Golds,
and metallic finishes are
popular because of a strong link
to a heritage of craftsmanship
and artisans. Right now, it’s all
about colour. We are now
looking at what colours will be
in vogue next year and the year
after that…

Indian consumers are
looking at simple ways to
navigate  menus, so Nokia has
introduced a one-touch feature
for the music, Internet, camera,
and GPS options.

Windows Live SkyDrive: 500 MB—For Now
Microsoft has unveiled Windows Live SkyDrive, their new online storage
service—currently available only for users in the US, the UK, and India! File
sharing options are featured—such as Personal and Public—along with
password protection. Visit skydrive.
live.com. It’s very user-friendly.

India Now Nokia’s Second-Largest Market
India has overtaken the United States in the second
quarter of 2007 to become Nokia’s second-biggest
market by sales, after China. The company shipped 60
million handsets from its factory near Chennai in the 18
months to August. Demand is expected to remain strong.

Amajority of
broadband users
“share” music both

legally and illegally and
watch YouTube videos. No-
one thinks they could be
doing something
potentially dangerous; turns
out, it could be. Hacking
pranks—and even serious
attacks—are in the news in a
fairly big way, probably for
the first time.

The BlackHat
conference, a gathering of
computer protection
professionals, was held in
Las Vegas in the first week
of August. Security
specialists demonstrated
serious vulnerabilities in
social networking sites. This
means cause for concern
for everyone.

MySpace users, for
example, customise their
pages with various layouts,
CSS, and HTML code.
Unscrupulous hackers take
advantage of poorly-
written code, and inject
malicious code into such
pages. These aren’t “real”
hackers—this kind of
hacking is all too easy.

Rick Deacon, a network
administrator (and a benign
hacker) in Ohio, discovered a
“zero-day” flaw in MySpace.
This is a security ulnerability
that becomes publicly known
immediately after the attack
happens. The flaw allows
intruders to take command
of personal Web pages.

Clones of popular social
networking sites provide
streaming media, and the
facility to share that
content with others.

Many small- and
medium-sized social
networking start-ups centred
on the streaming of audio-
visual content are cropping
up. User-generated content
that social networking sites
offer could now turn out to
be a threat. Malicious code
can even be injected into
files streamed from such
sites. According to David
Thiel, iSEC researcher,
“Stream formats are good for
containing exploit code and
are quite dangerous because
of the widespread use of it
with kids online these days.”

Incidentally, at last year’s
Black Hat conference,
security professionals
revealed how hackers Bad
Code using RSS feeds.

Then, hackers and
security professionals have
talked about the
vulnerabilities in social
networking sites due to cross
site scripting loopholes—this
is for those who know what
CSS is. We can’t go into the

details here, but suffice it
to say it’s a bad thing.

The problem exists
even at the browser level:
CSS loopholes have been
found in older versions of
Firefox. Opera recently
fixed a JavaScript flaw
using a Firefox tool (!)
called Fuzzer.

Millions of people
who frequent social
networking sites don’t
even have an anti-virus
installed—or at least
don’t regularly update
their virus definitions.

Web 2.0 stands tall on
the trust model with

user-generated content. If
that trust is going to be
subject to exploit code,
where do we go from here?
On a non-technical note,
what’s frustrating is that
what the bad folks are doing
is just for fun, just for cheap
thrills, pure and simple. 

THE VIEW FROM THE
MOUNTAIN

There’s G In
The Air

This is yet another
Google tale that must
be told. The (US)

Federal Communications
Commission’s (FCC) wireless
700 MHz band auction to
take place on 16th January
2008 was announced in July
of this year. Google, as we
learn, has intentions of
stepping into the mobile
advertising market—and
the announcement was

Enter
VULNERABILITY 2.0

They’re Invading Your Space

Illustrations Harsho Mohan Chattoraj

■ The Compact Disc turned 25 this August ■ 46 million Nokia phone batteries identified as potentially dangerous ■ Google shuts down video service

JanBlom,
Head of the Nokia Satellite Design

Studio, India



precisely what they were
waiting for. Newspapers,
columnists, and bloggers
couldn’t but talk about
only one thing: Google’s
commitment to bid $4.6
billion (Rs 19,320 crore) in
that spectrum. 

To elaborate a little:
what happens when a party
wins this auction is, it will
have a say in what content
uses that part of the
spectrum. The winner
would be able to roll out its
services in conjunction
with the partner(s) that it
decides upon. Essentially,
the winner will “own” that
band—they would be able
to pump whatever content
they’d choose on it.

Google’s plans to enter
the mobile market tie in
well with the fact that the
company has already rolled
out mobile versions of the
YouTube service, Google
Maps, and Gmail. Along
with the applications
themselves, Google has the
potential to create revenue
through ads, like it has
created from Web
advertising. The Wall Street
Journal has reported that
Google already has been
working on a mobile search
engine and browser, and
that the company has

invested “hundreds of
million dollars” in their
own cell phone project. The
phone prototype is
currently being dubbed the
Gphone. WSJ reports say
The Company Based In
Mountain View “is courting
wireless operators to carry
handsets customized to
Google products, including
its search engine, e-mail
and a new mobile Web
browser.”

A key quote here from
four months ago: “What’s
interesting about the ads
in the mobile phone is that
they are twice as profitable
or more than the non-
mobile phone ads because
they’re more personal,”
Google Chief Executive Eric
Schmidt said, at D: All
Things Digital in May.

Speculation about the
whole Google / mobile
affair is aplenty, and we
don’t want to get into it all.
Still, we must wonder: will
they be able to tap into
India? Remember that
wireless service providers
are already inundating
customers with their
schemes and customised
ads. Players like mGinger,
m-Earn, and YouMint are
even into things like “pay-
to-read” SMS ads.

Phone owners have
good reason to be fed up:
think VAS product schemes.
But Google has the will, so
they could well find a way.
All you need do is think
about the G-company’s
unobtrusive, targeted ads
on the Web—including
those in its Gmail service—
and then hark back to the
days when pop-up blockers
weren’t ubiquitous and
pop-ups were in plenty.

Wikipedia
Scanner
A new tool
called Wikipedia
Scanner, just developed. It can
reveal who is behind the edits
in Wikipedia articles. Visit
http://wikiscanner.virgil.gr.
Please do—you’ll find a lot of
dark, interesting things!

Big Companies
Organisations
(big ones!)
like Disney,
the CIA, the
FBI, the BBC,
and more
have been
found to be enhancing their
own Wikipedia entries,
removing or altering
controversial topics.
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Security Watch

Two New Vulns—
Patch And Update!
The Problem

A vulnerability has been
reported in several editions of
Microsoft Excel. It can be
exploited to take control of a
user’s system. Memory could be
corrupted and arbitrary code
executed.

Various Symantec products,
including Norton AntiVirus
2006, Internet Security 2005
and 2006, SystemWorks 2006,
and AntiSpyware Edition 2005
have vulns that can be exploited
to compromise a user’s system.
They are caused due to errors in
certain ActiveX controls under
certain conditions.

What To Do
Microsoft has released patches
for the various editions of
Excel. Find them at
www.microsoft.com/technet/s
ecurity/Bulletin/MS07-
044.mspx. 
Symantec Security Response
has released
Bloodhound.Exploit.148 to
detect and block attempts to
exploit the aforementioned
vulnerability. Get the fix at
http://tinyurl.com/4kwu. The
vuln can also be fixed by
updating virus definitions and
signatures through LiveUpdate.
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This month, we asked a few of our readers which OS they thought has the best GUI, and why 
they felt so

Ubuntu Windows Vista        Windows XP        Mac OS X4321

“I choose (3). Windows
XP is the most easy-to-
use OS. It has the best
available manual help
and one can achieve
better looks with free
third-party software.”

Saurav Basu 
Kolkata “(1) because it has vari-

ous Desktop environ-
ments and window
mangers, which range
from the minimalist
Fluxbox and Xfce which

are low on resources to the full-featured
GNOME and KDE. Besides customisability,
there is now Compiz Fusion, which can
amaze you with its effects.”

Gaurish Sharma
Jaipur

“It’s (4) for me. Mac OS X has
a very smooth look and a
good balance between appeal
and performance, while tak-
ing up very less system
requirements for smooth per-
formance. I like the glassy

look and feel of a Mac—it looks polished.”
Mayank Makhija

New Delhi
“(3) for me… I think XP is
the best operating system
because the user interface
is easy to use, and simple
enough for everyone to
understand.”

Pritish Kulshrestha
New Delhi

“(1). Ubuntu + GNOME is
really simple to use and very
customisable. And with
Compiz added to Ubuntu, it
changes how we looked at
GUIs in the past.”

Gopi Charan
Bangalore

“”I’ll say (3). It has an easy-
to-use interface and the
Taskbar is great. I like
using [Alt] + [Tab] to navi-
gate between windows.”

Kushagra Srivastava 
Nagpur

■ China to play Big Brother with 20,000 security cameras in Shenzhen ■ UN Web site attacked, sections deleted ■ MTV to invest Rs 2,000 crore in games

(You, too, can participate in this poll at www.thinkdigit.com)Opinion Poll
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NOW, THE MORE THE MERRIER

Software
Reprogra-
mmed  

The advantages of multi-
core processors—of
which a lot is being

talked about these days—
include the use of cache
memory, and more
importantly, distribution of
threads for processing to the
various processors. So that
you get a clearer picture,
here’s what threads are:
think of a thread as part of a
program in execution. A
program is software; when it
runs, it creates (one or more)
thread(s), each of which do
part of the overall task. So,
for example, if your browser
is loading a page, the
browser is the program, and
there is one thread that
loads an image, one that
loads another, one that runs
a script, and so on. (This is
simplistic, mind you.)

The hardware advantages
are meaningless without
software to take advantage

of it. The majority of
common software
applications cannot as of
now take use multi-core to
its potential—they just aren’t
coded to use multiple
concurrent threads in an
effective manner.

“The power of multi-core
processors to increase
software performance is
fantastic, but not automatic
and not happening fast
enough,” said Elliot Garbus,
general manager of Intel’s
Developer Relations
Division. In July of this year,
Intel introduced a global-
scale curriculum for
training developers in
better multi-threaded
application design. (It
should be clear why Intel
took the initiative.)

Now, AMD has made
available a specification
called “Light-Weight
Profiling” (LWP), which
developers can use to code
multithreaded applications
and improve their
performance using the
features to be offered in
future AMD processors. 

In simple words, LWP
manages to look at the
threads in a program,

collect this data, and report
to the programmer.

The Java Runtime
Environment (JRE) is
probably installed on your
computer to facilitate
interaction of your browser
(for example) with Web
applications. (Online Java
games need the JRE.) The
JRE, as an example, will
benefit from LWP; it is
capable of running multiple
threads, and it is widely used
in application development.
LWP can also be
implemented in the
development of operating
systems and compilers.

On the other side of the
battlefront, Intel recently
published eight papers on
programmable multi-core
processors. These focus on
memory architecture, cache
sharing, on-die integration
of cores, and hardware
architectural changes that
will accelerate application
multithreading and
parallel programming.

These efforts will in all
likelihood close, to some
extent, the gap between
where the hardware and
software are today. The
developer community hasn’t

yet reacted in regards to the
viability of the LWP
proposition, though.

The best use of these
developments can be made
by virtual machines (cf.
virtualisation) and allied
applications at the server
level. However, the gestation
period for software that can
follow multiple instructions
cannot but increase.
Software production costs
will rise—developers will
need to be trained in new
coding methods.

CHINKS IN THE CHIP

Bypassing
The Port

The EU, along with the
US and twelve other
countries have started

issuing e-passports, which
involve biometric
recognition; in some cases,
only to particular officials
and citizens, and in the case
of the US, to all citizens. The
International Civil Aviation
Organisation (ICAO), a
transnational organisation
that sets the standards and

A Round-up Of Technology News From Across The GlobeThe Digital World

GERMANY
A court in Offenburg has ruled
that file sharing is a “petty
offence” and that German law
has no provision allowing for
action in such instances!

FRANCE
Peugeot will move
20,000 of its 72,000
computers to Linux—
Novell’s SUSE Linux
Enterprise. The
package includes the
Novell edition of
OpenOffice.org 2.

An NGO in the US—with members
like Yahoo!, Dell, Eli Lilly, Hilton,
HSBC, Verizon, and more has
launched a campaign against
cybersquatting. The NGO says it is
a threat to the future viability of
Internet commerce:
cybersquatting is costing brand
owners over $1 billion annually.

UNITED STATES

The Coalition political parties have
rolled out a program to clean up Net
porn at a cost of $160 million (Rs
650 crore). Individuals will be able
to request a filtering program or ask
the ISP for a “clean line.”

AUSTRALIA

UNITED STATES
The US Air Force has opened up the
bidding for upgrading the Global
Positioning System with the
construction of eight new GPS III
satellites, which will be deployed in
2013. It has also called for bidders on
its ground-based GPS system.

CHINA
The miniOne, an iPhone clone, has
been released, with upgrades that
beat the original. Specs include a
resolution of 720 x 480; two cameras,
one of them 3MP; a DMB TV-Tuner;
GPS; and video output. The 4 GB
version will sell for $250 (Rs 10,200). 

■ Sony and Virgin Comics to launch a video game based on the Ramayana ■ Universal Music to sell songs in various online partnerships without copy protection ■
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Photograph S Bhojwani

E-mail your caption with the
subject “Beat That”, and your
postal address, to
beatthat@thinkdigit.com
and win 
Visual Studio 
2005 Team System
by Jean-Luc David, 
Tony Loton,
Erik Gunvaldson
Published by

Each month Digit will carry a caption for a photo. Come up with something funnier, 

and beat the Digit team at their own game! Entries accepted by the 20th of this month.

Digit Caption

“Sweet Chills @256kbps”

rules for conduction of
international flights, issues
the specifications for RFID-
enabled biometric passports.

Security experts from all
over have been saying for a
while now that e-passports
aren’t safe. First, experts on
the subject in the EU said
the concept of the e-passport
was “poorly conceived,” and
a week later, a chink in the
armour of the e-passport was
reported by The Guardian in
the UK: the data on the RFID
chip was easily accessible, it
turned out.

Later last year, Lukas
Grunwald, a German
security researcher from
consulting firm DN-
Systems, demonstrated in
collaboration with another
researcher that e-passports
carrying RFID chips could
easily be cloned—in five
minutes, at that—using an
RFID reader.

Grunwald has now found
another flaw. The RFID chip
embedded in the passport is
meant to thwart document
forgery; Grunwald cloned a
passport’s RFID chip,
manipulated the image file
containing the photo, and

then used the altered chip to
break the RFID reader that is
currently used.

It has been pointed out,
though, that Grunwald used
a German passport with a
fingerprint biometrics; his
exploit would not hold in
the case of other countries’
biometric passports. Paul
Proctor from Gartner’s
technology research group
has commented that there is
only a small probability of
the same exploit being found
in other e-passport systems,
but that if one is found, it
might have high impact.
Still, the probability is there,
and we’ll be watching for
developments. As of now, the
biggest issue is that there
exist no uniform biometric
technologies and
specifications for e-passports.
India is completely out of the
picture here, though
Pakistan has been issuing
machine-readable passports
since October 2004!

We cannot go into the
issues behind the need for e-
passports in the first place—
we’d have to talk about
terrorism and such. But
there are lessons to be

learnt: standards and
international cooperation
are a necessity if the whole
e-passport thing is to take off
worldwide; that the rollout
of a technology in as
important a field as citizen
safety should not be rushed;
that as our dependence on
technology increases, even if
we live with the fact,
responsible bodies should
be, well, responsible.

SUIT UP!

PowerPoint
An Essential
Skill

We’ve all made /
laughed at / heard
jokes about how

the fancy corporate types live
their lives by the spreadsheet
and the PPT—and they do,
too. PowerPoint skills are
highly appreciated at the
workplace—not only for
effective communication, but
(if used wisely) to keep people
interested enough not to
drop dead with boredom.

And now, the University of
Chicago has finally bowed to
the inevitable, decreeing that
PowerPoint skills will figure
in the criteria for their
selection of potential
B-school students. 

Starting this year,
hopeful candidates will be
required to submit four
pages of PowerPoint (or
similar) slides with their
applications. The goal,
apparently, is to be able to
judge students on
creativity—something not
entirely possible through
their test scores, application
essays or even letters of
recommendation. The
tactic, the university says,
will help them attract truly
creative students—the rare
breed that can actually
create an interesting
presentation.

Microsoft estimates that
the world is subjected to 30
million presentations a day—
most, as we’re sure you’ve
noticed, highly unpleasant
viewing. Oh, the stories...
we’ve seen execs who think
that using Comic Sans MS
can magically “lighten the
mood” of a presentation, or

Last Month’s Winner!
Sumit Banerjee, 
Kolkata, West Bengal

“WINDOZE K9 EDITION”

■ Tata Indicom and Samsung launch dual SIM card phone ■ Symantec and Intel to work on chip-level security products ■ Two “fix packs” for Vista released
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that using the cheesy “laser”
sound effect makes for a
“cool, dynamic” look... the
list is endless.

Seriously, though, it’s a
good move. B-school
students we know have also
confirmed that one of the
first and most important
skills they learn while
within those walls is to
make good presentations.
Your projects are worthless
if you don’t have the
presentation summarising
it, so it’s only logical that
your application should
include something similar.
We’re just waiting for our
Indian B-schools to follow
suit. Maybe then this era of
PowerPoint abuse will
finally end.

THEY DO RESEARCH, TOO

Beyond
Windows And
Word

Microsoft, known
rather more
popularly for

Windows and Office, recently
bundled four applications
into a design suite called
Expression Studio. It
comprises Expression Web,
Expression Blend, Expression
Design, and Expression
Media. These tools work
together for Web and
Desktop applications to
support Silverlight (which

we’ve spoken about in this
space) and the .NET platform.
What’s interesting here is
that this is significantly
indicative of the fact that
Microsoft is seriously looking
at research, cutting-edge
research beyond what we call
mundane. (It takes a
horizontal shift of thought to
realise that research goes
into operating systems, too.)

Whenever there’s a
mention about research in
computer graphics, a few
names are always at the top
of the list—Adobe, Industrial
Light & Magic, and, as if we
need to mention it, NVIDIA.
At SIGGRAPH 2007, Microsoft
researchers presented one of
every eight papers on
industrial computer graphics.
(SIGGRAPH is an
international conference
around research in computer
graphics and interactive
technologies; it is held every
year, and have been active for
more than three decades.)

Richard Szeliski, head of
the interactive visual media
group at Microsoft Research,
said, “What we produce is of
the same quality and calibre
as the best universities in the
world.” The latest from the
Microsoft Research stables
includes image de-blurring
software, which combines
pictures blurred due to
camera shake and
reconstitutes them into a
single high-quality image.
Szeliski says the software can
improve images taken even
from a 1MP phone camera.
So you’ll be able to take a lot
of bad pictures and use them
to produce one good one!

Then there’s Soft Scissors,
which cuts an image with
complex edges from one
background to another—in
real-time, on a regular PC.

For instance, you can add a
picture of a pet to the family
portrait using Soft Scissors.
The outline of the pet could
involve fur, and Soft Scissors’
algorithm can deal even with
such complex edges.

Enthusiasts and
professional digital
photographers will make the
best use of such tools.

Mind you, Microsoft
Research isn’t the only set of
teams out there working on
such algorithms. But most
research isn’t productised,
and Microsoft has the edge
because, well, they’re in the
business of selling software.

An interesting issue here
is copyright… if image
enhancing tools such as
these are made available to
the public at large, then
imagine the following: an
enemy could pick up a
portrait of yours and mess
around with it. You could
end up looking ridiculous.
But it’s been morphed
beyond recognition, so it
would be tough for you to
claim it’s your picture… and
would you want to make
that claim?

There is also speculation
about whether the algorithms
and final products Microsoft
Research comes out with will
be commercialised—or
remain interesting online
pastimes. But remember
there’s a “$” in “M$”.

PROTECTION NEEDS PATCHING

Safe In The
Knowledge 

The last piece of
software on your
computer to have a

security vulnerability would

AMD has revealed its plans to release, in 2009, an
eight-core chip code-named Sandtiger. AMD hopes that
this new offering, coupled with its quad-core Barcelona
and Shanghai (for its second-generation Opteron
platform) processors, will tip the scales in its favour—
with Intel on the other side, of course. Sandtiger will
have an inbuilt memory controller and eight
“Bulldozer” cores built using the 45nm fabrication

technology. It will be at the heart of AMD’s third-
generation Opteron platform. 

Aimed at the high-end server and workstation
segments, Sandtiger incorporates a slew of new
technologies like HyperTransport 3.0 (which links
individual cores) and Direct Connect 2 (which improves
system speed and efficiency). Sandtiger will also
support DDR3 memory. 

Does Intel care about Sandtiger? Will it? We’ll have
to wait for 2009…

Sandtiger

It’s all in the numbers

Stat Attack

Top five vendors, worldwide PC 
shipments, second quarter 2007 The number of

active Internet
users in India

had increased to
60 lakh by

March 2007 vs.
41.2 lakh a year

before

Desktop PC sales in India
increased 19% in 2006-07 over

the previous financial year.
Notebook sales, a whopping

97%

Half of the 24
million homes
in the US with
HDTVs lack an

HD cable or
satellite feed.

A quarter didn’t
even know they

were still
watching non-

HD signals!

Half of 25 to 34-year-olds in
the UK would not be able to
“carry on” without e-mail.

More women (41%) than men
(38%) were hooked to their

Inbox

Lenovo (4.9)

Acer (4.3)

Toshiba 
(2.4)

Others (26.5)

Dell (9.5)

HP  (11.3)

■ Opera uses Mozilla tool (“Fuzzer”) to nail down “Highly Severe” security bug ■ Next-generation mobile Linux platform—“MOTOMAGX”—unveiled by Motorola

Source: ID
C; Figures in m

illions
(D

esktops, notebooks, x86 servers)



23DIGIT SEPTEMBER 2007

Enter

Moblin.org
What is it?
An open source initiative, in
partnership with Intel, to build a
mobile entertainment and
communications platform for
use on tablet PCs and Intel-
based Mobile Internet Devices
(MID), Moblin.org hosts projects
that will provide the kernel,
multimedia applications, power
management framework, etc.
for open source projects.

Who is behind it?
Intel has mooted this project to
work in collaboration with
programmers from Canonical,
Red Flag MidLinux, and Pepper
Linux. Independent
programmers can also
contribute their development to
these projects and build
applications for these devices.

Why is it a good thing?
Moblin.org aims to ensure the
interoperability of the various
components used in open
source platforms of the MID
genre. It will provide all the
source code and binary images
that can run on these devices
for developers to build on. 

How does this help?
Developers, with access to
shared information, can now
learn of new developments and
quickly build applications for
the platform of their choice. For
Intel, this move  takes them
closer to open Web standards
while partnering with Linux
architects who even participate
in kernel development.

Where does this project
intend to go?
It is hoped that the project will
be a technology incubator for a
lot of MIDs and handhelds that
will be produced in the next
three years.

When will the project be
completed?
It is an ongoing endeavour
and will not focus on
deadlines. Intel says
Moblin.org will only host the
source code and tools such as
documentation and mailing
lists for programmers to use.

be the anti-virus, you’d
believe. Even if not you,
many people would—they
do consider they’re fully
“safe,” “secure,” and such—
if they have that nice
yellow icon in the taskbar,
indicating protection from
all that’s bad on the
Internet. You have the
icon, nothing gets into
your computer. It’s that
simple—for many people.

It turned out in the
second week of August
there’s a major bug—with
two ActiveX controls, to be
precise—in the 2006
versions of Norton
Internet Security, Norton
AntiVirus, and others,
including some 2005
versions. 2005 we can
understand. But 2006 is
more difficult to
understand—you updated
it just a year ago, and it’s
already gone to the bad.
Symantec warned users,
“This error could allow an
attacker to crash IE, or
possibly run (code) with
the rights of the logged in
user.” The security
advisory also mentioned
that the attacker would
first have to sway the user
to navigate to a specially-
crafted Web site. (Which
isn’t all that hard, we
should remind the more
Net-savvy amongst you.)
The answer is to run
LiveUpdate, a rather

helpful
feature in

the
software.

Well-
known security
firm Secunia
rated the flaw
“highly
critical.”

Some are
pointing out
the silliness of
those who do
not update
their anti-
virus on a
regular basis.
If you’re
stuck with
a 2006
version in
its
original

form (without having
updated it), the fault lies
with you—or so a lot of
people would have you
believe. But does the
LiveUpdate program itself—
tell users that updates are
“critical”? That your
computer might become
vulnerable if you don’t use
it? Does even the
installation guide, or the
help file, mention explicitly
the following: “It is of
critical importance to use
LiveUpdate on a regular
basis; failure to do so could
put your computer at risk”?
It does not.

What if your car
manufacturer suddenly told
you you’re accident-prone
because you didn’t service it
often enough?

On the other hand,
some commentators are
taking a negative view of
Symantec in general, saying
the news of the
vulnerability does not
surprise them. We will not
go one way or the other: it’s
up to you to use Symantec’s
products or pay for a
different anti-virus or use a
free one. But do remember
to update it regularly, and
this is the 3,428th time
we’re telling you this.

Our only comment is
that the vulnerability
hasn’t done good to the
company’s already-
diminishing reputation.

SO WHEN?

Déjà Vu

This is just about
something we noticed
in the news. November

2005, much of the Web—at
least the part we frequent—
was abuzz with: “Samsung
challenges Japanese fuel
cell tech.” The report was
that Samsung had
developed a prototype
notebook fuel cell that
could last twice as long as
rival systems—and it was
lighter and slimmer. Some
speculated the cell would
be in the market by 2007.

December 2006: “Samsung
has made significant
progress towards the
battery life problem,
demonstrating a 12,000 Wh
fuel cell for its Q35 laptop.”
It used Direct Methanol
Fuel Cell technology.
Speculators speculated it
could come to market by
end of 2007.

Now here’s 13th August
2007: “The Direct Methanol
Fuel Cell, recently showed
off on a Q35 Samsung laptop
in Korea, provides total
energy storage of 12,000 Wh. 

12,000 Wh... where did
we hear that before? Hark
back two paragraphs.

One analyst is now
saying fuel cell technology is
on the brink of becoming a
very promising option for
the future, once final
engineering work has been
completed. (Our italics.)

We’re as befuddled as
you are. Disclaimer: if
Samsung does do
something revolutionary,
don’t tell us we predicted
something to the
contrary—we aren’t. We’re
just wondering about how
the same news is coming
out every year with
clockwork regularity.

3rd October 2006:
“Consumers will have to
wait a few years before they
(get) fuel cells, Nokia said.”
It was something about the
supply chain. But it could
also be about the final
engineering work. Hark
back two paragraphs. 

■ Windows Update makes Skype users restart, causing network to go under for two days ■ Nokia to offer Windows Live Services on upcoming mobile phones
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Zorks. Borgs and solar systems. Mother ships
and Planet Zyclone and teleportation.
Androids and cyborgs and robots and super-

human strength. Jetpacks and light-sabres and
Snork guns and pulsar beams and Xanatron. All
those “trons” and “orks.” Those Science Fiction
(SF) writers spared nothing—they were creative as
hell, they imagined like no-one else did, they cre-
ated cults. Sci-fi created a culture—a culture far
removed from the goings-on on boring Earth.
Those writers, some of them brash and in the
limelight, some bespectacled and room-bound,
were all creators of universes. They rambled.

But sometimes they told the truth. About
the future.

What drove those science fiction authors to
imagine weird stuff? Weird stuff apart, how did
they manage to tell us tales of things to come?
How does, as the popular phrase goes, “science fic-
tion become science fact”? Why is sci-fi some kind
of benchmark, as in “the truth today is stranger
than science fiction”?

Illustrations Shrikrishna Patkar
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But these are idle questions, and the idea here
is to explore stuff people said that is now fact,
some stuff that will—in our limited opinions—
remain in the clichéd realm of science fiction,
and what debates are currently on about our
future as a race. Think gizmos, universes, tele-
portation. But forget the Zorks. We made that up.

The Man, The Machine, The Cliché
We’d be insulting your awareness if we were to
tell you that androids, cyborgs, robots, and other
superhuman stuff is the most common theme in
SF. (Actually, these share top spot with space
travel.) It’s quite simple, really—if you’ll let us be
analytical. Desire drives imagination, and what
desire is stronger than to be stronger, mightier,
faster, …? As for space travel, the underlying motif
is freedom… but we digress.

Here’s Edward Ellis, in The Steam Man of the
Prairies (1868), about a robot of a sort: “It was about
ten feet in height, measuring to the top of the
‘stove-pipe hat,’ which was fashioned after the
common order of felt coverings, with a broad
brim, all painted a shiny black. The face was made
of iron, painted a black color, with a pair of fearful

eyes, and a tremendous grinning mouth.” Note
the language, note that it’s stuff like this that
made illustrators do all those tin-can robots,
and note the lack of imagination: the excerpt
screams, “Mechanical Man!”… and little else.

And now here we are: ten feet? No, EveR-2
Muse is petite. (Digit, February 2007…

remember? Take vitamin supplements.)
Face of iron? Not quite… EveR-2

Muse has a face of real
flesh. Black? No,

Sci-Fa
Lead Feature

Imagination drives sci-fi; tech drives sci-fact; sometimes they intersect, sometimes they don’t
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money… he’d bought an implant-watch. He told
time by one red mark and two red lines glowing
beneath the skin of his wrist.” Fa-sci-nating? No-
one’s done this, but we can. If a cyber-punk called
Stelarc could implant an entire ear into his forearm
(Digit, July 2007), why not a little watch with
glowing hands? Stelarc’s ear is clearly visible,
meaning it’s pretty close to the surface of the skin.
A watch wouldn’t be too hard. Ask a medical
expert if you don’t believe us. That guy went
ahead and did it; you could if you wanted to. Not
that you do.

Tanks, Logics, Metaverses
Now you know that in 1946, computers were huge
and all that; they weren’t networked; hell, they
didn’t even store information for other people to
use. But in that year, someone called Murray Lein-
ster was prophetic enough to write a story called
A Logic Named Joe. Leinster is under-celebrated; in
fact, he hardly is celebrated. Decide for yourself
whether he should be—from this trimmed
excerpt (our italics):

“You got a logic in your house. It’s got keys
instead of dials and you punch the keys for what
you wanna get. It’s hooked in to the tank… Say you
punch ‘Station SNAFU’ on your logic. Relays in the
tank take over an’ whatever vision-program SNAFU is
telecastin’ comes on your logic’s screen. Or you
punch ‘Sally Hancock’s Phone’ an’ the screen
blinks an’ sputters an’ you’re hooked up with the
logic in her house an’ if somebody answers you got a
vision-phone connection. But besides that, if you punch
for the weather forecast, that comes on the screen
too. The tank is a big buildin’ full of all the facts in
creation an’ all the recorded telecasts that ever
was made—an’ it’s hooked in with all the other tanks
all over the country—an’ everything you wanna know or
see or hear, you punch for it an’ you get it. Very con-
venient. Also it does math for you…”

First mention of the Internet? Could be. Com-
puters in the house; connected to a server; pod-
casts; voice chat; a weather widget; Google servers
that host much of the info we have access to; and
servers connected to each other. And what else is the
Internet?

1946! The mind boggles!
The Internet is quite something else when it

comes to foresight: no-one knows what’ll happen
the day after tomorrow. Snow Crash by Neal
Stephenson—1992—actually foresees Second Life!

“Hiro sees two young couples, probably using

let’s not get into racism and racist stuff… fearful
eyes? Well, The Muse is supposed to have sensi-
tive eyes (though she does end up having fearful
eyes, in the sense of being as dead-looking as they
are). A “tremendous grinning” mouth? EveR-2
Muse has a sweet, lipsticky mouth.

Much more importantly, the Steam Man was
imagination, but EveR-2 Muse is a flesh-but-not-
blood robot that exists.

There is, obviously, the “stronger and
mightier” theme in the Steam Man: he possesses
exceptional strength, so much so that he pulled
a chariot in his role as Horse. Besides, he is 10 feet
tall. Refer Virtual Weapons In Real Life, Digit, July
2007—the US now has an exoskeleton for soldiers
that allows them to lift very heavy things,
run very fast, and leap into the air like no-one
leapt before.

Coming back, that steam-powered concoction
was not called a robot; the first mention of the
word was in the play R.U.R. (Rossum’s Universal
Robots) (English edition 1920) by a certain Karel
Capek (don’t blame him—he didn’t name him-
self). Here, too, the robots are simply human-like
machines. They also happen to be slaves, but
badly-treated ones. Then someone gives them
emotions, they revolt, kill most people, and take
over. Bring on the clichés… but it wasn’t a cliché
in 1920!

No history lessons here, so we won’t tell you
why they were called “robots.” Figure that one
out. But we dug up this one about digging
machines—that they feature in H G Wells’ War of
the Worlds—and here’s one line: “So far as I could
see, the (digging machine) was without a
directing Martian at all.” Meaning some directing
was required, so the machine was self-directing…
meaning it had some intelligence. That might be
(in our opinion) the first mention of a “real”
robot. This, in addition to the “taking over”
theme, would involve some talk of AI. We’ll come
to that in a bit.

Androids are automatons that resemble
human beings in the essential aspects, and so
“android” is a generic term. But cyborgs are aug-
mented in some way; they are super, well, super-
something… either their senses are more acute,
or they can live a thousand years, or something
like that. But you already know, if you’ve been
reading Digit. Refer a couple of our past issues.

Then take this one, from Cloak of Anarchy,
1972, by Larry Niven: “…when Ron was flush with

Biological evolution is
too slow for the human
species. Over the next
few decades, it’s going
to be left in the dust”

Ray Kurzweil
Inventor and Futurist

Ray Kurzweil was fascinated by sci-fi in his childhood, and that's
one reason we're talking about him. He invented many things,

including OCR systems, a text-to-speech synthesizer, the CCD
flatbed scanner, and more. Even so, he’s now primarily known as a
futurist—and here’s some of what he says and what people think.
(In 2005, Gate$ called Kurzweil “the best at predicting the future of
artificial intelligence.”)

Kurzweil subscribes to the “Technological Singularity.” This is
the (supposed) creation of entities smarter than humans, which will
accelerate technological progress beyond the capability of humans
to participate in the progress. Think runaway bots doing stuff you
can’t understand. There are several criticisms we cannot go into,

but think of it as a hyper-extension of Moore's Law.
Nanobots (which we've spoken about more than once in Digit)

have the potential to help solve problems such as climatic change.
They could also extent human lifespan significantly—even to the
extent of immortality.

(Another Herbert Simon?) Kurzweil says computers will become
smarter than humans (crudely put) in 25 years from now.

Elements of what you saw in The Matrix could very well come
true in your lifetime.

Head to www. KurzweilAI.com for the complete picture. Such are
the predictions of today: hedge your bets with confidence, because
it’ll happen (or it won’t) in this life of yours.

The Present Of The Future: Featuring Ray Kurzweil, Futurist
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their parents’ computers for a double date in the
Metaverse, climbing down out of Port Zero, which
is the local port of entry and monorail stop. He is
not seeing real people, of course. This is all a part
of the moving illustration drawn by his computer
according to specifications coming down the
fiber-optic cable. The people are pieces of software
called avatars. They are the audiovisual bodies
that people use to communicate with each other
in the Metaverse.”

Stephenson’s “Metaverse” is, of course, the
Internet. Specifically, the part of the Net that
hosts virtual life.

Still, as far as we know, no-one predicted the
magnitude of the speeds we have today on our
undersea cables—or the volume of the traffic—or
even that they would be under the sea. Sci-Fa.

Artificial Idiots
It’s time we quoted Arthur C Clarke, an SF god.
Here’s from The City and the Stars, 1956: “...the all-
but-infinite intellect of the Central Computer. It
was difficult not to think of the Central Computer
as a living entity, localized in a single spot, though
actually it was the sum total of all of the machines
in Diaspar. Even if it was not alive in the biological
sense, it certainly possessed at least as much
awareness and self-consciousness as a human
being.” Primitive, simplistic, almost child-like.

But then here’s from Ralph 124c 41 +, by Hugo
Gernsback, 1911, in relation to voice recognition:
“...she called out sharply: ‘Lux!’ The delicate detec-
tophone mechanism of the Luminor responded
instantly to her command; the room was flooded

at once with the beautiful cold pink-white
Luminor light...” 1911 for voice recognition is
prodigious indeed. But we’re still at 99.8% accu-
racy or thereabouts, and that’s the theoretical
figure—and remember, 99.8 is very different from
99.9 is different from 99.99. Sad.

Let’s cease and desist. They imagined what
was to come; it turned out to be harder than
anyone had imagined; and it didn’t come.

Nobel Laureate Herbert Simon, an authority on
AI and a pioneer in the field, said that by 1985,
machines would be capable of doing any work a
man could do. KRASH, KA-BOOM, and PLONK are
the sounds of that ludicrously optimistic predic-
tion falling flat—nuff said. Sci-Fa—not.

So Where’s My Flying Car?
Way too many people ask that in sarcastic tones
without looking up the facts. The Flying Car—as in
everyday transportation, with no runway or
airstrip required—happens to be a staple of way
too many sci-fi novels. So where’s your flying car?
In Massachusetts.

2009 will be the year, if you can believe a com-
pany that will take 5
per cent of the cost
of their flying car
right now by credit
card as a booking
deposit. That com-
pany is Terrafugia
(figure the URL—and
no prizes). They are
“roadable aircraft”

Herbert Simon,
an authority on
AI and a pioneer
in the field, said
that by 1985,
machines would
be capable of
doing any work a
man could do

Terrafugia’s “Transition”—now here’s your flying car!
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developers: the thing, described by the company
as a Personal Air Vehicle, can be a car and a plane—
it can change its configuration. Price (in 2009):
$148,000 (60 lakhs—not obscene by any standards).
You drive it from your garage to the airstrip. Fuel:
premium unleaded. Range: 160 to 800 km.

Then there’s the Moller Skycar M400. Takes
off and lands vertically like a chopper. Cruising
speed 550 kmph; range 1,450 km. Almost exactly
Bangalore to Bombay and back. (Sorry, old
names—that’s the way it is at indo.com, where we
found the distance.) Initial cost: a million dollar-
bucks. Mass-produced price could come down to
$60,000 (Rs 25 lakhs). Sounds too good to be true,
but let’s see. (We might have to see for a long
time; it’s been a while since Mr Moller began his
experiments.) If you’re shaking your head, you’ll
shake it more vigorously when you visit
www.autoblog.com/2006/10/13/ moller-skycar-makes-
it-on-ebay. And if you’ve gotten excited, please
don’t visit www.spectrum.ieee. org/jan07/4835 !

But do you seriously think neither of these—
or none of those at the Wikipedia entry for Flying
Cars—will take off (ooh!) sometime soon? Place
your faith in German Engineering: both CEOs
have Teutonic names…

The Good Stuff
Poor you: you didn’t think jetpacks existed. Or you
thought (blast these miserable clichés!) they
existed only in science fiction… 

Enter Jetpack International. Their site show-
cases the JetPack H202-Z, T-73, and more—prom-
ising names indicative of their sci-fi origins. About
the T-73… price: 80 lakhs not including life insur-
ance, flight time 19 minutes, speed 130 kmph,
and it goes 250 feet into the air. (When it’s
released, December this year.) Text won’t do all this
justice: visit the site for pictures and videos. No
hoax this: they’ve done it at shows. Caveat: you
can’t just strap it on and hover. One needs to have
an Officially-Certified Aviation-Authority-
Approved Major Qualification Certification to
even think of strapping it on, or something to that
effect. Watch the popular video at www.youtube.
com/watch?v=THEcWrznicY—we know you’ll think
it’s been doctored.

At www.jetpackinternational.com/video.html are
plenty more detailed videos. But no word on when
you’ll be able to get one off the shelf.

“Terminator Hand hits North America” is the
YouTube caption for www.youtube.com/watch?
v=5MkJk6797mI. Watch the video. Now. It features
the iLIMB, a prosthetic hand with five fingers—
the special thing being they’re individually pow-
ered. The tiny electric signals from the
remaining portion of the limb power the thing,
and each individual finger can open and close! “Ter-
minator Hand”… nice caption, we say. Sci-Fa.

And some people are calling even this
“baby steps.”

Miscellany
This almost-just in: a real mineral with
most of the chemical properties of kryp-
tonite was discovered in Serbia, April
of 2007—just five months ago. Pure
magic, this… but we’ll leave the
wonder to you.

Moon Base. Tiberius Station
et al. You know. But NASA is indeed
planning a permanent base on the
Moon by the mid-2020s. This one was
easy prediction, actually—the Moon
isn’t too far away, and we’d need Leben-
sraum at some point or the other.
Stephen Hawking, incidentally, says
humans won’t survive if they don’t re-
engineer themselves and go into outer
space! Now that’s a current prediction—

Fi or Fa? Or Fo, or Fum?
And then there’s an official definition of

“Communicator” in Star Trek: Enterprise: “A
portable Personal communications device.   Com-
municators provide individuals a means of voice
transmission from a planetary surface to an
orbiting spacecraft or other nearby facility... Early
versions of the communicator were compact
handheld units with a flip-up antenna grid.” Now
here’s something lovely, almost delicious: re-runs
of Enterprise were on when people were already
talking on their cell phones! And those phones
were pretty much like those Communicators…
and “Communicator” is even a brand name. Duh.

Then, stun guns: for real. Look at this: “It uses
a temporary high voltage, low-current discharge
to overcome the body’s muscular mechanisms.
The recipient feels great pain and can be tem-
porarily paralysed. But since the amount of cur-
rent is low it is supposed to be safe—it won’t kill.”
From http://gadgets-tech.blogspot.com/2007/07/ stun-
gun-science-fiction-or-reality.html.

We live in interesting times.

And Now It’s Down To…
…to some nonsense. At least, let’s look at what
seems like nonsense to us. There’s mind down-

loading / uploading, a popular theme
with sci-fictors. The idea here is, quite
simply, that you hook yourself up to an
info-server of sorts and upload or down-
load your brain’s contents onto it / from
it. (Britney Spears’ brain could probably
be uploaded onto a CD, but never
mind.) What this entails is a complete
mapping of the brain. Nanotech can do

it, true. But each and every neuron? All
that would take the computational

powers of a zillion bajillion universes,
assuming they exist. Sure, quantum com-

puting might step in, but when? Too far into
the future, sorry. Not happening.

Then there’s all this stuff—all too common,
all too cheap—about “different worlds.” No, not

parallel universes, which is a deep idea; we’re
saying so many writers just go into imaginary
worlds where you can fertilise a woman over the
phone and such. There’s Liquid Sky, directed by
Slava Tsukerman (1983), about heroin users in
New York City; an alien spaceship lands in one
apartment, and starts to kill people by growing
crystals inside their head. Yes. It’s got a 4/5 at
Amazon. Bur cheap sci-fi predicts nothing.

We’ll sign off with faster-than-light travel. Col-
lege students smoking illegal substances discuss
such stuff late into the night, voices raised. You
can do it if you like. But It’s Not Sci-Fa. 

ram_mohan@thinkdigit.com

The iLIMB thingy holding a coin
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Back in the good old days, you’d stare at
your dirty laundry for a while, think,
“Hmm... an hour for this lot,” pop it into

the old machine and twist the dial to the one-
hour mark. The washing machine, like all the
dumb machines of those times, would go
about its business, little caring for how dirty
the clothes are or how much water it’s
supposed to use. Ah, simpler times...

Today, your washing machine takes one look
at your laundry, tut-tuts inwardly, and then tells
you how much time it’ll take to do its work. As
it does so, it’ll also make sure that not a drop of
water is wasted, its temperature is just enough
not to ruin your delicates without compromis-
ing on cleaning power. Short on detergent? No
worries—the machine makes amends for that
too. Regular super-dhobi, this. 

And it’s not just the washing machines,
either—refrigerators, air conditioners and a

whole assortment of household devices are
getting smarter thanks to the miracle of fuzzy
logic (no, they’re not smart enough to come
after you in your sleep, so stop shaking)—
though you’re more likely to have heard the
term in a washing machine commercial. 

Thinking Different
In the peak of summer, when you exclaim,
“Boy, it’s a hot day!”, other humans have no
trouble understanding you. Of course,
dwellers of the equatorial region may not
agree, but they’ll still appreciate the senti-
ment regardless. A machine—a PC, for
instance—won’t have a clue, though. How do
you define “hot”? Let’s say you’ve programmed
your PC to accept 30° Celsius as “hot.” But
machines only understand binary talk—yes or
no, this or that, hot or cold. You can’t expect
them to have any concept of “maybe” or
“somewhat hot.” So to your PC, even 29.999°
Celsius doesn’t qualify as “hot”. Silly, yes?

Ever wonder how the humble washing machine got so smart? And what’s
this mysterious “Fuzzy Logic” got to do with it?

Almost Intelligent

Imaging Shrikrishna Patkar
Photograph Sandip Patil
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Human decisions are often based on “fuzzy”
or imprecise data. Have you ever heard a human
go, “Wow, her height is 174.25 cm!”? Of course
not. “Wow, she’s tall!” is what you’ll most likely
hear. Except in the Zulu tribes in Africa, where
she’d be “somewhat tall”, and “gargantuan”
amongst the pygmies. But enough with the
tribes—the point is, there’s no real mathemati-
cal relationship between a person’s actual
height and how tall they’re perceived to be. The
most we can do is gather those perceptions to
create “fuzzy sets.” In school maths, you’ve
learnt that mathematical sets are groups of
numbers or objects that meet a specific require-
ment—numbers greater than 2 but less than 80,
for example. All nice and properly defined. The
members of fuzzy sets, on the other hand, meet
a vague (or fuzzy) definition—old people, dirty
clothes, warm days and so on. The members of
these sets overlap each other—a 50-year old, for
example, is in that grey area between “middle-
aged” and “old.” How deep in the grey area?
Well, that depends on who’s making the sets. If

you’re having trouble with this, look at the
image above and all should be clear.

Your First Washing Machine
We’ll use the washing machine analogy here—
you’ve probably already seen it in action, but
even if you haven’t, it’s easy enough to relate
to. We’ll start simple—building a fuzzy rela-
tionship between your clothes’ dirtiness and
the time it’ll take to wash them. Washing
machines use dirt sensors to measure dirti-
ness—using either light or sound to detect the
presence of dirt on your clothes (very RADAR-
like, this is, but we can’t go too much in-depth

for lack of space). Let’s say the dirt sensors give
us the weight of the dirt (in grams) for every
kilogram of clothing. Obviously, we’re assum-
ing our washing machine also comes equipped
with a weight sensor.

The first step is to decide what our fuzzy set
is going to look like. Let’s group clothes under
“Clean”, “Dirty” and “Filthy”. If your load has
zero grams of dirt for every kilo of clothes, then
they’re clean. It goes downhill from there, and
if your clothes have 100 grams of dirt for every
kilo of clothes, they’re at the peak of the dirty
set. Finally, at 300 grams, they reach the pinna-

cle of filth (you’re free to make your own stipu-
lations, though). This is what we end up with:

And now, we lay down the law.

The Rules Of The Game
We started out with the intention of building a
relationship between dirtiness and time taken
to wash—that time has come. The rules for a
fuzzy controller are simple “if...then” state-
ments—the kind you learn about when you first
learn programming at school. They go thus:

IF {condition} THEN {result}
(No, there’s no ELSE)

Let’s now define the rules for our washing
machine:

IF clothes are Clean THEN time = 10 minutes
(This is mostly for psychological effect. Some

people want their clothes extra clean)
IF clothes are Dirty THEN time = 45 minutes
IF clothes are Filthy THEN time = 90 minutes

(In the real world, the creation of these
rules and fuzzy sets are based on a lot of
research and some highly-educated estimates;
even if the manufacturers start with this
random set of rules, they’ll be modifying them
once they run the first simulation and discover
that they were wrong)

Well, we’ve built our machine; now let’s see
how it works.

The First Batch
When you dump your first load into the
machine’s drum, the dirt sensor kicks into
action and measures its dirtiness. The result:
200 grams of dirt per kilo. The machine takes
this value and “fuzzifies” it—mapping it to the
fuzzy sets we fed it in the beginning. As you can
see overleaf, this dirt level falls somewhere
between Dirty and Filthy—more specifically, it’s

Digital Passion l Insight

A 50-year old,
for example, is in
that grey area
between
“middle-aged”
and “old.”

How machines really think. We’d get nowhere in a world
like this

The fuzzy set for dirty clothes

This is how fuzzy sets are usually represented. The
peaks indicate complete membership (a value of 1). This
will become clearer as you read on
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0.4 Dirty and 0.6 Filthy. The numbers are called
degrees of membership, and mathematically repre-
sent the value’s position in the sets. 

To find out how much time it’s going to take
to wash these clothes, we need to see what
happens when we apply our rules to this value
of dirtiness.

I Want The Truth!
Another new term we come across here is degree
of truth—a mathematical representation of the
extent to which our measured value satisfies a
rule. Let’s look at our conditions one by one,
and consequently how much truth the corre-
sponding results have.

clothes are Clean
They’re not, so the result time = 10 minutes

has no truth
clothes are Dirty
They’re 0.4 Dirty, so the result time = 45

minutes has a 0.4 degree of truth
clothes are Filthy
They’re 0.6 Filthy, so the result time = 90

minutes has a 0.6 degree of truth

Now that we have this information, we need
to “de-fuzzify” it to get a single, non-fuzzy output.

Making Sense Of It All
We know that if the clothes were perfectly dirty
(a degree of truth of 1 for the second rule, 0 for
the others), it would take 45 minutes to wash
them. Similarly, it’s 10 minutes for perfectly
clean clothes and 90 for perfectly filthy clothes.
If we plot these values on a graph, we get some-
thing like this:

Now let’s put our findings—viz. 0.4 Dirty
and 0.6 Filthy—on this graph. Using a mathe-
matical technique called the Centre of Gravity
method (which we won’t get into here), we find
that the answer we want is 72 minutes.

Complicating Matters
We’ve just designed a very simple washing
machine here, but you can see where all this
can lead: you can bring more variables into the
picture—clothes’ greasiness, water tempera-
ture, the weight of the load (to optimally utilise
water), and so on. It can be quite the intellec-
tual exercise, this. 

Just remember that fuzzy logic systems
aren’t supposed to be overly complex—too many
variables lead to too many rules (just adding the
“greasiness” variable to the machine above
causes the number to increase to six), resulting
in a lot of inefficiency. 

Don’t forget, the washing machine isn’t the
only place you’ll find fuzzy logic used. It’s been
used in digital cameras to isolate faces from the
rest of the scene, optical drives and heaven
knows where potential applications lie. 

Big Picture 
Fuzzy logic is, as you might have guessed, the
first step to artificial intelligence. After all, it is
trying to duplicate the human thought process,
no matter how primitively. For all its complex-
ity, even game AI has its roots in a fuzzy logic
system (“If health is low, take cover”—sound
about right?). 

Unlike true AI (which we’ve talked about a
lot in these pages), though, fuzzy logic systems
are perfectly realistic, and we’ll continue to see
them grow in applications where you don’t
need the mechanical versions of Einstein. We
see them perfecting speech recognition
systems, perhaps even bringing emotion to text-
to-speech, and when the nanobots come, it’ll be
fuzzy logic telling them the difference between
the harmful and harmless cells in your body. 

nimish_chandiramani@thinkdigit.com

What would you do if you had to design a simple, smart washing
machine (how’s that for a mind-bender?) like the one we spoke about?

One catch, though—pretend that fuzzy logic doesn’t exist.
You’d need to develop a dirt sensor that’s dead accurate even in a

tangle of clothes, of course—but that’s not the worst part. You’d need to
develop a mathematical relationship between the dirtiness of clothes and
the time that it would take to clean them. Even if you could, it’d end up
being a complicated quadratic equation in the eighth degree, with fractional
coefficients to boot (or as some mathematicians would say, “mind-numbing
pain”). Just for fun, what if you were asked to factor in the concentration of
the detergent used? Or water temperature? 

And then, what if you (miraculously) did it all, only to find out that all
the seemingly right calculations in the lab fell apart in the real world?

Fuzzy logic saves lives, you’ll agree.

The Fuzz-less Life

Fuzzifying the measured dirtiness—the degree of
membership is where the value intersects the Dirty and
Filthy sets

The relationship between time and degree of truth

Voila! An answer!

Remember that
fuzzy logic
systems aren’t
supposed to be
overly complex—
too many vari-
ables lead to too
many rules



36 DIGIT SEPTEMBER 2007

Digital Passion l Tomorrow

Robert Sovereign-Smith

W e’ve always been using boring-keyboard
and boring-mouse to interact with
computers. Why? Because that’s what

was in use when the PC gained in popularity. As
if the case with PCs wasn’t bad enough, some
mobile devices have incorporated the QWERTY
keyboard. You get tiny little keys that are generally
used by the thumbs, which the keyboard layout
wasn’t designed for in the first place. Should we
settle for mediocre (or worse) just because it’s
popular? When it comes to mass-produced
devices, sadly, the answer is We Must. 

What Choice Do We Have?
For now, none! But more and more innovative
research is being done in the field of Human
Computer Interaction (HCI), in fields as diverse as
touchscreens, natural language processing, eye
tracking, and more.

Before you think of questioning the need for
new interfaces, think of the popularity of prod-

ucts such as every tablet PC, every
PDA, the Wii, and the iPhone.
These are popular only because
they give you an alternative to
pressing buttons or tapping away
at a keyboard, and it’s mainly their
interfaces that set them apart
from the crowd.

The GUI
The WIMP interface, short for
Windows, Icons, Menus and
Pointer, was revolutionary for its
time. In 1984 the Macintosh was the
first publicly-available computer; it

featured the WIMP inter-
face. Twenty-three

years later,
things haven’t

changed much,
have they?

Now we’re defi-
nitely not suggesting

that interfaces change for
the sake of change. The fact

is as long as we’re limited to a
two-dimensional screen as the PC’s

output, we’re probably not going to see
anything but the WIMP interface. But with

so much research happening to bring 3D real-
ism to our screens, what happens when it does
get here? Do you really want to be sitting and
trying to use a mouse to drag a 3D window?

Another aspect to consider is the types of tasks
we’re trying to accomplish: for example, why
bother taking word processing to a 3D level? It’s
not like you will be able to type along all three
axes! It’s quite obviously the application that
needs to be looked at, and one common GUI for
everything might not be the way ahead.

Take gaming for example. There are games
that are built for consoles and those built for PCs.
A racing game, for example, might be a lot easier
to play on a console, while an FPS might only be
playable on the PC. However, platforms be
damned, because both the racing game and the
FPS could be so much better if they were more
immersive and in 3D. Also, the racing game is a lot
more fun if you have a steering wheel control,
while an FPS might be more fun if we had a
controller that looked like a gun and we had to
physically turn around to see what’s behind us.

Touchscreens
From PDAs to Tablet PCs and now smartphones,
everything is going the touch input way. If we’re
going to have to use the point-and-click interfaces,
nothing beats just tapping a screen—especially

Either you’re working with a keyboard and mouse, or reading what your computer displays on-
screen. Don’t you just wish user interfaces could go through a full makeover?

Alterface!

Imaging Chaitanya Surpur 
Photograph Jiten Gandhi



with handhelds or laptops. 
The problem, however, is that our current

WIMP system was built for mice and keyboards, so
it’s not ideal for touchscreens.

In our June 2007 issue, we spoke about Jeff
Han’s multi-touch interface, which allows you to
use multiple points of contact, or even have multi-
ple people using the same interface at the same
time. Han’s interface is revolutionary: it will allow
users to actually get a feel for applications that
needs graphics, zooming and interaction. But
such an interface is useless for, say, gaming,
because there’s no interaction required. Ditto for
word processing. However, let’s say you’re manag-
ing or editing photographs, browsing the Net, or
using Google Earth. That’s where Han’s vision
comes in. Perhaps the way gaming has broken
away into the specially-made machines we know
as consoles today, the future might see different
hardware for different purposes.

Another example here is Microsoft’s Surface,
a 30-inch multi-touchscreen that’s kept horizon-
tally instead of vertically, and is embedded in a
desk. It allows multiple users to use it at once. It
uses Windows Vista, a PC embedded in the desk,
and five cameras to sense motion. It can sense 52
simultaneous touches, computing them and
translating them into on-screen inputs.

Check out Jeff Han’s work at
http://cs.nyu.edu/~jhan/, and the Microsoft Surface
at http://www.microsoft.com/surface/.

Direct Interaction
You’ve come across Natural Language Processing
(NLP) and Brain-Computer Interface (BCI) in this
space. We’ve discussed them at length earlier, so
we won’t get into the
details, but here’s about
two major technolo-
gies that promise to
get us interfacing
better with
computers.

NLP: NLP is
the ability of a
computer to under-
stand and compute a
human’s normal
speaking voice. The
perfect NLP system
would allow you to talk
to your computer the way you
would talk to another person. We’re
far from achieving this—subtleties of voice
patterns, background noises, accents, and more
play spoilsport (refer Tech Transcends Tongues, Digit,
April 2006.) Of course that doesn’t stop us from
trying, and there are a lot of NLP projects being
worked upon: check out http://opennlp.source-
forge.net/projects.html, a list of open source projects
related to NLP.

BCI: Imagine a computer that could read your
mind—yes, your mind—there’s no talking required.
Imagine sitting in a restaurant talking to your
laptop... now you know why NLP isn’t really ideal
for the way we currently use computers. However,
a computer that can read your thoughts… now

that’s something we all want. Imagine thinking out
that letter, moving your character in a game just
by thinking about it... even better, imagine having
a random thought, “I wonder who does the voice
of Bart Simpson?” while interfaced with your PC.

Currently, BCI is being researched by quite a
few groups all over the world. Most notable is
Fraunhofer’s Berlin Brain-Computer Interface
(BBCI; more at http://ida.first.fraunhofer.de/bbci/
index_en.html), which is already showing off the
ability for people to play Pong against each other
or the computer, using their thoughts as controls.
Fraunhofer also holds BCI-related contests to
encourage the development of this technology.
Currently, accuracy for such a system in ideal
conditions is between 91 and 99 per cent, which
is extremely good—and leaves us optimistic.

The Future
It will take years before we have decent prototypes
(leave alone products). We are also faced with the
challenge of making a billion people forget all
they know about computers, and re-learn to use
them from scratch. Technologies such as eye-
controlling the mouse, which uses a camera to
monitor your eye and translate it into data your
PC can understand is all very well and good, but
what use if we still have to type out our letters?

Brain-Computer Interfaces also have limita-
tions: how do we stop the PC from trying to inter-
pret thoughts we don’t want it to? Imagine
working in an office, looking over to that hot co-
worker and thinking, “I wish I could send him /
her an e-mail asking him / her out,” then turning
back to see that your PC just shot off a mail
asking the boss out!

New GUIs for operating systems / software
and new hardware bring us to the chicken-and-
egg scenario—software waiting for new input
devices to code for, and devices waiting to see
what software or AI can make possible. 

We loved the concept of Microsoft’s WinFS,
and were looking forward to having a file

system that was built like a database. Unfortu-
nately, looks like we won’t be seeing anything like
it for PCs soon. Still, we’ll keep our fingers crossed.
WinFS promised to be different from the WIMP
interface, and perhaps just that excitement of
seeing something new has us hooked.

Another trend we have to consider is the diver-
gence factor. When PDAs were killed by smart-
phones, Digit told you all about Convergence—the
coming together of gadgets, hardware, software,
and services into one do-it-all gadget. Things are
slowly beginning to shift in the opposite direction.
Sure, we all want more powerful cell phones, and
who wouldn’t want a device powerful enough to
run Vista yet small enough to fit in one’s pocket,
and which you can use to make and receive phone
calls? Still, how do we explain gaming consoles
and their runaway popularity? Then there are the
Internet tablets that have been popping up, allow-
ing you limited functionality as compared to a PC—
while still being ideal for browsing!

Perhaps the future of BCI is planting a chip
in the brain—who knows? Apologies for the
corniness when we tell you that all we can do is
wait and watch. 

robert_smith@thinkdigit.com
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The much-hyped Surface
takes boring computing to
mind-bogglingly amazing
new levels

We basically have to
un-teach people
what they have
learned so far about
computing, and
convince them that
they can use several
fingers, that several
people can work on
the screen at once”
Jeff Han
Researcher
New York University
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Solution To Last Month’s Challenge
Windows NT and Windows 2000 Resource
Kits come with a number of command-line
utilities that let you administer Windows
NT/2K/2003/XP/Vista computers. For last
month’s Take A Crack, we require a collection
of such tools—known as PsTools—fint it at
http://download.sysinternals.com/Files/PsTools.zip.

A Resource Kit is a set of software
resources and documentation released with
or after a major version of Windows. The
tools help administrators streamline
management tasks such as troubleshooting
OS issues, configuring networking and
security features, and such. 

Before we begin, do note that some anti-
virus scanners might report some of the
tools contained in the archive you download
as infected— specifically, by a “remote
admin” virus. None of the PsTools contain
any viruses, though. These tools are
sometimes used by certain viruses, and
therefore trigger the wrong virus
notification. Exclude these tools in your anti-
virus scanner to disable the warnings.

Extract the tools to a folder. These can be
run as standalone programs and don’t need
installation. The beauty of PsTools is that
you don’t even need to install any client
software on the remote computers at which
you target them.

PsTools are interesting and useful; to
learn more about them—and to clarify
anything you might want to—visit
http://forum.sysinternals.com.

To start a process on a remote computer,
you will require a tool PsExec. This is a
lightweight replacement for Telnet that lets
you execute processes on other systems,
complete with full interactivity for console
applications, without having to manually
install client software. A simplified usage of
this command looks like the following:
PsExec \\computer -u username -p
password command

where
computer = The name of the remote
computer in UNC format
username = An existing username on the
remote computer preceding the -u switch

password = The password associated with
the username preceding the -p switch
command = The command that is to be run
remotely

To stop a process on a remote computer,
you will need the tool called PsKill. This is a
utility that can not only kill processes on the
local computer, but can also those on remote
systems. Just copy PsKill onto your executable
path, and type in pskill with the command-
line options defined below. A simplified usage
of this command looks like
PsKill -t \\computer -u username
-p password process_id |
process_name

where
computer = The name of the remote
computer in UNC format
username = An existing username on the
remote computer preceding the -u switch
password = The password associated with
the username preceding the -p switch
process_id = This specifies the process ID
of the process you want to kill
process_name = This specifies the process
name of the process or processes you want
to kill

Note here that you can either specify the
process ID or the process name of the
process you want to kill. If you omit the
computer name, PsExec will run the
application on the local system, and if you
enter a computer name as “\\*” (without
the quotes), PsExec will runs the application
on all computers in the current domain.

If you wish, you can create scripts with
multiple commands of the above kind to
run it simultaneously against many
computers. Space does not permit a
detailed explanation of the scripting
process in this case. 

THIS MONTH’S CHALLENGE

Win!

No One 
Cracked It

LAST MONTH’S WINNER

How would you disable and
then re-enable the Menu
Bar in Windows Explorer?

Send in your solution with
the subject “Take a Crack”,
and your postal address, to
takeacrack@thinkdigit.com

How can you start and end processes on a remote computer?
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LAST MONTH’S CHALLENGE

Make Explorer’s
Menu Bar Vanish,
Then Re-appear

The title for last month’s Take A Crack
was “Start And End Processes On A
Remote Computer”, while the text to
the left of the title said “How can you
prevent your computer from appear-
ing in Network Neighbourhood?”.
These do not tally, and they refer to
two different problems. The error
is regretted.

CORRIGENDUM



Droolmaal The good stuff.
Stuff to lust after.
Stuff for the well-moneyed.

The Drop
drop is

literally what
these things

look like. They are
speakers—and really
good ones at that—
from a little-
known company
called
Scandyna.
These 2.3 kg
“Drops” are
hardly your
typical
Desktop
speakers:
they’re two
feet high
including the
spiked legs. They
can be set up for stereo or 5.1
surround. Equally stylish accessories are available; these
can allow you to hang them off the ceiling or on walls.
These speakers come in six gaudy colours—white, black,
silver, blue, yellow, and red. (Yellow… ugh!) Very stylish, a
Drop set costs £549 (Rs 45,000). That’s the kind of price you
pay for in-your-face design—the kind we love the most!
(Except for the yellow).

A
ou’ve probably heard of Lacie products—they’re
mostly huge disks or highly-expensive monitors. Now
this hub looks like a bulb, and it’s got tentacles

popping out like it’s an
octopus. Its arms have
more than just the four
USB ports and two
FireWire ports: it’s
got a fan at and a
light at the ends of two of
its arms
respectively. It
also has an
extendable
USB cable. The arms
can be moved around
and bent… naturally. The
Lacie Hub has been
designed by Ora Ito, a
famous designer who’s created all
sorts of fashionable designs for
brands like Adidas, Gucci, and
Swatch. The Hub should fit right
in place on your white table with
an Apple computer, an iPod, and
an iPhone. This gizmo is probably
the last thing we expected from
Lacie, but we have to say… We like!

Y

Lacie Hub

Digital Passion l Droolmaal

rofessional filmmakers require high-quality video shooting
equipment, and more importantly something to store their gigantic
files on when out in the field. The Codex Portable is a compact field

recorder. It supports recording of video formats all the way up to 4096 x
2048—that’s like a little more than two times current HD resolution
standards. 8-channel audio streams can be recorded. To store all this data, it
has removable 400 or 800 GB hard drives! You can also plug in a cheap USB

Flash drive.
Unlike its bigger
brother the Codex
Recorder, the Codex Portable weighs 4

kg instead of 45. The touchscreen allows
you to use the interface, which can also be
wirelessly controlled—through a laptop, for
example. This whopper should be out towards
the end of the year. Serious filmmakers might

be the only prospective buyers, and they will be a
very happy pack when it does arrive. No price has

been stated so far, but our sixth sense (we’ve still got it!)
tells us it isn’t going to be cheap.

Codex Portable

P
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Nokia 7900
he Nokia design department has gone extreme with the introduction of
their new 7900—and its little brother, the 7500. The 7900 has jagged
edges and cuts everywhere, which give it a unique look—as you can see.

The surface has been etched, and you should be able to choose from 49 colours
that can be used to light up the keypad. There’s a whole gigabyte of space on this
baby to store your 2MP images taken from its camera. There’s a 16 million colour
OLED screen to preview your dear photos on. Perks include wallpapers that

change their appearance as time passes by, and with changes in
battery and signal strength. The phone should be out by

the final quarter of the year, with a rumoured price
of around 400 (Rs 22,000).

T

Sony Ericsson Z250i
okia throws punches and Sony Ericsson makes sure they return them with even
more oomph. The Z250i is a sexy SE phone. With the cover of the clamshell

design closed, you can see the icons on the back are there
for a reason. They tell you things like if you have

new mail or any missed calls, so you don’t have
to open the phone. The coolest part is the

artwork on the metallic-finished cover.
This isn’t exactly a feature-packed,

power-user kind of phone; it’s more
for the style-conscious younger

folks. They won’t have to
wait too long—the Z250i

should be out this
quarter. The phones

will be available in
two colour
schemes that
Sony Ericsson

likes to call
“Silent” White and

“Silent” Black. No
statement on price so far.

N
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E
very business generates data, and how
a business manages it has a significant
impact on performance. The tradi-
tional method of organising data was
by using the humble pen and paper (no

wonder they call it book-keeping), and as busi-
nesses grew, the increasing volume and com-
plexity of data demanded drastic measures.
With the advent of computers came software
capable of managing huge databases. Earlier
database management programs were tied to
specific architectures; later software was stan-
dardised to run on all platforms. Oracle, DB2,
Microsoft SQL Server, and MySQL are some enter-
prise-level data management tools.

But these tools are not entirely suitable for
the home and the small office segment, because
using them requires knowledge of relational
database concepts and query languages, which
could mean having to enrol in a course! Besides,
using software like these to maintain the data
generated by a small business is like using a
cannon to kill a rabbit—it’s simply not necessary.

There is therefore the need for a middle-
road software that’s simple to use and gets your
data-related jobs done. Microsoft Access fits
into this category.

Inside Access
Microsoft Access is a database manager. It is
part of the Microsoft Office suite and has many
versions, the latest being MS Access 2007. Here
we have used Access 2003,an earlier version
because it has been around for a longer time,
and chances are most people haven’t been
exposed to the newer edition. That said, the
essential elements are the same for the two
editions, with the only major difference being
the user interface.

Enhance

3D Modelling Shrikrishna Patkar

Digital Tools l Jumpstart
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Do you get that sinking feeling when you see all that disorganised data?

Access: Granted
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ular form in a database. This is also the case
with Access. To start storing data, open Access
and select File > New. Click on Blank data-
base, enter a name for your database, and save
it. A Database window pops up showing all the
elements in an Access database.

You have three options there—Create table
in Design View, Create table by using wizard
and Create table by entering data. We don’t rec-
ommend using the Wizard—it looks simple and
is tempting, but you can easily foul up and have
to return to square one. Use either the first or
the third option. For beginners, the third
option might be the best, but once you get the
hang of it, you will be benefited by creating
your table in Design view.

For our student record database we created
two tables—student info and fees, using Design
view. A tip: design the layout of your tables on
paper before you get cracking at the computer.
Think about all the fields you need to put in a

Access is a Desktop application, not a client-
server one, and hence is not scalable for use over
a wide network. It uses tables, forms, queries, and
reports to store, manipulate, and access data.
Here we are going to describe how to use these
data elements to create and manipulate a data-
base consisting of student records for a coaching
academy. This is an example; Access can be used
by a wide variety of small-and medium-sized busi-
nesses like bookshops, travel agencies, clinics,
restaurants, etc. to store and handle data. In cases

where the database or the number of users
becomes too large for Access to handle, it can be
upsized by linking the front-end of the database
(the user interface) with enterprise-level database
management tools (like Microsoft SQL Server,
Oracle, or MySQL, like we mentioned).

Tables
Tables are the backbone of any database man-
agement system—data is typically stored in tab-

Access 2007 is part of the newly-released Microsoft Office
2007, which had been timed for release along with Vista. As

with other Office 2007 components, Access 2007 has been
packed with a lot of new and useful features. Here is a low-
down on some of them:

New look and feel: Access 2007 has a completely revamped
look and feel. The “Getting started” page is a completely new
experience compared to that in the earlier edition. The
Ribbon—one of the most widely-talked about features in Office
2007—is used inside Access, replacing all the old-style menus,
buttons, and toolbars. The benefit of the Ribbon is you don’t
need to dig deep into the menus to find out a particular option;
the Ribbon displays it to the user according to the context. You
get lots of slick templates to choose from—this gives your user
interface that “cool” look. Also, Access now implements the
Single Document Interface, where forms and reports open in
new tabs.
New formats: The databases generated by Access 2007 are
in a new format, .accdb. Old-style .mdb databases can be
opened in Access 2007, but .accdb files cannot be opened by
Access 2003.

Easier database construction: Access 2007 automatically
assigns data types to fields entered in a database. This is a
very useful feature for users who are not clear whether they
ought to use, say, text or number as the data type for phone
numbers.
New Form and report authoring tools: A new WYSIWYG
editor presents itself. It lets users see, during design, what
their final reports and forms will look like. This feature saves a
lot of time otherwise spent in redesigning the look of the
reports and forms. Exporting them to PDF format is a mouse
click away. You can incorporate .png or .jpg images without
increasing the size of the database and make your tables look
prettier by colouring alternate rows in different colours.
Search capabilities: A search box enables you to search any
field in datasheets and forms. This feature is useful especially
with large documents. 

Access 2007, though a big improvement over its previous
avatar, suffers from quite a few bugs like compatibility and
interface issues. There are also doubts as to how it will work
with forms, pages, etc. prepared using Access 2003. As of now,
therefore, most people are adopting the wait-and-watch policy
regarding the use of Access 2007.

Access 2007—What’s New?

Here’s how to create a database in Access

The database window is your primary handle on Access
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single table, and how many tables you need. A
database is only as efficient as the table structure.

Each table needs a “primary key.” In plain
English, this simply means a unique value—like
a serial number or ID—that is not likely to be
repeated in the table. So select a field as the pri-
mary key, or if you are not too sure, let Access
do it for you. Take care with the data types of the
fields. You get a short description of each data
type, so it’s very unlikely that you’ll use Text as
the data type if your field is Date. Browse
through the options and select what seems to be
the best fit. Give a name for your table and save
it. This appears in the Database window. 

Click on the newly-created table and enter
your data. If you have done your spadework
right, the data will fit nicely into their places. If
you goofed up, sweat not: go to the Database
window, right-click on the table, select Design
view from the menu, and tweak the field types.
If you need to add or delete columns, you can do
so from inside the table.

You can add data to your table—or delete
data—simply by choosing to edit it.

Queries
Queries are used to extract data from databases.
In Access, queries are of five types—select
queries, action queries, parameter queries,
crosstab queries, and SQL queries. Most users

deal with select queries—those that retrieve
required data from your tables and display them
in spreadsheet view. Action queries do jobs like
deleting or updating records. Parameter queries
are interactive: a single query can give different
results, depending on your parameter. Crosstab
queries are used for restructuring data and
doing operations like addition, calculating aver-
ages, etc. SQL queries are written in SQL (Struc-
tural Query Language) and are the most
powerful of them all. In fact, all the other types
of queries are converted by Access into the equiv-
alent SQL forms and then executed. However,
SQL queries are not suitable for the lay user
because its grammar and syntax is complex.

From the Database window, click on the
Query tab and select New. You get five options—
Create query in Design view, and create query
using the Wizards (for Simple Query, Crosstab
Query, Duplicate Query, and Unmatched
Query). Parameter queries and SQL queries can
be created using the Design view. For our stu-
dent database, we have used the Design view to
create queries, though the job can be done
using the Wizard too.

Click on Design view. Select the tables that
contain the data for your query. In fact, you can
also create sub-queries by selecting the queries
you created earlier. Select the requisite data
fields from the tables, add a sorting order if nec-
essary, and save and name your query. That’s all—
click on the created query in the Database
window and view the results. As an example, we
have used both the Fees and the Student Info
table and selected appropriate fields to create a
query that relates student ID, name, subjects
taken, and month joined. 

Parameter queries can be created by adding
an expression typed in square brackets with a
prompt in the Criteria cell of the Field to be used

You can edit the
data in tables
just like you
would in an Excel
worksheet

The student info table, one of the two tables used in our sample database

The second table used by us, the Fees table

This query was created in the Design view…

And here are the results of the query
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as the parameter. For example, to find students
who have fees less than a particular amount,
type < [Fees lesser than:] in the Fees
field of your table. When you click on the saved
query, a message box pops up prompting you to
enter a value for the chosen parameter. So if you
need to find students who pay fees less than 500,
enter 500 as the parameter. 

Forms
These represent another data element in Access.
Forms are mainly used to enter data into tables,
and to view data. They can be used to edit data
as well. They are also used to make a splash-
screen or a “switchboard”—an entry screen
where tabs and buttons guide you to the major
parts of the database. Well-designed forms serve
to demystify a database for first-time users who
might be apprehensive of using one. Besides,
they are easy on the eyes.

Forms are of five types—columnar, tabular,
datasheet, pivot table, and pivot chart. Pivot
tables and pivot charts are like bar diagrams—
they are used to efficiently summarise and visu-
ally display large amounts of data according to
set parameters. To create a form, you can use
either Design view or the Wizard. For our sample
database, we chose the Wizard.

Select your data fields from the field list.
You can use tables or queries as the data
source, but make sure the fields come from
tables and queries where the fields have cer-
tain relations. Table relations may be one-to-
one, many-to-one, or many-to-many: these refer
to the different permutations in which fields
in one table relate with fields in other tables.
For instance, one single student might take up
more than one subject. This would create a
one-to-many relationship. 

There is also the concept of subforms in
Access. A subform is a smaller form that can be
embedded in a larger form. Subforms are par-
ticularly suitable for complex databases. If you

want to create subforms or create other types of
forms using the Wizard, select New in the Data-
base window. Choose your form type and the
table or query from where your form gets the
data. In our database, we used forms to enter
data for the student info table. Click on Create
form by using Wizard and choose Student info

table as the source. Choose all the fields from
the source table, select layout and style, and
click Finish. You will be able to check out the
data in the Student info table, edit it, and add
new data. Any changes or additions you make
will be reflected in the Student info table. 

Reports
As the name indicates, reports are usually used
to represent data in easily viewable or printable
formats. Tables and queries are used as data
sources for reports. You can design reports to
represent the way you want to display the data:
sort data in alphabetical or in increasing /
decreasing order, and display sum, average,
maximum, and minimum of data. If the report
runs into multiple pages, you can add page
numbers.  Access gives you the option to display
data in visual form.

For beginners, the best way of creating
reports is using the Wizard. This way you can
create autoreports—using a single table or
query as the data source—in columnar and
tabular forms, or you can pick and choose
your fields using the Report Wizard. There 
are Wizards for representing data in visual
format (the Chart Wizard) and another to
print out labels.

In the Report tab, click New and choose the
type of report you want. For our student data-
base, we used the Autoreport Wizard. We chose
the data source as the query for the number of
students joining in January. After clicking
Finish, we got a nice, printed report. 

The Form Wizard takes some of the headache out of form-making

The Student Info Form

A sample view of the Report Wizard

Imagine building
the same query
every month—
just use Reports
for...well...regu-
lar reports!
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If you don’t want to use all the fields or if
you want to customise the look and feel of your
reports, use the Report Wizard. Follow the
instructions and you will get the result. To
export reports to other formats like .html or
.doc, right-click on the saved report, select
Export from the menu, and select the required
format. The Chart Wizard has plenty of options
(bar chart, column chart, 3D area chart, and
more) to visually represent your data.

Pages
Imagine a business with a Web site containing
data that changes regularly. The data on the
Web site needs to be updated regularly. If the
data volume is small, the data can be manually
updated. But for larger databases, this method
is infeasible. Data Access Pages lets you connect
your database to the Internet so that any
changes made in the database are automatically
reflected on your site. You can also edit an
existing Web page. Pages are displayed using a
combination of technologies like ODBC, Active
Server Pages, IIS, and DHTML.

Creating a page is simple. As with other
data elements in Access you can create pages
in design view as well as using a wizard. We
recommend the Wizard. Click on New tab in
the window and select the type of wizard you
want. We selected the Page Wizard. The data
sources for Pages are tables or queries. As in

other Wizards, the process of creating a page
is the same. The created pages are stored by
default in C:\My Documents. If you intend
to display the pages over a network, specify a
network path.

A note here: pages created by Access are
only visible if you use IE 5.0 or above. If you use
other browsers such as Firefox or Opera, only
the title of the page will be visible, not the data
elements. This is a big drawback; those
browsers are widely used today.

Macros And Modules
These are advanced features in Access. Both add
functionality to your other data items like
forms and reports.

Macros trigger specific events when run.
For example, if you open a database, a switch-
board that enables you to navigate to previ-
ously-constructed data elements like reports,
forms, etc. can be displayed. This is done by a
macro. If there is a Print button in your report
or form, it is a macro that does the job when
the button is clicked. 

Modules are collections of user-defined rou-
tines, subroutines, and procedures that auto-
mate many tasks. Modules, once written, can be
used with any data object in the database. For
example, a simple three-line module can be
written to launch a Word application from
inside Access at the click of a button. You could
write a module that can connect Oracle to
Access or test whether a string contains
alphanumeric characters.  

The Big Picture
Microsoft Access gives a lay user the ability to
create databases that have the structural
robustness of databases built using enterprise
level tools like Oracle. It is also extensively used
by developers to develop database models for
rapid application development. Access is pack-
aged with an eclectic collection of templates;
templates are also available online, from
Microsoft’s Web site and also elsewhere. A
sample database called Northwind comes with
every copy of Access. This database illustrates
all the functionalities of Access. Take some time
to go through the Northwind database. Believe
us, it will be a wise investment.

After you are comfortable with the basics of
Access, you will be able to explore features such
as adding security options, using macros to
automate tasks, and more. You could also look
up sample databases on the Web (www.data-
baseanswers.org/data_models is a very good repos-
itory) to see how they are structured. 

There are similar database management
tools, both paid and free, like Lotus Approach
and OpenOffice.org Base. Access, however, is
most widely used in this segment because of
the ubiquity of the Windows / Office duo. The
idea of databases and anything associated
with them may sound geeky, but as you get
more and more comfortable with Access, you
will start to discover the sea change Access
will bring to the way in which you deal with
all those mounds of data. 

bhaskar_sarma@thinkdigit.com

You get several visual options for your reports

The Page Wizard in Access

Use Data Access
Pages to update
your web site
every time your
database changes
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You’ve been
seeing Desktop
PCs move from
the privacy of the
bedroom to the
living room... and
all the family
loves it! So which
one will grace
your centre-
table?

Michael Browne

P
eace of mind. The phrase
probably has you thinking
warm summer beaches, and
coconut trees, gently swaying
in the breeze—all taken in

with cool lemonade in hand. But what
about when you’re not holidaying—
hard at work at your Desktop, when
suddenly, something goes wrong?
Many PC vendors are elusive when it
comes to offering after-sales support,
and the wide, genuine smile fades the
moment you hand over the cheque… 

When it comes to purchasing a
Desktop PC, a large chunk of users pre-
fer to forego the small financial savings associ-
ated with assembling a PC, and buy a branded
PC. In fact, the branded and assembled markets

have an equal fan following. We
aren’t here to propagate either
vendors or brands—and the choice
of assembled or branded largely
depends on the kind of person you
are,  your exact needs, and how
much you’re willing to learn.

If you’re new to the
world of computers,

you have a couple
of options
before mak-
ing a pur-
chase deci-
sion. This

assumes
y o u ’ r e

interested
enough in

making an
informed decision. If

you aren’t interested in get-
ting into computer components

and want a ready-made solution,
then a branded Desktop is for

you. Or you could learn a bit
about individual components
like motherboards, proces-
sors, memory, hard drives,
and others, and use that

knowledge to assemble a PC
where you get to play creator and

hand-pick components.
The most important factor associated

with branded PCs isn’t their “hassle free” acqui-
sition, but the fact that brands mean war-
ranties—and warranties mean no hassles after

purchasing. All major brands now offer at least a
year’s warranty on their Desktop PCs; some of
them offer support for three years. On-site sup-
port is another catch-phrase, and basically means
you will have a support engineer dropping over
the next time that box gives you trouble!

We did a comprehensive survey of the mar-
ket and came up with the 17 contestants you’ll
see pitched side by side. Dig in and get comfort-
able—this promises to be quite the contest!

BASIC BOXES
Desktops Between Rs 20,000
And Rs 30,000
If it sounds too good to be true, it could be true…!
PC prices have well and truly crashed to new
depths. While we aren’t seeing very cheap (read
Rs 10,000 and below) computers, we’re getting
better technology for our buck—for the last cou-
ple of years. Today a Core 2 Duo costs less than
what an Athlon 64 cost a couple of years ago,
which was in turn cheaper than the Pentium 4s
of the early 21st century. And so, for the first
time, this humble value category sees fast dual-
core processors.

Features
What…at that price?

Good PCs don’t come cheap. We’ve been long-
term believers of functionality over funkiness;
however, the phrase “bang for the buck” comes
to mind. The Intex PCs sport identical cabinets—
only their mental acumen differ. The decent-
looking (if plain) cabinet bespeaks functionality,
and we liked the simple build. With easily acces-
sible USB ports and well-built HIDs (human
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interface devices), these PCs are for those look-
ing at something really simple yet attractive. It’s
a pity the chassis itself has a few sharp edges, as
our fingers ruefully discovered.

Acer’s Aspire IE3214 doesn’t look radically
different either. The cabinet appears to be as
well built as the Intex cabinets—a knuckle rap
on the side panel will give you some (not so
good) vibes. Both Intex and Acer ship their prod-
ucts with 19-inch monitors, but the ultra-slim
bezel on the Acer 19-inch widescreen really
sets it apart visually. The Intex 19-inch LCD, in
comparison, looks too bulky and rounded,
with too large a bezel.

The Presario SG3053IL is another plain
looker—nothing special here, and the cabinet
is tinny (rap it with your knuckles and you’ll
figure!). HCL touts the EzeeBee Max XP Z999
as a value offering, and that shows. The cabi-
net build is a little better than that of the
Presario, but that’s not saying a great deal.

Incidentally, all the three Intex PCs have
excellent expandability, with loads of space
for installing additional hard drives and CD
drives. The motherboards are pretty expand-
able too—four SATA ports and an x16 PCI
Express slot. The Aspire IE3214 has a total of
three PCI slots.

Hey! Where’d it go?
We were surprised to see an extremely rich soft-
ware bundle with the Acer IE3214. A carton
inside the main box contained a set of 11 CDs
and DVDs. The contents ranged from games to
movies, recipes, utilitarian software and even
an encyclopaedia. Intex was not to be left
behind and bundled Red Hat Enterprise Desktop
Version 4 with each PC. A couple of useful soft-
ware were also found in the DVD writing soft-
ware disc. Intex provided both Windows XP and
Vista drivers—a definite plus point.

The usual cables and other paraphernalia
were also provided by all vendors—something
that is typically overlooked in this category.
None of the vendors provide wireless keyboards
or mice. Shockingly, no speakers are provided
either! You’ll need to invest at least in a pair of
headphones for any kind of aural experience on
any of these desktop PCs.

Intex was thoughtful enough to provide
dust covers for the entire PC with all three mod-
els—something Acer missed out on.

The EzeeBee Max XP Z999 comes with a pair
of supraaural headphones (meaning they par-
tially cover your ears).

Performance
Clash of the Tortoises!

All these PCs are Intel-processor-powered. The
newer budget Core 2 Duo processors (the E4x00
family) are fast, but not as fast in terms of clock
speeds as the older Pentium D 925, which runs at
a whopping 3 GHz on the Intex BF-73411—the
fastest CPU (in terms of clock speeds) here. Heat
could have become an issue, but the cabinet has
sufficient vents to allow dissipation.

The Core 2 Duos in these PCs belong to the
4x00 and 2xx0 family. These are basically

stripped-down Core 2 Duos and their perform-
ance is around the same as that of the older
Pentium D—with a lot less heat, of course.
Incidentally, one of the areas where the
Pentium D runs out of steam is while watching
HD movies—our test 1080p clip experienced
some stuttering on the Intex BF-73411. No such
issues on the other three. The BF-73411 has
another issue: its hard drive is very slow—in fact,

almost too slow for a SATA drive.
We’re thinking this was a problem
with the hard drive that came with
the test PC, and not something that
might occur with another hard drive
on the same make and model. 

With integrated graphics, these
PCs aren’t for gamers—unless you
opt for a discrete graphics card. All

four PCs have PCI
Express x16 slots, so
you can opt to upgrade
to a discrete graphics
solution.

The AL1916W monitor bundled with
the Acer Aspire IE3214 is much better than

the monitor provided by Intex (all three Intex
Desktops have the same monitor). HCL also pro-
vides a good 19-inch widescreen. All the vendors
are pretty stingy with storage space, with the
exception of the Intex BM-45431, which has a
250 GB hard drive.

Conclusion
Have I made the right choice?
Intex’s BM-45431 is our Best Buy Gold winner—
good specifications, a large hard drive and
great expansion possibilities. Intex’s warranty
will also keep you happy—one-year on-site sup-
port is available, after which you’ll get anoth-
er two years of carry-in support. This PC makes
a good choice for someone looking for an
affordable yet fully-functional Desktop. It’s
quite powerful too, and also a decent multi-
media performer; how we wish Intex had 
bundled a widescreen monitor!

We’re awarding a joint Silver to Acer’s
superb Aspire IE3214 and
HCL’s EzeeBee Max XP Z999:
their scores just too close to
make a decision one way or
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Acer Aspire IE3214
Whatta bundle!
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Intex BM-45431
A value-for-money performer
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the other. Acer gets a nod ahead due to the
superior bundle, though—11 discs consisting
of games, movies, software, utilities, recipes,
and an encyclopaedia. At Rs 25,000, if you’re

looking to start your DVD
collection with a bang, get
the IE3214. The widescreen
monitor is attractive if you’re
a movie buff. If you’re look-
ing for a little more process-
ing power, go with the Intex
BM-45431. 

A CUT ABOVE
Desktops
Between
Rs 30,001 
And Rs 40,000
This category is
where the fun
starts—all vendors

now have a good budget to work with. You can
expect a better processor, perhaps more memo-
ry and a bigger hard drive. Discrete graphics is
not a necessity unless you want to game a bit,
but it’s something to look for. (Integrated video
solutions eat up valuable main memory to use
as video memory.)

You should also look for at least a 19-inch
LCD monitor—flat panels have become dirt
cheap, and are easily available within this
budget. If you’re into multitasking a bit, then 2
GB of memory is the way to go.

50

Features
I want it!

The LG XDZ caught our attention first. It devi-
ates from the usual black colour scheme most
vendors follow for a smoky grey hue. Opinions
will differ drastically—some will love it, some
will love to hate it: no lukewarm emotions here.
A card reader has been cleverly integrated into
what at at first glance looks like a second CD
bay flap. We also like the quality of the cabi-
net—it feels very sturdy, and the sheet used is
quite thick.

Compaq’s Presario SG3063IL looks just like
its cheaper SG3053IL, except for the hardware
under the hood. Zenith’s 401G is passably usable
as a mirror with its glossy front bezel. The rest of
the cabinet is much the same: one sore point is
the optical drives’ eject mechanism—the front
bezel that tilts outwards has the eject button
built into it. When you eject the drive tray, the
entire bezel (including the button) bends down-
wards—meaning you have to push the tray back
into the drive.

Sahara’s 20CK16 has the biggest cabinet of
the lot—plenty of ventilation.

HP’s Pavilion a6110in has an attractive
transparent and backlit power button mounted
atop the cabinet. In fact, all the HP and
Compaq PCs had one common feature—when
powering off, the button glows orange, and it’ll
glow green while powered. The card reader
integrated into a floppy drive bay is functional.

PARAMETERS
Features
System Specifications

Upgradeability
Specifications And General
Features
Ergonomics
Performance
PC Mark 2005

SiSoft Sandra 2007

3D Mark 2005

DisplayMate

HD Movie Viewing

Video Encoding
File Transfer Test

Game Test: Doom 3

Game Test: FarCry

Price
Operating System

WHAT WE LOOKED FOR

The hardware under the hood, correlated with price justifications. We gave points for larger monitors—
widescreens got preference, as did bigger hard drives
We looked at how much expansion is possible. After all, everyone needs to upgrade once in a while
Number of USB ports provided, video connectivty, audio connectivity. We also checked for the software and
add-on bundles and rated the PCs accordingly. Price points were considered
How easy is it to access those USB ports? How good is the keyboard?

This synthetic benchmark tests the CPU, GPU, hard drive, and memory, and brings up scores. It is very
sensitive to any change in components
A little more detailed than PC Mark2005, this utility individually tests each performance-affecting hardware
device, and lets us know how good each component is
Tests the pixel and vertex shader capabilities of 3D acceleration hardware. Good for testing consumer graphics
solutions. Its newer brother, 3D Mark 2006, is used to check enthusiast hardware
Tests the capabilities of a monitor—since we were looking at multimedia capabilites like colour rendition and
pixel response, we ran only the relevant tests
We played back a 1080p clip. Observations included stuttering, dropped frames, colour and crispness, and the
suitability of the monitor for HD content
Perhaps the most suitable real-world benchmark for testing a CPU’s capabilities
Stresses out the hard drive, and is a good benchmark for storage. We used a 4 GB test file for sequential tests,
and a mixture of different file types of varying sizes for random tests
The OpenGL benchmark of choice—still one of the best geometry and shader engines in the business—scales
very well with changes in CPU, memory, and GPU frequency or parts
The DX equivalent of Doom 3. This game features intensive shader operations and some great outdoor scenes
with gorgeous detailing. Great for stressing out video solutions
Cheap doesn’t necessarily mean better—bang for your buck is what we’re looking at
Windows XP Professional with SP 2

How We Tested

HCL EzeeBee Max XP Z999
Feature-rich, fancy-free
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Goodies Galore!
HP provides a fully-function-
al complete system recovery
suite, but apart from that,
the bundle is light. LG pro-
vides a system recovery suite
from Stellar, and for some
weird reason, FreeDOS!

Once again, no-one pro-
vided speakers. We were
also disappointed to see
wired keyboards and mice
with all these PCs. We were
equally shocked to see only
80 and 160 GB drives being
shipped with all these.

In terms of expansion,
the Sahara 20CK16 provides
all that you’ll need—the
huge cabinet will handle four hard drives and
two optical drives. The motherboard provides
four  SATA ports, and one PCI Express x16 slot
with a 7600GS graphics card. Strangely
enough, this card features 512 MB of video
memory—this is overkill for the GPU core.
Sahara has been miserly with the monitor—a
15-inch LCD just doesn’t justify this kind of
video hardware.

Performance
Duelling Desktops!

Up front, the Sahara 20CK16 has superb specifi-
cations. With a brand new Core 2 Duo E6320 and
1 GB of system memory, along with a graphics
card of the GeForce 7 family, this PC can lay

claim to being something of a gaming machine.
Although hardcore gamers will look at faster
graphics cards, this one is definitely capable of
running most current-generation games at medi-
um settings and moderate resolutions.

The HP Pavilion a6110in features an AMD
processor that is slightly slower than the fire-
breathing Core 2 Duos, but tries to compensate
by providing a very capable video solution—the
integrated GeForce 6150 should be good for
those looking for a multimedia PC—good HD
video acceleration, among other things.

Compaq has another solid offering in the
Presario SG3063IL, though we couldn’t stomach
the tiny 80 GB hard drive. The Zenith 401G is
deceptively fast—the E6320 sees to all your pro-
cessing needs quite well. The monitor makes for
a crisp widescreen experience—definitely worth
it for movie buffs.

Conclusion
Which is mine?

If you want something powerful enough to
crunch through most applications and multi-
tasking, look at the Sahara 20CK16 and the
Zenith 401G. The 20CK16 is recommended for
those looking to work with image editing or
even casual 3D rendering work. It steals our
Digit Best Buy Gold award on the basis of its sheer
performance.

Another very capable multimedia PC,
thanks in part to a very good integrated
graphics solution, the HP Pavilion a6110in 
is our Best Buy Silver. We’d have liked to see 
a faster processor here, though. HP bundles 

Sahara 20CK16
Great components under
the hood
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BRAND 
MODEL

Price #
Comments

Grand Total (Out of 100)
Features (Out of 48/46*)
Performance (Out of 40/44*)
Price (Out of 12/10*)
Features
System Specifications
Processor Model No./Speed (MHz)

RAM (MB)/Type/Speed (MHz)
Chipset
Graphics Chipset/Memory (MB)
Audio Solution/No. of Channels
HDD Size Unformatted (GB)
Screen (Inches)/Aspect Ratio/Resolution 
Speakers (✔ /✖ )/Power (Watts RMS)
Keyboard/Mouse(Wired/Wireless)
Case Ventilation (So 10)
Upgradeability
Memory (No. of Slots)
HDD (No. of SATA Ports)
HDD/Optical Drives (No. of Bays)
PCI Express x16 Slot (✔ /✖ )/No. of PCI Slots
Specifications and General Features
No. of Ports (USB (Front+Rear)/FireWire)
Audio (Coaxial/SPDIF/✖ )
Video Connectivity (VGA/DVI/TV-Out)
Memory Card Reader(✔ /✖ )/Types of Cards
Bundled Applications

Miscellaneous Bundled Goodies
Bundled OS
Ergonomics 
Location of Front Panel Ports (So 10)
Keyboard Tactile Feedback/Layout (So 10)
Performance
Synthetic Scores
PC Mark 2005 (Overall Marks)
CPU/Memory
Graphics/HDD
SiSoft Sandra 2007
CPU Arithmetic (Dhrystone/Whetstone)
CPU Multimedia (Integer/Floating)
HDD (Drive Index/Access Time)
Memory Bandwidth (Integer/Floating)
3D Mark 2005/CPU Score
DisplayMate Colour Suite (So 10)
Real-World Tests
HD Movie Viewing (So 10)
Video Encoding  (100 MB file) (Sec)
File Transfer (MBps) Seq./Random
Doom 3 (fps) (800x600, medium detail)
Far Cry (fps) (800x600, minimum detail)
Warranty (On-site/Overall)

Scoreboard                      Rs 20,000—30,000
Acer

Aspire IE3214

Rs 25,999
+ Good monitor & bundle

– Plain looks

58.45
21.88
26.18
10.39

Pentium Dual Core/1600
MHz
512 MB/DDR2/667 MHz
i945GZ
Intel 82945G/Shared
Realtek ALC888/8
160 GB
19”/W/1440x900
✖ /NA
Wired/Wired
7

2
4
6/2
✔ /3

2+4/✖

✖

VGA
✖

Drivers, DVD & CD Value
Pack—11 Discs
(Astromania Math 1, Kar
Racing, Mindbusters,
Touch the sky touch the
universe1

NA
Windows XP Pro

5.5
5.75/6.5

3196
4087/3415
928/5980

14176/9828
84536/45965
68 MBps/14 ms
3226/3231
402/2975
6.25

6.75
136.07
22.70/19.69
7.50
16.95
1 year/1 year

Compaq
Presario SG3053IL

Rs 26,490
+ Good Monitor

– Mediocre performance

49.62
14.71
24.72
10.19

Pentium Dual Core/1600
MHz
256 MB/DDR2/667 MHz
i945GZ
Intel 82945G/Shared
Realtek ALC888/6
80 GB
17”/W/1440 x 900
✖ /NA
Wired/Wired
6.75

2
2
1/2
✖ /2

0+2/✖

✖

VGA
✖

Norton Internet Security
2007, Drivers

NA
Vista Home Basic

3
5.25/5.75

3047
4094/3410
896/5511

14072/10218
87889/47835
68 MBps/14 ms
3296/3293
346/2585
6.25

6.25
138.70
168.87/198.2
6.30
11.00
1 year/1 year

HCL
EzeeBee Max XP Z999

Rs 29,900
+ Good specs

– Plain looks

58.39
21.07
28.29
9.03

Core 2 Duo E4300/1800
MHz
1024 MB/DDR2/667 MHz
Intel i945GC
Intel 82945G/Shared
Realtek ALC888/8
160 GB
19”/N/1440 x 900
✖ /NA
Wired/Wired
6.5

2
4
3/2
✔ /2

1+4/✖

✖

VGA
✖

Drivers, Nero + utilities,
CyberLink Power DVD and
Power Producer

Headphones
Vista Home Basic

6
6.5/6.5

3345
4361/3654
934/5647

16514/11523
99222/54038
69 MBps/18 ms
3195/3201
440/3715
6.25

6.25
126.04
148.5/160
6.40
19.57
1 year/1 year

Intex
BA-73401

Rs 25,000
+ Airy cabinet

– Low on storage space

57.86
21.19
25.87
10.80

Pentium Dual Core/1600
MHz
512 MB/DDR 2/667MHz
Intel i945GC
Intel 82945G/Shared
Realtek ALC888/8
80 GB
19”/N/1280 x 1024
✖ /NA
Wired/Wired
7

2
4
6/3
✔ /2

2+4/✖

✖

VGA
✖

Norton Antivirus 2006,
Nero Express, CyberLink
Power DVD & Power
Producer, Win2000/XP
Drivers, Vista Drivers 

Dust Covers
Red Hat Enterprise Desktop

6.5
6/6.5

3024
4093/3551
1029/4654

14714/10210
87750/47818
55 MBps/14 ms
3650/3680
468/3429
6.25

7
127.81
10.52/11.35
13.00
17.87
1 year/3 years

Intex
BF-73411

Rs 28,000
+ Expandable

– Low on memory

55.09
22.06
23.39
9.64

Pentium D925/3000 MHz

512 MB/DDR2/533 MHz
Intel i945GC
Intel 82945G/Shared
Realtek ALC888/8
160 GB
19”/N/1280 x 1024
✖ /NA
Wired/Wired
7

2
4
6/3
✔ /2

2+4/✖

✖

VGA
✖

Norton Antivirus 2006, Nero
Express, CyberLink Power
DVD & Power Producer,
Win2000/XP Drivers, Vista
Drivers 

Dust Covers
Red Hat Enterprise Desktop

6.5
6/6.5

3064
4940/3478
927/4755

13000/10677
33081/38695
73 MBps/15 ms
3384/3388
434/3354
6.25

5.25
125.32
9.99/9.53
9.80
14.32
1 year/3 years
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1Art Explosion Scrapbook Factory Standard,
Terminator 2: Judgement Day & Rambo:
first blood part 2, American Pie & Rush
Hour 2, The Laurel and Hardy Collection,
The Jungle Book Vol 1, Desi Khana, Simon &
Schuster New Millenium Encylopedia

* Rs. 30,001 to Rs 40,000
# Price exclusive of all taxes



Rs 30,001 to 40,000
Intex

BM-45431

Rs 25,900
+ Balanced performance

– Plain looks

60.92
23.35
27.15
10.42

Core 2 Duo E4300/
1800MHz
1024 MB/DDR2/667 MHz
Intel i945GC
Intel 82945G/Shared
Realtek ALC883/8
250 GB
19”/N/1280 x 1024
✖ /NA
Wired/Wired
7

2
4
6/3
✔ /2

2+4/N
✖

VGA
✖

Norton Antivirus 2006,
Diskkeeper 9 Home Edition,
CyberLink PowerDVD and
Power Producer, Nero 7
Essentials

Dust Covers
Red Hat Enterprise Desktop

6.5
6/6.5

3240
4666/4209
2222/5524

13538/11327
100956/76216
55 MBps/14 ms
3372/3294
461/3490
6.25

6
138.23
23.68/21.87
7.00
11.50
1 year/3 years

Compaq
Presario SG3063IL

Rs 36,989
+ Good monitor

– Plain looks

42.79
12.40
22.73
7.66

Core 2 Duo E4400/2000
MHz
512 MB/DDR2/667 MHz
i945GZ
Intel 82945G/Shared
Realtek ALC888/6
80 GB
17”/W/1440 x 900
✖ /NA
Wired/Wired
6.75

2
2
1/2
✖ /2

0+2/✖

✖

VGA
✖

Norton Internet Security
2007, Drivers

✖

Windows Vista Home Basic

3
5.25/5.75

3459
5082/3892
1029/4806

18386/12769
109828/59533
55 MBps/14 ms
3384/3295
433/3305
6.25

6.25
141.2
23.38/21.26
6.6
11.12
1 year/1 year

HP
Pavilion a6110in

Rs 31,490
+ Good monitor

– Slower CPU

52.47
20.82
22.65
9.00

Athlon 64 X2/1900 MHz

512 MB/DDR2/667 MHz
nForce 6100
GeForce 6150/Shared
Realtek ALC888/8
160 GB
17”/N/1280 x 1024
✖ /NA
Wired/Wired
7

4
4
2/2
✔ /2

0+4/1
Coaxial
VGA
✔ /MMC, SD, CF, xD, MS Pro
HP Recovery Suite,
Symantec Norton Utilities,
Drivers

✖

Vista Home Basic

6.5
6/6.5

2798
3811/2871
683/5278

13153/11754
36035/31660
62 MBps/20 ms
3698/3727
588/5772
6.5

6.25
144.03
24.16/22.31
8.5
15.45
1 year/1 year

LG
XDZ

Rs 36,500
+ Good looks and bundle

– None in particular

50.41
19.88
22.77
7.76

Core 2 Duo E4300/1800
MHz
512 MB/DDR2/533 MHz
Intel i945GC
Intel 82945G/Shared
RealTek ALC883/6 
160 GB
17”/N/1280 x 1024
✖ /NA
Wired/Wired
6

2
4
2/2
✔ /2 

2+4/✖

✖

VGA
✔ /MMC, SD, CF, xD, MS Pro
Nero Express, Power DVD,
Power Producer, Stellar
System Safeguard Suite
(Shield, Smart, Revive-It,
InstaBackup), Panda
Antivirus, Free DOS
✖

Windows XP Pro

4.5
5.75/6

3469
4602/3643
997/5987

16604/11488
98810/53799
69 MBps/13 ms
3265/3267
426/3229
6.25

7
118.59
21.26/17.86
8.00
19.60
3 years/3 years

Sahara
20CK16

Rs 40,000
+ Great performance

– Small monitor

58.34
18.26
32.99
7.09

Core 2 Duo E6320/1866 MHz

1024 MB/DDR2/667 MHz
nForce 650i Ultra
NVIDIA GeForce 7600GS/512 MB

Realtek ALC885/8
160 GB
15”/N/1024 x 768
✖ /NA
Wired/Wired
7

4
4
4/2
✔ /3 

2+4/✖

✖

VGA, DVI, TV-Out
✖

Drivers, Nero Utilities,
CyberLink PowerDVD &
Power Producer

✖

Windows XP Pro

6
6/6

3825
4701/3974
3454/5367

17270/11878
102216/55677
50 MBps/13 ms
3542/3560
4064/8871
4.75

5.75
115.2
21.69/20.38
116.1
167.41
1 year/1 year

Zenith PC
401G

Rs 35,750
+ Good CPU

– Weird CD bay mechanism

45.25
13.63
23.69
7.93

Core 2 Duo E6320/1866 MHz

1024 MB/DDR2/533 MHz
Intel i945GC
Intel 82945G/Shared
Realtek ALC883/6
160 GB
19”/W/1440 x 900
✖ /NA
Wired/Wired
7

2
2
1/2
✖ /2

4/✖

✖

VGA
✖

Zenith PC drivers for
Windows XP & Vista, Nero
Express, CyberLink
PowerDVD & Power
Producer

✖

Windows XP Pro

4
5.75/6

3342
4776/3893
1095/5198

17163/11832
102443/55787
58 MBps/13 ms
3303/3325
528/6567
6.25

7.25
111.57
21.59/17.48
8.3
21.01
1 year/1 year
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an excellent 17-inch moni-
tor (the HP VP-17).

If you want something a
little different-looking, the
curvy and very grey LG XDZ
should be worth consider-
ing. It’s a very capable per-
former with a Core 2 Duo
processor (E4300). It also
comes with a very good LCD.

It’s rather plain-looking,
but the Compaq Presario
SG3063IL does have a
decent set of components
and a noteworthy bundle—
just buy a bigger hard drive.

MEDIA CENTRE
DESKTOPS
Home Entertainment With A
Personal Touch
These PCs are also called Home Theatre PCs
(HTPCs). Aimed at making your DVD player obso-
lete, such PCs have the added benefits of a full-
fledged DVD / VCD / audio player, and all PC
functionality is present as well. Most HTPCs
include wireless remote controls, much like a
home theatre system. They may also have wire-
less keyboards and mice to improve ergonomics.
Finally, a good HTPC should have a large
widescreen—a must for HD content. A decent
graphics card also ensures skip-free playback,
particularly of HD content.

Features
Why Didn’t They Bundle A Sofa Too?

Although a media centre is usually associated
with a remote control and a large screen, all
our contestants break the mould in some way
or the other… The unconventional contender in
more ways than one was Acer’s Aspire L310. By
far the sexiest Desktop we’ve tested here, this
stunner has an unbelievably tiny footprint, and
stands just over a foot tall. A great-looking sil-
ver-grey finish complements the exceptional

build quality. Your desktop will draw covetous
glances with this sitting atop it… The fact that
Acer provided the largest monitor in the whole
shootout to partner this baby (a 22-inch
widescreen LCD) speaks of its HTPC intent.
Moreover, the monitor has a reed-thin bezel—
very desirable.

HCL’s Dominator will do just that—domi-
nate your desktop. This was the largest HTPC
cabinet we’ve seen. Bulky isn’t good as far as
anything media centre goes—to its credit, the
cabinet is well-built and quite spacious. The
third competitor in this category was another
HCL—the Beanstalk Classic Z944. Slightly larg-
er than the Acer L310, it comes decked in
piano black. However, we didn’t like the looks
too much: glossy black looks good on curvy
products. This one was a touch too angular.
HCL bundles the same 19-inch widescreen
monitor with both models. 

Hey! Where’s The Popcorn?
Acer shockingly lets the Aspire L310 go without a
remote control—criminal, really, considering
Windows XP Media Center Edition is bundled.
This severely cripples the couch potato—you actu-
ally (gasp!) have to burn precious calories each
time you want to pause a movie. No wireless key-
board and mouse is also a shame—and this is our
only gripe (though major) with this Desktop.

The software bundle is a
little on the skimpy side, too.
A couple of driver CDs is all
you get. What we liked was
DVI connectivity for video.
There’s a wireless access
point in-built so WLAN is just
an antenna away... Acer pro-

vides all the cables nec-
essary to get you start-
ed.Unfortunately, the
shrink in size comes
at a price: there’s a
bulky power adapter
to contend with, not
very smart for your

The HP Pavilion s3180in

The first thing that’ll strike you about the Pavilion s3180in is the
extremely good use of piano black on the front bezel. Thanks to

superbly-designed rubber feet, this cabinet won’t budge on your
desk, and is surprisingly heavy for a small-form-factor PC. The
monitor supplied is the excellent VP 17, also finished in glossy black—
unfortunately, it’s not widescreen. HP bundles a wireless keyboard

and mouse with this desktop, and the
quality shows. The USB module is tiny,
inconspicuous, and looks like a thumb
drive. A memory card reader is
integrated into the front bezel. The
rear panel has Digital Audio Out as
well as FireWire connectivity.

Windows Vista Home
Premium is bundled. A
recovery suite from HP
has been provided, as is
Symantec’s protection
and maintenance suite.

Powered by a Core 2 Duo E4300 and with 1 GB of memory,
the s3180in cuts through most regular applications like a hot
knife through butter. What we really liked was the large hard
disk—250 GB is good (500 GB would have been fantastic). This
PC is up to HD movie playback, but we’d have loved to see a
larger widescreen monitor. Rest assured, though—everyone
except image editing professionals and gamers are well-
covered.

The real appeal of this Desktop lies in its diminutive size—
only the Acer Aspire L310 is smaller—and its classy looks.
There’s that distinctive upmarket feel to the entire system that
bespeaks status, and visitors will definitely take another look at
this atop your desk!

If you’re looking at something that gives solid bang for the
buck, we suggest you look elsewhere—the same specifications will
be available for a cheaper price point. At Rs 45,990, the s3180in is
pricey—not value for money, but rather value for the moneyed! If
you’re looking for a classy Desktop PC that’ll save you loads of
room, look at this—but not before looking at the Aspire L310!

HP Pavilion a6110in
Great monitor & build quality

SEPTEMBER 2007

HCL Dominator Q965
Four cores on a rampage!
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BRAND 
MODEL

Price #
Comments

Grand Total (Out of 100)
Features (Out of 50/)
Performance (Out of 40/36*)
Price (Out of 10/14*)
Features
System Specifications
Processor Model No./Speed (MHz)

RAM (MB)/Type/Speed (MHz)
Chipset
Graphics Chipset/Memory (MB)
Audio Solution/No of Channels
HDD Size Unformatted (GB)
Screen (Inches)/Aspect Ratio/Resolution 
Speakers (✔ /✖ )/Power (Watts RMS)
Keyboard/Mouse(Wired/Wireless)
Case Ventilation (So 10)
Upgradeability
Memory (No. of Slots)
HDD (No. of SATA Ports)
HDD/Optical Drives (No. of Bays)
PCI Express x16 Slot (✔ /✖ )/No. of PCI Slots
Specifications & General Features
No. of Ports (USB (Front+rear)/FireWire)
Audio (Coaxial/SPDIF/✖ )
Video Connectivity (VGA/DVI/TV-Out)
Memory Card Reader(✔ /✖ )/Types of Cards
Bundled Applications

Miscellaneous Bundled Goodies
Bundled OS
Ergonomics 
Location of Front Panel Ports (So 10)
Keyboard Tactile Feedback/Layout (So 10)
Performance
Synthetic Scores
PC Mark 2005 (Overall Marks)
CPU/Memory
Graphics/HDD
SiSoft Sandra 2007
CPU Arithmetic (Dhrystone/Whetstone)
CPU Multimedia (Integer/Floating)
HDD (Drive Index/Access Time)
Memory Bandwidth (Integer/Floating)
3D Mark 2005/CPU Score
Display Mate Colour Suite (So 10)
Real-World Tests
HD Movie Viewing (So 10)
Video Encoding  (100 MB file) (Sec)
File Transfer (MBps) Seq./Random
Doom 3 (fps) (800x600, medium detail)
Far Cry (fps) (800x600, minimum detail)
Warranty (Onsite/Overall)

Scoreboard                      Home Theatre PCs
Acer

Aspire L310

Rs 39,999
+ Great looker, great LCD

– Slightly underpowered

46.31
18.56
18.75
9.00

Core 2 Duo E6300/1866
MHz
512 MB/DDR2/667 MHz
i945GZ
Intel 82945G/Shared
Realtek ALC888/8
160 GB
22”/W/1680 x 1050
✖

Wired/Wired
5.75

NA
NA
NA
NA

4/1
✖

VGA, DVI
✖

Drivers, Nero toolkit,
CyberLink PowerDVD &
Power Producer

NA
Windows XP MCE 2005 

NA
5.75/6.5

3429
4719/3545
1109/5767

17345/11900
102347/55714
71/13
2968/3010
386/3455
6.75

8.25
154.82
21.27/16.59
3.10
12.60
1 year/3 years

HCL
Beanstalk Classic Z944

Rs 54,990
+ Attractive-looking

– Expensive

69.27
37.30
25.42
6.55

Core 2 Duo E6320/1866
MHz
2048 MB/DDR2/667 MHz
i945GZ
NVIDIA GeForce 7500LE/256 MB

SigmaTel STAC9227/8
500 GB
19”/W/1440 x 900
✔ /25W
Wireless/Wireless
7.25

NA
NA
NA
NA

1+4/✖

SPDIF
VGA, DVI, TV-Out
✔ /MMC, SD, CF, xD, MS Pro
Microsoft Works 8.5, Intel
Business Application Suite,
CyberLink PowerDVD and
Power Producer, iPerform
CBSE & ICSE Syllabus study
material
MC Remote, headphones
Vista Home Premium

6.5
7.25/7.25

3642
4718/3876
2187/5653

17024/11764
100231/55233
59/14
3428/3302
1576 / 3675
6.25

6.5
123.56
24.51/22.46
26.20
45.43
1 year/1 year

HCL
Dominator Q965

Rs 59,990
+ Quad-core, good ventilation

– Bulky cabinet

71.73
33.40
32.33
6.00

Core 2 Quad Q6600/ 2400
MHz
2048 MB/DDR2/667 MHz
Intel 965Q
NVIDIA GeForce 7500LE/256 MB

SigmaTel STAC9227/8
250 GB
19”/W/1440 x 900
✔ /10W
Wired/Wired
7

4
6
4/4
✔ /2

2+6/✖

SPDIF
VGA, DVI, TV-Out
✔ /MMC, sd, CF, xD, MS Pro
Microsoft Works 8.5, Intel
Business Application Suite,
CyberLink PowerDVD and
Power Producer, iPerform
CBSE & ICSE Syllabus study
material
MC Remote, headphones
Vista Home Premium

6.75
6/6.5

4673
7519/4881
2243 / 5423

44318/29826
262153/142898
72/13
4887/4899
1707/14231
6.25

7.5
88.32
31.41/24.68
37.80
93.88
1 year/1 year

Under Rs 20,000
Acer

AP E361

Rs 13,799
+ Awesome value

– CRT monitor

54.22
16.75
24.87
12.60

Sempron/2000 MHz

256 MB/DDR2/533 MHz
ATI Xpress 200
Radeon Xpress 200/Shared
Realtek ALC655/6
80 GB
15”/✖ /1024 x 768
✖ /NA
Wired/Wired
7

2
4
2/2
✔ /2

2+4/0
✖

VGA
✖

Drivers, Utilities

NA
NA

5.5
5.5/6.5

2321
2856/3543
1201/4323

9834/6575
43023/26409
65 MBps/14 ms
3142/3087
667/2321
7

4.5
162.1
178.2/186.3
15.3
24.75
1 year/1 year

eSys
EUC3223CI

Rs 18,990
+ Great value

– None in particular

53.21
19.45
24.60
9.16

Pentium Dual Core/1600 MHz

512 MB/DDR2/667 MHz
Intel i945GC
Intel 82945G/Shared
Realtek ALC888/8
160 GB
15”/✖ /1024 x 768
✖ /NA
Wired/Wired
7.5

2
4
2/2
✔ /2

4/0
✖

VGA
✖

Drivers, Nero Utilities

NA
NA

6
6.25/6.75

3066
4109/3467
968/5018

14773/10209
87894/47854
57 MBps/14 ms
3568/3396
419/3161
5.75

5
135.56
160.43/200.85
12.8
17.69
0/3-years
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designer Desktop. Thankfully, the cable is a lit-
tle longer than most.

HCL’s Dominator and Beanstalk Classic Z944
come with a cartonful of goodies—loads of soft-
ware, utilities, speakers, headphones, and

Media Center remote controls.
Additionally, the Z944 is bundled
with a wireless mouse and keyboard
kit from Microsoft—both have great
ergonomics. The little Acer is out-
shone in this department—though it
does come with a much better (and
larger) monitor!

Performance
Ready… Get Set… Go!

Due to the small form fac-
tor typical to HTPCs, they
don’t run particularly cool.
The Acer L310 does get hot
owing to its small size—
thankfully, it runs a rela-

tively cool Core 2 Duo E6300. The real monster
in this category is the Dominator, which fea-
tures a mighty Core 2 Quad (Q6600) at 2.4 GHz.
Thanks to the impressive hardware, this PC
hammered the competition in most CPU-inten-
sive tests and benchmarks.

Acer misses out on a graphics card, while
both HCL PCs feature cards based on NVIDIA’s
GeForce 7500LE chipset. Having a graphics card
doesn’t necessarily make these PCs good gaming
machines, but the HD video playback experi-
ence is enhanced.

What really impressed about the Z944 was
the colossal hard drive—a 500 GB hard disk is a
really positive step by HCL, and something we
hope becomes a trend. Even the Dominator only
manages 250 GB.

Despite the fact that Acer’s 22-inch monitor
is a real show-stopper, it is, in fact, a TN panel,
and has minor colour rendition issues. That
said, this LCD is miles ahead of the competi-
tion—movies and games are a delight with all
the pixel real estate available. Pity it runs an
onboard video solution.

Conclusion
So…do I get the job?
If you want something classy-looking and really
compact with the added benefits of a large mon-
itor and reasonably powerful components, look
no further than the Acer Aspire L310. Even
though it’s intended as an HTPC, we’d heartily
recommend it to bigwig corporates for whom a
Desktop is all about making the right impres-
sion. With integrated Wi-Fi as a bonus, this little

marvel is a definite “must see before buying oth-
ers.” A definite gold winner if beauty came
before brains…

For sheer performance, it’s hard to ignore
HCL’s Dominator. A quad-core processor, 2 GB of
memory, and a GeForce 7-series graphics card
make this one heck of a performer. It’s not a
hardcore gaming machine—the 7500LE will
play most current-generation games at low to
medium settings—but is a solid PC for multi-
tasking and HD playback. The additional media
player functionality and the feature-rich
remote make it very attractive indeed—this is
your Digit Best Buy Gold.

HCL’s Beanstalk Classic Z944 is another pow-
erful option in slim guise. It’s as richly featured
as the Dominator, but with a much smaller foot-
print, attractive looks and better speakers. The
added advantage of a 500 GB hard drive is irre-
sistible for data hogs: if you want loads of space,
here’s your PC… 

MINNOWS
Breaking the sub-20000 barrier
Although we only found two worthies in this
category, it thrills to see some very decent
machines at such throwaway prices! No mat-
ter what advertisements may say, a proper sub-
20,000 PC is still partly fantasy and party
wishful thinking. This is because of the
extremely low margins on such a desktop, and
the nightmare of providing support for com-
paratively cheaper (hence somewhat inferior)
components. Acer and eSys have taken up the
gauntlet and thrown in extremely pocket-
friendly Desktops.

Features
Surprisingly enough!

Acer’s AP E361 sports a surprisingly sturdy
cabinet, and is powered by a basic AMD
Sempron processor running at 2 GHz. Acer’s
bundle is very spartan, and with a tiny 15-inch
CRT, you won’t be doing a lot of movie watch-
ing. We suggest upgrading to a 17-inch LCD—
this will ensure a richer Internet and movie
experience.

eSys’ EUC3223CI provided an even sturdier
cabinet, with a little more visual appeal—a par-
tially meshed front bezel is never a bad thing.
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Acer Aspire L310
Designer Desktop!

Acer AP E361
Value has a new name!

You Want
The cheapest possible Home PC
A basic PC with a little more punch
Decent multimedia functionality
A decent gaming PC
Compact yet powerful Desktop
Media Centre PC with remote

Powerful CPU-based PC for multitasking
Large monitor for HD movies

Upto 15,000
Up to 25000
Up to 35000
Up to 45000
Upto 50000
Up to 60000

Up to 60000
Up to 45000

Acer E361
Acer Aspire IE3214, Intex BM-45431
Intex BM-45431, HP a6110in
Sahara 20CK16
Acer Aspire L310, HP s3180in
HCL Dominator Q965 & 
HCL Beanstalk Classic Z944
HCL Dominator Q965
Acer Aspire L310

Your Budget
13799
25999, 25900
25900, 31490
40000
39999, 45990
54990, 59990

59990
39999

We Recommend

Decision Maker

The Price
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Both bundles are on the skimpy side but
you’d have to be a little barmy to expect some-
thing extra at this price point.

Performance
Huh?

The eSys EUC3223CI outperforms the tiny
AP361 both on paper and in practice, due to the
huge difference in processing power—an AMD
Sempron is no match for a dual-core Pentium
processor. The AP361 has a capable ATI Xpress
200 graphics chipset, though—this will allow a
variety of multimedia applications, though
there’s only 256 MB of system memory.

The EUC3223CI has double the system
memory and double the storage space. This
seems right, considering there’s a 5,000-rupee
price difference.

So...
The entry point to the world of computers is here!

If you’re extremely fund-shy and need a very
basic PC to run office applications, dabble in a

little multimedia, surf the Net, or even as a sec-
ond PC for downloading (an increasing trend),
take a serious look at the exceptionally well-
priced Acer AP361—Rs 13,799 with a whole one-

year onsite warranty.
If you want a little more pro-

cessing punch and a bigger hard
drive, we’d suggest the eSys
EUC3223CI. You’ll also get a 15-inch
LCD monitor instead of the 15-inch
CRT bundled with the Acer.

To Sum It Up
The specifications on some of our
test candidates were drool-worthy,

but we expected more—
especially from PCs
priced at over a half-
lakh rupees. For one,
DX10 graphics cards,
which cost below Rs

5,000. Another trend we’d like to see done and
buried is the inclusion of tiny hard drives.
There’s absolutely no way a Desktop PC will
cope with a family’s storage needs with 80 or
160 gigabytes.

There’s much to be appreciated though, like
the inclusion of LCD monitors all round. Also,
the inclusion of fast processors on cheaper PCs.
Another heartening point was the de facto 512
MB of RAM.

In any case, if you want a Desktop PC with-
out the headache of choosing components your-
self, and running circles around dealers for sup-
port, take the branded way! 

michael_browne@thinkdigit.com

eSys EUC3223CI
Good specs, great price!

PhoneCompany E-mailBrand

Contact Sheet Branded Desktop PCs

Acer
Compaq
Esys
HCL
HP
Intex
LG
Sahara
Zenith PC

Acer India Pvt Ltd
HP
eSys Information Technologies Ltd
HCL Infosystems Ltd
HP
Intex Technologies Ltd
LG Electronics India Pvt Ltd
Sahara Computers & Electronics Ltd
Zenith Computers Ltd

9342172109 
9810061022
1800-1020304
9818989875
9810061022
1800-116789
9811354331
0120-4397777
1800-222004 

anup_agrawal@acer.co.in
shubhodip.pal@hp.com
in.info@esysmail.com
sachin.tyagi@hcl.in
shubhodip.pal@hp.com
info@intextechnologies.com 
ajaysurjan@lgindia.com
info@saharacomputers.co.in
info@zenith-india.com
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As much as common sense
tells us to avoid slider

phones for obvious reasons—
as in moving parts, wear and
tear—they’re hot! The E65 is
red-hot (literally), and it’s
available in mocha, too. The
entirely matte-finished body
offers good grip, and it
manages to also look classy.
Red—russet brown really—
might not appeal to all, but
the soft contours are nice.

With Bluetooth, Wi-Fi,
3G, EDGE, and more, the E65
is a business-oriented device
with some artistic flair. The
number keypad is well-laid-
out with raised
demarcations on each key,
similar to the N95—but
remember there’s no
QWERTY. Keypad
backlighting is good. The
2MP camera and the music
player are pretty ordinary.

Pop the hood and it’s a
Symbian S60 9.1 device.
Quick Office has been
provided, but it’s Word and
Excel editing at its barest (no
document creation). GPS
software is bundled: it’ll
work with any Bluetooth GPS

device. There’s also a pretty
nifty text-to-speech module
that will read out data
whose menus are placed in
the Voice Aid folder. Contacts
can be read out, as can
phone numbers, recent calls,
and the time. You also get a
voice assist while dialling,
which will help (only if you
remember the number) in
the event of mis-dialling
while in a hurry. Still, we
think the software needs a
lot of work to be functional.

The phone is slow,
though, especially while
using the voice functions—
which bespeaks low memory.
Call quality is good, but not
on par with some of the
other Nokia phones we’ve

tested. Calls disconnect easily
when reception strength is
at one tower.

At Rs 22,469, the E65
isn’t the definitive business
phone that the E series label
indicates it to be. A phone
with very similar
specifications and functions
with a cheaper price tag
comes to mind—the N80. But
then all new phones are
costly, and a couple of price
cuts may see this hottie
become popular.

Specifications
Weight: 115 gm; dimensions: 105
x 49 x 15.5 mm (L x W x H);
screen: 240 x 320 (16M
colours); 50 MB shared
memory; 2MP camera; GPRS,
EDGE, 3G, Wi-Fi, Bluetooth, IR,
and USB connectivity

The 965 PLT-A, from the
Elitegroup stable,

targets the
value-conscious.
Straight out of the
box, the board
supports Core 2 Duo
and Core 2 Quad
processors, promising a
decent upgrade path. Long-
life solid state capacitors
are only used in the
vicinity of the LG775
socket, showcasing the
board’s “budget” colours. 

The use of the 946GZ
chipset limits FSB support
to 1033 MHz, which will get
the job done only for now.
Though there is dual-
channel DDR2 support,
addition capacity is
restricted to two DIMM
slots, meaning a max of 4
GB of RAM. Support for
high-speed DDR2 modules
is restricted to 667MHz.

The
16x PCIe slot

provides the vital graphics
expansion capability, along
with one 4x PCIe slot for a

physics
card. Featured

are four SATA ports
and one IDE slot. Out of
eight USB 2.0 ports, four
are on the rear panel while
the rest of them are
expandable through the
onboard jacks using the
PCI bracket provided
alongside. 

The board scored 3598
in PC Mark 05 when we
used an Intel Core 2 Duo
E6700, meaning it’s an
average performer. In our
game tests, the board
churned out 11.7 fps in

Doom 3 at 1024 x 768 with
shadows disabled. The
overall 3D Mark score of
362 indicates mediocre
onboard graphics

performance.
The 946GZ

chipset does a
respectable job

for the price (Rs
4,300). The board doesn’t

excel in any department; it
doesn’t pack a punch for
gamers and overclockers—
but the just-average guy
won’t complain.

Specifications
Intel 946GZ and ICH7 chipset;
Socket 775; Core 2 Duo / Quad
ready; 1066 / 800 FSB; DDR2
667 / 533 MHz; integrated Intel
Graphics Media Accelerator
3000; 4 SATA ports

Performance  
Features
Ease of use
Value for Money
Overall 

RATINGS

Contact: Zenith Technologies 
Phone: 9323584048
E-mail: malay.ray@zenith-
india.com
Web site: www.ecs.com.tw
Price: Rs 4,300

Contact: Nokia India
Phone: 30303838
E-mail: ext-manoj.goel@nokia.com
Web site: www.nokia.com 
Price: Rs 22,469

We test the latest hardware 
and software products available 
in the marketBazaarBazaar

Features
Performance  
Build Quality
Value for Money
Overall 

RATINGS

ECS 965PLT-A
The budget contender

Nokia E65
Not quite the E…
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Wireless is generally a
strict no-no for

audiophiles. Enter the
RS130, aimed at making
believers out of the aurally-
discerning that wireless
headphones can indeed
deliver the goods. Turns out
they’re not audiophile-grade,
but they’re good—much
better than you’d expect
wireless headphones to be.
The major problem with all
wireless headphones is
interference, and the fact
that air isn’t as good (gross
understatement!) a medium
to transfer disturbance-free
sound waves as compared to,
say, 99.9% oxygen-free
copper cables!

The RS130 comprises a
transmitter unit with an AC
power adapter, and the
circumaural-type
headphones that feel very
light (280 gm) despite the
rechargeable AAA NiMH
batteries inbuilt. Surround
sound is a switch away; the

RS130 employs additional
circuitry for this. Sennheiser
has also touted “Self
Learning Volume
Controller,” a newfangled
name for automatic volume
levelling. We must say it
works reasonably well here.

The headphones
themselves are extremely
comfortable on the outer
ear—no stress or pressure
even after five hours of
continuous use for this
reviewer. This is partially due
to the ear-cup design and the
extremely soft padding.
These are open cans (others
will hear the sound too).

The RS130 has an
impressive soundstage for a
wireless set. Audiophile cans

these are not, like we said,
yet they impressed us with
clarity and depth in almost
every genre of music.
You’ll find low bass a little
lacking in grunt, and mid-
range seems a little
muted, especially vocals.
Still, this set downs every
other wireless set we’ve
tested in the past couple of
years, and manages to give
some of the good wired
ones out there a run for
their money.

Coming to the personal
aspect, these cans are huge,
and while they offer a superb
range of around 16 metres—
with obstacles including
walls—we don’t really see
anyone walking around with
them. Still, if wired is a no-
no for you, give the RS130 a
look—if you can handle the
steep price: Rs 10,900.
Remember we’re talking
about the best wireless set
we’ve tested in years—and
the brand image itself will
do a little to massage your
ego after the liquidity
plunge! But do remember
that if you’re OK with a cord,

you’ll
find something acoustically
similar at half the price.

Specifications
Circumaural; frequency range
18 Hz ~ 21 kHz; wireless RF
receiver; surround sound mode;
3 RF channels

Sennheiser RS130
Good. Very Good.

The new Buffalo
DriveStation Quattro

crams in four 250 GB hard
drives to give you a terabyte.
Structurally rugged, this
drive is encased in a rather
bulky black casing, with all
sides made of metal.
Weighing in at 6 kg, it is
tough to move around.

The drives are SATA150 at
7200 rpm. The accompanying
software allows you to
configure the drives to work
in five different modes:
Normal mode (appearing as
four separate 250 GB drives),
JBOD (which shows the drive
as one contiguous 1 TB
drive), RAID 0 (also
appearing as a single 1 TB
drive but faster), RAID 1 (500
GB with mirroring), and
RAID 5 (750 GB and a

combination of speed and
reliability). 

The Quattro supports
USB 2.0 and the newer and
faster eSATA interface.
Buffalo even provides a PCI
eSATA card with a bracket
and a cable for those—and
that’s the majority—whose
motherboards do not
support that interface.

It took 43 seconds for a 1
GB file to get copied to the
drive; a gigabyte of assorted
data took 52 seconds. The
unit tends to heat up

considerably during
operation; the 12 cm fan at
the back doesn’t seem to be
doing its job.

The Memeo Autobackup
software that accompanies
the drive is versatile. It
automatically backs up your
data to a wide variety of
destinations such as hard
disk, removable drive, FTP
server, Network Places, iPod,
and Memeo Internet Disk—
an online service  for Memeo

Backup users. Secure
Lock Ware—another
bundled application—
uses 256-bit AES
encryption to protect
your data.

The absence of a
backup button and the
relatively slow speed
bring down the appeal of
the Quattro for system
administrators, and the
rather high price tag of

Rs 49,000 doesn’t help.

Specifications
1 TB (4 x 250 GB SATA); 7200
rpm; Seek time: 11 ms;
Interface: USB 2.0, eSATA;
eSATA PCI card with bracket;
Software: Memeo Autobackup,
Secure Lock Ware; Weight: 6 kg

Buffalo DriveStation Quattro    
Good on features, low on appeal

Contact: Advent Infotech Pvt Ltd
Phone: 011-41436751
E-mail:buffalo@adventelectronics.com

Web site: www.buffalo-technology.com

Price: Rs 49,000

Performance  
Features
Build Quality
Value for Money
Overall 

RATINGS Contact: Sennheiser Electronic 
India Pvt Ltd.
Phone: 0124-4187816
E-mail: Ankush.Agarwal@
sennheiserindia.com
Web site: www.sennheiserindia.com
Price: Rs 10,900

Performance  
Features
Build Quality
Value for Money
Overall 

RATINGS
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Lenovo’s 3000 series line-
up makes up its

mainstream laptops.  The
latest addition is the N200
and is based on Santa Rosa,
the latest laptop platform
from Intel.

A biometric scanner lets
you log in to Vista with a
swipe of your finger. Setting
up the software for the
finger scanner is simple, and
logging in is convenient.

The performance in
PCMark 2005—a test for
measuring mainly the
graphics subsystem
performance—was more then
satisfactory. The 1 GB of RAM
makes sure Vista runs fine.
The benchmark for FarCry
recorded a frame rate of 5.70
fps, and Doom 3 did 9.3 fps,
both of which are pretty bad,
but comparable to most mid-
range laptops of today. The
memory and drive
benchmarks in SiSoft Sandra

show pretty good results—a
42 MB/s drive index and a
score of 3786 for memory.

The 15.4-inch screen does
a maximum resolution of
1280 x 800. It is crisp and
vibrant—decent enough for
day-to-day use, but you start
to see the bandings in colour
gradients with HD videos—a
sign of a poor LCD.

The keyboard is sturdy;
the keys have decent travel,
and most importantly, lack
the flimsy, plasticky feel you
find in quite a few cheaper
laptops these days. The right
edge of the touchpad acts as
a scrollbar. The blast of hot
air from the left vent is
noticeable, which clearly
indicates that the laptop
runs quite hot. The speakers
are lacking in power, and
despite the low volumes we
kept it at, the laptop only
stayed powered on for 2:41
hours on a full charge.

It’s down to
the extras,
because the
performance is
pretty standard.
You get Wi-Fi,
Bluetooth, four
USB ports, and a
FireWire port. The Wi-Fi
and Bluetooth can be
turned on and off with the
slide of a notch instead of
through the OS. There’s a
VGA connector for an
external monitor, a 5-in-1
memory card reader, and a
1.3MP webcam.

Gaming is out of the
question because of the
lacking graphics

subsystem,
but the N200 should be

fine for students and
business users for regular
work—and the occasional
movie or two.

Specifications
Core 2 Duo T7100; 110 GB HDD;
memory: 1 GB; 15-inch
widescreen; resolution: 1280 x
800; 5-in-1 card reader (SD,
MMC, XD, MS, MS Pro)

Today’s powerful
processors’ cooling

solutions are just too noisy,
mainly because faster fans
are needed to dissipate all
that heat. We’re looking at
the perfect foil for all that
racket… the 20 dB Cooler
Master AquaGate S1. Suitable
for nearly all sockets, this
complete liquid cooler from
Cooler Master is aimed at
cooling your processor.

Liquid coolers have
always been nasty things
that most of us don’t like to
tamper with for the fear of

damaging internal
components. Cooler Master
takes away this from the
equation with a completely
assembled kit.

This one is extremely
easy to set up—it’s usually
a hassle with liquid
coolers, but we were able
to do it in 11 minutes flat! 

We used this cooler and
compared it to the stock
Intel cooler. The processor of
choice was the Core 2 Duo
X6800, which heats up with
CPU-intensive applications.
We overclocked too, just to

see what would happen.
Note that these aren’t idle
temperatures. The results
are in the graph.

As you can see, the
AquaGate is effective at
cooling an
overclocked
X6800. At 3.5
GHz, a
temperature
of just 52
degrees is
good,
though it’s
only 9
degrees less
than what the stock cooler
does; we expected more.

At Rs 4,500 the S1 makes
a good choice for someone
looking at an affordable and
hassle-free liquid cooling
solution with moderate to
heavy overclocking. If you’re

running an Intel or AMD
processor at stock speeds,
you won’t really need the S1.

Specifications
Current 0.3 A; Ceramics Bearing
pump (life 50,000 hours); 120
mm blue LED fan (life 40,000
hours); base material copper,
other material aluminium

Lenovo 3000 N200
Feature-packed, Santa Rosa-powered

Contact: Lenovo India
Phone: 080-22108412
E-mail: direct@in.lenovo.com
Web site: www.lenovo.com
Price: Rs 52,000

Contact: SMC International
Phone: 9810026658
E-mail: Himanshu
@amigointernational.biz
Web site: www.coolermaster.com
Price: Rs 4,500

Performance  
Features
Build quality
Value for Money
Overall 
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Overall 
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Cooler Master AquaGate S1
Water is good for you!
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The AV series drives have
been tailored to deliver

optimised AV performance,
and is targeted at the CE
segment (HDD Recorders,
Video Surveillance
Recorders, etc.) and digital
video professionals.

According to WD, a lot of
research has gone into
engineering these drives to
incorporate enhanced
features. These drives are
touted to be very reliable
with an MTBF (mean time
between failures) of 1
million hours, and are
rugged enough to survive
high-temperature, always-on
environments.

SilkStream technology
provides continuous smooth
playback of up to 12 HD
streams with an assumed
transfer block size of 2 MB
per stream. Its compatibility
with the ATA streaming

command set also enables
CE customers to use
standard stream
management and error
recovery options.

IntelliSeek is another
technology incorporated
here; it calculates optimum
seek speeds to lower power
consumption and vibration.
Indeed, we found this to be
a silent performer. The
recording heads are parked
off the disk surface during
spin-up and spin-down and
when the drive is off, to
reduce wear and improve
reliability and non-
operational shock tolerance
(350 G as opposed to 250 G

for
standard
drives).

The drive features
Pre-emptive Wear
Leveling, which means the
drive arm frequently and
evenly sweeps across the
disk to reduce uneven wear
on the disk surface—a
common thing with AV
streaming applications.

The drive consumes less
power than non-AV drives;
in fact, WD has removed
the 
3.3 V SATA power from this
product. It also runs cooler
than most.

The drive was better
than most other non-AV
drives in the synthetic
benchmarks. In the real-
world tests, it was fast in
the sequential file copy test,
but lagged behind all the
drives we have tested thus

far
in the

assorted file copy
test, taking at least 50%
more time.

The 2 MB buffer appears
to be too little in an age
where 8 MB is the starting
point (and it did hurt the
performance). At the same
price as a 320 GB drive, this
fails to justify its price.

Specifications
160 GB; 7200 rpm; 2 MB buffer;
SATA II

Contact: Compuage Infocom Ltd
Phone: 022-23842200
Email: info@compuageindia.com
Web site: www.westerndigital.com
Price: Rs 3,500

Western Digital AV 160 GB WD1600AVBB
Tailored for the AV specialist

The P1i is the latest in
Sony Ericsson’s business

line, succeeding both the
P990i and the M600i—
bringing the functionality
of the former to the form
factor of the latter. Its
dimensions are nearly the
same as those of the M600i,
and its style statement is in
Chinese—the shiny plastic
sides and the chrome
details look downright
tacky. It’s based on the
same Symbian UIQ 3 plat-
form as the P990i and
M600i, with a few minor
changes. The OS is defi-
nitely quicker, which is
probably due to the oodles
of program memory that
the phone comes with—128
MB. Other than that,

there’s nothing remarkably
new here. 

Just like the M600i, this
one doesn’t feature any
soft-keys, and you operate
it using either the stylus or
your fingers on the touch-
screen. There’s also the
three-way jog dial, which,
thankfully, does away with
the annoying protrusion
featured on the previous
phones. The screen itself is
wonderfully vibrant and

quite responsive to the
touch, but is, naturally, a
fingerprint magnet. We
recommend slapping on a
screen guard the second
you open the box—the
screen’s responsiveness
will suffer a tad, but it’ll
be worth it.

The stylus is longer and
easier to write with, and its
locking mechanism seems
much firmer than the
M600i’s flimsy setup. The
QWERTY keypad is the same
as that on the M600i—two
letters to the key. Not too dif-
ferent from the M600i, but
the keys do feel more tactile.

The 3.2MP camera is
respectable, though not
exceptional—indoor photos
are a bit grainy, but overall,
the clarity and colour bal-
ance of the photos satisfies.
There’s a second camera on
the front for video calls,
but you can’t take self-por-
traits with it. Like the
P990i, this model comes
with a business card
scanner. The feature works
just as nicely (or as badly,
depending on the card) as
the one on the P990i. 

The P1i supports 3G (but
no EDGE) and Wi-Fi 802.11b.
Wi-Fi speeds are decent, and
battery life, thankfully,
doesn’t suffer for it.

The P1i isn’t really light
years ahead of the P990i, but
it definitely nudges it off top
spot. There’s no annoying
flip top, the QWERTY
keypad can actually be
worked with, the audio
levels are louder, and the
huge program memory has
you multitasking like you’ve
never multitasked before. 

Specifications
Quad-band GSM; UMTS; Wi-Fi
(802.11b); Symbian v9.1 UIQ
3.0; TFT touchscreen (256 K
colours); 160 MB shared
internal memory; Memory
Stick Micro (M2) support (1 GB
included); 3.2 megapixel
camera; VGA video-call
camera; FM radio

Sony Ericsson P1i
Filling the gaps

Contact: Sony Ericsson Mobile
Communications 
Phone: 39011111/1800-11-1800
E-mail: questions.in@
support.sonyericsson.com
Web site: www.sonyericsson.com
Price: Rs 24,000

Performance  
Features
Value for Money
Overall 
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The T91W is the latest LCD
offering from the BenQ

stables. It can be tilted up to
20° up and 5° down verti-
cally, but it can’t be tilted
horizontally. The three but-
tons on the monitor take
care of all the functions, but
they are placed behind the
monitor—inconvenient.
Furthermore, the buttons
seem tacky, and are unre-
sponsive at times.

This 19-incher is sleek,
and weighs just 4.8 kg. It has
a widescreen aspect ratio of
16:10, and supports a native
resolution of 1440 x 900—
something movie buffs will
love. With a fast response
time of just 5 ms (millisec-
onds) for grey-to-grey, this
one will not disappoint
gamers either; it is just as
good for fast-paced gaming
as your CRT.

The T91W has an excel-
lent contrast ratio of 700:1.
The 300 cd/m2 brightness

spec is more
than enough.
The backlight
is placed
evenly, so there
are no bright /
dark spots along
the border. 

Colours are
vibrant. It should
be mentioned,
though, that the
LCD could not pro-
duce the darkest regions as
pure black, but it did fairly
better than most of
the LCDs we’ve
tested. It has wide
viewing angles of 160° for
text and 150° for movies.
Movies on this monitor are a

treat;
games look

equally good. The black
borders become inconspic-
uous while viewing, adding
to the immersive experience.

VESA wall mounting is
supported. Power consump-
tion is 45 W at full load and
2 W in standby mode,
meaning significant savings
on your electricity bill. BenQ
has put in a pair of speakers,
though you might never

want to use them—the
quality of these is nothing
that really deserves a men-
tion.

The sore point: a DVI
connector is lacking. This
will really be missed by
videophiles who demand
the purest of video sig-
nals. In the final analysis,
we think Rs 13,400 for
the BenQ T91W is a
little too much.

Specifications
Viewable size 19”; Native reso-
lution: 1440 x 900; Aspect
ratio: wide (16:10); Response
time: 5 ms (grey-to-grey);
Contrast Ratio: 700:1; bright-
ness: 300 cd/m2; Interface: D-
Sub; power consumption: 45 W
(max), 2 W (standby);
Dimensions: 381.2 x 449.2 x
185.2 mm (H x W x D); Weight:
4.8 kg; Stereo speakers inbuilt

BenQ T91W
Good but pricey

Contact: BenQ India Pvt Ltd
Phone: 1800-22-0808
E-mail: Sales.EnquiryIn@BenQ
.com
Web site: www.benq.co.in
Price: Rs 13,400
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Overall 
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Wi-Fi streaming devices
are a dime a dozen,

but HAVA has several aces
up its sleeve to differen-
tiate from me-too products.
To begin with, it’s a video
streaming device with a TV-
Tuner inbuilt. Yes—TV pro-
grammes can be streamed
within your home or on
the Internet.  

Setting up the HAVA
unit requires a basic under-
standing of networking.
Configuring the appliance
does take considerable time,
but it wasn’t overly diffi-
cult. DHCP (Dynamic Host
Configuration Protocol) is
well-implemented, and the

settings are comprehensive. 
Local wireless clients

connect automatically once
DHCP is activated in the
embedded WebServer. If you
so want, the device can be
hooked up via a regular
Ethernet connection—
simple and effective. The
setup Wizard is designed
with two options, Basic and
Advanced—thoughtful. Basic
mode doesn’t concern itself
with Security or advanced
networking protocols; one
can use Advanced mode to
configure these.

The unit comes bundled
with and IR-Blaster (the IR
emitter module), which can
be used to control
streaming devices such as a
DVD player, satellite
receiver, etc. attached to the
HAVA unit. The remote con-
trol is software-based; it
drives the IR Blaster. The
software on the client side—

your PC
or laptop
connected to the
HAVA over Wi-Fi or
Ethernet—allows simple
control over the TV-Tuner. It
also allows recording of live
streams onto the client PC.

On the performance
front, the HAVA Wireless
HD can stream 720 x 480
MPEG2 video at a constant
5 to 6 Mbps. We didn’t
encounter jerky video or
lag in the audio stream.
The device can directly
stream to the Internet at
320 x 240 in the MPEG4
format, and it requires 300
Kbps+ bandwidth. Using
the HAVA Mobile Player
(available at the Web site),
the live video stream can be

received
on a cell phone; the

Mobile Player only supports
Pocket PC 5 / 6.

Rs 16,500 is steep for a
device like this one, but it is
unique, and is appealing.

Specifications
Video source (in/out):
Composite, S-Video, Antenna,
and Component Video; net-
working: Ethernet, Wi-Fi
(802.11g); software: HAVA Setup
Wizard, HAVA PC Player

Contact: Monsoon Multimedia Pvt
Ltd
Phone: 011-32909146
E-mail:yogesh_dutta@
adityagroup.com
Web site: www.myhava.com
Price: Rs 16,500

Performance  
Features
Ease of Installation
Value for Money
Overall 

RATINGS

HAVA Wireless HD
The leap to video streaming
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Norton’s latest product—
the 360 All-In-One—is a

complete security solution.
The interface has changed a
bit from the earlier software
by Symantec; it now has a
fancy, sleek, Vista-like
theme. The colourful
controls should suit
beginning computer users.

It looks like Symantec
has covered pretty much
everything on the security
front. You get an anti-virus
and a spyware scanner to
hunt down viruses, worms,
and spyware. There’s a
firewall, and a Transaction
Security feature which is
meant to safeguard the
online transactions you do—
shopping and banking, for
example. It verifies whether
the sites are online scams
or authentic.

The Tune-Up feature is
very basic; its task is to

clear out your Windows
and Temporary Internet
Files and defragment
your disk(s). You can set
the software to
automatically back up
important files like the
stuff in your My
Documents folder and
others. Schedules can be
set for this.

You get 2 GB of online
space that can be used to
back up important data:
once you’ve activated
Norton 360, you register
for the online space.

If Norton 360 finds
anything that could hamper

security, it highlights this
by displaying it in the main
window. For example, if the
firewall is disabled, or if the
software isn’t up to date, it
gives out alerts. The
software even reminded us
that our Windows password
wasn’t strong enough!

360 All-In-One performed
quite a lot better in terms of
resources consumed than
what we expected having

seen previous Symantec
products—like Norton
AntiVirus. When idle, RAM
consumption was a mere 8
MB. With the interface on, it
went up to 17 MB, and it was
75 MB while running the
barrage of scans.

All in all, Norton 360
All-In-One Security as a
complete security solution
does make some sense. The
software’s focus is ease of
use, so it cannot be
compared to full-fledged
anti-virus software or
spyware detectors.
Everything is automated,
so it’s great for those who
don’t want to be bothered
with checking for viruses
and backing up data
frequently.

Norton 360 All-In-One Security
Security simplified

Contact: Ingram Micro India (P) Ltd
E-mail: deenu.m@ingrammicro.
co.in
Web site:in.symantecstore.com
Price: Rs 3,699 (3 licenses per
household; 2 GB online storage)

Listening to music on
mobile phones while

travelling has become one of
people’s favourite pastimes
all across India. The sudden
blossoming of radio stations
everywhere has contributed
to this trend. The creators of
Mundu Radio believe
streaming music from
Internet radio stations could
be the Next Big Thing.
(Geodesic is the company
that makes software for
mobile devices with the
“Mundu” name; we tested
one of their other products—
Mundu IM—a while ago.)

We tried out the Symbian
OS version on a Nokia N70.
The interface is colorful and
elegant. Stations are stored
by genre. There are some
preset stations, and you can
add more manually through
their site, www.radio.mundu.
com. Also, the default
playlist, which contains all
the stations, can be updated
from your account on the
Mundu Radio site. Recently-
played stations can be viewed

quickly from a list that
updates itself when you play
a new station. We must say it
would be nice to able to add
stations directly through the
software interface instead of
having to log in to the
Mundu Radio site to add
stations to your list. 

We used a GPRS
connection to access the
streams on Mundu Radio;
you can use Wi-Fi as well—if
your phone supports it. The
streams we used were 32
Kbps and 24 Kbps, and the
performance was quite
decent—they sounded good
enough for a mobile phone.
There was, however, a lot of
buffering even with the
slightest drop in signal
strength. The other concern,
if at all, is the rates at what

you are billed
for downloads.
For example,
using a 32 Kbps
radio stream for
an hour will
result in around
14 MB of data
transferred. 

There are
lots of Internet-
based radio
stations, and
you have no
shortage of
music to choose
from. Mundu
Radio is
currently a free
beta and
upgrades can be downloaded
from their site. How good
the experience will be will
eventually come down to the
quality of service of your
provider, and also the
schemes suitable for long
periods of radio listening.
Either way, it’s a great
concept that can be
implemented on the current
infrastructure without

hassles, and it’s definitely
worth trying out. Mundu
Radio is currently available
for Palm, Symbian 7 and 8,
and Windows Mobile devices.

Contact: Geodesic Information
Systems Ltd
Phone: 022-28311849, 28306837
E-mail: enquiry@mundu.com
Web site: www.mundu.com
Price : Working beta; currently free

Performance  
Features
Ease of Use
Value for Money
Overall 

RATINGS

Mundu Radio
Internet radio on your mobile: sound cool?
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Overall 

RATINGS
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Sony’s Sound Forge 9 is
the latest version of the

highly-acclaimed sound
editing software. There isn’t
much competition left in
this space, but new releases
and updates still keep
pouring in. 

The interface hasn’t
changed much since the
previous releases. It is still
easy to use for intermediate-
and expert-level users.

To start with, Sound
Forge allows you to import
from a wide range of
formats—including video
formats that contain more
audio streams than stereo.
Let your imagination run
wild with the number of
effects Sound Forge gives
you—flange, chorus, and
reverb are just a few of
them. The overwhelming
number of effects and tools
is what makes Sound Forge
unique.

Setting up parameters
for each of the effects is
easy. Windows pop up for

every effect you apply where
parameters can be changed,
and real-time previews are
played back
instantaneously. 

It’s not all fun and
games either. The Detect
Clipping feature finds
instances of clipping in a
track and marks them so
they can be treated. The
Plug-In Chainer queues up
multiple effects. Several
audio files can be processed
and effects applied one
after another automatically.

Support for scripts is
inbuilt, as well as some
presets for normalising,
cropping and fading, etc.
These can be used to run
automated tasks like
extracting audio CDs and

encoding them, for
example. A script editor is
provided; anyone with some
understanding of
programming can make his
own scripts.

Sound Forge stays well
under the 50 MB limit while
working on more than a
couple of MP3s.

As it stands now, Sony’s
Sound Forge has become a
well-refined and optimised
audio editing software that
performs well and manages
to have as many features as
you’d want. All is well, it
might seem, but the price

tag of $299.96 (Rs 12,150) is
bound to create some
hesitation for prospective
buyers. Professional-level
users already on older
Sound Forge versions will
have no such doubts, all
thanks to support for new
formats and standards—and
the added effects and tools.
Newcomers to the field of
audio editing would be
better off starting with
open source alternatives—
Audacity, for example.

Sony Sound Forge 9.0a
Expert-level audio editing made easy

Web site: sonycreativesoftware.com
Price: $299.96 (Rs 12,150)

Toon Boom Storyboard
Pro should help you do

away with all the paper and
pens that people normally
associate with storyboarding
without a computer.

The interface is
somewhat dull, and the
layout disappoints: tools like
the colour palettes are not
easily accessible enough.
The drawing tools are very
basic; Storyboard Pro is
meant for rough sketching
and basic drawing, and we’d
have liked better brushes.
Some changes to the brush
can be done to improve on
the default set, though.
Sounds can be added to the
shots; voice-overs can be
recorded in the software
and added. You can also add
notes—useful for dialogues.

The Onion skin feature
is especially useful: it
allows artists to use earlier

panels as a reference and
make accurate additions to
the next shots.

A few templates are
provided as well. You can
select from ready-made
characters and items and
add them to a scene by a
simple drag-and-drop move.

The colour selector in
Storyboard Pro is pretty
advanced; it displays a wide
range of colours using
three separate parameters—
Hue, Saturation, and Value,
for the three standard
colours—red, green, and
blue. However, this three-
wheel selection mode

window is
too large to
fit into a
resolution of
1152 x 864. A
minimum
resolution of
1280 x 1024 is required.

Storyboard Pro has
incorporated cameras similar
to those in 3D modelling
applications. The camera can
be panned and moved about.
Transition effects can be set
between shots—this makes
Storyboard Pro a viable
option as an animation tool
(to some extent). Prepared
animations can be exported
as rendered frames in TGA
and JPEG or as QuickTime or
Flash animations.

Toon Boom Storyboard
Pro demonstrates that by
moving the process of
storyboarding to a
computer, it’s possible to
exponentially improve
flexibility—make changes
effortlessly; easily put

detail put into pre-
production plans.

Rs 50,000 for the
commercial version may
seem high, but remember
that professional studios’
3D software and
compositing software run
into lakhs. Still, you can
find similar storyboarding
software at around half the
price. The educational
package for students—
which adds a watermark—is
expensive, at Rs 20,000.

Toon Boom Storyboard Pro
Do your story on the computer

Contact: Rahul Commerce
Phone: 020-26113853 / 54
E-mail: rahulsales@vsnl.com
Web site: www.toonboom.com
Price: 50,000 (Commercial), Rs
20,000 (Educational with
watermark)
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Overall 
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VirtualDub is used to encode videos.
Video encoding isn’t as difficult as
it is often made out to be.

VirtualDub is a very popular software for
the purpose. Encoding your videos brings
down file sizes of your gaming videos,
home videos recorded on your camcorder,
etc. We look at some useful features in
VirtualDub, as well as some finer tweaks.
VirtualDub can be downloaded from, as
expected, www.virtualdub.org.

Opening And Saving Rendered
Image Sequences 

When animations are rendered through
3D modelling software, for example,
they can be rendered as a sequence of
images. They are generally easier to

VIRTUALDUB handle in composition software. Using
formats like TGA, for example, can store
much better quality as well.

It is generally assumed that
VirtualDub only allows importing and
exporting of videos. But actually,
VirtualDub can open up sequences of
images as long as they are named with
the standard convention, for example,
RENDER001.TGA, RENDER002.TGA,
RENDER003.TGA and so on. To open a
sequence, select File > Open video
file. Select the first file of the image
sequence and click Open. The entire
image sequence will be loaded as an
animation. You can now do the same set
of tasks with it like with any video file.

In the same way, a video can be
exported as a sequence of images. When
you have a video opened in VirtualDub,
select File > Save image sequence.
Enter a filename prefix, the location

where you want the sequence to be
saved, and the format you want to save it
in. If you choose JPEG, you are allowed to
set compression levels, though TGA is
preferred for best quality.

Encoding MP3 Audio Streams
Anyone using VirtualDub for the

first time will immediately notice that
audio encoding bit rates for MP3 will
be limited to a maximum of 56 Kbps,
whereas MP3 allows much higher
bitrates. 56 Kbps is really low; to make
sure you are limited to this bitrate,
check by selecting Audio >
Compression after switching to Full
Processing mode from the same
Audio menu. 

Downloading a third-party MP3
codec such as LAME will allow you to
encode at any bitrate up to 320 Kbps. You
can download the LAME ACM codec
from http://rarewares.org. Unzip

the file to a suitable location. Go to that
folder, right-click on the LameACM.inf
file and select Install. Click on Continue
Anyway when prompted. Start
VirtualDub and under the Audio
Compression settings, a LAME MP3 entry
should have appeared. This allows the
complete range of bitrates.

VirtualDub can import and export videos as
sequence of images

Once installed, LAME MP3 Codec gives you a
much wider range of bitrates

Installing the LAME MP3 Codec
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Tweaking VirtualDub’s
Performance

Performance is key when you’re talking
about encoding large files, and this can
take hours depending on the size of the
video and the codecs used. VirtualDub
allows you to make some small changes
that can help boost performance.

Select Options > Performance.
The sliders here can be used to change
the amount of buffer for WAV and AVI
output. Changing the buffer for AVI can
help speed up performance while
working with very large uncompressed
files, although it must be said that
making any drastic changes can cause
major instability.

The other useful feature appears
when the encoding process is on. You
can use the drop-down from the
processing window and change the
processing thread priority. If you
always want encoding to be set as high
priority, select Options >
Preferences. Under Dub defaults in
the General section, set the process
priority to the level you want. Setting it
to Idle will allow you to work on other
programs without VirtualDub taking
up all the CPU. Setting it to Higher or
Even Higher will not allow other
programs to make use of the CPU, but
performance can go up a little.

Combining Multiple AVIs
Home videos are most often

multiple, small clips which we would
like joined together as one contiguous
video. VirtualDub allows you to add and
then encode them as a single file. Just
make sure the videos are AVIs. 

First select File > Open video
file. Choose the first video clip and
click Open. Use the slider and move it to
the absolute end of the video. Now
select File > Append AVI
Segment and choose the file you want to
add to the end of the file. Follow the
same steps for the rest of the clips before
finally entering your encoder settings,
then save the file.

Cutting Up Clips
You might want to know how to

split videos and cut out unnecessary
sections. Open the video that needs to be
cut. Move the slider to the position of the
start of the cut, and press the [Home]
key or select Edit > Set selection
start. Now move the slider to the end of
the cut and click [End] (or select Edit
> Set selection end). This creates a
selection. Pressing [Delete] or selecting
Edit > Delete will cut out the selection.
You can also do other tasks like copying
and pasting of selections in the same
manner using the Edit menu.

If you want to quickly be able to
select certain portions and output them

to files, it can be done by creating
selections using the steps we just
mentioned. Now directly jump to
setting up compression levels and codec
settings, which can be accessed from
the Audio and Video menus. Select
File > Save as AVI. Only the
selection will be exported.

Cropping Videos
Videos, depending on the source

and aspect ratio, have black bands at the
top and bottom. Unnecessary
information such as logos and headers
may be displayed in those areas, or the
section might not be needed at all. You
can crop out those areas using the
Cropping feature. Open your video and
select Video > Filter. Click Add,

choose Null Transform, and click OK.
The Null Transform filter is a filter that
is meant to be used for changes like
cropping, and serves no purpose other
than that. Now click the Cropping
button. Change the values of the Y
offsets to crop the video vertically. (You
can also crop the video horizontally
using the X offsets if needed.)

Fixing Audio Sync Problems
Some videos have audio sync

problems; you have a person saying
something on-screen with his voice
lagging a second or two behind the video.
It can be the other way round as well.

To fix this, you need to compensate
by shifting the audio a little behind or
forward in time. Select Audio >
Interleaving. Under Audio
correction, you can enter a suitable
value in ms. Add a positive value to
have the video lagging and a negative
value for the audio to lag. You will
require some trial and error runs to get
it spot on.

Changing Video Frame Rates
VirtualDub can change frame

rates of video in order to fix audio sync
or just to bring down file sizes. Be well

aware that changing frame rates can
create issues with already well-synced
videos. Video frame rates can be
changed by pressing [Ctrl] + [R] or
selecting Video > Frame Rate. Click
the radio button for Change to (text
entry box) frames per second and enter
a suitable value.

Capturing Video
VirtualDub can be used to dump

video streams using your TV-Tuner card
to your hard disk. This is useful for
recording video clips from your
camera, for example, or TV channels.
To start capturing, select File >
Capture AVI. A different window will
take the place of the usual VirtualDub
interface. You need to first select a

device: select the Device menu and
choose from one of the devices. Then
select a file where the video should be
dumped. Select File > Set capture
file, and set a file and location.

To start the capturing, you can click
on Capture > Capture Video, or use
the shortcuts [F5] or [F6]. To stop
capturing, press [Esc]. Codecs and
compression levels can also be set by
clicking on Video and then on
Compression before starting the capture.
The same can be done with audio. It’s
best to have the uncompressed videos
dumped on your hard disk first and then
compressed at a later time.

Extracting Audio
Some videos have some great

music playing; say you want to be able
to save the music as an audio track. You
can do this, too, in VirtualDub. Open
the video file; click on the Audio menu
and set it to Full Processing mode.
Select File > Save WAV to save the
file. Codec settings can then be set by
selecting Audio > Compression if
needed, or else, save the uncompressed
WAV file and encode to MP3 (for
example) using another program such
as Winamp Pro or Foobar.

The video cropping feature allows you to crop out unnecessary areas on-screen
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Free Download Manager (FDM) has
been gaining popularity for being a
minimal and clean download

manager that has some really useful
features built into it. We look at some of
FDM’s unique features.

Limit The Speed For A Single
Download

Speed limiting is a feature available in
almost all download managers, but what
makes FDM unique is its ability to limit
speeds for one particular download.
When you add a new download by
selecting Downloads > Create new
download, click on the Advanced
button in the window. Click the Limit
traffic checkbox and set the
maximum bandwidth you want the
download to use.

Check File Integrity
People normally use download

managers to download files that
usually would take much longer than
five to 10 minutes. Some huge
downloads like Linux distribution ISOs
come along with a MD5 checksum

value—an alphanumeric value that can
be used to verify whether the download
was completed without corruption. Use
the drop-down and choose the
algorithm used to check the file. Under
Checksum, copy and paste the value
provided by the download site or
developer. Click Check and you will get
a confirmation on whether the
download has any problems.

Remove The Advertisements
FDM has a small advertisement bar

at the right top of the window, and that
might turn some people off. You should
know that it can be disabled by simply
right-clicking on it and clicking Hide.

Better Browsing Speeds While
Downloading

FDM gives you the option to use one of
three bandwidth priority levels—Light,
Medium, and Heavy. You can switch to
any of them by pressing [Ctrl] + [1] /
[2] / [3] respectively. FDM even has an
option that allows it to detect any
browsing activity and reduce its
download rates immediately. To enable
this option, go to Options > Download
options > Network tab. Check the
box called Decrease traffic usage on

browser activity. You can use the radio
button to choose whether you want the
bandwidth usage level to drop by one, or
set it to Light mode.

Adding Comments To
Filenames

Some of us need to add comments for
downloaded files to avoid confusion due
to odd naming conventions. FDM can
rename your downloaded file with the

comment appended to it. To be able to
set this option, you first enter a
comment to a download that’s about to
begin. Select Downloads > Create new
download. Enter, in the Comment text
field, the text you want as the comment.
Then select Advanced >
Miscellaneous and click the box called
Append comment to the file name
when done. Click Apply and then OK.

Scheduling Selected
Downloads

There may be scenarios when you want
certain downloads to begin at a
particular time and the rest to start a bit
later. First create a schedule by clicking
the Scheduler tab in the FDM window.
Click the Scheduler menu and click Add
task. Use the drop-down and click Start
download. From the list of downloads
that have been added, select the
downloads you want to schedule. Click
the “Up Arrow” button to add them to
the schedule. Click on the Start time tab
and select the schedule details. Click OK.

The Site Manager
Many a time, a site will have a

limitation on how many connections
can be made simultaneously to it. Any
more and you can end up banned or
have the downloads stopped or delayed.
The site manager is a list where you can
add rules for your favourite sites. It
allows you to add settings to be used

while downloading, such as the
maximum number of connections and
authentication information. The site
manager can be started by clicking the
Site Manager tab in FDM. Here, right-
click in the main window and click Add
site. Enter the site address and input all
the necessary settings. Click OK.

Quick Queuing Downloads
Pretty much every time you wish

to download a file, you have to confirm
it. The silent mode feature in FDM
allows you start downloads in the
background without popping up any

FREE DOWNLOAD
MANAGER

Downloaded files can be verified using
checksum values 

Download speeds can be reduced to allows
better browsing speeds

The Site Manager is useful in setting
permissions and settings for sites

Comments for a download can be added to the
downloaded file’s name



70 DIGIT SEPTEMBER 2007

Picnik: Log On, Import, Edit, Share!

Digital Tools l Tips & Tricks

Rossi Fernandes

Getting perfect photos all the time is
impossible, as you know, and all of

us depend on a little image editing
every now and then to tweak our pics
to perfection. With all the Web 2.0
buzz, developers are moving applica-
tions away from your Desktop and to
the Internet. They’ve already done it
for office applications and operating
systems; it’s now the turn of image
editing software.

We look at Picnik (www.picnik.com),
an image editor that allows you to edit
your pictures through your browser. Of
course, before you begin, register for
your own (free!) Picnik account.

Acquiring And Exporting Images
Picnik isn’t an image creation tool; it’s
for editing. The first obvious step, there-
fore, is to get photos into Picnik. The
tool offers many options from where
you can import images, and also a wide

variety of formats. It allows for
uploading of images from your local
computer. This can be done by clicking
on Photos and then on Get from
Computer. Click on Get Photo and
then choose the image you want to edit.

There’s support for two of the com-
monly-used photo-hosting sites—
Google’s Picasa Web, and Flickr, which
Yahoo! now owns. Click on the link of
the site you have an account in and
click Connect. Enter the username and
password and sign in.

You also have the option to load
images from random pages by clicking
on Get from Web Site link and then
entering the site address. The WebCam
Photo features allows for capturing of
images from your webcam.

After you’re done with the editing,
click on Save and Share. Here, you can
choose to save images to your Flickr or
Picasa Web Albums by clicking on the
link. Enter information such as the tag,
caption for the image, album, etc. and
click Save Photo. You can also save the

image to your local hard disk, or have it
printed. Use the links called Save to
Computer and Print Photo. Clicking
on Save to Computer gives you the
option to resize the photo, and set the
format and compression levels.

HDR And Other Effects In Picnik
Adobe Photoshop only recently
included the HDR feature, which lets
you create HDR images (HDR—High

Dynamic Range—is a technique that
uses photos taken at multiple exposures
and merges them to give a more vibrant
image). Picnik has a feature that simu-
lates the HDR effect. Click on Create
and then on HDR-ish. Use the sliders for
radius, strength, and fade till you get
the right look for your image. Click
Apply when done.

Similarly, you can use the large list
of effects such as sharpen, soften,
matte, doodle, and many more using
the same Create menu. All the smaller
tweaks you need to do such as
changing levels of colour saturation,
brightness, contrast, etc. can be done
from the Edit menu.

Installing The Firefox Plugin
The ability to quickly access and redi-
rect data is a challenge, and
addressing this are plugins for

browsers. Click on the Help link on the
top and then on Tools. 

Firefox users can click on the link
for the Picnik Firefox Extension v2.0.
Click on the Install Now link on this
page. Scroll down the earlier page and
you’ll find a bookmarklet that can be
locked to your Bookmarks Toolbar.
Drag and drop the link for the Firefox
bookmarklet into the Bookmarks
Toolbar. 

Now when on a particular site,
click the Edit in Picnik button from
the bookmarks bar to open the URL in
Picnik. All the images from that site
will appear in Picnik. You can then
double-click on any of the images to
edit in Picnik.

To use the Picnik Firefox extension
you installed earlier, right-click on any
Web page and click Edit Image in
Picnik. An extension for Internet
Explorer is available in the same page. 

E-mailing Photos To Sites
Picnik doesn’t allow you to export
images to all your photo hosting sites,
so to be able to send images to the vast
majority of the other sites, you can
make use of the E-mail to Web Site fea-
ture. Most sites where you create
accounts allot an e-mail address or
some kind of ID to which you can mail
photos and they’ll automatically be part

of your online collection. Click on Save
& Share. Then click on the drop-down
and select your photo hosting site. Enter
your e-mail address or ID for the site
and then click Send Photo.

So there you have it—a quick intro-
duction to what could quite possibly be
the future of quick and casual photo
editing for everyone. An advantage of
services like Picnik is that they’re Web
based applications, so you can expect
frequent updates. 

rossi_fernandes@thinkdigit.com

Photos can be easily imported from a
number of locations

There’s no need for image editing software any more—and no more the hassles of
Desktop-to-Internet. It’s all seamless

Picnik has a huge number of effects—among
them, HDR

Plugins for Firefox give quick access to
Picnik

Export your images to sites via e-mail
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windows. To enable Silent mode, go to
Options > Download Options >
Monitoring. Check the box for Silent
monitoring. Click OK. Now every time
you click on a downloadable file, FDM
will automatically queue and start
downloading them without asking you.
If you want to avoid getting any

unwanted files downloading by
mistake, go back to the same window
where you enabled Silent Monitoring.
Check the  ALT must be pressed
box. Click  OK. Now downloads will only
be added if you have the [Alt] key
held down while clicking. 

Adding FDM Support For
Firefox

If FDM hasn’t integrated itself with
Firefox, you’ll have to manually add
downloads. To enable integration for
Firefox and any other browsers like
Netscape, Opera, etc., select Options >
Download Options. Click on
Monitoring. Check the box for Firefox
and any other browsers that you may
have installed. Click  OK. A plugin will
be installed into Firefox. You can now
right-click on a link in Firefox and click
Download with FDM to download it.
You can also download all the links in a
page using the same menu. 

The silent monitoring feature enables adding
of downloads without confirmation

KB/s. This value needs to be changed to a
suitable value for your connection; for
example, a 256 Kbps connection would
be 32 KB/s. To change the value, go to
Tools > Options > Graph/Log.
Under Scale, change the value to
appropriately and click OK.

Connection Settings For
Manual Speed Limits 

FlashGet has a manual speed mode that
allows you to limit the connection
speed, which will help if you’re also
browsing, for example. With the latest
few releases and updates of FlashGet, the
speed limiting icon from the Desktop
may not be visible in the toolbar. You
can add it by right-clicking on the
toolbar and clicking Buttons. Choose
Speed from the Available toolbar buttons
list and click Add and then Close. The
button will appear on the toolbar. 

To set the speed, go to Tools >
Options > Connection. From the
Connection Type/Speed drop-down,
choose the type of connection you have.

FLASHGET

Afew years ago, download managers
were either ad-based or
commercial software. FlashGet,

Download Accelerator Pro, and GetRight
were some that were used a lot despite
them being shareware or adware.
FlashGet, now, is totally free and ad-less.
Support for some P2P protocols has been
added as well in the latest release, which
means FlashGet can become your
universal downloading tool. We go
through the latest version, FlashGet
1.9.2, looking at some of its key features.

Download Without
Confirmation

Confirming every single download you add
can be irritating. FlashGet has a
workaround for this, which can be enabled
with a couple of clicks. Select Tools >
Options. Click Monitor in the left pane.
Uncheck the boxes Add Job With Confirm
for both the browser and the clipboard.
FlashGet will now not pop up confirmation
windows for adding downloads.

Adding Additional eMule Servers
FlashGet has added support for

eDonkey servers and BitTorrent. A default
set of eDonkey servers will already have
been added when you install FlashGet. To
add any favourite servers, go to Tools >
Options > eMule. Click the Server
List button. Enter a server name, its
address, and the port provided by the site.
Click Add and then OK.

Setting Up The Right Graph Scale 
FlashGet’s dropzone doubles up as a

graph that shows the current download
speed. The scale by default is set to 100

Set up the FlashGet graph to suit your
connection speed

If it’s not on the list, choose Other, and
enter the speed in bytes per second.
Click OK. When you have downloads on,
click the Speed button in the toolbar
and select Manual to set a limit. A slider
will appear in the status bar below. Move
it to set the appropriate speed to limit
downloads to. To make it unlimited
again, click the same button from the
toolbar and click Unlimited.

Disabling P2P 
Most of us might prefer using our

favourite BitTorrent and eDonkey clients,
like uTorrent and eMule, for example. You
can stop FlashGet from being the default
torrent client, and even disable the eMule
component from FlashGet. Select Tools
> Options. Click BT and uncheck the box
Make FlashGet as default BitTorrent client.
To disable eMule, click General and
uncheck the box Enable eMule. Click OK.
A restart of FlashGet might be required
for the settings to take effect.

Creating A Torrent
FlashGet acts as a full-fledged

torrent client, allowing you to create
torrent files and upload them to trackers.
Select Tools > Make Torrent File.
First add the file or directory you want to
share by clicking the Browse button after
choosing one of the two radio buttons
called Single File and Directory. Choose a

network type from the drop-down menu.
Enter the address of the tracker in the
text field. Entering multiple tracker
addresses with allow you to have the
torrent hosted on multiple trackers. Then,
click Browse under Output to have the
torrent file output to a different location
(where the torrent file will be dumped for
your friends). Click Make and then OK.

Now that the torrent is created, you
need to open the torrent file so you can
upload data to other users. Select File >
Open torrent file. Select the torrent
file and click OK. Choose to save the file
or folder to the same location from where
you created the torrent file. Click OK.

Limiting speed leaves bandwidth for other
applications to use

FlashGet can create and then seed torrents
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Opera and Firefox are nibbling away
at IE’s share of the browser
market, as you very well know…

Firefox has hundreds of downloadable
add--ons if you need more features,
whereas Opera comes preinstalled with
many of them. Some of the features can
be tweaked to become more useful, so
we’ll look at ways to customise the just-
released Opera 9.3 using just its INI files.

Setting Up Fast Forward To
Work Better

Opera has a feature called Fast Forward,
which allows you to browse to the next
page in sequence (for example, a
sequence of pages in a Google search)
without having to click the link. It works
by using certain keywords or code in
pages. Although it is a useful feature, it
doesn’t always seem to work as well as
you want it to. You can add more or
make changes to existing keywords to
make this feature a little more useful.

The .ini file that contains the
keywords is fastforward.ini, and is located
in Opera’s installed folder—usually
C:\Program Files\Opera. (We’ll assume
you’ve installed Opera on your C drive.)
Open it in Notepad. Add suitable
keywords to the list, for example, To Page.

Opera Customisation From A
Single Page

Like in almost all browsers, the “about:”
scheme is used to display features and
other information about the browser in
Opera. The about:config link,
specifically, allows you to change a lot
more settings than you normally get
access to through the Preferences
window. Click on the address bar and
enter about:config and press Enter. Here
you can expand each of the features and
make changes to the settings. Most of

the tips that we’ll be talking of won’t be
there on this list. 

Fight Ads Using Opera’s Filter
Ads are everywhere on almost any

site you visit. Firefox may have Adblock
Plus, but Opera has its own ad blocking
system in place. The file urlfilter.ini in
C:\Documents and
Settings\Your_Username\Applicat
ion Data\Opera\Opera\profile
contains a list of sites to be blocked.
Add site addresses and wildcards such
as “*” (the Star) to block sites. There are
several such lists available on the
Internet ready for download. One such
good list can be found at
www.fanboy.co.nz/adblock/. Just
download the Opera list and copy the
file to the given location or its contents
to the file that already exists.

Modifying Tab Width Range
Tabbed browsing is a boon, but

the use of too many tabs in Opera
causes the names to be cropped off.
This makes reading the tab headings
close to impossible. You can set a limit
to how small and how wide a tab can
be allowed to be. Extract the skin.ini
from the skin.zip from c:\Program
Files\Opera\skin. Open skin.ini in
Notepad and modify these lines
Pagebar max button width = ____
Pagebar min button width = ____
to suitable values. If the lines aren’t
present, create them and then save the
file. Add the edited file back to the
skin’s ZIP file. Restart Opera and select
the skin from Tools > Appearance.

Adding Program Shortcuts To
Opera’s Menu

Opera’s menu can be used not just for
browsing-related functions, it also

allows you to start up Windows
applications! First create a copy of your
standard_menu.ini. Select Tools >
Preferences. Click on Toolbars in the
left pane. Click the lone Menu Setup,
then click Duplicate. Now, you need to
open the newly created duplicate
standard_menu.ini in Notepad located
at C:\Documents and
Settings\Your_Username\Application

Data\Opera\Opera\ profile\menu.
To create an entry, scroll down till you
reach the [Document Popup Menu]
section. Create entries using the
following format. Here, we’ve created
an entry for starting Notepad.  
Item, “Start Notepad” = “Execute
Program, “Notepad.exe”” 
Save the file and restart Opera.

Adding Shortcuts To Execute
Programs

Keyboard shortcuts can be used in
Opera to quickly start programs to go to
a particular site. The trick is to add
shortcuts to the shortcut.ini file located
at C:\Documents and
Settings\Your_Username\
Application Data\Opera\Opera\
profile\keyboard. Open it in
Notepad. Creating shortcuts is done in
manner similar to this: 

G,G=“Execute program,
“c:\WINDOWS\Notepad.exe”

Here, typing [G] [G] will start
Notepad. In a similar manner, the path
of the program can be replaced with a
site URL, for example, =“Execute
program, “www.thinkdigit.com”.
Opera will load the site when you use
the shortcuts.

Opening A Page In A Different
Browser

If you’re visiting a page and want it to
be opened in a different browser, which
is sometimes needed because Opera

can’t render it properly, you can create
a new entry in the menu when you
right-click. Browse to C:\Documents
and Settings\Your_Username\
Application Data\Opera\Opera\
profile\menu. Open the
standard_menu.ini file in Notepad.
Create an entry in the [Link Popup
Menu] in the following format:
Item, “Open link in Firefox” =
Execute program, “firefox”,”%l”

You can use a similar format for
Internet Explorer. Save the file and
restart Opera. 

HACKING OPERA’S INI FILES

Most of Opera’s fatures can be customized
using about:config

Programs can be launched directly through
the browser

Sites can be viewed on different browsers 
if needed
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Speed Up Your Web Site
Lower loading times for your visitors!

Rossi Fernandes

Broadband may have arrived in India,
but it hasn’t gone mainstream: the

large majority of people are still on dial-
up. As for the broadband we have, it isn’t
exactly blazing fast… but bandwidth is
getting cheaper, and so are Web hosting
solutions. Here are some of the simpler
things you can do while creating and
maintaining your site to make it just
that little bit faster.

Keep Images In Check
Images are, obviously, the biggest
culprits when it comes to slowing
down a site. In these times of Web 2.0,
you find sites littered with images.
Every single image means a separate
request sent to the server. Use image
maps: they bring down the number of
requests. Image maps are basically
single images with small sections
within it, which can be used to link to
other pages or images.

Image compression also plays a role
in slowing down pages and sites. GIFs
load faster than JPEGs, but don’t match
their quality. So use GIFs in less
important places like banners and icons,
and JPEGs for higher-quality content.

Compressed Pages
Most often, large pages are filled with
redundant text and HTML code. You
can have your site compress data
before sending it to the client.

The compression module for the
Apache Web server—mod_gzip
(http://sourceforge.net/projects
/mod-gzip/) is one of the most well
known. Many Web servers today come
with inbuilt support for compression,
and the ones that don’t use third-party
modules like in Apache’s case to
implement the feature. Such
compression techniques not only speed
up your site, they also might bring
down bandwidth bills by sending
smaller amounts of data.

Avoid Unresolved Domain Names
A large number of images and other
components in your page linked to
different sites by their domain names
can delay page loading. Every domain
name has to be resolved by the client’s
DNS server… Wherever possible, link
using the IP addresses of the servers.

Select The Nearest Host
Location and routing to your Web hosts
plays a fair role in the matter. If your site
audience is in India, hosting a site
overseas would mean that every
transaction will have some delay because
of the number of nodes of equipment it
has to go through. On an average, the
delay between a client and a server in
India depending on the locations could
be anything between 10 and 70 ms. A site
in the US, for example, could have a
delay as much as 250 to 300 ms or
higher. Clearly, local servers are a better
option. Routes are paths set by the ISP
for data to pass through, and it’s a good
idea to check the delays before choosing
a Web host.

Site Inspection Tools
There are some software and sites
that point out mistakes or poorly-

written code. One such is a plugin for
Firefox called Firebug, which can be
downloaded from www.getfirebug.com.
It allows you view the code of a page
and make changes to it. The changes
are reflected in real-time for you to
see. It also gives statistics of all the
images and scripts downloaded from a
particular site and the time taken. 

Opera has a similar add-on that
can be downloaded from the Opera
site. Select Tools > Advanced and
then go to the Developer console, or
you can directly go to
http://dev.opera.com/tools. Scroll down
to the Opera Developer Console tool
and drag the tool icon from the page
to a toolbar in Opera. When on any
site, you can click that button, and a
little window will load—which, like
Firebug, will allow the making of
changes to the page, and will also

allow viewing statistics and other
information on it.

There’s an add-on for Firebug; it’s
Yahoo!’s YSlow, downloadable from
http://developer.yahoo.com/yslow. Click
on the YSlow icon at the right bottom
of the Firefox window, and it gives
you a list of flaws if any, and tweaks
that can help fix the page. YSlow also
gives an overall grade to the page! 

Clean Up Your Code
WYSIWYG HTML editors are notorious
for leaving blank, unnecessary tags;
many of them end up creating un-
optimised, larger files. Use the
cleanup feature in your WYSIWYG
editor to optimise your code, and even
manually go through the code for
empty tags and comments before
uploading it to your site. 

rossi_fernandes@thinkdigit.com

Firebug—a Firefox plugin—shows statistics and
allows real-time modifying of code

Opera’s Developer Console is the alternative to
Firebug on Opera

Yahoo’s YSlow grades code and gives sugges-
tions to improve it
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Fast Cars
Typically, most cars in GTA:SA are

painfully slow; faster cars are rare to
come by. The cheat EVERYONEISRICH
gives all the people on the streets faster
cars to drive.

Exploding Cars
The cheat code ALLCARSGOBOOM

explodes all the vehicles in your region.
Enter it to witness an interesting
fireworks display!

Adrenaline Mode
One of the best cheats for GTA: SA

has got to be the so-called Adrenaline
mode. The cheat gives you the power of
a superhuman. In-game, type in
MUNASEF. You also get something on
the lines of bullet time from the Matrix
with time slowing down for everyone
but you. Another cheat that goes along
well this is the single punch cheat. Type
in IAVENJQ. Here on, you will be able to
knock out people with a single punch.

GRAND THEFT AUTO: SAN ANDREAS

Rockstar has built a reputation of
making some of the most
controversial games ever but

which are, quite frankly, highly
entertaining. The last instalment of the
Grand Theft Auto series—San Andreas—was
no different in this regard. A great
game it was, but today, we look at some
things you might not have noticed.
Now there are many cheat codes, but
here are some of the funniest ones that
should give anyone a hearty laugh—or
at least a giggle. There are also a couple
of tweaks and mods to try out.

Your Personal Radio Station
In GTA!

GTA has a large collection of radio
stations of all sorts of genres, but you
can also create your own if things get
boring. Simply dump your music to your
My Documents\GTA San Andreas
User Files\User Tracks folder. Start
GTA: SA and go to Options > Audio
Setup > User Track Options. Here,
put on Automatic media scan. You can
have your music folder scanned as well
and change the mode of playback from
sequential to random.

GTA Multiplayer?
GTA has never had multiplayer,

but some developers have created
multiplayer modes which a whole load
of people play. Probably the only one
and the most played is SA: MP (San
Andreas: Multiplayer). Download it from
www.sa-mp.com. Install it to your game
folder. Run the newly-installed
program, and you can connect to a
huge list of servers. You can also
download a server program from the
same site and have friends connect to it
through a network or the Internet. 

Altering Car Handling
All the cars in GTA: San Andreas can

be modified to behave in a different
manner. The file that contains all the
parameters for all the vehicles is
handling.cfg in the {your game
folder}\data folder. Open the file in
Notepad. The mass, transmission, and
brakes settings are just some of the
parameters that can be modified.

Flying Cars!
You can have cars flying around like

planes in GTA: SA. While playing, type in
RIPAZHA. After the message saying Cheats
activated appears at the top left of the
screen, jump into any car and accelerate
down a road and your car will
automatically take off like a plane! Be
sure to have the throttle pressed—
otherwise your car will drop from the sky.

Find a clear strip of road and take off with
your four-wheeler!

You can have people flying off for
metres together with a single punch.

Spawning Vehicles
Quite a few vehicles can be got in

GTA: SA—everything from monster
trucks to helicopters and tanks. Here
are a few selected ones.
Tank: To have a tank spawn in front of
you, enter in AIWPRTON. Use the
mouse now to move the cannon around
and the usual movement keys for
driving the tank all over the place. It
can be used to run over pretty much
everything.
Helicopter: There’s an attack
helicopter complete with rockets, and
you can play with it. Type in OHDUDE
and you’ll have it in front of you. The
controls are pretty straightforward,
and it’s fun to fly it around! Use the
[W] and [S] keys to throttle up and
down. Use [A] and [D]—or the arrow
keys—to tilt from side to side. The Up
and Down arrow keys tilt the chopper
forward and backward.

Jetpack: Yet another nice little vehicle.
Type in YECGAA to get the jetpack
spawned in front of you. Use the
spacebar to throttle up and rise. The
other movement keys are used as usual.

Crazy People!
You can have the crowds of people

go completely berserk! The main cheat
here is CRAZYTOWN, where all the
people turn into clowns of sorts,
wearing costumes. IOJUFZN turns on
riot mode, and you find yourself
between a war zone filled with masses
of people fighting amongst themselves.
To make the scenario even more
hostile, type in FOOOXFT. This will get
everybody armed.

Serious Note: Cheats and unlocks are
meant for fun and laughs. The square
thing is to finish this great game
without any cheats or unlocks. We
don’t use them here at Digit! Use tanks to wreak havoc on the streets...

Or attack from the air using a chopper armed
with rockets!
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When U’re Hit…
While I was installing a game, a program
named WhenUSave got installed on my

computer. Now when I start my computer, it
appears immediately on screen and starts
connecting, and asks me to have patience as if it is
trying to install something. The computer gets
very slow. If I switch over to another user it hangs.

Satish Chandra

WhenUSave is adware
that installs with many

free software, but it usually
gives you the choice to install
it or not. It can be easily
removed using a spyware
removal software such as
Spybot—Search & Destroy
(version 1.4.0) from www.safer-
networking.org. Spybot is free-
ware, and you’ll find it on
this month’s CD.

It’s The Drivers Again
I have two 250 GB Seagate
hard drives and I want to

set them up in a RAID configu-
ration. When I try to install XP
on them, they aren’t detected
during the installation. What
could be the problem?

Aneesh Jagtiani

We’re assuming you’ve
already set up your

computer in a RAID configuration. XP setup
needs to be provided the RAID drivers to be
able to detect the hard drives in this configura-
tion. When you run the XP installation, press
[F6] at the start at the point you see Press F6
if you need to install a third-party SCSI or RAID
driver (at the bottom of the screen). Keep ready
a clean floppy with the drivers copied in the
root. You can find these drivers at the manu-
facturer’s Web site. Select from the list of
devices enumerated in the next screen (usually
the first). Press [Enter] and continue. Your
drive will be detected, and you can proceed
with the XP installation.

Power Play
I have an external USB 2.0 hard drive that
works very well on my Desktop PC. But when I

connect it to my laptop, it does not work.
Binu Mathias

Windows XP can still find it tricky to deal
with USB devices that aren’t keyboards,

mice, or printers. The external USB drive may
not be receiving enough power to initialise, so
try the following. Open the Device Manager by
running devmgmt.msc. Open the Universal
Serial Bus controllers tree and double-click on
all the USB Root Hub entries. There should be
two or more such entries. Click on the Power
Management tab for each one and remove any
check-mark in the box that has Allow the
computer to turn off this device to save power
next to it. Then disconnect the drive, restart
Windows, and connect the drive. If doing that
doesn’t work, the drive may have come with a
USB-to-5V cable, which you should use; it
provides extra power. If it’s not come with the
drive, you can purchase one for Rs 100.

Doing Me A Disservice!
I recently installed a program after which
Windows XP refuses to boot. I have searched

on the Internet and found that this particular
program installs a service at startup and causes
the problem. But I have not been able to find a
solution. I know the name of the service but am not
able to disable it, because I cannot boot at all. I use
Windows 2000 Server.

Atul Shrivastav

To disable the offending service, start
your computer with the Windows boot

disks, or with the Windows installation CD-
ROM if your computer supports booting from
the CD drive. When the Welcome to Setup
dialog box is displayed, press [R] to repair
when prompted to do so. Then press [C] to
start the Recovery Console. Choose to install
Windows and log on to your computer using
your Administrator account. From the
%SystemRoot%\System32 folder at the
command prompt, type listsvc and press
[Enter]. Since you know the name of the
offending service, locate the service or driver
that is causing the problem in the provided
list. Note that selecting the wrong service or
device could cause further problems. Type
disable servicename where servicename
is the name of the service, and press [Enter].
Note that the disable command displays the
old start_type of the service before resetting
it to SERVICE_DISABLED. You should note
down the old start_type, just in case you
need to re-enable the service. Type exit, and
the computer will restart automatically. You
should now be able to boot normally.

Let There Be Light!
When I Open the User Accounts in the Control
Panel in XP Professional, I do not see the

Administrator account in the list. I need to change
the password for the Administrator account.

Ritesh Chakraborty
The Administrator account is normally visi-
ble in the Normal mode booting of

Windows XP only if there is no other user
account, but is always visible in Safe Mode. To
work around your problem in Normal mode,
follow the following steps.

Your Questions, Our Answers

E-mail us your computing
problems along with your
contact details and
complete system 
configuration to
ssooss@@jjaassuubbhhaaii..ccoomm, 
and we might answer
them here! Since we get
many more mails per day
than we can handle, it
may take some time for
your query to be
answered. Rest assured,
we are listening!

Get Help Now!

Questionable
licenses and truant
uninstallers—all
dealt with right
here!

Illustrations Harsho Mohan Chattoraj
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Start the Microsoft Management Console
(Start > Run > mmc), and start the Local Users
and Groups snap-in. To do this, go to File >
Add/Remove Snap-in,  click on Add in the
Standalone tab, select Local Users and Groups,
and go through Add > Finish > Close > OK.
Under Console Root, expand Local Users
and Groups, and then click Users. In the right
pane, right-click Administrator, and click Set
Password. Click Proceed in the message box that
appears. Type and confirm the new password in
the appropriate boxes. Click OK.

No SP2, No Problem
I am a programmer. I’ve found that my
Windows XP Pro computer takes considerably

longer to compile programs and access files from
the network than it took when I was using Windows
NT on the same hardware.

Samir Ahmed

This is a documented problem; installing
Service Pack 2 will fix it. If you are unable

to install Service Pack 2 for some reason, here is
a workaround.

1. Map a network drive to the SMB server. Follow
these steps to do this: 

Start Windows Explorer. On the Tools
menu, click Map Network Drive. In the Drive
list, click a drive letter. Then in the Folder list,
type the UNC path of the shared resource on
the server. Use the following format:

\\ServerName\SharedItem
Alternatively, click Browse, and then locate

the shared resource. Click Finish.

2. Disable NetBT on a network interface. Do the
following:

Run ncpa.cpl. Right-click the network
connection you want to configure, and click
Properties. If the connection is a local area
connection, click the General tab, click
Internet Protocol (TCP/IP) in the This
connection uses the following items box, and
click Properties. If the connection is not a
local area connection, click the Networking tab.
Click Advanced, and then the WINS tab. In the
NetBIOS settings area, click Disable NetBIOS
over TCP/IP. Click OK thrice.

3. Add the ScavengerTimeLimit value to the
Registry:

In the Registry Editor, locate the key called 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentCo

ntrolSet\Services\MRxSmb\Parameters
Right-click on Parameters, go to New, and

click DWORD value. Name it
ScavengerTimeLimit. Double-click

You’ve Lost Mail…?
I upgraded to Windows XP from 98. My Outlook Express
mails and address book are missing.

Aatish Thadani

This happens only when you install XP in a location
that is different from that of the previous version of

Windows. Nevertheless, your e-mails and address book can
be retrieved.

First, find your previous mail messages. On your Desktop,
create a new folder called OldMail. If you use Identities,
create a new folder for each identity. Start a search for all
files and folders, and under the All or part of the file name
option, type *.dbx. Under More advanced options, choose
Search hidden files and folders.

Note that if you had previously used identities, each
user will have his own Identity folder. Each of these will
have a unique alphanumeric number (for example,
{9EFEBDEA-CE00-4DD7-A4D6-CDB85C3EEDBF}) followed
by “\Microsoft\Outlook Express”.

Copy the old mail folders to the OldMail folder. Make
sure to include the Folders.dbx file when you copy the
folders. This file is necessary for the import function in
Outlook Express. Perform this procedure for each Identity
folder, but make sure to create a separate folder for each
identity folder you find.

Then, Import your mail and folders. Open Outlook
Express. Select File > Import. Click Messages. Click

Microsoft Outlook Express 5, and then Next. In
some instances you may only see the options to
import from Outlook Express 4 and Outlook
Express 6. If your previous version of Outlook
Express was version 4, use the option for Outlook Express 4.
If you are importing from Outlook Express 5 or 5.5, you can
use the Outlook Express 6 option. Click Import mail from
an OE6 store directory, and click OK. Click Browse,
select the OldMail folder, click OK, and then Next. Click All
folders, and then Next. This procedure imports your previous
mail into the current Identity. After this is done, click Finish.
Repeat this procedure for each of the folders you created
earlier.

Now find Your Windows Address Book. Start a search for
all files and folders. In the What do you want to search for
box, click All files and folders. Under All or part of the file
name, type, *.wab, and click Search. When the search is
done, double-click each file to open it. When you find the
correct one (it will contain your Contacts), note the location
and name of the file.

Now import your Windows Address Book: in OE, select
File > Import, and then click Address Book. Point the
Look In field to the location you noted. Click the .wab
file and then Open. Click OK, and the Address Book will be
imported.

After you have verified that the import was successful,
remove all the folders you created during the mail 
recovery process.

Question 

of the

Month

The Microsoft Management Console for when you need
to set the Admin password
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Back Up And Restore With Nero BackItUp

Jayesh Limaye

Most optical writers come accompa-
nied by Nero Burning ROM, a

bundle of useful applications including
Nero Vision 4 and Nero Mobile. One of
these bundled applications is BackItUp2.
We take a look at how useful it is.

Getting Ready
After launching the application,
click on the File Backup icon.

You’ll see a file-explorer-like interface on
the right. Here, you can mark the files
and folders that are to be backed up. You
can also add files and folders to the
backup by dragging and dropping them
into the window. Click on Start File
Backup to proceed to the backup screen.

You can use File Filters to choose
the types of files you want to include /
exclude from the backup. You can also
add custom file filters, which you
create in the File Filters section of the
Backup tab in Options.

If you wish to back up an entire
drive, click on the Drive Backup icon.
You will see the installed hard drive(s)
with the partitions. Select the
required partition and click Start
Drive Backup to proceed to the
backup screen.

Setting Up The Backup
You now need to specify the
backup destination. This can

be selected from the drop-down list and
can be another drive, an optical drive,
or an FTP server. For the latter, you can
add the address of the FTP server to
which you wish to backup / restore data
in the FTP tab under Options. If the
backup destination is an optical drive
(as in our example), insert the appropri-
ate medium in the recorder drive.
Depending on the amount of data
you’re intending to back up, you can
opt to use a CD or DVD (of any type).

From the drop-down, select the
type of backup you intend to make. The
options available are:

Full backup (the only option if this
is a first backup)
Update backup (if a hard drive is the
destination, all previously backed-up
files will be replaced, but if it is an
optical drive, only files that have
been added or modified after the
most recent backup will be replaced)
Differential backup (a cumulative
backup of all the files that have been
modified since the last full backup)
Incremental backup (which will
back up all the files that were added
or modified files after the most
recent full or incremental backup).
Specify a name for the backup in the

Backup name field, and add comments
(if necessary), clicking OK to save them.

Under More, you can choose
whether to compress and/or encrypt
files before the backup. These options
are a good idea as they save on disk
space and secure sensitive data respec-
tively. Click on the Compression
Settings button to set the level of
compression from the provided presets.
Click on Set Password to set the pass-
word for the encrypted backup. Click
Next to proceed.

Reviewing Your Settings
And Backing Up
You can now review the

backup options you have opted for—a
green icon in front of a setting indi-
cates a selected option; red indicates
the option was deselected.

Click More. Check Verify data
after backup to be doubly sure that

your data has been safely backed up.
Select the writing speed and click
Backup to begin the backup process.

If Bad Things Happen
If things go awry and you need
to restore a backup, click on the

Restore icon. You will be able to view the
available backups on the right. Choose
one of them and set the file filter at the
bottom if necessary. You can even choose
to restore individual files in the File
View applet. Click Start Restore. You
can then opt to restore to the original or
to a different path. Click Next and then
Restore to start the restore process.

Under Tools, you’ll see an option
called Create Bootable Disc. If
you use this, a bootable disc with a
stripped-down version of Nero BackItUp
will be created, which lets you back up
and restore a drive when your computer
cannot start via your hard drive.

More Options!
Under Options is E-mail
notification, which sends

you e-mails when events take place.

In the Expert Features tab, check the
box next to Use the CRC checksum
when comparing files to make sure
that the backup is 100% perfect. 

Check the box next to Enable
scripting if you want to specify any
scripts to be run before or after the
backup process.

Enable intelligent
compression will let you specify
types of files that need not be
compressed; this saves time.

Check Use shadow copy for file
backup to first prepare a copy of
the backup before sending it to the
destination (target), rather than
doing it on the fly.

BackItUp also allows you to schedule
backups, and this is typically useful
for a system administrator.
You’ve had this utility for ages, but

just didn’t care to take a look at how
useful it really is. Backing up your data
cannot get any simpler! 

jayesh_limaye@thinkdigit.com

You probably have it on your computer… and it serves all your backup needs:
it’s Nero BackItUp

Choose what you want backed up

You can choose to back up an entire drive
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ScavengerTimeLimit, and In the Value
data box, type 60. Click OK and close the
Registry Editor.

A Sound Solution
I have a Creative SoundBlaster Live!
installed on my Windows XP computer.

Every time I try to shut down the computer, I get
an error message that says, “DEVLDR not
responding.” When I click End Now, the computer
stops responding.

Sarabjeet Singh

This is most likely a corrupt driver. Go to
Control Panel > System > Hardware

tab > Device Manager. Expand Sound,
Video and Game Controllers. Right-click on
Creative Labs SoundBlaster, and select Uninstall.
When you are prompted to confirm the dele-
tion, click Yes. Then download and install the
updated driver from the SoundBlaster Web site:
www.soundblaster.com/support/winxp

Out, Junk!
I frequently get
the low disk space

notification on my C
drive and so tried to run
the Disk Cleanup utility,
but it stops responding
while searching for
compressed files.

Veronica Gonzales

This problem can be
caused by a corrupt

temporary directory.
You need to clear this
directory to get rid of
the problem: close all
applications. Run
%temp% to open the
Temp folder. Delete all
the files there. Close
Windows Explorer.
Open the Control
Panel and double-click the Internet Options
applet. Select the General tab, and click Delete
Files. Check Delete All Offline Content.
Click OK.

Who’s The Boss?
In Windows XP, I accidentally marked a parti-
tion on my hard drive as active, and am not

able to boot ever since. I get this error message:
NTLDR is missing
Press Ctrl+Alt+Del to restart

Please help.
Rajesh Pai

The partition you’ve marked as active does
not contain the Windows boot files. Try

changing the active partition by booting via a
floppy disk and then using disk utilities to
manually change the active partition: boot to a
command prompt using a Microsoft Windows
9x / ME boot floppy disk. At the prompt, type
fdisk and press [Enter]. When you are
prompted to enable large disk support, click

Yes. Click Set active partition, press the number
of the partition that you want to make active,
and then press [Enter]. Press [Esc].
Remove the boot floppy disk and restart the
computer. If you don’t have a floppy drive, use
Parted Magic from our August DVD—it gives you
a graphical interface to do the same thing.

Telling The Tale
I’ve often wondered that if Windows creates
dump files when it crashes, shouldn’t there be

a way to read and interpret them?
Amit Chanana

Memory dump file creation is a very useful
diagnostic tool found in all Windows

systems based on NT. A memory dump is an
output file generated by the operating system
during a crash and is very useful in determin-
ing the cause of the crash. This file is saved as a
file with the DMP extension in the system32
directory. The option (if it is currently disabled)
to create a dump file can be set up by opening
Control Panel > System > Advanced tab
> Settings button under Startup and
Recovery. The dump file can be analysed using a
tool from Microsoft known as dumpchk.exe,
available for download from www.microsoft.com/
whdc/devtools/debugging/default.mspx. There are
different versions of this tool available for
different versions of Windows; choose yours.
Detailed information about using
dumpchk.exe can be found at http://support.
microsoft.com/?kbid=156280. To actually interpret
the dump, though, you need to know Windows’
ins and outs.

Reinstalling The Installer!
When I try to uninstall certain programs, I get
the following error:

Error 1719. The Windows Installer Service could
not be accessed. You may be running in safe mode or
Windows Installer may not be correctly installed.

Manish Sen

Your Windows Installer seems to be
corrupt and reinstalling it should solve

your problem. At a command prompt, type in
the following line and then press [Enter]
(“Drive” is the drive where Windows is
installed; “%Windir%” is the folder where
Windows is installed):
attrib -r -s -h drive:\
%Windir%\system32\dllcache

For example, you might type in
attrib -r -s -h c:\windows\
system32\dllcache

Then at the prompt, type in the following
lines, pressing [Enter] after each line:
ren msi.dll msi.old
ren msiexec.exe msiexec.old
ren msihnd.dll msihnd.old 

Exit the DOS prompt and restart your
computer. Update the Windows Installer files
on your hard disk to the latest version. Get it
from the Microsoft Download Center at
http://support.microsoft.com/kb/893803/. Shut
down your computer, and then restart it in
standard mode.
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New Ways To Play Old Games

and was un-priced when we checked—it’ll be out
by the time you read this. 

Logitech’s G11 (a G15 minus the LCD) is
another “to be out soon” product, and wasn’t
available for pricing during my visit to The Road.

Logitech’s G5 (Rs 2,900) is a 2000 dpi (500 Hz
polling frequency) laser mouse—ultra accurate,
and quite comfortable; it has weights provided
to lighten or weigh up the mouse according to
what you’re used to. Its infrared counterpart,
the MX518, is available for as little as Rs 1,500
now—a killer mouse with extra buttons and a
1600 dpi sensor. There’s also the cordless G7 for
Rs 4,200. It has hardware identical to that of the
G5, only it’s wireless.

Zebronics has a gaming keyboard and mouse
combo, but aside from the flashy colours and the
CounterStrike theme, this looked like a regular key-
board. The combo costs Rs 1,200; the optical
mouse bundled is IR-based (800 dpi).

Razer has two offerings for the discerning
camper. The Copperhead has the same hardware
as the G5. This one is smaller, and if anything,
even faster than the G5 (albeit only by a tiny
margin). It’s more suitable for those with
smaller hands, and you’ll have to check both out
to decide which to buy. The Copperhead has
backlit side stripes (available in three colours)
and costs Rs 4,500. The DeathAdder is the other
offering—1800 dpi on an infrared sensor, and a
much more comfortable design than either its
laser sibling or the Logitech trio. Price = Rs 4,000
= three MX518s!

Microsoft’s Habu is the last contender for the
gaming mouse. It costs Rs 4,000, and is basically
a Copperhead in DeathAdder guise. The 2000 dpi
sensor in a much larger body makes the Habu

more controllable (and less twitchy—geek speak
for not-so-controllable) in my opinion.

Looking at the options available, my friend
and I picked up an MX 518 each. We got the
dealer down to Rs 1,425 apiece. At the end of
the day I just couldn’t resist the allure of the
G15—I guess all those shimmering lights got
to me. I ended up paying Rs 4,200 for it. 

Playing Warcraft 3 is a wonderful
experience… I could now play with the
lights off (keyboard backlighting is bril-
liant), and the macro keys really helped
map complex unit selections. The
extra spacing between keys is also a
good thing. I’ve yet to subject the
MX518 to some serious action, and

am awaiting the weekend when I’ll get
to use my friends as frag bait! 

Good carpenters need good tools; good
gamers need proper equipment! I’d been
contemplating upgrading my input

devices for an upcoming rig. However, funds
being ever the problem, this idea was shelved. Till
a colleague at work started harping at me to
accompany him to Lamington Road to pick up a
new gaming mouse. This fellow is a newbie at
Digit and fancies himself to be quite the Quaker—
of the modern kind, that is. Excerpts of what we
saw at aforementioned hallowed Road follow.

Joysticks are becoming pretty rare and Log-
itech’s latest Attack 3 Joystick was not in stock
with the distributors. Typhoon’s Eagle-Max is
available for as little as 2,000 bucks. There is a trio
of brands making gamepads—Frontech, Zebronics,
and Typhoon. Zebronics’ Zeb 50JP is a decent-
looking gamepad, with dual analogue sticks and
12 programmable buttons. It costs Rs 1,300.
Typhoon’s basic gamepad with six programmable
buttons costs Rs 800. Frontech’s Fantasy Pad JIL
1736, priced at Rs 1,000, has elongated handles
that make it look something like the PS3’s con-
cept “banana” controller. The Josh stick (Fron-
tech’s joystick offering) is priced at Rs 1,850.

The Logitech MOMO wheel costs Rs 4,850—a
sweet deal if you play racing simulations all the
time. Saitek is another brand I was aware of, but
to my dismay, one guy said their products are
extremely rare. For those into a lot of button-
mashing games, Microsoft’s X360 controller is
available for Rs 1,200. It saves your poor keyboard
the hurt (and the long-term wear and tear) while
button-hammering on games like Prince of Persia
and Mortal Kombat. While the force feedback is
gimmicky, the feel of the unit is good.

Zebronics has a racing wheel priced at 
Rs 2,500, but with no force feedback and
the trouble it takes getting it to stick
to your Desktop, the MOMO seems
worth the premium if you’re a
serious racing fan.

Now for the old school keyboard +
mouse legion of gamers… Logitech’s
G15 is a superb keyboard. Backlit
keys, 18 macro keys, and a well-laid-
out design mean the G15 is defi-
nitely for you if “4,500 bucks”
doesn’t cause an “ouch!” It also has a
LCD that dishes up all essential game
data, and will also serve as a pop-up
window. Razer’s Tarantula (which we
recently spent 30 Days With) is another
option, but isn’t really worth the price
(1,300 bucks more than the G15), consid-
ering it has fewer macro keys, no LCD, and
that the regular keys aren’t backlit. There is also
the Logitech G1—a combo of optical mouse and
keyboard. This kit was just about to hit the market

Want more of Agent 001? Turn over to read his
answers to your buying questions

Agent 001

Illustration Shrikrishna Patkar

Your favourite Agent—001, that is—isn’t right up there, but he is a gamer. He’s now paying attention
to the equipment

DIGIT SEPTEMBER 2007
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Two Uses, Two Options

I’m looking to buy a laptop. I have two options
in mind. One is from your July review—the

Compaq v3225AU—and the second is the Dell Insp-
iron 1420. The difference between the laptops in
terms of price is around 10K. Which will be better?
Do you know if Dell offers finance options?

Abhishek Tripathi

First up, banks will flock to give you
finance options; the laptop has become

the single most-financed IT product in the con-
sumer market. That said, its also possible each
vendor (HP and Dell) has tie-ups with certain
banks for even better deals (lower EMIs, etc.)
The Inspiron 1420 has a Core 2 Duo processor
which offers greater performance. However,
this is relative to your usage, and regular office
applications, music, Internet apps, etc. will not
see much benefit—the Presario v3225AU also
has a reasonably fast CPU (the Turion 64). If you
only plan on using your laptop for tasks of this
sort, save yourself some cash and buy the
Compaq. If you plan on a little more power
usage, get the Dell. And please opt for 1 GB of
memory—both laptops offer 512 MB in their
base avatars.

As Vague As It Gets…
I want to purchase a mobile with a good
camera and music playback. What are my

options?
Amit Barla

No budget mentioned, no preferred
brands mentioned, and it’s not clear if

you want good music playback, but anyway… a
“good” camera is relative to how much money
you want to spend. On a budget of below Rs
10,000 I’d recommend the Sony Ericsson K750i
(8,000 bucks street price). This phone is excel-
lent value for money right now. It also has good
MP3 playback. If you want something in the
price range of 15K, look at Sony Ericsson’s
K790i. With a 3.2MP camera and great music
quality, it’s a great buy. Nokia’s N73 also makes
a good buy at around 1,500 bucks more—it has
the same features but is based on Symbian’s
S60 operating system, which has a lot of appli-
cation support and is more functional.

A Nod For The Pod
I want to buy a PMP. My requirement is: 40 to
80 GB, good battery life, best music quality,

canal headphones, and compactness. No budget
issues. Also, what is the difference between a reg-
ular iPod and a nano?

Satyam

The iPod 80 GB seems right for you. It’s
a full-featured PMP with good audio

capabilities. The regular iPod plays videos,
while the nano doesn’t. The nano is, however,
just as good in terms of audio quality, and was
designed with sleekness and weight in mind.
It’s much more portable than the iPod Video. It
uses Flash memory, while the iPod Video uses

a hard drive—Flash makes the unit sturdier.
Hard drives tend to get damaged with sharp
impacts. If you travel a lot and your player
might get banged around in your pocket, or
even dropped a bit the iPod video isn’t for you.

The nano will offer you up to 8 GB, while
the iPod Video will give you the magic figure of
80 GB. If you want to lug loads of music along,
then go the iPod Video way. However if all you
need is a few gigabytes of music and if you
want something really light, then look at the
nano. The iPod Video 80 GB should cost you
around Rs 17,000 (street price). The nano 2 GB,
4 GB, and 8 GB versions will cost you Rs 7,500,
10,000, and 13,000 respectively.

Ancient’s Expensive
I am planning to buy a new AGP graphics card
(AGP). Can you tell me about cards within Rs

10,000? Also, I have an unbranded 400 W power
supply. Is that enough for powering such a graphics
card? My current system specs are:
P IV 3 GHz
ASRock p4i65GV motherboard
512 MB DDR RAM
LG GSA—H12N DVD R/W
Samsung 160 GB SATA HDD
NVIDIA GeForce 4 MX 4000

Renjith N P

As far as your query goes, the 7600GS
has an AGP variant that should cost you

Rs 6,000. The 7800GS is the most powerful AGP
card you can get (Rs 11,000). I must caution you
that AGP is now a dead interface with no more
cards being made for it. Because of this, AGP
variants of cards are also very expensive. The
7600GS PCI-Express card, for example, costs
just Rs 4,500. I’d suggest you consider
upgrading your motherboard, memory, and
CPU to a PCI-Express platform.

A 400 watt PSU will not suffice. Look 
for a 500 watt VIP, which should cost you
around Rs 3,500.

Old Is (Sometimes) Good
I have a Nokia N70, and I want to buy a second
phone. My budget is Rs 5,000 to 6,000. I’m

looking for a cell phone with a 1.2 MP camera, Blue-
tooth, a good colour display, a good MP3 player,
and GPRS.

Abhigyan Sarmah

Consider the Sony Ericsson W700i—it
offers all you’ve mentioned, and a 2MP

camera. It’s a compact and good-looking
phone. The real icing on the cake is the fact
that this isn’t the newest of models, and is
therefore excellent value for money now (Rs
8,000 street price). The reason I have gone
above your mentioned budget is that good
music quality and expandability is not some-
thing we’re seeing in lower-end phones right
now. Sony Ericsson’s K750i is also available for
around the same price. It’s an older model,
with good music capabilities. The camera (2.0
MP) has auto-focus (the W700i doesn’t). 

Want a tech product, but
don’t know how to go
about buying it? E-mail
agent001@thinkdigit.com
with your complete 
contact details, and he
might answer them here!
Please note that
Agent001 only answers
purchase-related
questions in this space.

Ask Away!

Ask Agent 001
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Wi-Fi Access Points
Linksys WAP54G

Great performance
None in particular

Contact Ingram Micro India Pvt Ltd
Phone 9323112279
E-mail sunil.z@ingrammicro.co.in
Price Rs 3,816

5.1 Speaker Sets
Artis S6600R/FM

Good performance, radio
None in particular 

Contact Kunhar Peripherals Pvt Ltd
Phone 022-66345758
E-mail mail@kunhar.com
Price Rs 8,500

Processors
Intel QX6700 Core 2 Extreme

Extreme performance
Expensive
Contact Intel Corporation
Phone 080-25075000
E-mail saranya.rustagi@intel.com
Price Rs 52,000

Projectors
Acer PD726W

Great overall performance
No remote sensor at rear

Contact Acer India Pvt Ltd
Phone 9880544226
E-mail alankar_s@acer.co.in
Price Rs 1,50,000

Digital Cameras
(High-End)
Sony Cybershot W50

Excellent image quality,
vibrant colours
Trouble focusing in low light
Contact Macro Photo
Phone 022-22618639
E-mail macro.photo@gmail.com
Price Rs 15,000

Flash Drives
Transcend JetFlash 150 1 GB

Fast
Poor package bundle

Contact Mediaman Infotech Pvt
Ltd

Phone 022-23828100 
E-mail santosh@

mediamangroup.com  
Price Rs 1,500

LCD Monitors (19-inch)
AOC 197S

Good looks and performance
Gloss finish catches smudges

Contact AOC India
Phone 1800-425-4318
E-mail info@in.aocmonitor.com
Price Rs 12,000

LCD Monitors (17-inch)
AOC 177V

Good performance
None in particular

Contact AOC India
Phone 1800 425 4318
E-mail info@in.aocmonitor.com
Price Rs 9,800

MP3 Players up to Rs 4,000
MobiBlu DAH-2100

Good performer
Tiny screen for video

Contact J.J.Mehta & Sons
Phone 022-24306356
E-mail   info@jjmehta.com
Price Rs 4,000

MP3 Players up to Rs 10,000
Sandisk Sansa e250

Good performance, 
feature-rich
Tacky scroll wheel

Contact Rashi Peripherals Pvt Ltd
Phone 022-67090909
E-mail navinderc@

rptechindia.com
Price Rs 8,150

Internal DVD-Writers
Lite-On LH-20A1P

Fast performance, 20x 
writing to DVD+R and DVD-R 
None in particular

ContactMediatech India
Distribution Pvt Ltd

Phone 022-26361111
E-mail digit@ 

mediatechindia.com
Price Rs 2,095

Internal SATA Hard Drives
WD Caviar SE16 WD5000AAKS

Fast transfer speeds
None in particular

Contact Champion Computers 
Pvt Ltd

Phone 011-26214751
Web site www.championindia.com
Price Rs 7,500

Graphics Cards (High-End) 
NVIDIA GeForce 8800 GTX

Blistering-fast
Runs slightly hot
CCoonnttaacctt Rashi Peripherals Pvt Ltd
PPhhoonnee 022-67090810
EE--mmaaiill navinderc@

rptechindia.com
PPrriiccee Rs 41,000 + taxes

Graphics Cards (Mid-range) 
XFX 8600GTS

Best of the mid-range cards
Could do with more memory
CCoonnttaacctt Rashi Peripherals
PPhhoonnee 022-67090909
EE--mmaaiill navinderc@

rptechindia.com
PPrriiccee Rs 16,000

External Portable Hard
Drives
WD Passport Portable (Black)

Excellent performance, good
value
None in particular
Contact Champion Computers 

Pvt Ltd

Phone 011-26214751
Web site www.championindia.com
Price Rs 6,500

Internal SATA Hard Drives
WD Caviar SE16 WD3200AAKS

Value for money, 
performance
None in particular

Contact Champion Computers 
Pvt Ltd

Phone 011-26214751
Web site www.championindia.com
Price Rs 4,500

The best products tested so far in different 
hardware and software categoriesThe A-List

DIGIT SEPTEMBER 2007
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Multimedia Phones
Rs 12,501 to Rs 20,000
Sony Ericsson CyberShot K790i

Great all round
Cam slider flimsy
Contact Sony Ericsson Mobile 

Comm. India Pvt Ltd
Web site www.sonyericsson.com
Price Rs 16,222

Up to 12,500
Nokia 6300

Great screen, build
Hard joystick

Contact Nokia India
Web site www.nokia.com
Price Rs 11,489

Intel High-end Motherboards
Foxconn 975X7AB-8EKRS2H

Inexpensive, good performer
None in particular

Contact Mediatech India 
Distribution Pvt Ltd

Phone 022-26361111
E-mail info@mediatechindia.com
Price Rs 10,750

Intel Mid-range Motherboards
Gigabyte GA-965P-DQ6

Good build quality and 
performance
Expensive 

Contact GIGABYTE Technology 
India Ltd

Phone 022-26526696
E-mail sales@gigabyte.in  
Price Rs 16,000

Desktop PCs
Sahara 20CK16

Great performer
Slightly bulky

Contact Sahara Computers & 
Electronics Ltd

Phone 0120 - 4397777 
E-mail info@saharacomputers.co.in
Price Rs 40,000

AMD AM2 Motherboards
ASUS Crosshair AM2

Great bundle and performance;
accessories for the enthusiast
None in particular

Contact ASUSTeK Computer Inc
Phone 022-40058888 
E-mail media_india@asus.com
Price Rs 15,400

Home Inkjet MFDs
Canon PIXMA MP160

Good performance
No memory card reader 

Contact Canon India Pvt Ltd
Phone 1800-345-33-66
E-mail info@canon.co.in
Price Rs 5,999

Mono Laser MFDs
Brother MFC-7420

Great cost per page, fax
No Ethernet Port 

Contact Brother International India
Pvt Ltd 

Phone 1800 222 422
E-mail customercare@brother.in
Price Rs 18,000

PCI TV-Tuners
Leadtek Winfast PVR2000

Excellent video quality and 
software
Expensive

Contact Topnotch Infotronix (India)
Pvt Ltd

Phone 044-42042565
E-mail naqui@zebronics.net
Price Rs 5,500

Mono Laser Printers
HP LaserJet 1020

Good combination of speed,   
print quality, and warranty
A bit slow in comparison to
others

Contact Hewlett-Packard India 
Sales Pvt Ltd 

Phone 0124-2566111
E-mail kakuni.mahto@hp.com  
Price Rs 6,999

Mice
Logitech MX Revolution

Has a flywheel
Expensive

Contact Logitech Electronic 
India Pvt Ltd 

Phone 022-26571160
E-mail response@logitech.com
Price Rs 8,000

Performance Laptops
HP DV6226tx

Funky Looker, features 
Needs better graphics

Contact Hewlett-Packard India
Phone 0124-2838700
E-mail tapoti-t.tipnis@hp.com
Price Rs 56,990
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Up to 12,500
Samsung SGH-E840

Great build, slider
Keypad tactility

Contact Samsung Telecomm.
India

Web site in.samsungmobile.com  
Price Rs 10,700

PDA Phones Above Rs.25K
Nokia Communicator E90

Extremely powerful
Heavy, bulky

Contact Nokia India 
Web site: www.nokia.com
Price Rs 40,499

Office Inkjet MFDs
HP Photosmart C4188 All-in-
One

Good print quality
No fax

Contact HP India Sales Pvt.
Ltd.

Phone 0124-2566111
E-mail kakuni.mahto@hp.com
Price Rs 7,999

PC Webcams 
Logitech QuickCam IM

Strong performer
Manual focus

Contact Compuage Infocom Ltd
Phone 022 - 65297356
E-mail india_getcreative 

@ctl.creative.com
Price Rs 1,995
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Now this one isn’t just “Incredibly Useful”—it’s incredibly fascinating.
Marvellous content here—pure science discovery and fun, totally

cutting-edge.
“Saturn’s strange moon Iapetus... has a ridge running along its

equator. This feature and others of the walnut-shaped moon suggest
that Iapetus has been frozen in time, giving astronomers a glimpse into
the outer solar system’s early development.” If you enjoy and thrive upon
such news, take one look at Science News Online and you’ll be hooked.

Mind you, this one is not for the fritter-brained. If you’d like to know
why dirt roads develop a “washboard” surface, if you need to know what
computer scientists are doing to crack the Rubik’s Cube puzzle—then and
only then head here. Zero
frills: they won’t make
things for you “kiddie-
friendly” the way The Dis-
covery Channel does.

After that intimidating
warning, we must say the
language itself is simple
enough. A sampler: “Rubik’s
Cube has approximately 43
quintillion possible configu-
rations. Even a supercom-
puter can’t search through
every possible configuration
to find the quickest way...”

Many articles are sub-
scriber-only, yes, but there’s
more free stuff than you have free time.

Quick links include archives for many years, a blog as rich as the
main site, and one to the most viewed articles. In terms of navigation,
you’re best off starting at the Table of Contents link.

If you’re smart enough (and you are, since you’re a Digit reader), do
take a quick look regardless of whether you consider yourself a science
buff. You might just find you are.

In Theory And In Practice

The kind of visuals you can expect at
Science Online

Digital Tools l 3 Incredibly Useful Sites

No pretty boxes to click on at
this site. The focus is man-

agement, but it’s a loose focus.
Much of what applies to that dis-
cipline applies elsewhere, too.
There’s also information for the
would-be entrepreneur, people
working with non-profits, and
more. The material is geared
towards student, teacher, and
worker alike.

At the main page are a whole
lot of links; actually, five thou-
sand for the site—and e-books on
650 topics. At or close to the
main theme are such topics as
Interpersonal Skills,

Organisational Change, and
Employee Performance. In the
middle ground, we have Group
Skills, Coordinating, and
Ethics & Social Responsibility.
Now take a look at Creativity &
Innovation, Problem Solving /
Decisions, and Communi-
cations (Writing)—and you
know you can use this site
even if you don’t know the M
of management.

Visit the main page. Click
here and there. You’ll proba-
bly find some more Incredibly
Useful stuff. 

ram_mohan@thinkdigit.com

www.sciencenews.org

www.managementhelp.org

The only visual relief here: book covers. You get recommenda-
tions for all the main topics
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www.ephotozine.com

“Averitable Swiss Army Knife of a site, ePHOTOzine has
everything a photographer could wish for.” That’s the

quote they use, and we’ll agree. Subscription is not neces-
sary, but it allows you to access the forums and the com-
petitions—as in upload your photos. You can keep them up
for modification (!) so you know what your photo could be.
And thus, you learn.

You’ll also learn a lot at the forums: general photog-
raphy techniques, techniques specific to digital photog-
raphy, gadgets and models and such, image editing issues…
pretty much every-
thing. And the
c o m p e t i t i o n s !
Submit your pho-
tograph to pit it
against some of
the coolest, most
b r e a t h t a k i n g
photos we’ve seen.

There are
plenty of reviews,
and buying advice
to boot. The reviews aren’t limited to cameras—they span
everything a photographer (budding or otherwise) might
encounter, such as display devices.

The Techniques area is all about techniques—at least,
a lot. Summer portraits? Landscapes? B&W in CS3? You
name it, it’s there.

Photographer or not, you’ll want to go to the most
obvious section—the photos. Looking at all that art, you’ll
want to learn the techniques, then you’ll want to get the
equipment, then you’ll want to ask questions. Photos,
Techniques, Buyers’ guides, Reviews, Forums, competi-
tions. That rounds off the picture—this is an all-in-one
site. Don’t be intimidated by all the photoman-speak…
you’ll get into it in no time.

“Holy Sheds” by “jeanie” at ePHOTOzine

Ram Mohan Rao

Students have it so much better these days...
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Prakash Ballakoor

You’ve seen touchscreens at
information kiosks, in
museums, hotels, and

ATMs, and you did marvel (at
least the first time) the way they
interacted with you. Touch-
screen-based systems allow for
easy navigation around a GUI-
based environment. Tap on the
screen twice for double clicks,
and drag a finger on the screen
to move the cursor. You can do
almost everything the mouse
does, and you do away with the
additional device (the mouse)—
leaving only the screen.

Falling prices and improved
technology has fuelled the use of
touchscreens in smaller
consumer devices like mobiles,
Tablet PCs, and handheld gaming
consoles like the Nintendo DS.

As an aside, you don’t need to
buy a full-fledged touchscreen
for touch-based interaction.
Touchscreen components can be
bought off the shelf (at least in
developed countries) and used
with an existing screen!

The Components
There are four popular touch-
screen technologies we’ll talk
about, but all of them have three
main components: the touch
sensitive surface, the controller,
and the software driver. 

The touch sensitive surface is
an extremely durable and flexi-
ble glass or polymer touch-
responsive surface, and this
panel is placed over the viewable
area of the screen. In most
sensors, there is an electric
current or signal going across the
screen, and a touch on the
surface causes a change in the
signal depending on the touch
sensor technology used. This
change allows the controller to
identify the location of the touch.

The controller is an electronic
device that acts as the intermedi-
ary between the screen and the
computer. It interprets the elec-
trical signals of the touch event
to digital signals that a computer
can understand. The controller
can be integrated with the screen
or housed externally.

The software driver is an inter-
preter that converts what comes
from the controller to informa-
tion that the OS can understand.
It is similar to a mouse driver, to
take a common example.

Four Touchscreen Sensor
Technologies

Resistive touchscreens
Based on an old technology,
these are durable and resistant to
humidity and liquid spills. But
they offer limited clarity, and the
surface can be easily damaged by
sharp objects. Resistive touch-
screens have two glass or acrylic

layers. One of the
layers is coated
with thin conduc-
tive material, and
the other is
coated with resis-
tive material.
When in opera-
tion, electricity
passes across the
screen on the
conductive layer;
when pressure is
applied, the two
layers are pressed
against each
other and there is
a change in the
electric current
due to the resist-

ance brought in by the resis-
tive layer. This change is regis-
tered and the location of
touch is calculated.

Capacitive touchscreens
These are used for applica-
tions where clarity and
precision is of concern—as in
laptops and medical imag-
ing. Such screens cannot be
used with non-conductive
inputs (like rubber-gloved
hands or styli).

Here, we have a glass
panel with a coat of charge-
storing material on its
surface. When the panel is
touched, a small amount
of charge is drawn at the
point of contact. Circuits located
at each corner of the screen
measure the difference in
charge and send the informa-
tion to the controller for calcu-
lating the position of touch.

Surface Acoustic Wave
Touchscreens
This newer technology uses
ultrasonic waves that pass over
the screen. When the panel is
touched, there is a change in the
frequency of the ultrasonic
waves, and the receiver at the
end of the panel registers this
change. Since only glass is used
with no coating, there is nothing
that can wear out.

Other technologies
The above are the mainstream
technologies; there are others as
well. Strain gauge touch panels
have springs mounted on the
four corners; when touched, the
change in the compression in
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Touchscreens
They’re all the rage, they’re the buzzword, they’re probably the
hottest thing in tech right now!

The three basic components of a touchscreen: the sensor,
controller and driver 

Resistive touchscreens—the most
robust and affordable

DIGIT SEPTEMBER 2007
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each corner is measured to find
the coordinates of the touch.
Such panels weren’t durable
enough, so they flopped. More
recently, we’ve seen optical
imaging touchscreen technol-
ogy. This uses cameras that
sense usually far infrared light;
when the light is interrupted by
touch, the location can be calcu-
lated. Microsoft improved upon
this technology and introduced
the Surface, which you’ve doubt-
less heard about.

Microsoft’s Surface
The Surface is a touchscreen
computer that looks like a
coffee table and allows for
surface computing. Through
“surface computing,” you can
seamlessly synchronise elec-
tronic devices that touch its
surface. For example, the
Surface allows you to connect a
camera with a mobile. You can
transfer images from your wire-
less-enabled camera to a Blue-
tooth-enabled mobile phone,
with both on the Surface. On

placing the wireless-enabled
camera on the tabletop,
pictures are wirelessly trans-
fered to the hard drive of the
Surface. Using your fingers, you
can fiddle with and pinch the
images to rotate, crop, or resize
them. To transfer images, you
put your finger on the Surface
and just drag the images to your
Bluetooth-enabled phone!

Thanks to multi-touch, the
Surface can accept input from
multiple fingers and multiple
users simultaneously and allow
complex gestures like grabbing,
stretching, swivelling, and slid-

ing of virtual objects like images
and files across the table.

Misconceptions And
Disadvantages
Misconceptions include the idea
that grease will spoil the surface
of a touchscreen. Not true;
touchscreens with glass surfaces
can resist dirt, grease, moisture,
and also household cleaning
agents. Another misconception
is that touchscreen displays gets
washed out when viewed under
sunlight. This has nothing to do
with the touchscreen in itself;
visibility depends on the quality
and contrast of the display. 

With improvement in tech-
nology of touchscreens, precise
pointing is also possible. Having
said that, touchscreens have
their share of disadvantages.
People with fat fingers may mis-
hit keys and find it tough to
navigate. One needs to be care-
ful while handling mobile
devices with touchscreens
because the screen gets
damaged when kept in a pocket

with coins and keys. Touch-
screens are complex items, and
unlike keypads, there are many
things that can go wrong: dete-
riorating response, unruly cali-
bration, and dead pixels.

Touchscreen tech has its crit-
ics: of all people, Nokia’s general
manager for mobile devices,
Antti Vasara, claims people
don’t like touchscreens and
prefer keyboards and joysticks.
He says they wouldn’t like to use
an interface designed for a
mouse—such as a regular moni-
tor—as a touchscreen, and that
nothing beats a keyboard, which

Capacitive touchscreens – clear screens, but at a high cost

provides plenty of tactile feed-
back. But recent demonstrations
of the TouchFLO mobile phone
from High Tech Computer Corp
(who design, manufacture, and
market smartphones and PDA-
phones) have shown that the
combination of a finger and a UI
designed for the finger can
make for data input as fast as
with a keyboard.

And There’s More!
Many large companies—
Microsoft and Apple included—
have gotten on the touchscreen
bandwagon, multi-touchscreens
in particular. After the iPhone,
rumour has it that Apple will
soon come up with a tablet PC
wherein multiple fingers (up to
15 simultaneous touches!) can
be tracked. It’s further been
said that Apple has patented an
“Integrated Sensing Display”
wherein display elements are
integrated with image sensing
elements. (Think of “image sens-
ing elements” as micro-
cameras.) If this were to be put
to use, you could have a single
device—that looked like a
monitor—for videoconferenc-
ing, wherein the monitor would
be the camera!

As you’ve been noticing,
keypads on mobile devices are
getting cramped—with more
and more buttons for launching
all the various applications.
With the number of buttons
that can fit on a mobile device
reaching its limit, it might not
be far-fetched to predict the
gradual death of the button,
giving way to the touchscreen. 

prakash_ballakoor@thinkdigit.com

Acoustic touchscreens—accurate, and good for big displays
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Samir Makwana

As you very well know, the Indian telecom
industry is at a phenomenal stage of
development. It is considered one of the

fastest-growing industries of all time. The num-
ber of phone users in the country crossed 22.5
crore in June 2007. According to the Press
Information Bureau of India, during 2006—07,
the country saw the addition of about 7.2 crore
phone subscribers—a 47 per cent increase over
the previous year. These figures serve to indi-
cate the frenetic nature of progress in this field.

At the Confederation of Indian Industries
Summit at Bangalore in January 2007, Dr Sam
Pitroda, National Knowledge Commission

Chairman and research pioneer in telecommu-
nications and handheld computing, pitched for
the manufacture, in India, of telecom equip-
ment such as mobile phones. If manufacturing
of phones does start in India, employment
opportunities on a large scale will open up.

A wide range of career opportunities can be
seen on both the hardware and software front.
The list is long: mobile telephony, wireless 
communications, Internet protocol media 
system, GSM (Global System for Mobile
Communications), GPRS (General Packet Radio
Service), CDMA (Code Division Multiple Access),
UMTS (Universal Mobile Telecommunication
System), VoIP (Voice over Internet Protocol), the
Symbian operating system, data networks, 
optical networks, and more! Internet Service

Opportunities
abound in the
Indian telecom
sector—be they
hardware or
software,
technical or
managerial,
innovative or
hands-on

Tech Careers
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Providers use telecom hardware and therefore
employ telecom engineers for their network-
related operations.

Opportunities In Hardware
Design and implementation: Designing tele-
com systems equipment, infrastructure, and
networks is a career option—the installation of
equipment such as switchers and routers at a
base station requires proper design in the first
place. However, design and manufacturing of
original telecom equipment is yet to start off on
a large scale in India. Equipment design engi-
neers, therefore, see better prospects abroad.

For telecom infrastructure, the design archi-
tect / solution architect / business analyst is
required to have the know-how of voice, data,
and fibre-optic networks. Telecom infrastructure
design is required for proper transmission voice,
data, and other cabling solutions over a network.

As mobile service providers install more
antennas and base service stations, the demand
for those who specialise in telecom design and
implementation is bound to rise.
Operations and maintenance: The telecom
infrastructure requires operational support
and maintenance to function at optimal capac-
ity: this domain includes monitoring, trou-
bleshooting, and analysis of the operations that
take place at the base service station.
Ultimately, the job of those in the operation
and maintenance department is to ensure voice
can be transmitted from one end to another.
Network: Job functions in wired, wireless, and
data networks all fall under the “network”
umbrella. Employed in this domain are engi-
neers who specialise in wireless technologies.
They are, for example, GSM engineers / special-
ists, GPRS engineers / specialists, and CDMA engi-
neers / specialists.  Specifically, installation, plan-
ning, administration, security management,
troubleshooting, and testing of networks are
what is involved in this domain.

It should be mentioned that freshers are
usually absorbed into the industry in network-
ing jobs. Network engineers at times design
terrestrial networks and certify them. Vendor-
specific certifications are a plus in a network
engineer’s profile. Of all the network func-
tions, security is an area worthy of mention in
terms of opportunities.
Services: Increased competition means tele-
com service providers must provide quality
service keeping operational costs under con-
trol. They deploy solutions for service quality
management, fault management, and perform-
ance management. This domain therefore com-
prises service desk functions, service assurance,
quality of service management, and such.

Opportunities In Software
Software in the telecom industry usually
enables signal testing and network monitoring.
Real-time operating systems are of particular
importance to aspirants.
Revenue and billing services: Those skilled in
DBA (Database Analysis) software systems and
data warehousing are employed in this sector.
They specialise in working on vendor-based
applications and software systems such as Oracle,
Kenan, and Siebel. The professional here keeps a
check on whether customers are properly
charged, and prevents fraud or faulty billing.
Value-Added Services (VAS): A fiercely-grow-
ing domain, emerging as a separate industry,
VAS includes entertainment, commerce, TV,
and more—on the mobile. The majority of the
opportunities in VAS are towards programming
for the mobile platform. WAP (Wireless Access
Protocol) specialisation is in particular
demand. Programming and scripting languages
used in mobile applications include C, Java,
Delphi, Visual Basic, Pascal, PERL, SQL and MAT-
LAB should also be mentioned.

Education
The most obvious and advisable path that
leads to a career in the telecom sector is via
telecommunications engineering. Only stu-
dents from a science background can opt for
telecommunications engineering or diploma
courses: to join a telecom engineering course,
one needs to have passed the higher second-
ary or a vocational course that includes
physics, maths, and chemistry in the syllabus.
These subjects have been made compulsory as
the minimum eligibility criterion to appear
for entrance tests such as the IIT Joint
Entrance Exams.

In all cases, for employment with a telecom
company, the first preference is telecom engi-
neers. Next is electronics and communication
engineers, and then those with a B. E. or B.
Tech. in computer science.

“The industry generally prefers those with a
B. E. / B. Tech. either in computer science or
electronics. However, leverage is given for can-
didates with relevant experience and industry
certifications,” according to Shinu Karim, 
ex-employee, Cable & Wireless Ltd. Aspirants
should pursue their B. E. or B. Tech. degree in
telecommunications only from universities and

The Indian Institutes of Technology
Bombay, Delhi, Guwahati, Kanpur,
Madras, and Roorkee
The National Institutes of
Technology
Durgapur, Hamirpur, Jamshedpur,
Karnataka, Rourkela, Silchar, Srinagar,
Trichy, and Warangal
Advanced Level Telecom Training
Centre, Ghaziabad
Army Institute Of Technology, Pune
Assam Engineering College, Guwahati
Indian Institute of Science, Bangalore
Bangalore Institute of Aeronautical
Engineering and Information
Technology, Bangalore
Bharat Ratna Bhim Rao Ambedkar
Institute of Telecom Training,
Jabalpur
Birla Institute of Technolgy, Mesra
Birla Institute of Technology and
Science, Pilani

BMS College of Engineering,
Bangalore
College of Engineering, Farmagudi,
Goa
Dayanand Sagar College of
Engineering, Bangalore
Dhirubhai Ambani Institute of
Information and Communication
Technology, Gandhinagar
Dr. Ambedkar Institute Of
Technology, Bangalore
Dr. Babasaheb Ambedkar
Technological University, Mumbai
Hughes Communication India Ltd,
Gurgaon
Jadavpur University, Faculty Of
Engineering And Technology,
Kolkata
Symbiosis Institute of Telecom
Management, Pune
Veermata Jijabai Technological
Institute, Mumbai

Educational Institutions

As mobile service
providers install
more antennas
and base service
stations, the
demand for
those who spe-
cialise in telecom
design and
implementation
is bound to rise
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institutes recognised by the All India Council of
Technical Education (A.I.C.T.E.).

Those willing to pursue higher education
should opt for M. Tech. courses with a speciali-
sation in telecommunications technology and
management. One can opt either for a core
technology area or for a specialisation in the
management aspect of the telecom industry.

The telecom education curriculum covers
subjects on telecom regulatory policies, which
are essential knowledge for all aspirants.
Telecom companies have begun to collaborate
with the top educational institutions to
improve the curriculum and also directly pull
in skilled, qualified engineers.

Skills
Those with hands-on knowledge of installing,
maintaining, and troubleshooting equipment
are sought after. That apart, “The telecom indus-
try looks to employ candidates with relevant
experience. There are not too many telecom
companies in India, so employees at the higher
management level keep shuffling only between
these few companies,” says a telecom industry
official who requested anonymity. This means it
is a kind of “closed circle,” meaning one cannot
hop between job profiles as easily as in other
industries—and that in turn means one needs to
develop deep expertise in one
specific area.

On the hardware side of the
industry, experienced candidates
with industry certifications are
given first preference. Soft skills are
a must at any level. Leadership skills,
presentation skills, and such are also
necessary. “Experience in the relevant
field and industry certification is the
prerequisite, and most positions
emphasise soft skills,” says Karim.

Freshers, Take Note
As mentioned earlier, the industry
believes in hiring experienced and
qualified candidates. Internships
are offered to students and fresh
graduates. Engineers who pass out of engineer-
ing colleges might get an equal chance.

Companies access their potential recruits
through placement consultants, employee
referrals, and advertisements. Campus recruit-
ment for hardware functions is not common—it

is more for software functions that freshers are
recruited off campuses.

According to L K Bhatia, vice president of
the resource management group, Tech
Mahindra Ltd, “The expansion of the education
system in general—and catching people young
to put them into different streams of their
interest and aptitude—could speed up the
recruitment process. Taking higher technical
education to tier 2 and tier 3 cities could uncov-
er a vast pool of talent.”

Fresh recruits undergo induction and train-
ing for a period ranging from seven days to six
months. Classroom training sessions are often
organised for officials and engineers working
on new technologies adopted by a company.
Training sessions are held by product (such as
routers and switchers) vendors to enhance skills
in the context of the use of the product.

The Money…
The remuneration offered by any telecom com-
pany would, in general, be competitive. A
majority of employees keep job-hopping until
they have the expertise and experience to grow
vertically, like we hinted at earlier.

At the entry level, salaries offered range
from Rs 1.5 to 3 lakh per annum. This can shoot
to Rs 20 lakh per annum for technical positions,
and for management positions, the remunera-
tion can cross that figure.

A Parting Word
Projects, technologies, and operations in the
telecom industry are in a phase of expansion.
A mention should be made of the ingress of
3G technologies. Most of the opportunities in
this field come under the umbrella of the
service industry.

However, service providers outsource their IT
needs; Bharti has recently outsourced to IBM, for
example. Network needs are outsourced to
product vendors to leverage their expertise.
Opportunities related to IT in telecommunica-
tions therefore lie also in those organisations, and
not only with the service providers themselves.

Do take note: this industry demands super-
specialisation in a specific area—you can’t move
around easily between domains. Choose that
domain wisely, and you can be a proud archi-
tect or facilitator of one of the most fundamen-
tal of human needs: communication. 

samir_makwana@thinkdigit.com

Engineers who
pass out of engi-
neering colleges
might get an
equal chance
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If your business is growing fast, you’ll soon need a multi-functional device that can keep up with
the needs of your organisation—here’s what you need to decide on one

Jayesh Limaye

O
ffice needs that have to do with paper—
printing, scanning, fax printouts, and copy-
ing—have solutions primarily in the form
of inkjet and laser devices. The other classi-

fication is standalone devices vs. MFDs. The latter is
not much of a dilemma any more, really: MFDs are
here to stay, and with good reason. But in regards to
the former—inkjet or laser—you might ask: why a
laser MFD test now, when we did an inkjet test two
months ago?

It’s simple. Inkjet MFDs are good for the SoHo
consumer. They are great if your work requires
colour prints such as photographs, and if you are on
a tight budget. Now as your business grows, your
needs grow too, and when your regular daily work-
load involves high-volume, high-speed printing—and
if colour prints are not a daily affair—you need a
faster and more cost-effective solution than inkjet
MFDs. That’s where the lasers come in. These are
more expensive than inkjets, but the initial cost is
recovered quickly—within a few months of printing.

To give you a good feel for what the market has
to offer, in fact, to help you with a purchase decision,
we rounded up quite a few laser MFDs and tested
them to see if they perform as they promise. (You
must go beyond the advertisements!) We reviewed
four laser MFDs from Brother, three from 
Canon, five from HP, and one each from Lexmark
and Panasonic.

The MFDs we’ve tested here range from the very
basic to the heavy-duty, and we’ve also included copi-
er-based MFDs that cost less than Rs 50,000.

From Brother, we have the DCP-7010, MFC-7320,
MFC-8460N and MFC-8860DN. We have the Canon
MF4122 and MF4150, along with the Lexmark X342n
and Panasonic KX-FLB802CX. From the HP stables,
we have the M1005 MFP, 3052 All-in-One, 3055 All-
in-One, 3390 All-in-One, and the 3392 All-in-One—
all of them under HP’s LaserJet range of products.

We categorised the MFDs into three classes
for your convenience:
Budget MFDs—priced up to Rs 16,000: These
are for businesses just starting up and those
that cannot afford to put in too much capital
into a laser device, yet want a solution that
is faster and more cost-effective than an
inkjet machine. Small establishments
would rather have a device that can do it
all—print, scan and copy—than stand-
alone devices, because of limited
resources and office space. The MFDs
in this category are the Brother DCP-
7010, HP LaserJet M1005 MFP, and the
Panasonic KX-FLB802CX.

ALL-IN-WONDERS!
SoHo MFDs—priced between Rs 16,001 and 
Rs 30,000: The products in this category are for
businesses are at the SoHo(Small Office Home
Office) stage. Standalone fax functionality assumes
some importance here. The Brother MFC-7420,
Canon imageCLASS MF4122 and MF4150, HP
LaserJet 3052 All-in-One and 3055 All-in-One, and
the Lexmark X342n fall in this bracket.
SMB MFDs—priced between Rs 30,001 and 
Rs 50,000: Look in this category if you are a small
or medium business (SMB) that requires very high-
volume printing, speed, and also machines that
can handle heavy workloads while having the
capability of being networked. This bracket is pop-
ulated by the Brother MFC-8460N and MFC-
8860DN, and the HP LaserJet 3390 All-in-One and
3392 All-in-One.

With all the above in mind, read on to find
out which products delivered and which didn’t,
which seem unlikely purchases for you and which
seem right. 
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Compact with a footprint of 43.2 x 39.5 cm
(which is quite small), the DCP-7010 is a mono

laser printer, scanner and copier, but does not fea-
ture standalone fax functionality; you need to use
it in conjunction with a PC to send faxes.

The printer has a claimed hardware resolution
of 2400 x 600 dpi—rather high for an entry-level
product. In our tests, this one took 19.1 seconds to
warm up, and 10.3 seconds for the first text print.
Print quality was average for text in Draft mode,
but improved a lot in the best mode.

The scanner resolution is 600 x 2400 at 24-bit
colour, and it supports a maximum paper size of
A4. The scanner is a bit slow: it took 13.7 seconds
for a mono scan, which is on the higher side for a
scanner with the WIA driver interface. A full-
colour A4 photo scan at 600 dpi takes just under 4
minutes, again very slow. The machine reproduced
colours fairly well—we’d say it’s good enough for

scanning photographs.
The OCR test didn’t see
it fare well, however.

The printer features
the USB and even the
parallel interface (the
latter for those with
older computers). The
MFL-Pro suite—a control
centre to take care of jobs such
as scanning, faxing, and more—is
good, and also bundled is PaperPort
9.0SE (OCR software). The claimed printer
duty cycle is 10,000 prints per month, while the
toner has a duty cycle of 2,500. The DCP-7010 is
decently priced (Rs 11,150); the toner cartridge
costs Rs 2,150, meaning the cost per print is 86
paise. We still recommend this MFD because of
portability, speed, and overall performance.

Brother DCP-7010
Decent, we say!

BUDGET LASER MFDS (UP TO RS 16,000)

The Panasonic KX-FLB802CX is in a class of its own:
it is the only copier-based MFD we tested. Being

copier-based, it comes with separate drum and toner
cartridges. The advantage of such a device over print-
er-based MFDs is this: the toner and drum have dif-
ferent duty cycles, and the drum’s duty cycle is
always more than twice that of the toner. In the case
of printer-based laser MFDs, the toner and drum are
integrated, and the duty cycle of the single unit is
that of the toner—so you have to replace the whole
thing even when the drum’s duty cycle hasn’t been
expended. With copier-based laser MFDs, you need
to change either the toner or drum as and when its
duty cycle is over. This proves to be cost-effective.
However, copier-based units have traditionally been
more expensive to manufacture. This one breaks the
mould, and costs just Rs 15,999.

At 44 x 44.5 cm, this MFD occupies a compara-
tively large area, but can just about fit beside a PC on
a regular desktop. Installing the drum is very easy,
but installing the cartridge is not. Input tray capaci-
ty is 250 sheets, and there is also a multipurpose tray
for additional paper storage.

The printer supports 600 x 600 dpi. The initiali-
sation time of this MFD is just under 20 seconds. For
the text document, it took 14.7 seconds to print the
first copy and thereafter printed at 16 ppm. It takes
a couple of seconds longer to print the first copy of
the combi-document, but thereafter prints at just
about the same speed as the text print. Text is quite
sharp, and inverse text was pretty good, too.

The scanner supports 600 x 1200 dpi, but the
driver doesn’t support the newer WIA interface—
which many modern scanners do, because it is
more standardised. The scanner is good at captur-
ing colours and fine details, but is extremely slow,
especially at resolutions lower than 600 dpi. Since

these are the resolu-
tions at which people
most often scan docu-
ments and even photo-
graphs, the
scanner loses
out on per-
f o r m a n c e
points. It
took 27.2 seconds to scan a
monochrome document at 200
dpi, while a colour document at 600 dpi took
just over 2 minutes—pretty good. The scanner did
not fare well in the OCR test, committing 25 mis-
takes, which is bad.

The first copy took 18.3 seconds. We found the
copies rather dark, and as a result, the inverse text
was not very legible. Fine print didn’t turn out
legible, either.

This is the only contender that comes with a
handset, which doubles up as a phone if you are
using your phone line for fax (as is the case with
most SoHo users). It can store up to 170 pages of
incoming fax in case it runs out of toner. The hard-
ware junk fax prohibitor filters out faxes from
unwanted numbers, using caller ID.

The interface is USB, though there is the option
to upgrade to an Ethernet port interface. The MFD
comes with Readiris 7 OCR, Remote Control PCFAX
to send faxes via the PC, and a Network Scan
Module, which helps deploy the machine over a
network. The duty cycle of the printer is 10,000,
which is the same as that of its drum, while the
toner cartridge has a duty cycle of 2,500. Cost per
page comes out to be Rs 1.20—a bit on the higher
side for a laser MFD. Still, like we said, it’s cheap
for a copier-based MFD.

Panasonic KX-FLB802CX
A super-value copier

SEPTEMBER 2007
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The Test Rig
For all the tests, we used 100 gsm (grams per square metre) A4-
size paper from Berga.

Features
We noted features such as printer and scanner resolutions, scanner
type and size, presence of a fax unit and ADF (Automatic Document
Feeder), input tray capacity, and more. For the copier tests, we
noted the MFDs’ ability to work as standalone devices, the
maximum number of pages that can be printed in multi-copy mode,
the facility to reduce or enlarge a copy, and more.
Warm-up Time
All laser MFDs needs to “warm up” when they are first started, only
after which they are ready to function. We noted how long each
MFD took to warm up.
The Printer Tests
We used a text document to test the raw print speeds of the
printers on the MFDs. To test the ability of the MFDs to handle
the various aspects of a regular office document (which can have
both text and graphics), we created a “combi-document” that has
black text interspersed with graphs and images. We used the
Draft and best quality settings for the text and combi-document
tests. We gauged the speeds by sending the Print command and
clocking the time the MFDs took to print the first sheet.

The Scanner Tests
We tested the scanners for speed using an average of five
previews of an A4-size image. We did this with the scanner just
turned on, so as to incorporate the warm-up time. We imported
the same A4-size image at 150 and 600 dpi in Adobe Photoshop
CS2, and scanned a full-text document in B&W mode at 200 dpi.
We then put the scanners through a test to determine colour
differentiating capabilities using the Kodak IT8 card (which has
different shades of colour in a gradient). Next, we scanned the
resolution chart at 300 dpi—this has five boxes consisting of
parallel lines very close to each other, with the boxes arranged in
order of density of the lines. This test was, of course, to check
whether the scanners could scan and differentiate between the
parallel lines, and gave us a measure of the scanners’ ability to
capture fine detail. Finally, we did an OCR test to check the
scanner’s ability to differentiate between light and dark areas: we
scanned a print article to the trial version of ABBYY Fine Reader

Pro 8.0 PE, and counted the
wrongly-interpreted letters.
The Copier Tests
We copied the colour
combi-document to black-
and-white and rated the
MFDs on speed and print
quality. Here, too, we
noted the time it took for
the first print, and then
noted the number of pages
printed in the minute after
that to calculate the
maximum achievable
copies per minute (cpm)
while multi-copying.

How We Tested

The HP M1005 MFP is a printer, scanner, and copi-
er targeted at the entry-level consumer or small

SoHo. It is pretty sleek and doesn’t take up too much
desktop space—just 43.7 x 36.3 cm. It looks good, too,
and weighs a manageable 8.5 kg.

The control panel is intuitive with a two-line, 16-
character display, but the menu offers a limited set
of functions to control. Input tray capacity is 150
sheets, which is fairly good for its class. Output tray
capacity is 100—more than sufficient for this catego-

ry of MFDs. Unlike with
many HP drivers, the
installation for this one
was fast. One Windows
restart later, the M1005
was ready to start multi-
functioning…

Print resolution is the
standard 600 x 600 dpi,
and 32 MB of buffer is good
enough to handle long
print queues. It took only

14.2 seconds to warm up and
start printing. The first text

print took just under 10 seconds,
while the combi-print required 12.8

seconds. Maximum print speed is around 13 ppm for
all kinds of documents. The quality of the prints is
not much to boast about, especially the graphics.
Inverse text, though, is printed better than on more
expensive machines.

The flatbed scanner scans documents of up to
A4 size at 1200 x 1200 dpi in 24-bit colour. It took
us just 7.3 seconds for the monochrome scan, but
it got lethargic during the photo scan, taking
over a minute and a half. Scan quality is excel-
lent, though—colour and detail capture was supe-
rior to that of most of the MFDs we’ve tested thus
far! This was the only MFD here that was perfect in
the OCR test.

The first photocopy took 12.8 seconds, but the
quality was below par—a little washed out.

HP does not bundle their software suite with this
one: it is a “value” product. But they do supply the
impressive Readiris Pro OCR software for PC as well
as Mac. The monthly duty cycle of the M1005 is 5,000
prints; understandable, since this is an entry-level
MFD. The cartridge has a duty cycle of 2,000 prints
and costs Rs 2,961.

Rs 12,999 makes the M1005 an attractive choice
if your work won’t be hampered by the relatively
slow printing speeds and the lack of standalone fax.

HP M1005 MFP
A value product that delivers

Processor
Motherboard
Chipset
RAM
Graphics Card
Host hard drive
OS

Test Rig
Intel Core 2 Extreme X6800 @ 2133 MHz
Gigabyte GA-965G-DS3
Intel 965G 
1 GB Kingston HyperX DDR2 @ 533 MHz
NVIDIA GeForce 7300 GS
Seagate Barracuda 750 GB SATA II
Windows XP with SP2

The Combi-document we used
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We decided to club these two together because the
only thing different about them is that the

MF4150 has an ADF, sheet-fed scanner, and fax.
Both MFDs occupy 39 x 43.2 cm—relatively small.

Their dashboards feature the same button placement;
the MF4150, obviously, also has fax features such as a
dialpad and speed-dial buttons to dial stored numbers
(up to 100). 

Both MFDs are built very well, but as is often the
case, the trays seem a little delicate. The input tray has
a capacity of 250 sheets; the output tray, 100. There is
also a multipurpose tray that holds one sheet of
paper—handy for one-off print jobs on media other
than what you’d normally keep in the input tray. The
ADF of the MF4150 accommodates 35 sheets.

The printer resolution of these MFDs is the lowest
600 x 600 dpi, but as you’ll find out, that fact does not
affect performance. These can’t print as fast as any of
the Brother MFDs, but their warm up times are
markedly lower. The MF4150 takes 15.7
seconds to warm up, and the
MF4122 takes just 7.4. This is the
fastest warm-up time we’ve ever
recorded for a laser MFD! The
first print takes just under 9 sec-
onds. A combi-document will
take the same time to print as a
text document. In text as well as
graphics, the Canon MFDs print
better than any of the other
MFDs in this test. The only prob-
lem was they could not print
white text on black (yes, they
printed just a black block). This
did not change even when we
tried printing at the best quality.

The flatbed scanners sup-
port A4-size paper, and have
an interpolated resolution of
9600 x 9600. The scanners
brought up top-notch per-
formance. In the Kodak IT8 card
scan test, they were not only able to
recognise all 22 shades of grey, but were
also able to reproduce all shades of colour
better than the other MFDs. The OCR test  results
were acceptable. These are the fastest scanners of all
the ones we’ve tested, taking just over 6 seconds to
scan a monochrome document and less than 40 sec-
onds for an A4-size colour document.

Even in the copying department, these are two
of the best! Fine text in the copies was legible, and
shades of grey turned out as close to the original as
we’d think possible. They were the fastest to print
the first copy, taking under 10 seconds.

Canon provides OmniPage SE OCR and Presto!
PageManager to handle your OCR needs. The MFDs

have a monthly duty cycle of 10,000
prints. Now here’s the sore point:
while the toner duty cycle is just
2,000 prints—the lowest of all the
ones we tested—the cartridge is not
inexpensive either, and costs
Rs.3,999. This brings the cost per
page to an uncomfortably high 2
rupees.

The MF4122 is available for Rs
17,995, while the MF4150 is priced at

Rs.25,995. The prices of the units are
not too high, but the running costs make

it hard to recommend these, even considering their
excellent performance.

Canon MF4122 and MF4150
Inexpensive units, high running costs

The MFC-7420 is the bigger sibling of the Brother
DCP-7010—refer to the Budget Laser MFDs section,

earlier in this article. Similar in specifications to the
DCP-7010, the extra this one features is fax function-
ality and an ADF tray that holds 35 sheets of paper.

The design, too, is similar to that of the DCP-7010,
except that the 7420 has additional buttons for fax,
such as the dialpad and eight one-touch dialling but-
tons. Even the footprint is the same. It is a bit heavier,
though, at 9.45 kg. It is built fairly well, except the
flaps don’t seem too sturdy. The input tray has a
capacity of 250, sufficient for most SoHos, while the
output tray holds 100 sheets, again not bad.

The scanner happens to be a bit better than that
on the DCP-7010 in colour scanning, but is very sim-
ilar that one in the other aspects. The result of our
OCR test was even worse than with the 7010.

The printer and the scanner specs are the same as
those of the DCP-7010. Even the printer performance
is similar. This unit has a fax memory of 500 pages.

Copying a page
took around 21 sec-
onds the first time, but
the sustained ppm is
around 20 after that.
Pretty good, we should
say.

This unit features
the USB as well as the
parallel port interface, and
although it does not come with an
Ethernet port, it has that option by
means of a separately-purchasable Ethernet
Print Server. The bundled software comprises the
MFL-Pro suite with PaperPort 9.0SE OCR, and also
a utility to set up the unit over a network.

The MFC-7420 has a toner duty cycle of 3,500,
making for an economical cost per page of 61 paise.
Rs 18,000 for this model is justified because of the
fax, ADF, and sheet-fed scanner.

Brother MFC-7420
A good office all-rounder 
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Canon MF4150
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HP takes care of the mid-range segment in the
form of its LaserJet 3052 and 3055 All-in-One

MFDs. These are identical in all but one aspect: the
3055 has a fax.

These MFDs occupy 49.7 x 40.6
cm, which is on the higher side, but
they weigh just 12.4 kg. The input
tray holds 250 sheets, and an addi-
tional 10 in the “priority tray.” The
output tray holds a hundred prints,
and the ADF holds 50 sheets.

The control panel is intuitive,
with a two-line, 16-character backlit

display. The 3055 also has an alphanu-
meric fax dialling keypad. This keypad is

also there on the 3052, which does not have
a fax unit, so they are only for input.

These MFDs feature high-resolution printers:
1200 x 1200 dpi. The input buffer is 64 MB, which is
sufficient for large print jobs and long queues. The
warm-up time we recorded was about 49 seconds.
Text is crisp, and the legibility of fine print
improves in the best mode, but greyscale graphics
are not produced equally well.

The flatbed scanner supports 24-bit scanning at
an optical resolution of 1200 x 1200 dpi, and this
can be interpolated to up to 19,200 dpi. The drivers
support both the WIA and the TWAIN interfaces.
They clocked average speeds, and were able to
resolve only two of the three blocks in our resolu-
tion chart. They did perform fairly well in the 
OCR test.

The first photocopy took 8.5 seconds—the fastest
in this test. The copies were, however, a tad too
dark.

These MFDs feature a 33.6 Kbps (about three sec-
onds per page) fax with up to 110 pages of fax
memory. The broadcasting and delayed fax features
are standard, and you can broadcast to up to 119
locations. The MFDs feature an Ethernet ports as
well as USB connectivity. 

Both these models come with HP ToolBox FX,
which allow you to monitor device status and also
manage fax tasks and setup alerts. (Alerts are in the
form of e-mail that is sent
to you when events such
as fax reception occur).

The monthly duty
cycle here is 7,000
prints; other MFDs in
this price range general-
ly offer more. The car-
tridge has a duty cycle of
3,000 prints and costs Rs
2,961; cost per page
works out to Rs 1.48,
which is a bit steep.

The HP LaserJet 3052
and 3055 cost Rs 20,999
and Rs 24,499 respectively,
and are almost at par with
the Canon MF4122 and
MF4150 in terms of speed, but trail the latter a lit-
tle in terms of print quality.

HP LaserJet 3052 All-in-One and 3055 All-in-One
Something decent for the mid-range

Lexmark has paid attention to looks here. This is a
rather tall MFD with a grey plastic body, broad at

the top and tapering towards the bottom. The bot-
tom is rather narrow, but it still requires a consider-
able amount of desktop space, with a footprint of 53
x 39.4 cm. Aesthetics have little to do with rugged-
ness, unfortunately. The hinges and the trays of the
X342n are built rather well, but the flaps (especially
the extension flap of the ADF tray) are flimsy.

This MFD has one of the largest paper
capacities of all those we tested; the
input tray holds as many as 550
sheets, while the output tray, 150.

The two-line LCD is backlit.
A niggle here—as you go deeper into

the menu to make changes and then go
back, you are not returned to the previous

menu, but rather to the root menu. You
therefore can’t make many changes at once.

This Lexmark can print at 600 x 600 dpi,
and has 32 MB of buffer (which takes care of

larger documents and long print queues). It ini-
tialises very slowly, taking 48.3 seconds to warm

up. Once warmed up, it is rather quick; our first text

copy printed in 11.4 seconds, and the rest at around
27 ppm. Our combi-document took a bit longer for
the first copy in Draft mode: 17.9 seconds. It took a
much longer 32.1 seconds in the best quality mode.
The rest of the copies of the combi-document were
printed even faster than 30 ppm in Draft mode—this
was the first MFD of the lot to achieve this.

Text quality was generally good. The faint por-
tions of the concentric pattern in Draft mode weren’t
perfect, but were fine in the best quality mode.

In addition to the sheet-fed scanner, there is a
Legal-size flatbed scanner capable of scanning at 600
x 600 dpi. Scanner scores were below average here;
the machine was able to differentiate between
shades of grey, but failed to differentiate well
between different colour shades in the mid-range
colours of the Kodak IT8 chart. In our OCR test, it
made way too many errors, and even failed to recog-
nise bold and large fonts.

The first photocopy took 11.9 seconds, and the
rest were produced in 4.4 seconds each. Text quality
was good, but the graphics looked washed out.

The Lexmark X342n has a USB as well as an
Ethernet port. It comes with Presto! PageManager
which is an OCR software. Lexmark provides a high-
yield 6,000 page duty cycle cartridge, which costs
Rs 4,500, meaning a rather affordable 75 paise per
page. Priced at Rs 23,900, this Lexmark seems to be
a good buy on every front.

Lexmark X342n
Très élégant!

HP LaserJet 3052 
All In One

HP LaserJet 3052 
All In One
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These two are for heavy workloads, and are
therefore more expensive than most of the

other MFDs we’ve tested here. They are almost
identical, with just a few differences.

Build quality is very good, and the 3390 and
the 3392 are as rugged as you’d want them to be
for regular office work. The footprint is 49.5 x 40
cm; these are the heaviest MFDs of the lot, with
the 3390 and 3392 weighing 17.8 and 21.8 kg
respectively. They’re certainly not meant to be
moved around once set up!

While the 3390 has an input
tray that holds 250 sheets, the
3392 can accommodate 500,
thanks to its two trays. You can
opt to augment the 3390’s
capacity to 500 by adding an
optional tray. Both MFDs have an
output tray capacity of 125
sheets. The ADF has a maximum
capacity of 50 pages.

The control panel features
alphanumeric buttons and menu
and cancel controls. There are
three discrete sections for fax,
scan, and copy controls. Sixteen
one-touch dialling buttons are also
present allowing you to speed dial
stored numbers.

The supported print resolution is
1200 x 1200 dpi—the highest we have

in this test; these two MFDs
also support duplex print-
ing. The 3390 has a 64 MB
input buffer, while the 3392
has 128 MB. And if this weren’t
enough, there is the provision
to add a 100-pin DIMM module
to get a maximum input buffer
of 192 MB! The 3392 also fea-
tures a convenient electric sta-
pler so you can quickly staple

together as many as 20 sheets.
We saw high warm-up times in

these cases: around 44 seconds.
Print quality is about average
in Draft mode, but very good
in the best mode. We should
also mention that these print-
ers produce very clean prints—
no carbon splattered anywhere.

The A4-size flatbed scanner
supports 1200 x 1200 dpi (optical)
and an interpolated resolution of
up to 19,200 dpi. The scanner sup-
ports both the WIA and the TWAIN
interfaces. We saw average speeds

at regular resolutions, but it was
faster as the resolution and colour

depth was raised. Captured colour qual-
ity is also not bad, but there were a few

too many errors in our OCR test. 

HP LaserJet 3390 All-in-One and 3392 All-in-One

Heavyweight performers

SMB LASER MFDS (RS 30,001 TO RS 50,000)

HP LaserJet 3390 
All-in-One

HP LaserJet 3392 
All-in-One
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Meant to handle the most rigorous of office
tasks, these two models from Brother are very

similar on all fronts. They have the same footprint
of 53.1 x 45 cm, meaning they’re a bit too large for
most desktops. They even have very similar dash-
boards; the MFC-8860DN just has one additional
button for Duplex (this is signified by the D in the
model name): the MFC-8860DN has an inbuilt
duplexer that lets you print on both sides of a page.
The 50-page ADF also duplexes, allowing you to
scan and fax both sides of a page. You can opt to
copy both single- and double-sided originals to your
choice of single- or double-sided copies using the
front panel menu and button. These feature a five-
line backlit LCD that provides a lot of information.

Built very ruggedly, these weigh a little over 16.5
kg, making them the heaviest in this test. The input

tray holds 250 sheets, while the output
tray supports 150 sheets—more
than adequate, we’d say. They

also have a multipurpose
paper tray with a capacity
of 50 sheets.

The printer, fax, and
scanner specifications are

exactly the same for the two.
The printer supports a high

hardware resolution of 1200 x
1200, and comes with 32 MB of

buffer memory, expandable to
544 MB. Printing is very fast with

text documents, and even with our
combi-document, the first page takes

12 seconds instead of under 10 seconds
for the text document—hardly a differ-

ence. Text is not sharp at Draft quality, but
it is flawless at best quality. We saw fine text repro-

duced with
good detailing
in high quality
mode.

Both these
MFDs have large
Legal-size flatbed
scanners in addi-
tion to the sheet-
fed scanner option.
The scanner resolu-
tion is 600 x 2400
dpi (optical) at 24-bit
colour depth. The scanner is fast, taking under 9
seconds to scan a monochrome document, and 100
seconds for a colour document. We saw colours and
fine details captured beautifully. Both units per-
formed very well indeed in our OCR test.

The dashboard sports the one-touch dialling
option for up to 40 fax numbers. These MFDs have
plenty of fax memory, 600 pages. A handset would
have been a welcome addition, but neither of these
two models even have the option to add one.

The first document copy took us 12 seconds,
and it reached a speed of 30 ppm thereafter. The
copies we saw were good, but shades of grey—and
also some finer details—weren’t perfect.

In addition to the USB and parallel port inter-
faces, these two also feature the fast 10/100
Ethernet interface. Bundled is the MFL-Pro Suite,
which allows you to send faxes using your PC if
you do not want to use the standalone fax exclu-
sively. PaperPort 9.0SE adequately takes care of
your OCR needs.

A bundled Driver Deployment Wizard helps you
set up these as network MFDs. Like the other
Brother MFDs, these ship with drivers for Mac in
addition to those for Windows.

The MFC-8460N and MFC-8860DN have a toner
duty cycle of 3,500; the toner cartridge costs just
Rs 2,150, meaning an economical 61 paise per
page. With a printer duty cycle of 20,000 pages
per month, the MFC-8460N and the MFC-
8860DN—which cost Rs 33,750 and 41,650 respec-
tively—are more suited for larger businesses, of
the order of an enterprise.

PhoneCompany E-mailBrand
Brother

Canon

HP

Lexmark

Brother International (India) Pvt Ltd

Canon India Pvt Ltd

Hewlett-Packard India Sales Pvt Ltd

Cyberstar Infocom

40988900

1800-345-33-66 

0124-256611

9343661888

info@brother.in

info@canon.co.in

samir-s_shah@hp.com

achaiah@cyberstarindia.com

Contact Sheet—Laser MFDs

Featured here is a 33.6 Kbps fax with up to 250
pages of fax memory. The broadcasting and
delayed fax features are standard, and you can
broadcast to up to 119 locations. In addition to
the RJ-11, there is an Ethernet port as well as USB
connectivity, but there’s no parallel port. Take
note of this if you have an older system.

HP bundles along the HP ToolBox FX, using
which you can monitor device status and also
manage fax tasks and set up e-mail alerts—this
means you’ll receive an e-mail when an event,
such as a fax reception, occurs. HP provides
Readiris Pro 11 for Windows, a premium OCR soft-
ware, and also Readiris Pro 11.5 for Mac.

The monthly duty cycle of these MFDs is
10,000 prints. We did expect a higher duty cycle,
though, because these two MFDs are in the high-
end category and also expensive. The cartridge
has a duty cycle of 3,000 prints and costs Rs 3,025;
cost per page works out to just over a rupee.
While we’ll admit that the print quality is in 
a class of its own, the running cost is on the 
higher side.

The HP LaserJet 3390 and 3392 are priced at 
Rs 36,999 and Rs 46,999 respectively. Get one 
of these only if print quality and speed is of 
prime importance and if running costs don’t mat-
ter much.

Brother MFC-8860DN

Brother MFC-8460N

SEPTEMBER 2007
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BRAND 
MODEL

Price
Price of Toner
Cost Per Page
Comments

Grand Total (Out of 100)
Features (Out of 45)
Performance (Out of 50)
Price Index (Out of 5)
Features
Printing
Printing Engine
Hardware Resolution (dpi x dpi)
Input Buffer (MB)/Upgrd. Possible (MB/✖ )
Input/Output Tray Capacity
Multipurpose Paper Tray (✔ /✖ )/Capacity
Automatic Duplex Printing (✔ /✖ )
Printer/Toner Duty Cycle (Prints)
Scanning
Scanner Type
Optical Resolution (dpi x dpi)
Size/Bit Depth
ADF (✔ /✖ )/Capacity
Scanner Lock (✔ /✖ )
Standards Compliance
Copying 
Enlarge/Reduce (✔ /✖ )
Multi-copying (No. of Copies)
Fax
Handset Provided (✔ /✖ )
Number of Pages Stored
Misc
Menu Interface (Scale of 10)
Connectivity
Weight
Footprint (W x D) CM2

Power Consumption: Max/Ready/Stdby (W)
Build: Flaps/Hinges/Trays (Scale of 10)
Drivers and Setup
Driver UI/Ease of Setup (Scale of 10)
Bundled Software

Performance
Warm-up Time
Printing
First Text Print (Draft)
First Text Print (Best Quality)
First Combi-print (Draft)
First Combi-print (Best Quality)
Text Print (Draft/Best) (Scale of 10)
Concentric Ptrn. (Draft/Best) (Scale of 10)
Scanning
Mono@200 dpi/Photo@600 dpi (sec)
OCR Test: No. of Errors
Copying 
Speed/Max Copies per Minute
Quality (Scale of 10)

Scoreboard                      SMB (Rs 30,001 - Rs 50,000)
HP

LaserJet 3390 All-in-One

Rs 36,999
Rs 3,025
Rs 1.01
+ Priced right, good print quality

– Photocopies too dark

67.21
33.50
29.61
4.10

Printer-based
1200 x 1200
64 MB / 192 MB
250 / 125
✔ / 1
✔

10000 / 3000

Flatbed and Sheet-fed
1200 x 1200
A4 / 24
✔ / 50
✖

TWAIN, WIA

✔

99

✖

250 pages

7
USB, LAN
17.8 kg
49.5 x 40
355 / 15 / 11
7 / 7 / 7

8 / 5
HP ToolBoxFX, Readiris Pro
for PC and Mac

43.9 sec

14.2 sec
20.9 sec
22.8 sec
45.2 sec
7 / 8.5
6 / 6

17.9 / 59.8
13

14 sec / 20
6

Brother
MFC-8860DN

Rs 41,650
Rs 2,150
Rs 0.61
+ Good performer, economical

– High power requirements

76.90
35.73
37.52
3.65

Printer-based
1200 x 1200
32 MB / 544 MB
250 / 150
✔ / 50
✔

20000 / 3500

Flatbed and Sheet-fed
600 x 2400
Legal / 24
✔ / 50
✔

TWAIN, WIA

✔

99

✖

600 pages

7
USB, Parallel, LAN
16.7 kg
53.1 x 45
1092 / 85 / 14
7 / 7 / 7

7 / 7
MFL-Pro Suite, PaperPort
9.0SE, BRAdmin, Driver
Deployment Wizard

22 sec

9 sec
9 sec
12.4 sec
12.4 sec
6.5 / 8
7 / 8

8.7 / 98.2
27

12 sec / 30
6.5

HP
LaserJet 3392 All-in-One

Rs 46,999
Rs 3,025
Rs 1.01
+ Dual input trays

– Expensive

66.68
33.91
29.54
3.23

Printer-based
1200 x 1200
128 MB / 192 MB
500 / 125
✔ / 1
✔

10000 / 3000

Flatbed and Sheet-fed
1200 x 1200
A4 / 24
✔ / 50
✖

TWAIN, WIA

✔

99

✖

250 pages

7
USB, LAN
21.8 kg
49.5 x 40
355 / 15 / 11
7 / 7 / 7

8 / 5
HP ToolBoxFX, Readiris Pro
for PC and Mac

44.1 sec

14 sec
21.2 sec
22.6 sec
45.4 sec
7 / 8.5
6 / 6

17.7 / 59.7
11

14.3 sec / 20
6

Brother
MFC-8460N

Rs 33,750
Rs 2,150
Rs 0.61
+ Very economical; fast printing

– High power requirements

74.45
33.03
36.92
4.50

Printer-based
1200 x 1200
32 MB / 544 MB
250 / 150
✔ / 50
✖

20000 / 3500

Flatbed and Sheet-fed
600 x 2400
Legal / 24
✔ / 50
✔

TWAIN, WIA

✔

99

✖

600 pages

7
USB, Parallel, LAN
16.5 kg
53.1 x 45
1092 / 85 / 14
7 / 7 / 7

7 / 7
MFL-Pro Suite, PaperPort
9.0SE, BRAdmin, Driver
Deployment Wizard

25.6 sec

9.2 sec
9.3 sec
12.2 sec
12.4 sec
6.5 / 8
7 / 8

8.8 / 102.7
2

12 sec / 24
6.5
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All Brands Provide One Year On-Site Warranty



BRAND 
MODEL

Price
Price of Toner/Drum
Cost Per Page
Comments

Grand Total (Out of 100)
Features (Out of 40)
Performance (Out of 45/50*)
Price Index (Out of 15/10*)
Features
Printing
Printing Engine
Hardware Resolution (dpi x dpi)
Input Buffer (MB)/Upgrd. Possible (MB/✖ )
Input/Output Tray Capacity
Multipurpose Paper Tray (✔ /✖ )/Capacity
Automatic Duplex Printing (✔ /✖ )
Printer/Toner/Drum Duty Cycle (Prints)
Scanning
Scanner Type
Optical Resolution (dpi x dpi)
Size/Bit Depth
ADF (✔ /✖ )/Capacity
Scanner Lock (✔ /✖ )
Standards Compliance
Copying 
Enlarge/Reduce (✔ /✖ )
Multi-copying (No. of Copies)
Fax
Handset Provided (✔ /✖ )
Number of Pages Stored
Misc
Menu Interface (Scale of 10)
Connectivity
Weight
Footprint (W x D) CM2

Power Consumption: Max/Ready/Stdby (W)
Build: Flaps/Hinges/Trays (Scale of 10)
Drivers and Setup
Driver UI/Ease of Setup (Scale of 10)
Bundled Software

Performance
Warm-up Time
Printing
First Text Print (Draft)
First Text Print (Best Quality)
First Combi-print (Draft)
First Combi-print (Best Quality)
Text Print (Draft/Best) (Scale of 10)
Concentric Ptrn. (Draft/Best) (Scale of 10)
Scanning
Mono@200 dpi/Photo@600 dpi (sec)
OCR Test: No. of Errors
Copying 
Speed/Max Copies per Minute
Quality (Scale of 10)

Scoreboard                      Budget (Up to Rs 16,000)
HP

LaserJet M1005 MFP

Rs 12,999
Rs 2,961 / NA
Rs 1.48
+ Sleek; excellent scanner

– Poor in the graphics test

62.48
19.36
31.54
11.58

Printer-based
600 x 600
32  MB / ✖
150 / 100
✖ / NA
✖

5000 / 2000 / NA

Flatbed
1200 x 1200
A4 / 24
✖ / NA
✖

TWAIN, WIA

✔

99

NA
NA

5
USB
8.5 kg
43.7 x 36.3
230 / 7 / 7
6 / 6 / 6

8 / 7
Readiris Pro for PC and
Mac

14.2 sec

9.7 sec
9.8 sec
12.8 sec
12.8 sec
6 / 7
5 / 5

7.3 / 91.5
0

12.8 sec/13.95
5

Panasonic
KX-FLB802CX

Rs 15,995
Rs 3,000 / Rs 4,000
Rs 1.20
+ Inexpensive copier-based

– No WIA support

61.17
25.04
26.72
9.41

Copier-based
600 x 600
32 MB / ✖
250 / NA
✖ / NA
✖

10000 / 2500 / 10000

Flatbed and Sheet-fed
600 x 1200
A4 / 24
✔ / 40
✖

TWAIN

✔

99

✔

170 pages

6
USB
15.5 kg
44 x 44.5
900 / 28 / 11
6 / 6 / 7

7 / 5
Device Monitor, Readiris 7,
Remote Control PCFAX,
Network Scan Module

19.8 sec

14.7 sec
14.9 sec
16.9 sec
16.9 sec
7 / 8
7 / 7.5

27.2 / 122.6
25

18.3 sec / 16.67
4
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* For SoHo (Up to Rs 16,001 to Rs 30,000)
All Brands Provide One Year On-Site Warranty

Brother
DCP-7010

Rs 11,150
Rs 2,150 / NA
Rs 0.86
+ Fast, economical printing

– No fax

64.01
19.90
30.61
13.50

Printer-based
2400 x 600
16 MB / ✖
250 / 100
✖ / NA
✖

10000 / 2500 / NA

Flatbed
600 x 2400
A4 / 24
✖ / NA
✖

TWAIN, WIA

✔

99

NA
NA

5
USB, Parallel
8.3 kg
43.2 x 39.5
460 / 75 / 10
6 / 6 / 6

7 / 7
MFL-Pro Suite,
PaperPort 9.0SE,
BRAdmin, Driver
Deployment Wizard

19.1 sec

10.5 sec
10.9 sec
14.1 sec
13.7 sec
6 / 8
7 / 7

13.7 / 231.1
41

19.7 sec / 20.69
7

Canon
imageCLASS MF4122

Rs 17,995
Rs 3,995 / NA
Rs 2.00
+ Good print quality

– High cost per page

64.56
23.08
32.48
9.00

Printer-based
600 x 600
32 MB / ✖
250 / 100
✔ / 1
✔

10000 / 2000 / NA

Flatbed
NA
A4 / 24
✖ / NA
✖

TWAIN, WIA

✔

99

NA
NA

5
USB
12.4 kg
39 x 43.2
710 / NA / 3
7 / 7 / 6

8 / 7
OmniPage SE OCR, Presto!
PageManager

7.4 sec

8.8 sec
8.9 sec
12.8 sec
13.2 sec
8 / 7.5
6 / 6

6.6 / 37.1
3

9.8 sec / 18.18
8

Brother
MFC-7420

Rs 18,000
Rs 2,150 / NA
Rs 0.61
+ Great cost per page

– No Ethernet port

65.66
24.36
32.30
9.00

Printer-based
2400 x 600
16 MB / ✖
250 / 100
✖ / NA
✖

10000 / 3500 / NA

Flatbed and Sheet-fed
600 x 2400
A4 / 24
✔ / 35
✖

TWAIN, WIA

✔

99

✖

500 pages

5
USB, Parallel
9.45 kg
43.2 x 39.5
1032 / 75 / 10
6 / 7 / 7

7 / 7
MFL-Pro Suite, PaperPort
9.0SE, BRAdmin, Driver
Deployment Wizard

21.7 sec

10.8 sec
10.9 sec
14 sec
14 sec
6 / 8
7 / 7

12.9 / 230
51

21.1 sec / 20
7
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At The Podium
Taking into account all essential aspects—fea-
tures, overall performance, price, and running
costs—we can state our recommendations by
saying which products won our awards.

In the Budget category, the Brother DCP-
7010 and the HP LaserJet M1005 MFP fought it
out for Gold. While the DCP-7010 offers great
value as well as speed and performance, the
M1005 has one of the best scanners in this test.
We award the Brother DCP-7010 the Digit Best
Buy Gold in this category for its better print
quality and its unmatched cpp of 86 paise.

Nothing came close to the Brother MFC-
7420 in terms of features in the SoHo category.
It prints very fast and produces decent output.
Monthly printer duty cycle is a healthy 10,000
prints. Fax-modem memroy is as large as 500
pages, and cpp is just 61 paise—all meaning a
Digit Best Buy Gold in this category!

The Canon imageCLASS MF4122 excels in
print quality. The MFD with the lowest warm-
up time in the entire test, it did not disappoint
in speed. The scanner is very good in terms of
capturing colour and detail, and it was fairly
accurate in our OCR tests as well. Based on
this, it receives the Digit Best Buy Silver.

Now for the SMB category: the Brother-
MFC-8860DN and MFC-8460N not only support
a memory upgrade to 544 MB, but also a very
large monthly duty cycle of 20,000 prints.
These are fast performers, and print quality is
decent. These are the only MFDs in this catego-
ry with a Legal-size flatbed scanner. They fea-
ture all three interfaces—USB, Ethernet, and
parallel port. Complementing all this is excel-
lent speed and a cpp of just 61 paise. We award
the Brother MFC-8860DN the Digit Best Buy Gold,
and trailing a bit on features, the Brother MFC-
8460N wins the Digit Best Buy Silver.

A Few Concluding Notes
If you mostly print large text documents, we
believe you should choose a mono laser MFD.
If you need to print colour photographs, there
are colour laser MFDs, but are expensive; a
colour inkjet makes more sense. Also consider
the running costs: the average laser MFD con-
sumes a lot of electricity—some heavy-duty
ones can even go past the 1000 W mark.

The HP machines performed well; they pro-
duced the cleanest of all the prints, but their
pricing was the problem.

We should also mention that HP MFDs
have come up with little things that make for
a better MFD—such as the inbuilt electronic
stapler and the superb OCR application from
IRIS. Also, the wide availability of their prod-
ucts and services across the length and
breadth of the country—an important factor
for any consumer—needs to be borne in mind.

The above could have led to the higher
pricing, but HP’s products did walk the talk.

We return to what we stated at the outset.
If you’re worrying about whether it’s wise to
go with an MFD rather than multiple devices,
we say an MFD these days is more likely than
not to prove reliable. 

jayesh_limaye@thinkdigit.com

SoHo (Rs 16,001 - Rs 30,000)
HP

LaserJet 3052 All-in-One

Rs 20,999
Rs 2,961 / NA
Rs 1.48
+ Good software bundle

– No fax, yet expensive

57.71
23.24
26.76
7.71

Printer-based
1200 x 1200
64 MB / ✖
260 / 100
✖ / NA
✖

7000 / 2000 / NA

Flatbed
1200 x 1200
A4 / 24
✔ / 50
✖

TWAIN, WIA

✔

99

NA
NA

7
USB, LAN
12.4 kg
49.7 x 40.6
300 / 13 / 10
6 / 7 / 6

8 / 5
HP ToolBoxFX, Readiris
Pro for PC and Mac

47.5 sec

13.2 sec
19.9 sec
22.1 sec
45.1 sec
7 / 8
6 / 6

19.9 / 67.3
1

8.7 sec / 19.35
6

Lexmark
X342n

Rs 23,900
Rs 4,500 / NA
Rs 0.75
+ Good looks, economical

– Slow in graphics documents

63.20
27.10
29.32
6.78

Printer-based
600 x 600
64 MB / ✖
550 / 150
✔ / 1
✔

15000 / 6000 /  NA

Flatbed and Sheet-fed
600 x 600
Legal / 24
✔ / 50
✔

TWAIN, WIA

✔

99

✔

NA

7
USB, LAN
16.33 kg
53 x 39.4
420 / 70 / 13
5 / 7 / 7

4 / 7
Presto! PageManager

48.3 sec

11.4 sec
11.4 sec
17.9 sec
32.1 sec
8 / 7
4 / 4

17.4 / 71.9
36

11.9 sec / 13.64
5

HP
LaserJet 3055 All-in-One

Rs 24,499
Rs 2,961 / NA
Rs 1.48
+ Fast copying, good scanner

– Slow warm-up

58.74
25.38
26.75
6.61

Printer-based
1200 x 1200
64 MB / ✖
260 / 100
✖ / NA
✖

7000 / 2000 / NA

Flatbed and Sheet-fed
1200 x 1200
A4 / 24
✔ / 50
✖

TWAIN, WIA

✔

99

✖

110 pages

7
USB, LAN
12.4 kg
49.7 x 40.6
300 / 13 / 10
6 / 7 / 6

8 / 5
HP ToolBoxFX, Readiris
Pro for PC and Mac

49.1 sec

13.4 sec
19.7 sec
22 sec
44.5 sec
7 / 8
6 / 6

19.8 / 67.6
1

8.5 sec / 19.35
6

Canon
imageCLASS MF4150

Rs 25,995
Rs 3,995 / NA
Rs 2.00
+ Good print quality

– High running costs

64.06
26.46
31.37
6.23

Printer-based
600 x 600
32 MB / ✖
250 / 100
✔ / 1
✔

10000 / 2000 / NA

Flatbed and Sheet-fed
NA
A4 / 24
✔ / 35
✖

TWAIN, WIA

✔

99

✖

256 pages

5
USB
13.4 kg
39 x 43.2
710 / NA / 3
7 / 7 / 6

8 / 7
OmniPage SE OCR, Presto!
PageManager

15.7 sec

8.5 sec
8.8 sec
12 sec
14.4 sec
8 / 7.5
6 / 6

6.2 / 38.3
3

9.8 sec / 18.75
8 DIGIT SEPTEMBER 2007
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Asfaq Tapia

Advertising your business used to be a
costly affair; now, however, if you have a
small business and want to advertise it

without spending too much, there is a range of
methods by which you can effectively reach
your target audience—thanks to the Internet.
Read on: we’ll show you the best ways to build
your brand on the Internet, with just a yearly
kitty of a lakh!

Search Engine Marketing
Before you do anything, get your Web site up and
running (domain names for your site can be
bought for as little as Rs 500 a year). If it’s pretty
and professional-looking, so much the better.

Your site can act as a brochure of services your
business offers. These days, most new business
is facilitated by searches conducted on search
engines, predominantly Google. If you are a
small business, it is hardly likely for customers to
search for your company name—the industry you
work in will likely be searched for. Hence search
engine marketing. 

It is important to create content with your
target audience in mind in order to make their
experience of visiting your site relevant and
useful. It is also essential to have your Web site
built by a professional who will optimise it so
that your name appears among the top search
results for a search query relating to your
industry. Search Engine Marketing (SEM) com-
prises two methods: Search Engine Optimisa-
tion (SEO) and Pay-Per-Click (PPC) Marketing.
We’ve mentioned SEO in The Future of Search
(August 2005) and The First Page (November 2005).
PPC refers to paid search results that appear at
the top and in the right-hand columns on
Google, Yahoo!, and Live Search when most
searches are conducted.

The SEM strategy for your Web site could
revolve around the following factors: 

Time frame: Since SEO relies on the Web
site first being indexed by the search engines,
it takes longer to start working for you than
does PPC. Search engine “spiders” need to
index the changes to your site made by the
SEO before you see improvement in your site
ranking. If a business owner wants to see his
site ranking higher in search results over a
longer period, SEO is the way to go. However,
if you need to market for a specific occasion,
like selling fireworks during the Diwali
season, and plan to advertise this in
September, PPC marketing would work
better—it can be implemented in a very short
span of time. PPC means you bid for an ad spot
and you pay the search engine each time
someone clicks on your listing. You could end
up paying Rs 1,500 a month (our estimate for
this example) by “targeting” four keywords.
(To explain the idea a little, you could target
the keywords “[your city]”, “fireworks”,
“crackers”, and “discount”. When any of these
keywords are searched for, your ad will appear
in the search engine).

Keywords being targeted: It is difficult for a
business with a new Web site to rank high for
very generic keywords like “laptop” or “car”.
Here you need to take a call on the geographical
area you want to do business in, and then work
on specific keywords, keeping budget in mind.
Again, it is possible to target a specific city
using PPC by using the city name as a keyword,
which is not possible with SEO.

The Internet can
be an
inexpensive way
to advertise your
business. Find
out how!

Cheapest Trumpet

Illustrations Chaitanya Surpur
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Age of the site: It is easier and quicker to rank
an older Web site with more unique content
pages compared to a brand new Web site. A call
therefore needs to be taken for the marketing
strategy keeping the age of the site in mind.

A search for “Search engine optimisation
India” will bring up some of the top companies
that provide that service. SEO is not cheap; it
can take you anywhere between Rs 30 to 40
thousand to SEO your Web site for six months.
Going with a PPC campaign depends on the
number of keywords you target, and the dura-
tion of the campaign.

Corporate Blogging
According to Jupiter Research, a leading
authority on the impact of the Internet and
emerging consumer technologies on business,
35 per cent of large companies plan to start cor-
porate blogs this year. The idea behind corporate
blogging is to form a direct and lasting impres-
sion on your customer, and to build trust, which
translates to more business.

A corporate blog should aim to highlight
the issues, concerns, successes, and future
strategies of the company, and can be used as
an effective tool to target the right audience. It
can also be used to announce new services or
products. Once your blog is ready, you can
advertise its presence by adding it to online
wikis—these are freely modifiable, so you can
include your blog. Sites like NewPR (www.the-
newpr.com),  BlogFlux (http://dir.blogflux.com/
tag/corporate), and Bloggeries (www.blog-
geries.com/Business/Corporate) allow you to
index your blog in directories related to your
field. The blog can then be used to quickly
gather feedback about new and existing prod-
ucts and issues.

Creating a blog is relatively inexpensive. We’d
suggest WordPress (http://wordpress.org)—it’s free,
and gives you detailed instructions on how to set
up a blog. All you really have to do is host it on
your Web space. However, maintaining a blog—as
in keeping it up-to-date—is time-consuming.
Remember a blog doesn’t help much if your busi-
ness is not directed towards the end user.

A negative with corporate blogging is that
there could be negative comments and feedback
on the blog. Still, companies like WATConsult
(www.WATConsult.com), RelevantNoise (www.rel-
evantnoise.com), and Cymfony
(www.cymfony.com) specialise in “Blog Moni-
toring and Crisis Management,” and for about
Rs 8,000, will advise you on the right course of
action if and when things go sour.

It is better to optimise a site using
SEO, which will ensure a steady
flow of traffic over a longer period
of time, rather than go in for PPC”

Vishal Sampat
CEO, Convonix Inc.
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Micro-Marketing
A fast-emerging medium for advertising your
online presence are social networking sites.
These sites allow users to create micro-commu-
nities amongst themselves based around user
interests. This gives you the opportunity to
advertise your products to the correct audience.
So if you are a dog-food manufacturer, just go
to a dog lover’s community and post on the
forums there! You can create excitement by
offering discounts. You could mass e-mail the
entire community, but that is risky. People just
might not like unsolicited e-mail… it might
seem like you’re being too pushy.

Mobile Marketing
This medium is fast catching the fancy of many
advertisers. Currently, all methods to advertise
on mobile phones remain invasive, as in
annoying SMSes and phone calls. There is, how-
ever, a fast-increasing list of Web sites that pay
users to receive SMSes. Sites like Adginger
(www.adginger.com) and YouMint
(www.youmint.com) allow users to list their likes
and preferences when they sign up, so you
advertise to a select target audience.

One of the most compelling reasons to use
this form of marketing is that the user has
requested to receive ads of a specific nature. This
is one of the most personal mediums to adver-
tise on—people carry their mobiles with them.
This therefore has the fastest time-to-market.
There is also a small component of viral mar-
keting involved: a user could forward your mes-
sage to others who might be interested.

Costs vary from site to site. However,
approximate costs per SMS go like this:
Number of SMSes Cost per SMS (Rs)
1 to 5,000 2.00
5,001 to 10,000 1.75
10,001 to 25,000 1.50
>25,000 Negotiable

Since these are the initial days of mobile
advertising, the database of registered users is
not very large; it’s a good idea to advertise in the
1 to 5000 band.

Viral Marketing
This term is often defined as a technique that
uses existing networks to produce increased
brand awareness by word of mouth. PR compa-
nies manage portfolios of small businesses in
the manner of press releases for new products or
services, and profiling corporate stories for sub-
mission to news Web sites as well as magazines

and newspapers. These can be handled for
approximately Rs 15,000 per year.

This technique could involve, for example,
the creation of eye-catching Web promotions in
the form of Flash animations and videos that can
be viewed at YouTube (www.YouTube.com) and
similar sites. If you are in the consumer goods,
entertainment, or foods industry, you could col-
laborate with sites like Hungama
(www.hungama.com) or Contests2Win (www.con-
tests2win.com) to create promotional games
around your products. With prizes as an incen-
tive, you can engage in brand-building—cus-
tomers might recommend interesting games to
their friends, for example.

According to Sandeep Krishnamurthy, asso-
ciate professor of marketing and e-commerce at
the University of Washington, firms planning to
implement viral marketing must understand its
negative aspects:

Brand control: There is no control over the
branding of your products. You can’t predict
who an individual will contact after seeing your
message. There is no control over what may be
added to your original message—and that can
affect your product branding.

Uncharted growth: Since viral marketing
depends so much on users to advertise your
product, it might lead to unwanted growth
paths for the brand. You might look at Hotmail,
which grew to be one of the leading Web mail
providers in India. Thanks to the Hotmail ad
appended to the bottom of every outgoing mail,
quite a few users out of India signed up for the
service. This worked well for Hotmail, but it
could be a negative for a small business if the
advertising is not done correctly. If users
perceive the “viral ad” negatively, a damage
control exercise will take up more time and
money than originally allocated.

Lack of measurement: You can’t always
track who viewed your promotions and what
actions they took thereafter. In most cases, it is
not possible to gauge if new business was
generated due to your viral marketing efforts.

Spam Threats: Especially when there are
incentives to promote a product to a friend, an
unscrupulous individual may resort to
spamming, which could ruin your reputation.

Having said that, there are several
instances where viral marketing has been used
to good effect. Take Zapak.com for example,
India’s largest gaming site, who recently part-

The PR industry has started creat-
ing a digital influence at a budget
well below 1 lakh rupees”

Meenakshi Bhalla
President, 

Ogilvy Public Relations Worldwide (India)

It is very important to read the pro-
file of those on social networks to
make sure you are targeting your
prospective audience”

Rajiv Dingra
Founder, 

WATConsult.com
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nered with St Xavier’s College in Mumbai to
host their college fest, Malhar. They become
their “Official Internet Partner.” They gener-
ated a buzz about their services by hosting
games and events at the fest. More recently,
Ogilvy, large PR company, handled a viral mar-
keting campaign for Cadbury, which aimed at
highlighting the idea that contamination in
their chocolates was caused not during manu-
facture but in storage.

Business Directories
Registering your business under the myriad of B2B
directories is one of the surest bets for getting new
business. There are tons of Web sites, free and paid,
that allow you to catalogue your business. 

Advertising in prominent international B2B
directories is important. Directories like Busi-
ness.com allow you to buy a yearly listing for
$199 (Rs 8,100). Closer to home, some of the
most prominent B2B directories are 
IndiaMART (www.IndiaMART.com), IndianYel-
lowPages (www.IndianYellowPages.com), Yahoo!
Directories (in.dir.yahoo.com), and EIndiaBusi-
ness (www.EIndiaBusiness.com). Several testi-
monials from these sites suggest that a lot of
business can be generated from them. All these
directories are free to list in.

Niche B2B directories are another option. For
example, there are sites like MagicBricks
(www.magicbricks.com), on which you can put up
information about all your properties on sale,
lease, or rent, and RentACoder (www.renta-
coder.com) from where one can choose to take up
programming projects.

Other Methods
There are quite a few other ways to promote your
brand on the Internet; quite a few of which don’t
require you to spend a rupee.

Content Participation: These days, it is not
only important to have a Web site, but also to
participate in creating
information. Sites like
Wikipedia (http://en.wikipedia
.org) and Yahoo! Answers
(http://in.answers. yahoo.com)
attract a lot of traffic and can
be a great place to advertise.
The idea is, you participate in
building the content at these
sites. Just having a small link
to your site in the References
section of Wikipedia—or
among the answers at Yahoo!
Answers—can drive traffic to your
site. Another avenue is social news
sites like Digg (www.digg.com) and
Reddit (www.reddit.com) which
display content on their
front page based on
the number of
times that
content has
been voted for by
its users. 

It is impor-
tant to con-

tribute meaningful content. Spam-posting your
site’s link all across such sites will cause your
brand more harm than good. Post intelligently
and mention your company only when required
or under a relevant topic. Also take up mem-
bership at various Internet forums and add
those links to your signature. Then, whenever
you post in the forums, your signature with
your company URL will appear below every post
in that forum.

E-mail signatures: Add your Web site URL to
your e-mail signature.

Affiliate Marketing: This involves your
placing ads and links on a Web site in
exchange for having their links and ads on
yours. Then there are high-traffic sites that
unknowingly facilitate affiliate marketing,
such as eBay (www.ebay.in). These have a large
number of users who advertise their Web sites
within their store pages or at the end of every
item up for sale.

Link Building: This is a grey area in SEO; the
ranking of your Web site in a search result
depends on how many URLs on the Internet
link back to your site. To increase the number of
links that link back, you can have many links
on a page that cross-link to various sections of
your own site. When a search engine crawler

indexes your page, it will see a large
number of links, thereby increasing

your site’s ranking in a search
result.

Endnote
For short-term advertising, it

is best to go with PPC market-
ing coupled with a viral cam-

paign in the form of discounts
offered at social networking com-
munities. You could also create a
buzz around it by posting the

information on Digg and
Reddit. For recurring, long-

term returns, however, it is
best to SEO your site and

participate in con-
t e n t - b u i l d i n g
activities on the

Internet.
Naturally,

not every-
thing we’ve

talked above
will work for you.

We do hope some of it
does, though. 

asfaq_tapia@thinkdigit.com

Adding links to Google Talk and
your e-mail signature is the cheap-
est way to market yourself online”

Rajesh Lalwani
CEO, 

Blogworks.in
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We have deployed security solutions in keeping with our budget,
requirements, and nature of business.  All our Desktops have
McAfee’s anti-virus software installed, and we’ve also deployed

SonicWALL firewall. That acts as the Intrusion Detection System. The
best feature of SonicWALL is the option of multi-Ethernet connections,
which isn’t found in any other firewall.

McAfee’s ePolicy Orchestrator auto-updates virus definitions and
sends them to connected machines, and the Microsoft Windows
Security Update Service downloads the latest security patches and
pushes them to all the machines. We use Netcore’s mail solution—
which keeps out spam and phishing mails.

Constant monitoring of the network security is done through a single
console, and reports from the logs generated are automatically sent to
pre-defined users. After deploying our security solutions, we’ve enjoyed
high protection from viruses and better bandwidth management.

Every company has a wide variety of
diverse network components that have
an effect on security—users, firewalls,

and network topologies. The various security
tools in the market are worth investing in if
they have a substantial ROI.

Security programs and services are
designed to meet the needs of small and
medium businesses—basically to reduce
costs, improve productivity, and protect data.
By deploying a well-designed firewall along
with DMZ (De-Materialized Zone, to host all
Web-based applications), Desktop anti-virus,
and operating system patch updates—apart
from implementing freeware tools like Snort
and Nesses—we can find and fix
vulnerabilities in the network.

Each company has its own network
infrastructure, security policies, and tools for
managing security. How you seamlessly
integrate these acquisitions into your company
and still keep all IT assets secure should be
part of your IT security project plan. 

An easy way to begin looking at network
security is via the well-known CIA
(Confidentiality, Integrity, and Availability).
Nearly 80 per cent of the threat is from
internal users; keeping this in mind, we can
plan accordingly to keep our business secure.

Rajesh Krishnappa
Principal IT engineer
FCG Software Services India
Pvt Ltd

Ravish Jhala
Manager, ICT
Mars Hotels and Restaurants
Pvt Ltd
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Cause For
We’re increasingly seeing companies of all kinds becoming aware of security issues. What are they
doing about it? Some outsource, some see internal users as the biggest threat… these and other
viewpoints discussed
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K. Ramaswamy
M. I. S. Manager
The Ruby Mills Ltd

Security of data and the network is crucial for any business,
irrelevant of size. At Hikal Ltd, we have deployed security solutions
at the Desktop, Network, and Service Provider levels. For the

Desktop level, we’ve been using three levels of security—McAfee’s
AntiVirus software, special data-encryption software, and user
authentication for accessing any machine and the Internet. This is
necessary to ensure security at the internal level.
At the network level, we use a proxy server for converged Internet

access. We have outsourced our mail solution to IBM and about 60 per
cent of spam as well as infected and phishing mails are blocked. We’re
thus able to save our network resources, and this also means time saved
for senior management. Outsourcing means no efforts are required on
our part to monitor and manage security—important, because getting
people with multi-faceted skills to manage all IT needs is very difficult.
We believe that other businesses should outsource their security
solutions such as mail systems and choose products / services
specialised for their security needs.

Falgun Shukla
Sr Gen. Manager IT
Hikal Ltd 

Our IT requirements are fairly limited. Only basic computer
systems are required at our office. We use Quick Heal’s
anti-virus solution for the Desktops. All systems undergo

regular scanning for viruses and Trojans. We have outsourced
our IT security services.

Reports and logs of the scanning are maintained. So far, we’ve
never had a problem with the security of our network or data.
Still, we always look to keep our systems protected from virus
attacks and spam. The biggest threat today in terms of security is
from internal resources. However, outsourcing our security needs
helps us stay protected against virus attacks and we can
concentrate on our business.

Sanjeev Raiphale
Kipa Architects

As told to Samir Makwana (samir_makwana@thinkdigit.com)

The security solutions deployed at The Ruby Mills are in a three-tier
mode for both e-mail and storage devices. A Unified Threat
Management appliance (UTM) has been deployed, and there is also

Kaspersky anti-virus at the gateway. At the Desktop and server level,
McAfee’s TOPS managed services—virus scans, spyware protection, and
inbuilt intrusion protection—work round the clock. 

The UTM package installed also provides intrusion detection,
protection against spyware, and content filtering. SonicWALL ViewPoint
is a good reporting server for monitoring and reporting content accessed
on the Web. All security-related events regarding contents of Web access
and e-mails are reported to the server, which is monitored. Access to the
Web is done through authenticated user login. 

All enterprises should adopt security measures with defined security
policies. Windows Domain functionality is useful—you can have three
security levels for user access. A business enterprise should evaluate their
needs and then deploy solutions from scratch.

Concern
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Technology Beyond Work
Leisure
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Prakash Ballakoor

You know all too well your help is needed,
and that’s true in any country, any time.
You can help by recycling stuff. You can

help by approaching governments and support-
ing social causes. You can help by directly feed-
ing the poor. This is all confused, but the idea is:
Your Help Is Needed. But let this not be a sob
story, and let’s get to our point.

Various hindrances prevent you from
contributing towards causes. Helping with
child welfare means working with NGOs after
having understood the problems. Educating
weaker sections of society means volunteering
as a teacher, possibly in a language you don’t
(yet) know. And so forth… and in today’s 
busy life, there are time constraints. Yes, you
can take time out, but what can possibly stop
you from crashing in front of the telly at the
end of a hard day? In addition, this is India,
and volunteering organisations—assuming you
can’t help directly—may be located far away or
even in other countries. So here’s the 
broad picture: you want to help. You have the
time, strictly speaking. You have the skills.
NGOs and other helping bodies exist. So what’s
to be done?

Yes, The Internet!
It turns out you can now volunteer over the
Internet—and so, much to your initial dismay,
you have no excuse. (But if you have a
conscience, you’ll be glad.) What you first need
is a strong desire to contribute for a cause. You
can do your part by taking up tasks that do not
require an on-site presence. Various tasks—such
as reading out and recording of passages from
textbooks for visually impaired students, and
documentation of activities and writing

136Gameon Jessica Loves
The Wii116 Webcam Test

A Chain For The
Touched By Tech

What separates you
from those who need
your help? Just a
keyboard, the will to
serve, and a bridging
organisation

CHASM

147

Imaging Shrikrishna Patkar
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proposals for grants from organisations—can
be done at home (or office, boss permitting).
Imagine this: you’re helping a blind child
somewhere while perched on your favourite
chair at home, in the wee hours when you’re
most comfortable.

Charity First
We’ll come to the middlemen in a bit—the
people who get you in touch with the NGOs.
Before that, here’s a flavour for exactly what
NGOs need of “virtual volunteers.”

Opportunities in virtual volunteering are
usually spread through word of mouth and
not via advertising or press releases: organisa-
tions simply don’t have enough money! It’s in
that spirit that we’re here informing and
encouraging you.

First off, you can write for the newsletters
of NGOs and do design and layout work for
them. If you have a flair for Web designing, you
can build a Web site for your favourite helping-
out organisation, or through research on the
Internet, build content for the site, identify
sources of funds, and rope in more volunteers.
Those of  artistic inclinations might consider
creative designing of brochures, campaign
posters, T-shirts, and presentations. Volunteers
with a marketing background can help in
online fund raising through marketing of in-
house products produced by the NGO—for
example, candles, greeting cards, and
sweaters—which can be sold online. Coming to

more skilled areas, those with the skills can
contribute to database management and trans-
lation. And remember, all this without leaving
that favourite chair.

Now for the really difficult part. You don’t
want to go running around looking for NGOs.
And here’s where iVolunteer comes in: the
organisation (www.ivolunteer.org.in) is an
exchange platform where volunteers get
connected with NGOs in India and abroad.   

The Middlemen
Rahul Nainwal and Shalabh Sahai founded
iVolunteer in 2001. They were then students at
the Institute of Rural Management Anand
(IRMA), Gujarat. They conceptualised the idea
in order to create what iVolunteer is today—a
platform where volunteers and voluntary
organisations could meet. Right from the
outset, then, iVolunteer had the aim of
contributing to society in terms of giving time
to and sharing skills with those in need. The
organisation now has a network of over 300
credible non-profits spread across India, and
is working on a variety of issues to create a
database of opportunities for volunteers to 
get involved. iVolunteer mobilises volunteers
and profiles them based upon their interest,
skills, and availability. Its Volunteer Relation-
ship team helps match volunteers to suitable
opportunities.

iVolunteer also has programs that cater to
those who don’t just want to help online: they
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Lend a hand if you can!

VolunteerMatch Support has loads of
opportunities in diverse fields like
Advocacy and Human Rights, Crisis
Support, Media and Broadcasting, and
more. Find a field that suits you:
www.volunteermatch.org/opportunities/vi
rtual.jsp.
Macdonald Youth Services has various
opportunities in diverse fields. To find out
about openings here, subscribe to their
newsletter: www.mys.ca/volunteer.
Daily Dump is a Bangalore-based
organisation that runs a project on home
composting so as to ensure homes manage
their own organic waste at source. 
They need a visualiser for DTP work. 
bangalore@ivolunteer.org.in
Ph.: 080-41466568
Maithri Educational and Charitable
Organization in Chennai deals with
providing scholarships to physically-
challenged students. They’re looking for
volunteers to read out and record passages
from textbooks for visually-impaired
graduate students.
chennai@ivolunteer.org.in
Ph.: 044-42892791
Abhyudaya, who help people reach a stage
of self-sustenance by training them to

make textile products like Dari, bed-sheets,
scarves, toys, etc. needs volunteers to
assist in documentation and proposal
development.
delhi@ivolunteer.org.in
Ph.: 011-26217460
The South India Cell for Human Rights for
Right Education and Monitoring (SICHREM)
works for human rights and seeks to
empower Dalits, tribal people, women,
children, and minorities. They’re looking
for someone who can write a four-page e-
newsletter and update their Web site.
Ph.: 080-41466568
bangalore@ivolunteer.org.in
Suyam Charitable Trust, which works in
child and youth welfare programmes,
needs volunteers to assist in
documentation work, online fund raising
activities, and media and corporate
publicity.
chennai@ivolunteer.org.in
Ph.: 044-42892791
GNAPE works in the field of nature
conservation, preservation, and education
through various research,
documentation,and outreach programmes. 
They need volunteers to design their Web
site and develop content.
chennai@ivolunteer.org.in
Ph.: 044-42892791

Organisations Where You Can E-Volunteer

“Virtual
volunteers can
help NGOs not
just technically—
like choosing the
Web server,
scripting
language, and
database server—
but also as
advisors on how
to gain best from
the Internet”

Shalabh Sahai
Director
iVolunteer
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have iVolunteer Indian Fellow, iVolunteer Over-
seas, Employee Volunteering, and National and
International Volunteering. Refer box More
About iVolunteer.

NGOs are realising the importance of the
Internet to be able to reach out to people in
far-off places (as in funding and mobilising
volunteers); they also find it difficult to
commit resources to build and manage their
Web sites. Sahai, director of iVolunteer India,
has this to say: “Virtual volunteers can help
NGOs not just technically—like choosing the
Web server, scripting language, and database
server—but also as advisors on how to gain the
most from the Internet.”

Richa Sood, relations executive at iVolun-
teer tells us, “Resource mobilisation—particu-
larly fund-raising, is a lifeline to almost all
non-profits. Often these require no face-to-face
interface with the organisation, and campaigns
can be carried out using the various mediums
that IT offers.”

One needs to remember that the efforts you
put in can possibly also help in career growth.
Web sites you create for NGOs can be listed on
your résumé. In the case of a businessman, the
Web site could stand testimony to your organi-
sation’s skills. NGOs are always looking out for
people to help spread awareness in regards to
relevant issues, and Web sites being the best
medium, volunteers for Web site development
are the most sought-after.

iVolunteer is seeking people to help with
writing and designing reading material. Those
with modest skill-sets are placed in back-office
work like keeping records of finances and day-
to-day activities. People who know more than
two languages are placed as translators, who
are in great demand by NGOs: as they grow,
they require people to localise all the reading
material they generate.

And coming to figures, iVolunteer has thus
far placed over 5,000 volunteers in various
programmes. However, they admit that virtual
volunteering is a small part of this figure. Yes,
it is just taking off, and again, you can help.

On The Other Side
Volunteers working over the Internet have
helped Ashoka, which we mentioned earlier,
even in areas such as research. Researchers at
Ashoka are working on projects as diverse as
rain water harvesting and genetically engi-
neered crops. Such research allows both scien-
tist and entrepreneur to attract fresh
participants and resources to the long-standing
problem of rural development. As an example
of how such work affects rural development,
research on genetically engineered crops and
foods helps in examining their impact on the
environment, human and animal health, and
traditional agriculture.

Bill Drayton, a social entrepreneur, founded
Ashoka in 1980 in Washington DC with an
annual budget of $50,000 (Rs 20 lakh). He
elected its first Fellow in India a year later. In its
early years, the focus of this NGO was on
promoting social entrepreneurs. Now with
over 1,800 volunteers from 60 countries rang-

ing from businessmen, journalists, investors,
and academics, Ashoka is helping out in a wide
range of programmes and initiatives that deal
with the basic necessities like food and water
around the world.

Ashoka has various other virtual volun-
teering opportunities. They need people to
promote funding, strategic planning, market-
ing, designing of their Web site, and transla-
tion. Opportunities can be found listed in the
Ashoka Volunteer bimonthly newsletter. 
You can sign up for the newsletter by writing
to volunteers@ashoka.org with “Newsletter” 
in the subject line. It carries information
about whom to directly contact if one wishes
to help.

One must never forget that motivation is an
important aspect for a volunteer working at
home or office. Of course, this is important
anyway, but is especially so for a virtual volun-
teer: it’s easier to fall asleep at your chair than
on the field! In addition, volunteers can tend
to feel isolated and undervalued, and over time,
decide to leave a project halfway. It is impor-
tant that a volunteer be willing to take owner-
ship over the experience.

If You Have A Heart And The Time…
Before embarking on any virtual volunteering
project, you need to remember—once again, it
must be repeated—that virtual volunteering
begins with a strong belief in the cause, so be
sure it’s something you want to, and can,
commit to. You can also make your contribu-
tion to a cause over the phone or via fax if you
don’t have access to the Internet.

With over a billion Internet users in the
world, even if a tiny fraction take up this route
of helping out, there can be a huge impact. We
won’t end on a weepy note… but we’ve told you
what’s possible. It’s up to you—remember, you
needn’t set foot in uncharted, unmapped terri-
tory, weather boots and all! 

prakash_ballakoor@thinkdigit.com

Here are iVolunteer’s programmes besides
their online volunteering coordinating efforts:

iVolunteer Indian Fellow
Here, undergraduates spend six weeks living
and working with rural NGOs.

iVolunteer Overseas
The volunteer goes to other developing coun-
tries for work in the field of child education,
housing, and sanitation.

Employee Volunteering
Employees of corporate organisations work
with local communities to contribute towards
the community and environment.

National And International Volunteering
This is for individuals, both Indian and foreign,
contributing to social causes in India.

More About iVolunteer

“I came to know
about iVolunteer
through word of
mouth. I am
usually free
during my
weekends, and I
thought, why not
utilise this time to
do something
beneficial for
society?”

Devang Bhatt
Virtual volunteer for
Akshara
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Sumedh Phalak

Y
ou’ve noticed it: webcams are every-
where these days. At least, they should
be: they’re useful, they’re fun, and
they’re cheap now—barring the few
that have some really cool features.

Instant messengers—Yahoo! Messenger and
Windows Live! Messenger included—now have
the embedded video chat option. VoIP-based
applications like videoconferencing use web-
cams so face-to-face meetings can take place in
virtual space. Videoconferencing is also used by
SoHos as a cheap and effective medium of com-
munication between various branches.

If you’re in the market for a webcam, we
encourage you to read what follows—we’ll tell
you all about what’s available, while also help-
ing you make a purchase decision. And here’s
our customary cautionary statement: don’t
just take what your dealer dishes out as the
best-selling cam!

Our categories here are Vanilla Webcams—
the really basic ones; Mid-range Webcams,
which are probably the most popular;
Performance Webcams, for the discerning;
and The Niche Category—for those who want,
well, something different.

VANILLA WEBCAMS
This first category comprises webcams below 
Rs 800. Cheap, yes? They offer just basic func-
tionality, as you might expect, and are just about
adequate for video chat.

This lower end of the test spectrum was pop-
ulated by 10 models from four brands. Logitech
and Intex contested with one contender each,
and Zebronics sent in two. Tech-Com features
prominently, with six models.

Features
Manual focus is standard in this category. A few
webcams—the Tech-Com SSD-644K, Tech-Com
SSD-645K, and the Intex IT 305 WC—support
digital zoom, but this tends to be of little help;
the images captured are grainy.

Night Vision
Several webcams in this category feature night
vision technology (not to be confused with IR
NightVision)—they have bright white LEDs in
the front, which act as light sources in low-
light conditions. This doesn’t make much dif-
ference when it’s dark, but it improves capture
quality in dim lighting.

The Tech-Com SSD-644K has a manual switch
on the camera to power the LEDs; the others have

automatic LED brightness control, which varies
according to the ambient light. This ensures that
the light on the subject is bright enough. The
option to override the automatic brightness con-
trol for the LED is there in the drivers, just in case
the bright LEDs hurt your eyes.

The Snapshot Button
A snapshot switch is useful—you can take still
shots in conjunction with the application bun-
dled with the webcam.

Imaging Rohit Chandwaskar
Photograph Sandeep Patil

Talk Tonight
Get closer to relatives and friends with the best webcams on the market
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of cheap plastic means the lifespan will be
short. The Tech-Com SSD-642K is shaped like a
foot (!), with four LEDs on its “fingers,” and the
snapshot button on its “toe.”

The ball-shaped, pretty, white QuickCam Go
boasts of rugged build quality with a flexible
rubber base. Both the Zebronics products—the
480 WC and 280 WC—have average build quality.

Accessories
The QuickCam Go is installation-friendly with
its long 180-cm USB cord, as well as good soft-
ware with detailed documentation. In addition
to this, the Vista support in the Logitech drivers
in this price bracket is a welcome feature. The
Tech-Com SSD-640K bundles Ulead software.

Performance
In Daylight
Webcams work best in good lighting conditions,
as you know. However, the performance of the
Tech-Com SSD-640K and 641-MP was just pass-
able. Colour reproduction was not a problem for
most of the contenders, but sharpness was. Still
images captured by the Logitech QuickCam Go
and the Tech-Com SSD-644K and SSD-645K were
better in terms of sharpness.

In Fluorescent Light
Under fluorescent lighting conditions, colour
tones reproduced are greatly affected by the
auto exposure / white balance controls of the
webcam. The SSD-644K excelled in our colour
reproduction test, and close behind were the
SSD-645K and the Intex IT 305 WC. The SSD-644K
had a fine balance between brightness and con-
trast.

Night Vision 
The Tech-com SSD-644K was the best performer
in dark lighting conditions; most of the others
failed to generate viewable images. The
Zebronics 280 WC, too, performed notably well.

The Clamp
The clamps on the Tech-Com SSD-644K and SSD-
642K are not suited for LCD panels, but work
well with laptops. The other webcams that have
a clamp for attaching to a LCD panel adopt
almost the same mechanism.

The Desktop-only webcams—the Tech-Com
SSD-640K and SSD-641-MP, and the Logitech
QuickCam Go, don’t have the clamp required
to support them on laptops and LCDs. However,
the stable base of the QuickCam Go means it
won’t topple easily.

Image Capture Resolution
Software interpolation allows captured
images to be scaled to higher resolutions, and
is found on many webcams. This allows them
to take higher-resolution still images com-
pared to the maximum video resolution sup-
ported, a useful feature if you want to set the
image as the Desktop background or print
high-resolution images.

Aesthetics And Build Quality
The Tech-Com SDD-644K with eight LEDs sur-
rounding the lens looks attractive, but the use

SEPTEMBER 2007
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Fragile yet firing performance
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MID-RANGE WEBCAMS
The Rs 801 to Rs 1,700 price range is where most
consumers gravitate to. Clarity and sharpness at
lower-resolution images / streams is the deciding
factor when it comes to competition.

Nine webcams made it to this category, from
five brands Logitech sent in four; Zebronics, two.

Features
The basic feature set here remains the same as in
the previous category, but these are better built
and designed.

Night Vision
The Zebronics 1300 WC implements a pop-open
top that hides three LEDs for better performance
in low-light conditions, and also a dual-lens
design: one for short distances and other for long
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distances (30 to 150 m). The provision by
Zebronics of a manual rotor to control the inten-
sity of the night vision LED’s is noteworthy.

The Clamp
The Genius Look 312P uses a flexible frame struc-
ture; yet it tends to fall off. The clamping mech-
anism implemented by Logitech is the best, and
poses the least problem in clamping onto LCDs.
Microsoft’s foldable clamp is one of the better-
designed ones, but this poses problems in clamp-
ing to thicker LCD bezels. The clamps on the
Zebronics aren’t wide enough to clamp onto
LCDs with thicker bezels.

The Snapshot Button
The Logitech QuickCam series is studded with
a snapshot switch on the camera. The provision
of snapshot switch on the USB cord by
Zebronics on its 1300 WC is a more practical
approach; it minimises the chances of the web-
cam shaking while taking a snap. The
Microsoft VX-1000 implements a similar but-
ton, but this is used instead for making calls
using Windows Live! Messenger.

Accessories
Logitech’s drivers support Vista. The software
bundled with the HP PhotoSmart and the
QuickCam V10  is feature-rich. Vista is also
supported by the Microsoft VX-1000’s drivers.
The software bundled with the LifeCam 1.2
has only a basic feature set—albeit with a
quick, easy-to-navigate interface. The Genius
also has Vista support, but the DD PlayCam 2
software is buggy in terms of navigation. The
Look 312P from Genius is supported in Linux,
unlike the others.

Aesthetics And Build Quality
The puppy-shaped Genius Look 312P is the
most attractive of the lot. The Microsoft VX-
1000 sports good build quality with a small,
foldable clamp that makes it easy to install on

The Digit Printer test image was used as the subject in this
webcam test. It was set 60 cm in front of the webcams under

test. All the webcams were then evaluated on the basis of three
basic parameters—Features, Performance, and Price. These basic
parameters are given relevant weightages based on the
importance each parameter plays in its category. The three
parameters put together contribute to whether a product gets
awarded the Digit Best Buy Gold and Digit Best Buy Silver for
each category.

Features
The feature sets of the webcams were looked at according to
category, and points were awarded on the basis of the part the
feature plays in terms of usability and the buyer’s application.
Features looked at included whether there is automatic, manual,
or fixed focus. We also checked for zoom, audio capture, a
separate headset / microphone, a snapshot button, swivel,
whether it is motor-driven, length of the cable and whether it is
detachable, a provided stand and a clamp for fixing the webcam to
LCD panels (some feature we expect only on high-end webcams).
We also checked the quality of each of these components.

Bundled software, their usefulness, ease of use, and support for
different operating systems was also noted. So were extra features
such as face tracking, and noise cancellation. In addition, the
sturdiness of the webcam, its stability, and aesthetic appeal were
also awarded points.

Performance
The tests were performed under both fluorescent lighting and
daylight conditions. The test for daylight conditions was conducted
indoors with a large window open to allow natural light to enter the
test area. We noted image capture quality and colour reproduction
compared to the original Digit Printer test image, and the amount of
brightness and detail. 

The fluorescent lighting condition test is more important, because
most people use webcams indoors. The testing area was lit up with a
tubelight and note was made of the quality of image capture. We
rated the captured image quality. Performance in the  dark was
gauged on both the regular as well as night-vision-enabled webcams.

A scale of 10 was used in both cases (daylight and fluorescent)
to rate sub-parameters like colour reproduction and image
brightness, contrast, and sharpness.

How We Tested 

SEPTEMBER 2007
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LCDs. The ZEXX webcam from Zen has its com-
plete body built of metal, with a screw mech-
anism to adjust the swivel—if the screw
loosens too much, the camera tends to pop
out of the base.

The Logitech QuickCam Easy is the black-
coloured clone of the QuickCam Go, and has a
f lexible base. The Logitech trio—the
QuickCam Family, Chat, and Messenger are
identical but employ a different colour
scheme. Logitech’s good build quality remains
on par for its complete range in this category.
The Zebronics 1300 WC looks distinct, sport-
ing two lenses on the front, but it has a some-
what cheap plastic feel to it.

Performance 
In Daylight
Compared to the Logitech QuickCam Easy and
QuickCam Messenger, the Logitech QuickCam
Family and QuickCam Chat performed poorly.
The Microsoft VX-1000 was average in terms of
sharpness and contrast, but in terms of bright-
ness, it was slightly below par. The ZENX was
average; the Zebronics 1300WC outperforming it

by a huge mar-
gin. The Zebronics
350 WC performed
much poorer than
the 1300 WC. The
Genius Look 312P
failed to impress—below-
par performance.

In Fluorescent Light
The QuickCam Easy and the
QuickCam Messenger webcams
were the better performers. The
Microsoft LifeCam VX-1000 and the
Zebronics 1300 WC lagged in our colour
reproduction test compared to the
Logitech QuickCam Messenger and Easy.

Night Vision
The Zebronics 1300 WC produced the
best images in the dark in this category.

Booru WebCam
(www.booru.net)
This simple program allows capturing of images from a webcam
and saving them to GIF, JPEG, BMP, TIFF, or PNG. The option to
upload to an FTP server is also available. Support for text as well
as image overlays with transparency is available.

Yawcam 
(www.yawcam.com) 
Yawcam, a Java-based freeware, has some useful features over
standard webcam software. Yawcam has support for motion
detection, with video streaming built in. It allows for FTP
upload of captured images / videos and also has an inbuilt
secure Web server with password protection—this requires the
motion detection feature. If you want to schedule SMS or e-
mail alerts from the motion detection engine, you can use
GrabMotion (www.grabmotion.com).

VirtualCamera
(www.soundmorning.com)
A webcam tool that allows you to stream virtual video feeds
from your computer. Even without a webcam, you can use it to
send video or feed images, recorded videos, and other items
through IM to friends. This program is a solution for anyone
wanting to share pictures and video over the Internet. The video
formats supported by the player are WMV, AVI, ASF, MPEG, RM,
RMVB, and more, and image formats including JPEG, GIF, and
BMP. The menu provides an easy switch for the input source
(virtual / real camera).

Barcodepedia
(http://en.barcodepedia.com)
A community-based online barcode database. Barcodepedia
can be used as a barcode scanner using your webcam—just hold
the barcode in front of the cam such that you can see the
entire barcode in focus in the preview area of the Web page,
and Barcodepedia will recognise the barcode and search the
article in several databases. It then gives you all the details
about the product.

Splitcamera
(www.splitcamera.com)
A virtual video cloner (for webcams and camcorders) and split video
capture driver (for TV-Tuners) that supports up to 64 clients
(applications running on one personal computer) from a single video
source. Extremely useful if you want to use a mix of multiple IM
clients and videoconferencing tools at the same time. Splitcamera
supports multiple video resolutions; each client can have its own
resolution and disable unused resolutions to lower processor load.

Cameroid (www.cameroid.com) 
Phozi (www.phozi.com)
These are two cool Web sites every webcam owner should visit. It’s
like Mac PhotoBooth loaded into your browser. Both sites use Flash
code to detect the webcam on the local client system and load
images from your webcam. Cameroid allows applying different
effects like colour, morph, and scene on uploaded images. Phozi
supports a wide range of frames and stamps (stick-on images) and
colour pencil tools too. Images created from these sites can be
used as avatars on IMs and also on social networking sites.

VideoMage Producer
(http://www.hollix.com/downloads.html)
This one allows superimposing and manipulating (fade, resize,
and move) graphic images over real-time images and video 
received from sources like webcams, TV-Tuners, or pre-recorded
files. The telestrator effect allows one to highlight special areas
of a video image by drawing shapes over it. The output is stored
as compressed files in the AVI and WMV formats.

Webcam Diagnostics
(http://noeld.com/programs.asp?cat=video)
Webcam Diagnostics, as the names suggest, provides webcam-
related information. Driver installation and USB issues become easy
to diagnose; red circles mark serious issues, and yellow triangles
point to minor issues. Right-clicking on the red / yellow marks
provides a context menu to fix the problem or a potential way to fix
it. In the case of corrupt USB drivers, Webcam Diagnostics points
out the problem and suggests reinstallation of the drivers.

Software For Your Webcam 

SEPTEMBER 2007

Zebronics 1300 WC
Two lenses, twice the fun
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BRAND 
MODEL

Price (Rs)
Comments

Final Score (Out of 100)
Features(Out of 38/45*)
Performance(Out of 50/45*)
Price Index(Out of 12/10*) 
Features
Specifications
Maximum Video Resolution
Maximum Still Resolution
Audio Capture (Microphone) (✔ /✖ )
Number Of LEDs
Snapshot Button
Optical Features
Fixed/Manual/Automatic Focus (✔ /✖ )
Zoom
Physical Features
Horizontal Swivel (✔ /✖ )
Vertical Swivel (✔ /✖ )
Clamp For LCD/Laptop Mounting (✔ /✖ )
Adaptability of Clamp (So10)
Cable Length (metres)
Detachable Cable (✔ /✖ )
Other Features
Software And Documentation
Driver Support
Bundled Software

Software Bundle Rating (So10)
Other
Build Quality (So10)
Stability Of Webcam (So10)
Aesthetics (So10)
Ease Of Installation (So10)
Performance
Image Quality (So10)
Fluorescent Lighting
Colour Reproduction
Image Brightness
Image Contrast
Image Sharpness
Daylight
Colour Reproduction
Image Brightness
Image Contrast
Image Sharpness

Scoreboard                             Vanilla Webcams (Up to Rs 800)
INTEX

IT 305 WC

Rs 796
+ Strong performance

– Overpriced

47.9
20.3
23.8
3.8

800 x 600
1600 x 1200
✔

6.0
✖

✖ /✔ /✖

✔

✔

✔

✔

4.0
1.35 m
✖

Windows 2000 / XP
AmCap / Video Power

4.0

4.0
5.0
5.0
4.0

5.0
4.5
4.0
3.5

6.0
5.0
6.0
4.0

TECH-COM
SSD-643K

Rs 350
+ Value for money

– Dull images

47.0
17.2
21.2
8.6

640 x 480
640 x 480
✔

8.0
✖

✖ /✔ /✖

✖

✔

✔

✔

4.0
1.31 m
✖

Windows 2000 / XP
AmCap 

3.0

4.0
4.0
5.0
4.0

3.5
3.0
4.5
3.0

4.0
6.0
6.0
4.0

TECH-COM
SSD-644K

Rs 495
+ Best performer

– Poor build quality

54.6
22.5
26.0
6.1

800 x 600
1280 x 960
✔

8.0
✔

✖ /✔ /✖

✔

✔

✔

✔

3.0
1.36 m
✖

Windows 2000 / XP
AmCap / Camera Fixer /
USB Camera Plus

3.0

4.0
6.0
6.0
4.0

5.5
5.0
5.0
4.0

6.0
5.0
6.0
5.0

LOGITECH
QuickCam Go

Rs 695
+ Good looking

– Bad indoor performance

42.7
17.8
20.6
4.3

640 x 480
640 x 480
✖

NA
✔

✖ /✔ /✖

✖

✔

✔

✔

NA
1.8 m
✖

Windows 2000 / XP / Vista
QuickCam v10 

5.0

7.0
6.0
6.0
5.0

2.5
2.5
3.0
3.0

6.0
5.0
6.0
5.0

TECH-COM
SSD-645K

Rs 595
+ Strong Performer

– Night vision unsatisfactory

50.6
20.6
25.0
5.0

1280 x 960
2304 x 1728
✔

8.0
✖

✖ /✔ /✖

✔

✔

✔

✔

4.0
1.36 m
✖

Windows 2000 / XP
AmCap / USB Camera
Plus

3.0

4.0
5.0
5.0
4.0

5.0
4.5
4.5
4.0

6.0
6.0
5.0
5.0

SEPTEMBER 2007 SEPTEMBER 2007
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Rs 801—1700
TECH-COM
SSD-640K

Rs 275
+ Packs great bundle

– Poor performance

40.4
14.5
15.0
10.9

640 x 480
640 x 480
✖

NA
✔

✖ /✔ /✖

✖

✔

✔

✖

NA
1.36 m
✖

Windows 2000 / XP
AmCap / Smart Camera /
Ulead Photo Express /
Ulead Photo
Explorer/Ulead Photo
Cool360
7.0

7.0
6.0
5.0
4.0

2.5
3.0
2.5
3.0

3.0
3.0
4.0
3.0

TECH-COM
SSD-641-MP

Rs 290
+ Affordable 

– Only for CRTs

45.2
14.0
20.9
10.3

640 x 480
640 x 480
✔

NA
✖

✖ /✔ /✖

✖

✔

✔

✖

NA
1.31 m
✖

Windows 2000 / XP
AmCap

3.0

6.0
6.0
5.0
4.0

4.0
3.0
5.0
3.0

3.5
6.0
6.0
3.0

TECH-COM
SSD-642K

Rs 325
+ Great value for money 

– Poor clamp 

47.2
19.3
18.7
9.2

640 x 480
640 x 480
✔

4.0
✔

✖ /✔ /✖

✖

✔

✔

✔

3.0
1.35 m
✖

Windows 2000 / XP
AmCap 

3.0

5.0
5.0
5.0
4.0

3.0
3.0
4.0
3.0

4.0
5.0
5.0
3.0

ZEBRONICS
480 WC

Rs 650
+ None in particular

– Overpriced

42.2
17.6
19.9
4.6

640 x 480
640 x 480
✔

6.0
✖

✖ /✔ /✖

✖

✔

✔

✔

4.0
1.41 m
✖

Windows 2000 / XP
AmCap

3.0

4.0
5.0
5.0
4.0

3.0
2.5
3.0
3.5

6.0
5.0
5.0
4.0

ZEBRONICS
280 WC 

Rs 425
+ Good at night vision 

– Poor indoor performer

43.1
15.7
20.4
7.1

640 x 480
640 x 480
✖

6.0
✖

✖ /✔ /✖

✖

✔

✔

✔

4.0
1.44 m
✖

Windows 2000/XP/Vista
Video Cam

3.0

4.0
5.0
5.0
4.0

3.0
4.0
2.5
3.0

4.0
6.0
7.0
3.0

GENIUS 
Look 312P

Rs 1,600
+ Looks attractive

– Poor performer

35.9
17.6
13.3
5.0

640 x 480
1280 x 960
✔

NA
✖

✖ /✔ /✖

✖

✖

✖

✖

NA
1 m
✔

All Windows/Linux
DDPlayCam 2.0

6.0

6.0
4.0
7.0
5.0

2.5
3.0
2.5
3.0

3.0
2.5
4.0
3.0

LOGITECH 
QuickCam Family 

Rs 895
+ Great value for money 

– Poor performer

46.7
23.7
14.1
8.9

640 x 480
640 x 480
✖

NA
✔

✖ /✔ /✖

✔

✔

✔

✔

6.0
1.8 m
✖

Windows 2000/XP/ Vista
QuickCam v10 / HP
PhotoSmart / ArcSoft
Collage Creator

7.0

7.0
7.0
6.0
5.0

2.5
3.0
3.0
3.0

3.5
3.0
4.0
3.0
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Scoreboard  Mid-Range Webcams (Rs 801—1700)
LOGITECH 

QuickCam Chat

Rs 1,495
+ Fetature rich 

– Costly 

47.4
27.1
14.9
5.4

640 x 480
640 x 480
✔

NA
✔

✖ /✔ /✖

✔

✔

✔

✔

7.0
1.8 m
✖

Windows 2000/XP/Vista
QuickCam v10 / HP
PhotoSmart / ArcSoft
Collage Creator

7.0

7.0
7.0
6.0
5.0

3.0
3.0
3.0
2.5

4.0
4.0
4.0
3.0

LOGITECH 
QuickCam Easy

Rs 1,345
+ Strong performer

– Average looks

51.0
19.2
25.9
5.9

640 x 480
640 x 480
✖

NA
✔

✖ /✔ /✖

✖

✔

✔

✖

NA
1.8 m
✖

Windows 2000/XP/ Vista
QuickCam v10 / HP
PhotoSmart / ArcSoft
Collage Creator

7.0

7.0
6.0
6.0
5.0

5.5
5.0
5.0
5.5

7.0
6.0
5.5
6.5

LOGITECH 
QuickCam Messenger

Rs 1,645
+ Feature rich

– Overpriced

53.7
24.9
23.9
4.9

640 x 480
640 x 480
✔

NA
✔

✖ /✔ /✖

✖

✔

✔

✔

7.0
1.8 m
✖

RightSound

Windows 2000/XP/Vista
QuickCam v10 / HP
PhotoSmart / ArcSoft
Collage Creator

7.0

7.0
7.0
6.0
5.0

5.5
4.5
5.0
5.5

5.5
5.0
5.5
6.0

MICROSOFT
LifeCam VX-1000

Rs 1,275
+ Good Looking

– No snapshot button

49.8
21.8
21.7
6.3

640 x 480
640 x 480
✔

NA
✖

✖ /✔ /✖

✖

✔

✔

✔

6.0
1.75 m
✖

Windows XP/Vista
LifeCam 1.2

6.0

6.0
7.0
7.0
6.0

4.5
5.0
4.5
3.5

5.0
5.0
6.0
5.0

ZEBRONICS
1300 WC

Rs 1,100
+ Feature rich

– Mediocre in night vision

54.5
23.8
23.4
7.3

1280 x 960
1280 x 960
✔

3.0
✔

✖ /✔ /✖

✖

✔

✔

✔

5.0
1.78 m
✖

Windows 2000/XP
AmCap

3.0

4.0
7.0
6.0
5.0

5.0
4.5
5.0
4.0

6.0
5.5
5.5
6.0

ZEBRONICS
350 WC

Rs 990
+ Good value For money

– Poor night performance

47.2
21.1
18.0
8.1

640 x 480
640 x 480
✔

6.0
✖

✖ /✔ /✖

✔

✔

✔

✔

4.0
1.45 m
✖

Windows 2000 / XP
AmCap

3.0

4.0
5.0
6.0
4.0

3.5
3.5
4.0
3.0

4.0
6.0
5.0
3.0

BRAND 
MODEL

Price (Rs)
Comments

Final Score (Out of 100)
Features (Out of 45)
Performance (Out of 45)
Price Index (Out of 10)
Features
Specifications
Maximum Video Resolution
Maximum Still Resolution
Audio Capture (Microphone) (✔ /✖ )
Number Of LEDs
Snapshot Button
Optical Features
Fixed/Manual/Automatic Focus (✔ /✖ )
Zoom
Physical Features
Horizontal Swivel (✔ /✖ )
Vertical Swivel (✔ /✖ )
Clamp For LCD/Laptop Mounting (✔ /✖ )
Adaptability of Clamp (So10)
Cable Length (metres)
Detachable Cable (✔ /✖ )
Other Features
Software And Documentation
Driver Support
Bundled Software

Software Bundle Rating (So10)
Other
Build Quality (So10)
Stability Of Webcam (So10)
Aesthetics (So10)
Ease Of Installation (So10)
Performance
Image Quality (So10)
Fluorescent Lighting
Colour Reproduction
Image Brightness
Image Contrast
Image Sharpness
Daylight
Colour Reproduction
Image Brightness
Image Contrast
Image Sharpness

SEPTEMBER 2007SEPTEMBER 2007

So10 = Scale of 10



123DIGIT SEPTEMBER 2007

Digital Leisure l Webcam Test

ZEN
ZENX

Rs 1,250
+ Well build

– Poor performance

44.1
17.7
20.0
6.4

800 x 600
800 x 600
✖

4.0
✖

✖ /✔ /✖

✔

✔

✔

✖

NA
1.48 m
✖

Windows 2000/XP
AmCap/Web Eye/VP
Eye / VP Hotline

5.0

7.0
5.0
6.0
4.0

4.5
4.5
4.5
4.0

4.0
5.0
4.0
5.0

With the Zebronics 350 WC, the problem was
that all the light fell on a particular part of the
subject. The performance of the ZENX was com-
parable to that of the Zebronics 1300 WC; colour
reproduction took a small hit, though.

PERFORMANCE WEBCAMS
Webcams in the Rs 1,701 to 3,000 category
sport superior build quality. Use of better-qual-
ity lenses and CMOS sensors ensure better per-
formance compared to the earlier categories.
The cameras in this category are not fast
movers on shop counters. Bandwidth-intensive
streaming like videoconferencing being buy-
ers’ chief applications, so a better-quality pic-
ture at high resolutions are demanded. We
reviewed five webcams here, with Microsoft,
Logitech, and Creative with one contestant
each, and two from Genius.

Features
The Genius Look 313 Media is a feature-rich,
multifunctional device: it flaunts a 2-watt RMS
stereo speaker, a USB hub, headphones, and a
microphone socket. The Genius—the Look 310S
is the smallest camera we received; it uses a
screw to clamp onto LCD panels. The Microsoft
VX-3000 implements a Live! Call button.

The Clamp
The Creative Live! IM Pro and the Logitech have
well-designed clamps; few problems clamping
onto thicker LCD bezels. The Genius Look 310S
uses a screw mechanism as a clamp: the small
clipping width precludes it clamping to some
Desktop LCD monitors, but is good enough for
most laptops.

Enhancements
Logitech features RightSound in the
QuickCam IM: this reduces background sound
by using compensation for the feedback
received from the mic. Creative’s Live View
Auto Tuning technology automatically adjusts
exposure in real-time, meaning better images.
The Creative Live! IM Pro and Microsoft VX-

3000 both support face tracking, this tracks
face movement and generates a frame in
which the subject’s face is prominent. The face
tracking mechanism on the Creative has an
edge over the Microsoft.

Accessories
All manufactures have future-proofed their
products, having incorporated Vista support in
the drivers. The DDPlayCam software, though
feature-rich, has a comparatively poor interface.
Creative and Logitech bundle a highly usable
package. Both the Genius webcams have a
detachable mini USB connector.

The Logitech QuickCam IM comes bundled
with a monoaural headphone and microphone
combination (153 cm long); Creative provides a
similar ear-set made of rubber with its Live! IM
Pro. Genius bundles a microphone with the
Look 310S. The Genius Look 313 Media has
headphone and microphone-out jacks. 
The unshielded speakers of the Genius Look
313 Media cause gaussing of CRTs: not for 
CRT owners! 

Aesthetics And Build Quality
The Microsoft VX-3000 is the best looker here.
The Genius Look Media has two foldable
speakers, so you can have them point for-
wards or to the sides, as your tastes dictate.
The Creative Live! IM Pro is slim and tall.

Logitech has the best build quality in this
class. Microsoft and Creative follow closely,
and are similar. The plastic used in the Genius
is slightly below par. The Genius Look 310S is
slightly unstable due to its small base; the
Genius Look 313 Media provides slightly better
stability than the Look 310S due to its larger
base. Creative and Logitech pose minimal
problems regarding stability, but the smaller
base in the case of Microsoft’s webcam  means
less stability.

SEPTEMBER 2007
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Logitech QuickCam Messenger
Price that pierces the performance shield 

Logitech QuickCam IM
Price and performance none can match 
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BRAND 
MODEL

Price (Rs)
Comments

Final Score (Out of 100)
Features (Out of 48/40*) 
Performance (Out of 42/54*)
Price Index (Out of 10/6*)
Features
Specifications
Maximum Video Resolution
Maximum Still Resolution
Audio Capture (Microphone) (✔ /✖ )
SnapShot Switch
Optical Features
Fixed/Manual/Automatic Focus (✔ /✖ )
Zoom (✔ /✖ )
Physical Features
Horizontal Swivel (✔ /✖ )
Vertical Swivel (✔ /✖ )
Motorised Swivel (✔ /✖ )
Clamp For LCD/Laptop Mounting (✔ /✖ )
Adaptability of Clamp (So10)
Cable Length (cm)
Detachable Cable (✔ /✖ )
Other Features

Software And Documentation
OS Supported By Drivers
Bundled Software

Usefulness Of The Software (So10)
Other
Build Quality (So10)
Stability Of Webcam (So10)
Aesthetics (So10)
Ease Of Installation (So10)
Performance
Image Quality (So10)
Fluorescent Lighting
Colour Reproduction
Image Brightness
Image Contrast
Image Sharpness
Daylight
Colour Reproduction
Image Brightness
Image Contrast
Image Sharpness

Scoreboard   Performance Webcams (Rs 1,701—3,000)
CREATIVE

Live! IM Pro

Rs 2,999
+ Good clamping mechanism

– Slightly Overpriced 

50.1
25.8
18.3
6.0

800 x 600 
1280 x 960
✔

✔

✖ / ✔ / ✖
✖

✔

✔

✖

✔

7.0
1.72 m
✖

Creative Live View Auto
Tuning, Face Tracking

Windows XP/Vista
SightSpeed,Muvee
AutoProducer ,Creative
Photo Calendar,Creative
Photo Manager
7.0

6.0
6.0
6.5
5.5

3.0
3.5
3.5
4.0

5.5
6.0
5.0
4.5

GENIUS 
Look 313 Media

Rs 2,450
+ Fetature rich 

– Costly

50.5
22.5
20.7
7.3

800 x 600
800 x 600
✖

✔

✖ / ✔ / ✖
✔

✔

✖

✖

✖

NA
1.5 m
✔

Stereo Speakers, USB 2.0
HUB, Headset and
Microphone slot

All Windows/Macintosh
DDPlayCam 2.0

6.0

5.0
5.0
6.0
5.0

4.5
4.5
4.0
4.5

6.0
5.0
6.0
5.0

LOGITECH 
QuickCam IM

Rs 1,995
+ Strong performer

– Manual focus

60
29.5
21.5
9.0

640 x 480
1280 x 960
✔

✔

✖ / ✔ /✖

✖

✔

✔

✖

✔

7.0
1.8 m
✖

RightSound

Windows 2000/XP/Vista
QuickCam v10/HP
PhotoSmart/ArcSoft
Collage Creator

7.0

7.0
7.0
6.0
5.0

4.0
4.5
5.0
4.5

6.0
5.0
7.0
5.0

GENIUS
LOOK 310S

Rs 2,050
+ Good value for money

– Poor clamp quality

47.7
25.2
13.6
8.8

640 x 480
640 x 480
✔

✔

✖ / ✔ / ✖
✔

✔

✔

✖

✔

4.0
1.5 m
✖

All Windows/Macintosh
DDPlayCam 2.0

6.0

5.0
4.5
6.0
5.0

3.0
3.5
3.0
3.5

3.0
4.0
3.0
3.0

MICROSOFT
LifeCam VX-3000

Rs 2,100
+ Value for money 

– Low on fetatures

46.6
22.5
15.5
8.6

640 x 480
1280 x 960
✔

✖

✖ / ✔ / ✖
✖

✔

✔

✖

✖

6.0
1.75 m
✖

Face Tracking

Windows XP/Vista
LifeCam 1.2

6.0

6.0
6.0
7.0
6.0

4.0
3.5
3.5
3.0

5.0
4.0
4.0
2.5
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Niche Webcams (Above Rs 3,000)
CREATIVE

Live! Cam Optia

Rs 8,990
+ Best performer

– Low value for money

59.5
22.7
34.1
2.7

640 x 480
1280 x 960
✔

✖

✖ / ✔ / ✖
✖

✔

✔

✖

✔

7.0
1.72 m
✖

Creative Live View auto
tuning ,Face Tracking

Windows XP / Vista
SightSpeed, Muvee
AutoProducer, Creative
Photo Calendar, Creative
Photo Manager
7.0

6.0
6.0
7.0
5.5

5.0
5.5
6.0
7.0

6.0
6.0
7.0
8.0

LOGITECH 
Quick Cam Pro 5000

Rs 5,895
+ Flexible clamp

– Fixed Focus

56.9
26.8
26.0
4.1

640 x 480
1280 x 960
✔

✔

✔ / ✖ / ✖
✔

✔

✔

✖

✔

7.0
1.8 m
✖

RightSound, RightLight2 ,
Face Tracking

Windows 2000 / XP / Vista
QuickCam v10 / HP
PhotoSmart / ArcSoft
Collage Creator

7.0

7.0
7.0
6.0
5.0

4.0
5.0
4.0
4.5

5.0
5.0
6.0
5.0

LOGITECH 
Quick Cam Sphere MP

Rs 9,195
+ Can take panorama shots

– Expensive 

55.6
23.0
30.0
2.6

960 x 720
2304 x 1728
✔

✖

✔ / ✖ / ✖
✔

✔

✔

✔

✖

0.0
1.85 m
✖

RightSound, RightLight 2,
Face Tracking

Windows 2000/XP/Vista
QuickCam v10

7.0

7.0
7.0
6.0
5.0

4.5
5.0
5.5
5.5

5.0
6.5
6.5
6.0

LOGITECH
Quick Cam Notebook Pro

Rs 5,895
+ Good build quality

– No lens protection

51.9
20.2
27.6
4.1

960 x 720
2304 x 1728
✔

✖

✔ / ✖ / ✖
✖

✖

✔

✖

✔

5.5
0.75 m
✖

RightLight2 ,Face Tracking

Windows 2000/ XP/Vista
QuickCam v10/HP
PhotoSmart / ArcSoft
Collage Creator

7.0

7.0
7.0
6.0
5.0

5.0
4.5
4.5
5.0

5.0
6.0
6.0
5.0

MICROSOFT 
LifeCam NX-6000

Rs 4,150
+ Lens cover

– Poor clamp quality

55.6
22.1
27.7
5.8

1600 x 1190
3200 x 2380
✔

✖

✔ / ✖ / ✖
✔

✖

✔

✖

✔

5.0
0.73 m
✖

Windows XP / Vista
LifeCam 1.2

6.0

6.0
6.0
7.0
6.0

4.5
5.0
4.5
5.0

5.0
6.0
6.0
5.0

MICROSOFT
LifeCam VX-6000

Rs 4,150
+ Good performance

– No snapshot button

58.8
25.4
27.6
5.8

1280 x 1024
2560 x 2048
✔

✖

✖ / ✔ / ✖
✔

✔

✔

✖

✖

6.0
1.75 m
✖

Face Tracking

Windows XP / Vista
LifeCam 1.2

6.0

6.0
6.0
7.0
6.0

3.5
4.5
5.0
5.0

4.0
7.0
6.0
6.0

SEPTEMBER 2007 SEPTEMBER 2007
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Performance
In Daylight
The snaps we took with the Logitech QuickCam
IM had the best contrast here, with richer natu-
ral colour reproduction. Excessively high-con-
trast images by the Creative Live! Pro meant the
captured frames were poor. The Genius Look
313 Media was better. The Genius Look 310S
doesn’t match up to the competition—capture
quality was not up to the mark.

In Fluorescent Light
The Genius Look 313 Media’s capture quality
was good, but the Logitech QuickCam IM pro-
duced better contrast ratio. The Creative Live! IM
pro was the better performer of the rest, with
the Microsoft VX-3000 missing out largely on
sharpness and slightly in brightness levels. The
Genius 310S colour reproduction was below par,
missing out on natural colour tones.

THE NICHE CATEGORY
Cameras above Rs 3,000 have features like
motorised swivel, face tracking, and better cap-
ture quality at higher resolutions. Software like
Muvee Auto Producer bundled with the
Creative Live! Cam Optia provides features rich
enough for authoring home videos, but the
short USB cable hampers free movement and
usability as a camcorder.

We reviewed six contenders in this category.
Three were from Logitech. Microsoft sports two
products, and Creative, one. 

Features
The Logitech QuickCam Notebook Pro and
Microsoft LifeCam NX-6000 are meant to be used
with laptops. They come with carry pouches. The
Logitech QuickCam Notebook Pro also has a 12-
inch, sturdy stand, making it Desktop-friendly as
well. The Microsoft LifeCam NX-6000 and VX-
6000 provide a call switch for Live! Messenger,
but miss out on a snapshot button.

The Clamp
The clamping mechanism for laptops is better in
the case of the Microsoft VX-6000 than that of
the Logitech QuickCam Notebook, but the
Microsoft’s clamp is not wide enough to work
with laptop that have thicker tops. The spring-
based, hinged mechanism of the Creative Live!
Cam Optia allows it to be clamped to any LCD
with ease. The Logitech QuickCam Pro 5000
implements a flexible base instead of a clamping
mechanism, which allows easy adaptability to
any LCD panel. 

Enhancements
All the webcams here support face tracking,
except for the Microsoft NX-6000. The

If you already own a webcam or are on your way to becoming
one soon, here are some lighting tips to help you get the best

possible images from your webcam. Lighting plays an
important role in any image, as in highlighting the subject
more than the background.

Webcams are generally placed on top of LCD or CRT
monitors, with the light falling directly on the face of the
subject (the monitors act as light sources). Faces will reflect
the colour of the window on the Desktop, and spectacles (if
any) will have reflections on them as well. The solution is
obvious—reduce the brightness and contrast of the monitor
and dim the lights in the room.

Use a table lamp to highlight the subject. The bright light
causes the webcam to lower its exposure, dropping
background objects a little. If the table light turns to be too
bright or harsh, use typing or butter paper to cover the mouth

of the table lamp so as to soften the light. Adjust the
background lights again; if possible, turn them off completely.
The light reflected off the walls and close-by objects due to the
table lamp will help.

If your face tends to change colour or tone during a
webcam session, that’s the webcam’s white balance / auto-
exposure at work. Tackling this is simple: wear white clothing!
The prominence of white in foreground further reduces the
effect of background light.

Getting a backdrop helps greatly, though it can be
expensive. One can even use curtains as the backdrop, just as
an alternative. A grey backdrop is best suited for the purpose.

Don’t get too close to the monitor while typing. A relaxed
sitting posture not only looks better, it also helps the soft light
of the table lamp bounce off all of your face, thereby
producing a clearer image.

Minimise Webcam Niggles!

Creative Live! Cam Optia 
Rock solid performance that gels with its looks

SEPTEMBER 2007

Genius Look 313 Media
The Swiss army knife of the webcams

SEPTEMBER 2007
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Logitech’s face tracking was the best; the
QuickCam Sphere MP even uses a motorised
swivel (pan and tilt, which can be controlled
using the software). Logitech’s RightLight and
Creative’s Live View Auto Tuning technologies
both support real-time (dynamically-adjusting)
exposure control for their webcams. The
QuickCam Sphere MP supports single-click
2304 x 1728 panorama shots.

Accessories
The QuickCam software bundle with the
QuickCam Sphere MP allows for software control
of the motorised swivel. The Advance Video FX
functionality in the Creative’s Photo Manager
software, and Logitech’s Video Effects, allow
using avatars during Web chats. Microsoft’s
Kiwe9 Theme pack needs to be downloaded and
is a limited trial.

The QuickCam Notebook Pro has a 153 cm
earphone and microphone combo—great for lap-
tops. It has a 12-inch Desktop stand, too. The
Logitech QuickCam Sphere MP is provided with a
9-inch extender to raise its height—a very effec-
tive add-on for a security camera.

Aesthetics And Build Quality
The Creative Live! Cam Optia is the coolest-look-
ing webcam we received. The blue LED lights up
while in use. The Logitechs are not the best-look-
ing ones here; the Microsoft scores better. Even
in the case of notebook cameras, it’s the same:
the Microsoft NX-6000 looks better than the
QuickCam Notebook Pro. Logitech, however,
leads in build quality. The Logitech webcams are
much more stable than the others, with their
slightly heavier base. The QuickCam Notebook
Pro’s Desktop stand and the QuickCam Sphere
MP’s heavy base prevent accidental toppling.

Performance
In Daylight
The use of good-quality CMOS sensors in this cat-
egory is evident. The Creative Live! Cam Optia is
unmatched in terms of sharpness, with excellent
natural colour tone reproduction. The Microsoft
VX-6000 excels in reproducing the accurate
amount of brightness along with good contrast
ratio and sharpness.

In Fluorescent Light
The Creative Live! Cam Optia remained unbeaten
in terms of sharpness and colour reproduction.
The QuickCam Pro 5000’s performance was
below par. The colour reproduction of the
Microsoft VX-6000 was off the mark. The Creative
Live! Cam Optia’s matchless image quality in flu-
orescent lighting conditions makes it the most

practical webcam
we reviewed—most

users typically use
webcams in low-light
and fluorescent light-
ing conditions. 

Rounding It Up
In the Vanilla Webcams
category (up to Rs 800),
most have average
build. In terms of price
as well as performance,
Tech-Com bags both
the Gold and the Silver.
The Tech-Com SSD-
644K, despite its poor
build quality, takes the
Digit Best Buy Gold on
the basis of its perform-
ance in our image qual-
ity tests. The snap
switch on the SSD-
644K, along with the
power switch for the
night vision LEDs,
boost its score. The run-

ner-up—the SSD-645K—is the Digit Best Buy Silver,
with performance way better than the others
in fluorescent lighting, along with good per-
formance in daylight conditions. Crafted in
alloy with a plastic base, the SSD-645K promis-
es to be long-term companion.

In the second category (Mid-range Webcams,
Rs 801 to 1,700), the Zebronics 1300 WC wins the
Digit Best Buy Gold. It has the right blend of per-
formance and features. Remember, it uses a dual
lens, one for short distances and other for long
ranges. The snapshot button on the USB cable is
an innovative feature that will be useful for
many; it reduces the possibility of the webcam
shaking while taking a snap. The Logitech
QuickCam Messenger takes the Silver medallion
on the basis of better colour reproduction in flu-
orescent lighting than the Zebronics 1300 WC.

Under Performance Webcams, Rs 1,701 to
3,000, the Logitech QuickCam IM is the best—
Digit Best Buy Gold. The Genius Look313 Media is
a feature-rich product that manages to come in
a close second, losing out on the price front to
the QuickCam IM.

In The Niche Category (above Rs 3,000), the
Creative Live! Cam Optia was the best-looking,
and it didn’t disappoint on the performance
front either. The Creative Optia takes the Digit
Best Buy Gold on the basis of performance. The
Microsoft LifeCam VX-6000 is an average per-
former compared to the Optia, but scores well on
the price front—taking the Digit Best Buy Silver.

Webcams aren’t overly expensive, and are
cheaper than ever before. Now you even know
what you should be buying… go ahead, take the
plunge! You never know how much fun you
might have with your webcam—and it’s not just
“fun”: Web chats become so much more person-
al with a camera on.

It’s also nice to have a webcam on top of your
monitor. Even if you don’t use it.

sumedh_phalak@thinkdigit.com

Microsoft LifeCam VX-6000
Convergence of performance and value

SEPTEMBER 2007

PhoneCompany E-mailBrand

Contact Sheet Webcam

Creative
Genius
Intex
Logitech
Microsoft
Tech Com
Zebronic
ZEN 

Compuage Infocom Ltd
KYE Systems Corp 
Intex Technologies (India) Ltd.
Logitech 
Microsoft India Pvt Limited 
Shree Sagarmatha Distributors P. Ltd.
Zebronics (TopNotch Infotronix)
H.T.Impex

022—65297356
011-28855229
011-30888920 
022—26571160
01800-102-1100
011-26428541/42
9380288850
022- 66587586

india_getcreative@ctl.creative.com
sales_india@geniusnet.com.tw 
info@intextechnologies.com
kavita_nath@logitech.com
kaverm@microsoft.com 
contact@techcomindia.com
naqui@zebronics.net
zenthemaster@gmail.com 



130 DIGIT SEPTEMBER 2007

FirstEscape

There’s been plenty of
news about the OLPC
foundation and the

laptop design for kids that
resulted, and about how
children in seventh-world
countries are going to gain
Wisdom through Education
by using those laptops. Wise
they have become of what
grown-ups do in bed, and
Educated they have become
as in sex education. Which
isn’t bad per se, but sex
education via porn isn’t
what the OLPC (One Laptop
Per Child) Foundation
foresaw, it’s not something
they liked, and they’re going
to do something about it.

The news came via the
Nigerian News Agency.
Formally, they said the
laptops that some kids in
that country received were
being used to surf porn sites.
Kids will be kids… in this day
and age, of course. These are
neo-kids. The folks at Digit
who pondered this issue only

knew that birds have cloacae,
and that bees have a Queen
that lays eggs. 

So, anyway, reporters
from the Agency visited
classrooms where the XO
operating system fitted
laptops were being used.
They noticed more flesh on
the screens than should have
been there, which is almost
zero. (Decent folks doing
decent things wear clothes.)
One of the scribes borrowed
a laptop to browse the
operating system, and shock
came to her vintage mind:
sexually-explicit images and
videos were stored on it.

As of this writing, efforts
are underway to include
porn filtering software so
the children won’t be able to
access What Boys Want,
involuntarily or otherwise.
But we’re betting these little
perverts will figure a way to
bypass the filters. Because
kids will be kids… neo-kids,
we should say.

KID’S PLAY

Gobbler
Hackers Hack
Wiki!

In an dizzying display of
über-l33t hacking skills,
a Turkish hacker group

going by the deliciously
uncreative name of Turkish
Professional Hacker Groups
defaced the Doctus
Information Security Wiki
(http://wiki.doctus.net).

Now we’re not saying
we’re über-l33t hackers
ourselves—so we can’t LOL
too much when a Hacker
Group thinks they’ve
Hacked when they haven’t.
In case this is the first time
you’re picking up a copy of
Digit, a wiki is, informally,
a Web page anyone can
edit. All you need to do is
click the Edit button and
type away.

That’s exactly what
these “script kiddies”
(hacker-speak for junior or

No Winner this month! Better luck next time!

GSOH: Hard To Come By(te)
You can’t tell your computer jokes, but the University of
Cincinnati has written a program that recognises the
humour in puns and wordplay. The folks behind it say it’s
rudimentary—so it probably won’t recognise there’s a byte
of humour in this sentence. But we’ll watch for more. 

THEY DON’T NEED NO EDUCATION

One MPEG Per Child

My Desktop

Whatever 
Happened To…

Remember the good ol’ days
of 2001? The Internet was

just beginning to get
affordable. New ISPs sprang
up every day and in the melee,
a Calcutta (now Kolkata)-
based ISP called Caltiger,
came up with a cool new idea,
called, in short, “free.”

Yes, free dial-up! It was a
huge sensation. Go to
www.caltiger.com, register an
account, describe your likes,
and download the software to
access The Free Internet. The
software acted as a dialler; it
would, umm, also place an ad
toolbar on your Desktop.

Users abandoned ship as
quickly as they got on.
Getting connected was like
winning the lottery, and just
in case you did, getting a
reliable connection was like
winning the state lottery and
the national lottery on the
same day. Add to that the
toolbar, which blocked a
quarter of the screen; and
yes, it was a resource hog too
(on the 64 MB RAM machines
of the day), causing them to
freeze. The company soon
walked the plank.

Actually, the idea could
never have lasted. Imagine
something like that today:
we’d probably have a Firefox
add-on to got rid of the ads.
And there’s broadband: no-
one would be stuck on
dialup just because it was
free. And coming down to
silly things, there’s always
the idea of using your
monitor’s controls to make
the screen larger vertically
and then moving it down!

Be Virtual When Online…
A judge who wanted to blow off steam against some
prosecutors unfortunately did so in his MySpace profile.
His boss noticed the offending profile and promptly
handed the hammer-man marching orders. Moral:
never use your real name online. Even if it’s YourSpace.

Send us your desktop  with a description of how
you made it to mmyyddeesskkttoopp@@tthhiinnkkddiiggiitt..ccoomm with
the subject ““MMyy  DDeesskkttoopp””,, and tell us your postal
address, too.

Participate in this contest and 
win next month 
Mastering Maya 8.5
by John Kundert-Gibbs

Published by

Caltiger

■ Google deleted the official Google Custom Search blog, erroneously tagging it spam ■ One US man drove 2,000 km to burn down an online critic’s house



upcoming hackers) did:
they clicked the Edit button
on the aforementioned
wiki, erased all the
contents, and wrote out
their H4x0r (hacker-speak
for “hacker”) message. And
that message is rather more
than the icing on the cake.
It tells the site
administrator to “Fix your
vulnerabilities in your site.” 

Vulnerabilities? Very
apparently, the Elite Group
of Hackers (or whatever they
call themselves) didn’t know
what a wiki is. Such news
elicits belly-busting guffaws
from men and hankie-
drenching tears of hilarity
from women who do know
what a wiki is.

See, we’re reasonable:
we’ll pardon the poor
grammar. Turks aren’t
native English speakers. We
neither in India are—see?

Actually, damn the
being nice. Here’s the
accompanying message on
the main page, which
slaughters the P of Poetic
License: “While you were
passing this roads, we were
returning. While you are
with girls in your dreams,
we are in a war with our
keyboards…. (and other such

nonsense). Defaced By
KontDrakula”

The people running the
Doctus Wiki (the page in
question) do seem to have
learnt a moral from the
story: it does not now allow
anonymous users to edit
the wiki any more. One
needs to be a registered
user to do so.

There’s a moral from the
story for us, too: expect
absolutely anything from
the men of a country that
names itself after a bird.
Especially one that gobbles
instead of chirping.

BILLS, CRAZY BILLS

The Gory
Details 

Justine Ezarik got her
phone bill in the mail
packed in a cardboard box.

Shipping and handling for
the cardboard box was $7.

Now the bill was
$274.81 (Rs 11,540), the
phone company was AT&T,
and the now-world-famous
cardboard box was large.
But the two details of real
interest are that the bill

was 300/- (three hundred
only/-) pages long, and that
Justine Ezarik uses a
hallowed iPhone.

Unanswered questions
abound at this point, and
we’ll answer them all.

Q. Why was the bill 300
pages long?

A. Because the now-
famous Ezarik sent out
15,000 messages in one
month from her iPhone. She
didn’t eat, she didn’t sleep,
she didn’t visit the
bathroom, she did nothing
but type and type and type,
and type and type, and type.

Q. Are you kidding me?
A. In regards to not

having visited the
bathroom, we are. That’s
pure speculation. But how
else could she have typed
out 15,000 messages?

Q. So how did she?
A. We don’t know. But

then, you see, we got this
bit of news off the Net like
everyone else, and
something could have
morphed over the wires.

Q. Why did Justine
Ezarik type out so many
messages?

A. Because she was
using her brand new
iPhone! Don’t you get it?
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Most notable amongst the
firsts in computing is, of
course, “the first computer.”
One good candidate is the
ENIAC, the
Electronic
Numerical
Integrator And
Computer. The
men behind
the beast were
J Presper
Eckert and John Mauchly.
We do not name the one
after the other, but what we
do know is it was Mauchly
who’d conceived the
architecture, and Eckert
had the engineering smarts.
The ENIAC was the first
digital, commercial
computer that could be
programmed to solve
general numerical
problems—quite like what
we have. It was a thousand
times faster than any other
calculating machine up
until then (1946). And if
that wasn’t enough, Eckert
and Mauchly led the
development of the
UNIVAC, which became an
American household
name—it had correctly
predicted the outcome of a
presidential election!

Mauchly, the archetypal
prodigy, began
experimenting with
electricity very young,
building a flashlight at age
five. His favourite pastime (a
little later, of course) was
weather prediction(!). A desk
calculator wasn’t enough,
Mauchly decided; he needed
something more powerful.
He was soon ordering
various electronic parts,
explaining, “I am intending
to construct an electrical
calculating machine.”
Famous first words.

http://www.seas.upenn.edu
/~museum/ says the ENIAC
“launched the world into
the computer age.” Proud,
perhaps true… read about it.

People Who
Changed

Computing

The Duo Behind The
Dawn

Desi Search!

WIN!
Send in your entry and you could win an exciting gift by sharing an amusing picture with a tech angle to it.
The picture should have been shot by you, and should not have been published anywhere earlier. 
E-mail your picture with “DigiPick” in the subject line, mentioning your postal address, oonn  oorr  bbeeffoorree  tthhee
2200tthh ooff  tthhiiss  mmoonntthh  to digipick@thinkdigit.com. One prize-winning picture will be published each month.

Participate and 
win next month: 

PC Upgrade 
& Repair
by James Pyles

Published by

Last month’s winner:
Chetan Panchal
Ahmedabad - 380063

Eckert and Mauchly

■ Police dogs in Malaysia that sniffed out pirated DVDs have a bounty of $28,000 on their heads ■ Labrador Records put up stuff on The Pirate Bay for promotion



Edit Away (Don’t)

You, we, and the
neighbour’s dog

can edit
Wikipedia. The
People’s
Encyclopaedia
should state, we
think: “First, be
unbiased.” But
that’s not happening,
no. People and groups have
been merrily editing the
‘pedia without giving two
hoots for neutrality. This
motivated a geek to create an
online scanning tool
(www.wikiscanner.virgil.gr) to
track edits. Many people
already have been caught
with their pants down. IPs
from the FBI have edited

pages related to Guantanamo
Bay. Church groups (for

Christ’s sake—
literally!) have
edited out
reportage about
sex scandals. Visit
that site. It’s going

to get interestinger
and interestinger.

Big Mother—And
Others

The next time you’re about
to post a picture of

yourself at a beer-drinking
contest, think again. And
again. Your mom could see it.
Reports are in that employers
have taken to checking out
new recruits’ profiles to go
beyond what’s in their CVs—

and that includes looking at
gory details in social
networking sites. Now parents
have been snooping around
their kids’ Facebook profiles
to find out what
misdemeanours junior is up to
as well! Momma is never far
away, children.

Another potential
problem is when the boss
sends out friend requests.
Poor employees are caught
between the devil and the
deep sea: ignore the request
and get into his sad books, or
risk him going through all
those scraps or posts that
describe how, in George
Costanza style, they spiked his
drink that time when… The
times they have a-changed.

It’s just a fabulous piece of
machine, and she just had
to use it.

Q. Are you serious?
A. We’re speculating

here, to be perfectly honest.
Q. In this age of

paperless communications,
why did AT&T not just tell
her to pay up the $200
whatever?

A. They have a policy.
Every data transfer has to
reflect in a customer’s bill.
So now you know. It’s
refreshing to see such red
tape outside of India.

Q. What do I gain from
all this?

A. Nothing much, just
the idea that you shouldn’t
buy an iPhone. It’ll get you
hooked to text messaging.
In fact, Justine Ezarik had
to have her fingers
amputated after all this.

Q. Are you kidding me?
A. Yes.

DUPED IN LOVE

Machete, No
Marriage

The Internet is a happy
hunting ground for
conmen. They peddle

scams ranging from
Nigerian oil bonds to free

iPods and trips to Tahiti.
Folks we contemptuously
call stupid fall for these,
and give out such details as
their credit card numbers
and whether they like to be
whipped during sex. This
one scam caught our
attention because the man
in question almost lost his
life. A sad one, this.

A misguided Australian
farmer was surfing on the
Net and he seems to have
hooked up
with a
chick in,
of all
places,
Mali.
(That’s
some-
where in
Africa.) The
“lady” was
willing to
marry, and
she also
seemed
rich, ready
with a
dowry of
gold bars
worth
$85,000 (Rs
35 lakh). Not to miss up
on the chance, our boy
from down under went to
Mali to formalise the
nuptials. All went well
until the prospective

groom found himself
shepherded into a room
where two machete-
wielding goons robbed him
of his cash and credit
cards, thrashed him, and
threatened to hack his
limbs off unless he gave
them that $85,000 as the
price for his life. Talk
about the shoe being on
the other foot…

To cut a long story
short, the shaken man
got off without serious

harm when
Australian
and Malian
police lured
the
kidnappers
into the
Canadian
embassy and

arrested
them. And
escorted the

farmer,
probably
swearing
bachelorhood
for life, back
to Sythe

Austrylia.
Someone said—

in a Dave Barry book—
”Look man, I don’t trust
anybody on the Internet,
man! Heck, not my mother!
Not even myself!” Now
that’s a lesson!
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Markup Languages
Most of the content you see on
the Web exists because markup
languages like HTML and XML
exist. That you know. But you
might not know that this class
of languages is not limited to
two or three. 

DHTML: Dynamic Hyper Text
Markup Language can be
described as a combination of
several technologies like HTML,
client-side Java Script, and
Cascading Style Sheets. Most of
the pages and multimedia
content on the Web are created
using DHTML. (Very popular.) 

XHTML: eXtensible Hypertext
Markup Language. Traditional
HTML does not impose much
structural strictness,
sometimes resulting in
poorly-displayed pages. The
use of XHTML enables content
to be displayed similarly
across different browsers. (A
good thing.)

VoiceXML: Used in voice
interaction between humans
and computers, mainly in
systems that enable you to, for
example, check your credit
card balance over the phone.
The logic—like dialogue
management and speech
recognition—is defined by
VoiceXML. (Sometimes iffy.)

LaTeX: A document markup
language used mainly by
mathematicians, authors, etc.
to typeset their content. It is
suitable for representing
mathematical formulas. (For
the boffins.)

Usage Hey, just looked at your
page… Schrödinger wouldn’t
recognise his equation if he
clicked on that link there… you
haven’t used LaTeX at all! And
you know what—use DHTML
and XHTML for your page; don’t
get stuck on HTML, you lazy
bum, you. Pages should look
nice wherever. Oh, and just
BTW, my Amex is maxed out.
Two clicks and I knew…
somebody finally got their
VoiceXML right.

Wild Wild Web

■ A guy called “Faisal” is charging Rs 500 to see and touch his iPhone for 15 minutes! ■ A Florida church is offering $15 iTunes vouchers to new members



133DIGIT SEPTEMBER 2007

EEscscapeape

AMERICAN BEAUTY

Lawsuit:
Badderies

Jose Trujillo bought an
iPhone for $500. He was
not happy when he

learnt, from the Internet,
that its battery would
function at only 80 per cent
of its original capacity after
400 recharge cycles (a full
battery drain followed by a
full charge).

In true-blue American
fashion, Trujillo decided he’d
exercise his legal rights as a
resident of the United States.
In simple words, he saw a
lawsuit here. Apple was soon
sued for “concealment of
information,” and for
charging customers $85.95
(visit www.xe.com, “The
World’s Favorite Currency
Site”) as part of the battery
replacement programme.

Some technicalities are
warranted here—the one-
year warranty on the iPhone
entitles one to a new battery
for free if its charging
capacity drops below 50 per
cent. There is also a
provision to extend that
warranty to two years by

paying $69 (visit www.xe.com
again). And the two central
points here: (a)Trujillo,
rather, his lawyer, claimed
he didn’t know the battery
was sealed inside the phone,
and (b) “The battery
enclosed in the iPhone can
only be charged
approximately 300 times
before it will be in need of
replacement, necessitating a
new battery annually for
owners of the iPhone.” Aha.
He even wanted a class

action suit. But according
to Apple, the battery “is
designed to retain up to
80% of its original capacity
after 400 full charge and
discharge cycles.” When
contacted, Trujillo was
unaware of any incorrect
information in his lawsuit,
and was hoping to reach a
settlement with Apple.
Commentary is warranted.

1. An American lawsuit
is one that says “I didn’t
know this at the time.”

2. A dumb lawsuit is
one that doesn’t look up
the facts and presents a
flawed case.

3. A fanatabulously
dumb lawsuit—one that
qualifies as the worst ever—
is one that tries to make its
way to the class action
league.

Here’s what Steve Jobs
said when he read about
this one: “Awright, naxt.”
Now file a suit against us for
making up stuff. 

Om Malik on the Skype outage of mid-August
http://tinyurl.com/2qb5bv (http://gigaom.com/
2007/08/18/skype-crisis-where-were-the-ebay-
management/)
The outage that caused anxiety amongst millions who
depend on Skype for communications exposed the
fragility of our digital lives. Ebay and Skype
management are happy to talk to the press when
delivering the good news, but in this crisis situation,
the silence was deafening.

Ebay CEO Meg Whitman, Skype co-founder Niklas
Zennstrom, and other Skype management made no
statement, gave no assurances to their community,
leaving their PR agency and the blog to keep people
informed. Of course, this led to even more
speculation, rumours and innuendoes.

Karin Meier talks about the Burning Man festival…
in Second Life, that is
http://tinyurl.com/2fpjdc
(http://blogs.msdn.com/karinm/archive/2007/08/17
/burning-life-a-virtual-burning-man.aspx)
I’ve always wanted to go to Burning Man, the annual
countercultural arts festival, but with both Windows
Server 2008 and Visual Studio 2008 screaming
towards RTM I can’t possibly take time for a jaunt to

the Black Rock Desert in Nevada. Luckily, I can easily
visit the virtual Burning Life in my Second Life. This
will be the fifth year that Second Life publisher
Linden Lab is donating some virtual land in their
virtual world for a virtual Burning Man festival.  

Just like the Burning Man in the real (?) world,
organisers will create a temporary zone in which
residents can create amazing works of art that will
last for a short period and then disappear forever.

Adding comments on Google News is “original and
fresh,” says Philipp Lenssen
http://tinyurl.com/2lm67c (http://blogoscoped.
com/archive/2007-08-08-n65.html)
Google News USA is rolling out an experimental feature
that lets people or organizations who are part of a news
story add a comment to the news.... You can start by
searching for your own name in Google News. For any
story you find that you feel deserves a second view, you
can then write to news-comments@google.com.

I’m curious to see how this Google News process
will work out; it’s an original, fresh way to look at news
aggregation. News reports already often interview “all
sides” of the story, but they don’t always do—and they
might also use selective quoting to skew an issue, to
push through an agenda of the publishing house...

The much-talked-
about Skype outage
has burnt a hole in
eBay’s credibility—at
least, bloggers seem
to think so. And
Google News manages
to pique the scribes...
yet again

Mutiny!
Ever heard of those bosses who won’t

“sink” to the level of their teams? Sure
you have—they’re the ones who’ll get
things done without actually doing them.
Deepak, our most exalted grand poo-bah,
is such a boss. It’s not necessarily a bad
thing (the writer’s adding this bit to stay
in the ed’s good books, obviously—unlike
you, he knows who’s typing this) but we’ve
often wished he’d see the view from the
Bottom every once in a while—to
experience all the trials, tribulations,
hardships and betrayals, and to have
someone nag him, for a change. 

And then came the day that Ram,
likely under the influence of a substance
or substances unknown, decided that
enough was too much.
“Deepak,” he said, “the

time has come. Many long months have
passed, and you have come of age. We seek
stories for Enter (that’s what this magazine
starts with, incidentally); and you must
contribute in the effort.” 

But, dear reader, our ed—he’s made of
sterner stuff than you’d think. He
squirmed for but a half-second, and then
with the skill of an Olympic fencer and the
stealth of a cat burglar, dodged the topic
completely, leaving Ram in a blur. And
poor, brave Ram, inexperienced as he was
in the ways of The Executive, suddenly
found himself saddled with the very work
he came to get Deepak to do! And so, the
balance of power restores itself.

Perhaps we’ll be editors of our own
magazines someday, and become

masters in this mystical art form.

■ Apple shipped keyboards with non-functional media keys. Stick to one-button mice! ■ An Australian foetus—the most famous foetus ever!—has a Facebook page
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O
n his twenty-first
birthday, contract
killer Jackie
Estecado underwent
some strange

changes (no, no, not those—
they happen earlier)—he
watched his friends die while
he figured out how to work a
shotgun, and stared in amaze-
ment as two snake-like crea-
tures and a number of
tentacles sprouted from his
back and started whispering
highly un-sweet nothings in his
ear. Thus begins the story of
The Darkness, and you must
play as Jackie and figure out
what this Darkness is, why it’s
infesting you, and, of course,
kill people. And other... beings.
That’ll teach them to make fun
of your hair.

The Darkness is a well-
made game—I’ll give it that. It
looks good—even if the HDR
effects are a tad overdone—

and the background score is
brilliant. And it’s definitely got
style, right down to the load-
ing screens—instead of boring
“Loading...”, you get little bites
of mafia wisdom from Jackie,
and the game itself has you
shuttling between the real
world and a version of hell
where World War I never ends.
Jackie sometimes “sees
things,” making for some very
F.E.A.R.-esque heebeegeebee-
inducing moments. 

The concept of this dark
force itself is interesting. The
creature feeds off shadows to
gather dark energy, which in
turn protects you from bullets
and other forms of harm. You
can also use one of the snakes
to sneak around and kill
enemies in beautifully grue-
some glory. And then comes
the best part—to gain more
darkness levels, you have to
consumes enemies’ hearts. Ah,

the merits of evil... You can
also summon darklings: little
minions, who lend a little
comedy to the game (à la Over-
lord)—to do your bidding, be it
blowing up things, riddling
enemies with bullets or other
activities of general carnage.
This is all very well the first
time you encounter it, but The
Darkness suffers from some
very annoying flaws.

First, there’s the matter
that first-person shooters and
consoles don’t go well
together.  Second, the story—it
drags awfully in places, espe-
cially the beginning, which
tempted me to throw my
controller away and call the
whole thing off.

Thirdly—and this is the
silliest—to keep the Darkness
from being harmed by the
light, you end up worrying
more about lights in the room
than enemies. It’s like being

trapped in a very stupid
arcade shooter. Fourthly, this
game, too, doesn’t escape
some of the annoying bugs
that plague so many FPSes—
you can be stopped dead in
your tracks by a lowly tree-
root or knee-high obstacles
that four-year olds wouldn’t
think twice about: the same
old nonsense. Tch, tch.

Finally, the enemy AI is
quite pathetic. The fact that I
was more worried about the
lights than enemies should
have given you some clue to
that end.

The Darkness is a decent
game—the evil, it gets addic-
tive—but not beyond the first
couple of hours. There are
much better things to do
with your 360. Like play Gears
of War.

nimish_chandiramani
@thinkdigit.com

Rating: 6/10; Developer: Starbreeze AB; Publisher: 2K Games; Distributor: Redington;
Contact: xbox360@redington.co.in; Price: Rs 1895; Platform: Xbox 360

Turn Out Those Lights!
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O
f late, it appears the Ragnarok hype
has fizzled down. Now I’m holding a
DVD of Sword of the New World, an
MMORPG that was launched around
May; the person behind this project

is the same guy who made Ragnarok Online. 
Well, you start the game and there is this

painful wait while it gets updated off the Inter-
net… Once logged in, you create a character
(like in every MMORPG or RPG out there). There
are five races to choose from—Fighter, Muske-
teer, Wizard, Scout, and Elemantalist, each with
its own set of strengths and weaknesses. 

(For those who aren’t familiar with
MMORPGs, they are multiplayer games
played alongside thousands of players, com-
pleting one mission after another. Experience
is gained when you kill monsters, which
moves your character to the next level.)

Nothing really special there, but what’s
special is, you can create up to three differ-
ent characters, and move all of them around
the game maps while still having control over
every character individually! There are plen-
ty of quests and missions to keep you occu-
pied for a long time.

It’s fairly easy to level up, but some of the
more powerful monsters can be a little diffi-
cult at times, and the lag doesn’t help—so
choose your monsters wisely. 

All seemed to be going fairly well, but then
came this monster camp. Get this—first you
have crocodiles hopping around like kanga-
roos. Then you have roosters as large as the
crocodiles. Just when you think you’ve seen

everything, some of them explode when killed,
into a mango, which you pick up to regenerate
health. Perfect! Just like in real life…

The character outfits are very well-made,
and more importantly, unique; not cheesy like
in most MMORPGs. The environments are
simple but colourful and fresh.

We knew lag was going to be the major
issue with MMORPG servers based far away
from India, but it didn’t feel all that bad, sur-
prisingly. There is a slight delay of one to two
seconds every time you execute a Move or
Attack command, but nothing that really
dampens the experience.

Unfortunately, you don’t come across a
lot of players in Sword of the New World— it’s
a very young community as of now.

This MMORPG is only getting started
and can be a crowd-puller given the right
amount of exposure. No Indian servers
yet, so we’ll have to do with the Euro-
pean and American ones. Sword of
the New World goes far beyond
Ragnarok Online, but it’s going
to be a tall order to knock
over heavyweights like
World of Warcraft and Guild
Wars. Personally, I’m not
very impressed—I don’t see
myself playing it for months
together. Still, the game is fun—in
a weird manner. It’s an over-the-
top experience Ragnarok fans
will undoubtedly appreciate.

rossi_fernandes@thinkdigit.com

Sword of the New World: 

Granado Espada NVIDIA GeForce 8800Ultra,
Intel Core 2 Duo E6600,

4 GB RAM, Windows Vista
Ultimate x64, WD 250 GB 

GAMING PC
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I’m overjoyed at seeing a 32-
inch LCD TV connected to
our Xbox 360 for one of this

month’s games to play. Well, I
move my focus from the setup
to the game title—Project
Sylpheed—a space combat
arcade game. We haven’t seen a
game from this genre for a
while now, so I feel a bit of
excitement building up and
some curiosity.

I pop in the disc and all of a
sudden I’m in the middle of a
good looking CG movie with
anime-styled characters—
something like Final Fantasy.
At the end of the cinematic, I
decide to get the game going
but I’m delayed by some more
cut-scenes.

In the game, you play the
role of one Katana Faraway, a
pilot whose job it is to blow the
enemy’s ships and destroyers
into kingdom come with your
ship. To help you do this, you fly
a small combat ship alongside
your “comrades,” who are of no

use other than screaming at
you and keep whining about
your higher-ups. You can have
your vehicle upgraded with all
kinds of weapons from simple
machine guns to lasers and
lock-on missiles that make
mincemeat out of enemies.

The game looks nice—it’s
cramped with colourful
exhausts and weapon rounds
from all kinds of ships and space
vehicles. The environment is
made up well—empty space
with stars scattered all over, and
an occasional planet. The on-
screen display is filled with
statistics and pointers meant to
lead you to enemies. There are
speed meters and a hundred
gazillion other things. This is
both messy and scary when you
first sit down to play this.

The controls are a little
difficult in the beginning. The
lock-on missiles make every-
thing very easy, though. You
hold down a key and manoeu-
vre your ship so you have your

enemy ship into the crosshairs
till you get a lock-on. Let go of
the key and the rockets will
home into the ship, destroying
it. The challenge comes in the
form of numbers. The missions
are quite long due to the
masses of enemy ships. The
entire gameplay is made up of
you chasing one ship after the
other—and that’s it. This
continues till a mission ends,
after which certain weapons
and achievements are
unlocked. You can then add
these to your ship before
moving to the next mission.

The sounds of the ships are
lacking considering it’s an
arcade game. There’s some
fairly decent character voice
acting, but the music is just
plain cheesy.

The game gets repetitive,
and you end up using the same
set of weapons and the same
strategies over and over. It can
provide satisfactory entertain-
ment if played once and once

only. There is no multiplayer
option either.

All said, it’s good to have a
space combat game around—
something we PC gamers
haven’t had a chance to enjoy
in a while—but then these
games are best played on
consoles or with a good game-
pad, not a keyboard. Retro
space-combat-lovers will find
a fulfilling experience in
Project Sylpheed. I can’t call
this game fun for everybody;
it’s not really deep, nor is it
very interesting.

rossi_fernandes@thinkdigit.com
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A Thanks For The Thankless!
Considering that there is a 50%
probability that my letter be published,
I’ll write just a little about myself, lest
people who read it come to know the
state of the writer.

To be honest, I am no alpha geek.
No, I don’t know what 90% of files in
the system32 folder do. But my life is
under no evident threat (or I may be
ignorant) for that. Like an average guy, I
encounter technology the way you may
expect me to, maybe a little more owing
to my inquisitiveness. But a fan of the
digital world, that I am. And thanks to
Digit, proudly so. Every issue makes me
realise how little I actually know and
how much more there is. And I know
how it feels to be ignorant as far as
technology is concerned.

All this time, I’ve read the letters you
receive from cynics, protagonists, fans,
followers and critics. All go about the
“stuff” you provide along with more
“stuff” they’d like (your team tackles all
letters with robust diplomacy, humility
and honesty, I must say). But apart from
the DVD, CD and Fast Track, I’d like to
mention a few things.

I am more than glad for the
computer info you provide, but what’s
more that makes an otherwise dreary,
all-geeky article is the language you guys
muster. Awesome is hardly the word for it.
It is real fun to read the articles, the
Escape section, and the rest of the mag -
full of pun, humour and satire. Actually,
I also learn a lot of good English from
your magazine too. Thanks for that and
keep up the amazing articles. For the
digital part of life, I’m soulfully
dependant on you, and satisfied fully
with everything you are putting up. So
no suggestions from me, except maybe:
just keep rocking our gadget infested,
mundane lives!

Siddhartha Mukherjee

Thanks, Siddhartha, for your kind remarks—
especially from our copy editors! From what I
understand, it is primarily them you’re thanking—
and it is primarily they who are responsible for
quality control in terms of language, and little
things like humour. (That’s not to say their roles
are limited to these functions, of course.)

A copy editor’s (or sub-editor’s) job is
seldom appreciated, because they get no formal
credit for anything they do—and rarely do they
even get informal credit. It is, in general, a
thankless job. Your mail has motivated them to
buck up and keep up the good work—and I must
thank you for that!

— Executive Editor

A Pal’s Praise And Problem
I’m a regular reader of your excellent
magazine. Digit is simply the best. I want
to wish Team Digit a happy Friendship
Day. If you’re wondering why I’m wishing
you, well, seriously, Digit is the best friend
to guys like me who want to know more
and more about technology. I live in a
remote village in the eastern part of India
where the use of technology is still a
dream for most people. I face so much
trouble to get simple software, and CDs or
DVDs of games, music, and movies. I have
to travel 10 km from my home to gain
access to the Internet. I can’t gain do that
regularly, and an Internet connection to
my PC is a dream in here. But in spite of
this, I love to know more about
technology, and you are who helps me a
lot. That’s why you are my best friend, and
I’m sure we will be friends for a really
long time!

In your August issue, you’ve
mentioned that the price of the Nokia
N73ME is Rs 24,349. I was planning to buy
a good camera phone, so I went to a Nokia
priority dealer. When I asked them about
the N73ME, they told me the price was Rs
18,500, and when I told them about the
price mentioned in Digit, they said the
price you’ve mentioned was in the market
five months ago, and that they’d reduced
since then. I’m a bit confused.

Hirak Ghosh
Dist. Hooghly

We do our best to serve the needs of all our
readers, but more so readers like you, who don’t
have easy access to technology and the Internet.
Thanks for the appreciation, Hirak.

Regarding the price of the Nokia model
you’ve mentioned, what we publish is the MRP
(maximum retail price), which is consistent
throughout the country. Dealers often quote the
MOP (market operating price), which is affected

by local taxes, VAT, and other levies. Hence the
discrepancy.

— Executive Editor

Faster, Higher, Stronger!
I wrote to you exactly two years ago. You
published that letter in August ‘05 as the
Letter of the Month. Much has happened
since then. My hobby of assembling
systems turned into a profession. I joined
a small computer sales and service centre;
I assembled systems as a hobby. I learnt
networking. In 2006 we turned to
importing PC hardware and marketing it
only through dealer channels. We
registered our own trademark and are
marketing our own brand. We have mice,
webcams, card readers, etc. Our stockists
and distributors are spread all over India. I
will soon be starting a cyber cafe. 

You’re probably wondering why I’m
telling you all this. It’s because Digit has
been my guide and companion all these
years. It has guided and taught me to
build a career out of a hobby. I want to
give credit where it is due.

I am still pursuing my creativity with
hardware. In April ‘07, you showed us how
to build a modded case. I’m thinking
about starting work on one. But instead of
using an old CRT, I’ve decided to use an
old 0.8 tonne AC cabinet… I am currently
experimenting with various flavours of
Linux using Virtual Box. Thank you for
keeping me young at 64 years of age.

D S Bapat
Dear Mr Bapat,
What can I say? All I can think of is that I’ve sent
out your mail to my team, and it has been
appreciated as hugely motivating. Thank you.

— Executive Editor

Misunderstanding
Notwithstanding…
Digit is my technology friend, philosopher,
guide, and my Guru. But this is about the
August 2007 Inbox. I’m referring to the
letter by Navin D’Cunha and your reply. It
is interesting and surprising!

Navin has rightly pointed out the
wonderful cover of the July ‘07 issue of
Digit. He wrote: “…the cover left me with a
pleasant feeling, at the same time
surprising me.” Most of us had that
feeling. This is certainly an appreciatory
note, and there is absolutely nothing
negative about it. He continues his words,
very simple and honest. But it looks that
you, in your reply, were confused and
offensive. Navin’s comments are highly
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positive, and you’ve misunderstood them.
Your elaboration (as if no one understands
the psychology behind the cover page!)
clearly reflects that. May I request you to
read (be cool!) Navin’s comments once
again? I can now hear your “Oh… Yeah…
That’s right…”

The cover was really excellent. Keep it
up, Digit designers! And, Navin, I’m sure
you’re checking that cover over again to
confirm… I too do that quite often since I
got that issue!

Prasanna
Thank you, Prasanna, for giving me an
opportunity to rethink myself… I’ve gone through
Navin’s mail again, and I must say that while I
have not taken enough note of the positive tone
there, you’ve missed Navin’s sarcasm.

What seemed a defense—on my part—of the
cover design was not really a defence. It was an
explanation, and I still say I’m not an expert in
such matters: although I do approve of the cover
before it goes to print, I leave the psychology
behind it to the designers! And coming to that, I
have passed on your congratulations to my
design team. They’re pleased as punch!

— Executive Editor

Beyond Tech
The great enlightened Maharishis of our
time are warning everyone that
electromagnetic field (EMF) damage to the
nervous system and health of the
physiology is real. You’ll not find Wi-Fi in
their Ashrams. In the 1990s, significant
scientific research linked leukaemia and
skin cancer to the EMF coming from poor
building wiring. More evidence on
damage from mobile phones and other
powerful electrical transmitters is
coming. The fascination of wireless
communication and entertainment is
real, but why not open your hearts and
mind to the experience of Totality and the
Kingdom of Heaven within?

Vidhyapeeth
Uttarkashi

Dear Mr Vidhyapeeth,
As I’ve heard—and as I see it—EMF having a
negative effect on physiology is a controversy-
ridden topic, with some people crying
themselves hoarse that there is a link, and some
doing the same thing to convince people there is
none. As a result, I must admit, I cannot say
anything for or against the idea.

In regards to all this vis-à-vis what you refer
to as the Kingdom of Heaven within, some might
subscribe to your view, some might not. We are
a technology magazine, and our only aim and
duty is to educate and motivate people on that
front. We might, perhaps, take an in-depth look

Inbox

Write to the Editor
E-mail: editor@thinkdigit.com

Snail Mail: The Editor, Digit, D-222/2, Om Sagar Building,
MIDC, TTC Industrial Estate, Nerul
Navi Mumbai 400 706

Digit will publish the best letters on these pages. Letters may be edited for clarity.
PPlleeaassee  iinncclluuddee  yyoouurr  ccoommpplleettee  aaddddrreessss  iinn  aallll  ccoommmmuunniiccaattiioonn..  

For subscription queries, call the help desk at 
022-27629191/9200, fax 022-27629164, or 
send an e-mail to help@jasubhai.com

at what the truth really is about wireless
radiation and health.

— Executive Editor

The Disc Is In The Mail!
Your team always proves that Digit is
the best. I’ve never subscribed to any
other magazine all the past five or six
years—nothing can make me feel
complete with its quality and overall
growth. But it’s only Digit that I’ve been
reading regularly. Every time I  think
Digit is repeating itself or that there’s
nothing in it to spend my time on, you
come up with something new… thanks!

This issue (August ‘07), though,
spoilt my holiday. The DVD isn’t
working. I found nothing wrong at my
end. It’s not the only problem I’ve had
with your magazine. The December
issue, too, arrived with damaged discs.
Thank God there was no problem with
the anniversary issue… is there
anything you can do?

I have some suggestions: please
make sure the packaging of the discs
and of the June and December special
issues is good. Second, always think
about those who do not have high-end
computers—and you could increase
your circulation, helping more people
use technology. Then, I am still waiting
for a Fast Track on programming.

Adding video or Flash-based
tutorials can help us understand new
software. This is one area Digit lacks in.

Shift some reading material to the
discs—like Tips & Tricks and Q&A. 

Inderdeep
Hoshiarpur, Punjab

Thanks for your suggestions, Inderdeep—
we’ll be thinking about them, but there are
lakhs of readers to please, and we need to
find the best way to please as many of them
as possible. I must say, though, that adding
something like Flash-based tutorials would
be a considerable added expense, one we
cannot bear.

We welcome suggestions, though,
because that’s the only way we know what
our readers want. Letters like yours are
especially valuable—feel free to write in
again, with as many suggestions as you can
think of!

Regarding your damaged discs, all you
need to do is mail us with your subscriber
number and postal address with PIN code,
and your replacementss will be on their way!

— Executive Editor

India Online
In your May 2007 issue,
the absence of a
vernacular Web presence
was discussed, and the
features of “uRekha” were
brought out. It is
necessary to bring your
notice that there is a single
software to create documents in almost
all Indian languages, and it’s free!
Kindly go to www.baraha.com and assess
its versatility and utility in a field
which, you lament, is neglected. You
can inspire enthusiasts to create Web
portals using the resources available.
The economics of maintaining a Web
sites is perhaps the main reason for the
current situation.

Here’s an extract from that page:
Baraha is a word processing application for
creating documents in Indian languages. It
is developed with an intention to provide a
free software to enable and encourage
Indians use their native languages on the
computers. Baraha can be effectively used for
creating documents, sending emails and
publishing web pages. Baraha 7.0 supports
Kannada, Devanagari, Tamil, Telugu,
Malayalam, Gujarati, Gurumukhi, Bengali,
and Oriya scripts.

“With 35,000 downloads/month, hundreds
of thousand users have downloaded Baraha so
far. Baraha is used in publications, schools,
banks, government and private offices, various
Indian organizations and millions of homes
around the world.”

M N Sathyanarayana Rao

Dear Mr Rao,
Thanks for bringing the site and software to
our notice. As we can see, the Baraha software
has its utility—it makes it easy to type in several
Indian languages using the regular US keyboard
layout. There is also a feature where you type
in something in English, choose a supported
Indian language, and you get character output
in that language—which you can then paste into
any application. (However, that feature is not
quite perfect.) We do encourage our readers to
visit www.baraha.com.

I’d also like to say that we made special
mention of uRekha because it is gesture-
based, making it very easy to learn—in fact,
there is hardly any learning required (for
supported languages) to be able to input text.
That is something that is sure to be
appreciated in our villages and other rural
areas, where people don’t know the English
alphabet, or are not comfortable using a
keyboard, or both.

— Executive Editor

Letter 
of the
Month
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Name the technology by
which Vista can use a Flash

drive as cache.
(a) Turbo Cache
(b) ReadyBoost
(c) Power Cache
(d) InstaBoost

What processor does the
XO-1 (the laptop in the OLPC

programme) use? 
(a) Celeron
(b) AMD Geode
(c) UltraSPARC T2
(d) VIA C7 M

You should know this one.
GSM stands for… 

(a) Groupe Spécial Mobile
(b) Global System for Mobile com-
munications

(c) General Standard for Mobility
(d) Gesellschäftliche Schema des
Motorolas

All FLAs, and the odd one
out is…

(a) CDMA (c) HSCD
(b) GPRS (d) EDGE

(Tough!) What was the code-
name of Windows CE?

(a) Prescott
(b) Worcestershire
(c) Wyvern
(d) Foxwood

Bill Gates and Paul Allen
wrote a version of BASIC for

which microprocessor?

(a) The 8080
(b) The 8088
(c) The Z80
(d) The Motorola 68000

And then, how much memo-
ry did Gates famously say

would be "enough for anybody"?
(a) 5 MB
(b) 64 KB
(c) 640 KB
(d) 1 MB

How many gigabytes are in
a petabyte?

(a) One million
(b) One hundred
(c) One thousand
(d) Ten million

Richard Stallman is well-
known in the context of…

(a) The GPL (GNU Public License)
(b) Cryptography (As in RSA)
(c) E-mail (He sent the first one)
(d) DRM (He’s a strong advocate)
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ACROSS
7. Extended Data Out Random Access Memory

(abbr) (6)
8. The process of locating information on the

Internet (6)
10. Electrical device that receives or sends radio

or television signals (7)
11. Spreadsheet programme from Microsoft (5)
12. Connection of two web pages or websites (4)
13. One more hardware unit put in a computer to
increase its utility (3,2)
17. Multi------—sound and video on computers (5) 
18. Front End Programming Interface(abbr) (4)
21. Computer cubicle in a cyber café (5)
22. ------pair- copper wire that connects home and
business computers to the telephone company (7)
23.------pages or the telephone directory (6)
24.Testing stage of a commercial hardware
or software product (4)

DOWN
1. Factory setting for user-configurable options (7)
2. E-mail security firm bought over by Google (7)
3. Net-----—child safety Internet software (5)
4. --------processor- Intel Corporation’s trade
name for its family of Pentium II microprocessors
(7)
5. Breaking-in or getting around a software
programme or password (5)
6. Programme that meiates access to a particular system
or server (5)
9. Information carrying capacity measured in Hertz (9)

14. ‘D,T’ in DTP (4,3)
15.’C’ in CPU (7)
16. Microsoft------—operating system for computers (7)
19. Digital------—programme that can quickly clone drives
to drives or files to files (5)
20. The smallest unit of a picture on a computer screen (5)
21.---board- input device (3)

Crossword 

Got an
interesting
question? 
Send it in with
the answer to
TQ@thinkdigit.com
Mark “TQ” in the
subject area.

Rob Peta To Pay Paul
Logitech is the first company

to have brought out  
(a) A mouse that works in the air 
(b) A waterproof mouse
(c) The laser mouse 
(d) A mouse with fur and 

big ears

1

In the Deep Web, the
part of the Web not

catalogued by search
engines, information is said
to be 500 times more than on
the WWW. Database queries,
for example, can access some of
that information.

Did You
Know?

Answers

1.(a) A mouse that 

works in the air

2.(b) ReadyBoost

3.(b) AMD Geode

4.(b) Global System

for Mobile 

communications

5.(a) CDMA; the 

rest use GSM

6.(c) Wyvern

7.(a) The 8080

8.(c) 640 KB

9.(a) One million

10. (a) The GPL

Crossword by Nitta Jaggi

Last Month’s Solution

August’s Winner:
Vivek Goel, Meerut - 250001

Send in your entries to
TQ@thinkdigit.com
on or by 20th of this
month. One lucky
participant will 
win Beginning Excel
Services
By Liviu Asnash, Eran
Megiddo, Craig Thomas
Published by

Win!



People And Events That Grabbed The Headlines—For Better Or For Worse

In general, people think the
Internet is here to stay. They
seem to like it. Yes, there

are people who say the
Internet is good. John, Sir
Elton, is not one of them. This
Sir-bloke hates the Internet—

he can’t wait to go back to the
good old days when the Big
Network was only for the
boffins and geeks in
universities.

So here’s his reason: there
has been a surfeit of
technology, and this has made
people too lazy. The Internet is
creating a lot of mediocre
stuff, which is good most of
the time, but that it is
hampering the creation of
masterpieces. 

Never a man to rant about
a problem without suggesting
a solution, the admittedly
talented musician says the
only solution is to shut down
the Internet for five years and
see what sort of stuff is created
then. Food for thought, is our
only comment. (Who knows?)

Pearl Jam hates Dubya. And
in case people doubt it,
they make their distaste

amply clear through lyrics like
“George Bush leave this world
alone” and “George Bush find
yourself another home.”
Problem is, nobody heard
them—those lyrics were edited
out. This happened during a

cybercast of a Pearl Jam concert
hosted on an AT&T Web site.
The company later apologised
in pleading tones; they said a
subcontractor was responsible
for what had happened. Come
on out, conspiracy theorists
and free speech advocates—tell
us about what politics went
into this. We can’t figure.

Marshall Mathers II—better
known as Eminem the
wannabe nigga—recently

sued Apple for featuring one of
his tracks in an iTunes Store ad
without consent. In the ad, aired
on MTV (who is also facing the
music), Eminem’s Lose Yourself
was belted out by a ten-year-old.
(White, black, or confused, we
don’t know.) Now the record com-
pany that owns the copyrights—
Eight Mile Style, if you really

want to know—is crying foul on
behalf of the “Wigger”—and
claiming about $10 million in
damages. There were efforts to
settle the deal out of court, but,
etc. etc. and now both sides are
readying themselves for a court
battle. Incidentally, a number of
Eminem’s tracks are available for
sale on the iTunes store, and
that’s another legal matter.

Apple has had run-ins with
the music industry earlier (par-

don us for insinuating
that Eminem’s stuff is
music). They was sued
twice by the Beatles’
music label Apple Corp.
for using its name. Then
there have been the law-
suits relating to restrict-
ing iTunes music to iPods
only… litigators just
seem to love the compa-
ny. But it’s reciprocal.
Let’s not get into that.

Eminem Raps Apple

We Don’t Need No Censors

Recognise the picture?
That’s Jessica Alba. She’s
featured on your

wallpaper at some point or the
other—if you’re a reasonably
red-blooded male, that is. If
you aren’t—or if you’re
female—you’ll need a line of an
introduction: Ms Alba is an
actress. She starred in Fantastic
Four, Dark Angel, and other
movies. In addition, Jessica the
natural brunette (!) has been
dubbed the sexiest woman in
the Milky Way or some such
epithet by practically all the
authorities out there: FHM,
Maxim, AskMen.com, and even
Playboy. Which is over the top—
she’s just a good-looking
woman, especially on
wallpapers.

Then,  someone seems to
have done body scans of her
(and why not?), and characters
that look just like her (she’s
said this is “completely cool

and bizarre”) have been
spotted on the games based on
those movies.

But Ms Alba hasn’t just
been featured (in a sense) in
games, she also plays them.
Quite a bit, apparently. She
loves the Nintendo DS, and
now, the Wii. Body movements
translate into movements in
the game, see? So that’s her
exercise plan… As a matter of
fact, her favourite is Wii Sports,
which includes baseball
and tennis games; an hour of
this at the Wii burns quite a
few calories.

Women gamers are hard to
come by, and celebrity gamers
are hard to come by, too. Now
take the two and you have
a woman celebrity gamer—
rare indeed!

Seriously, it’s refreshing to
see a body-based celebrity
whose first and last attribute is
not the curves.

Wallpaper Woman Wields
WiimoteIt Kills The Mind
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